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CHAPTER 1

How TIBCO EBX works

This chapter contains the following topics:

1. Product overview

2. EBX architecture

1.1 Product overview

Master Data Management (MDM) is a way to model, manage and ultimately govern shared data.
When data needs to be shared by various IT systems, as well as different business teams, having a
single governed version of master data is crucial.

With EBX, business and IT users can collaborate on a single, unified solution in order to design data
models and manage master data content.

EBX is an MDM software that allows modeling any type of master data and implementing
governance using the rich features included, such as collaborative workflows, data authoring,
hierarchy management, version control, and role-based security.

An MDM project using EBX starts with the creation of a data model. This is where tables, fields, links
and business rules related to the master data are defined. Examples of modeled data include product
catalogs, financial hierarchies, lists of suppliers or simple reference tables.

The data model can then be published to make it available to datasets, which store the actual master
data based on the structure defined in the data model. Datasets are organized and contained within
dataspaces, containers that isolate updates from one another. Dataspaces allow working on parallel
versions of data without the modifications impacting other versions.

Workflows are an invaluable feature for performing controlled change management or data approval.
They provide the ability to model a step-by-step process involving multiple users, both human and
automated.

Workflow models detail the tasks to be performed, as well as the parties associated with the tasks. Once
a workflow model is published, it can be executed as data workflows. Data workflows can notify users
of relevant events and outstanding work in a collaborative context.

TIBCO EBX® Product Documentation 6.0.5 15



Documentation > User Guide > Introduction > How TIBCO EBX works

Data services help integrate EBX with third-party systems (middleware), by allowing external systems
to access data in the repository, or to manage dataspaces and workflows through web services.

-

Repaository

Data Waorkflow

"Vodel (=
Model Publish ]
Users via
Web User Interface

Data I Data Set Data Space

al
Maodel Publish
) Systems
Child <:| via DataServices
Data Set | bsta Space

See also

Data modeling [p 26]
Datasets [p 28]

Dataspaces [p 30]
Workflow modeling [p 31]

Data workflows [p 32]

Data services [p 33]
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1.2 EBX architecture

The following diagram illustrates the EBX architecture.

User-friendly web tool with
automatic GUI generation

Rich data models
based on XML Schema

Data configuration and
validation, lifecycle and
permissions management

Integration with 3" party
systems through data
services and import &
export services

Data Integration

Custom

Applications RDBMS Data Warehouse ERP/CRM
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CHAPTER 2

Using the user interface

This chapter contains the following topics:
1. Overview

Advanced perspective

Perspectives

User pane
User interface features

Where to find EBX help

O e

2.1 Overview

The general layout of TIBCO EBX workspaces is entirely customizable by a perspective administrator.

If several customized perspectives have been created, the tiles icon 'Select perspective' allows the user
to switch between available perspectives.

The advanced perspective is accessible by default.

See alsoUI administration [p 407]

2.2 Advanced perspective

By default, the EBX advanced perspective is available to all users, but its access can be restricted
to selected profiles. The view is separated into several general areas, referred to as the following in
the documentation:

Note

The advanced perspective is still accessible to users through explicit selection (for
example through a Web component). Unlike other perspectives, it can only be "hidden"
in the user interface so that users cannot apply it themselves.

+ Header: Displays the avatar of the user currently logged in and the perspective selector. Clicking
on the user's avatar gives access to the user pane.

+ Menu bar: The functional categories accessible to the current user.
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» Navigation pane: Displays context-dependent navigation options. For example: selecting a table
in a dataset, or a work item in a workflow.

«  Workspace: Main context-dependent work area of the interface. For example, the table selected
in the navigation pane is displayed in the workspace, or the current work item is executed in the
workspace.

The following functional areas are displayed according to the permissions of the current user: Data,
Dataspaces, Modeling, Data Workflow, Data Services, and Administration.

| Menu bar | [Header | ?

<, Current section | | Context-sensitive help |

Workspace

Navigation pane

2.3 Perspectives

The EBX perspectives are highly configurable views with a target audience. Perspectives offer a
simplified user interface to business users and can be assigned to one or more profiles. This view is
split into several general areas, referred to as the following in the documentation:

» Header: Displays the avatar of the user currently logged in and the perspective selector (when
more than one perspective is available). Clicking on the user's avatar gives access to the user pane.

» Navigation pane: Displays the hierarchical menu as configured by the perspective administrator.
It can be expanded or collapsed to access relevant entities and services related to the user's activity.

+ Workspace: Main context-dependent work area of the interface.

Perspectives are configured by authorized users. For more information on how to configure a
perspective, see perspective administration [p 408].
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Example of a hierarchical menu:

= Reference documentation ?
Governance + Actions =

1-100 of 1,006 T View b M|
.l Dashboard

[5 Information governance

& Business glossary
Workflow

& & Inbox
«d Launcher

[l Supervision

Reference data

¥ Reference documentation

Favorite perspectives

When more than one perspective is available to a user, it is possible to define one as their favorite
perspective so that, when logging in, this perspective will be applied by default. To do so, an icon is
available in the perspective selector next to each perspective:

« A full star indicates the favorite perspective. A click on it will remove the favorite perspective.

« An empty star indicates that the associated perspective is not the favorite one. A click on it will
set this perspective as the favorite one.

Public access W9

Restricted access *
o

¢ Advanced perspective

See alsoRecommended perspectives [p 420]

2.4 User pane

General EBX features are grouped in the user pane. It can be accessed by clicking on the avatar (or
user's initials) in the upper right corner of any page.
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The user pane is then displayed with the user avatar and gives access to the profile configuration
(according to the user's rights), language selection, density selection and online documentation.

Attention
The logout button is located on the user pane.

Avatar

An avatar can be defined for each user. The avatar consists in a picture, defined using a URL path;
or in two letters (the user's initials by default). The background color is set automatically and cannot
be modified. Regarding the image that will be used, it has to be a square format but there is no size
limitation.

Note

Avatars appear in the user pane, history and workflow interfaces.

1

The feature is also available through the Java method uiComponentwriter.adduserAvatar™.

The avatar layout can be customized in the 'Ergonomics and layout' section of the 'Administration’
area. It is possible to choose between the display of the avatar only, user name only, or to display both.

Density

Users can now choose their display density mode between 'Compact’ and 'Comfortable'. The display
mode can be modified from the user pane.
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2.5 User interface features

Resetting the navigation pane width

After having resized the width of the navigation pane, you can restore it to the default width by
hovering over the border and double-clicking.

I -

D-5593 - Book store ?

Book store -

Actions ~

Titles
Publishers
Authors
Royalties
<+
Contracts

2.6 Where to find EBX help

In addition to the full standalone product documentation accessible via the user pane [p 211, help is
accessible in various forms within the interface.

Context-sensitive help

When browsing any workspace in EBX, context-specific help is available by clicking on the question
mark located to the right side of the second header. The corresponding chapter from the product
documentation will be displayed.
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Contextual help on elements

When you hover over an element for which contextual help has been defined, a question mark appears.
Clicking on the question mark opens a panel with information on the element.

Titles (ﬂ}3

Titleﬁs 4
Publi
Book titles
Authi
Table
Royal
History Profile: ebx-allBranches
Contr Database table name: EBX_HG_TITLES
Information Display is limited to 200 columns
Data path froot/Titles

When a permalink to the element is available, a link button appears in the upper right corner of the
panel.

Permalink to Titles
hitp:/localhost:8080/ebx/?xpath=%2Froot%2 GF 4%

Close
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CHAPTER 3

Glossary

This chapter contains the following topics:
1. Governance

Data modeling

Datasets

Data management life cycle

History
Workflow modeling

Data workflows

Data services

£ LN e WD

Cross-domain

3.1 Governance

repository
A back-end storage entity containing all the data managed by TIBCO EBX. The repository is
organized into dataspaces.

See also dataspace [p 30].

profile

The generic term for a user or a role. Profiles are used in data workflows and for defining permission
rules.

See also user [p 25], role [p 26].
Related Java API Profile™.

user

An entity created in the repository in order for physical users or external systems to authenticate and
access EBX. Users may be assigned roles and have other account information associated with them.

See also user and roles directory [p 26], profile [p 25].

Related concept User and roles directory [p 435].
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1

Related Java API userReference™.

role

A user classification, used for permission rules and data workflows, which can be assigned to users.
Each user may belong to multiple roles.

Whenever a role profile is specified in EBX, the behavior resulting from that designation is applied
to all users that are members of that role. For example, in a workflow model, a role may be specified
when defining to whom work items are offered. As a result, all users belonging to that role can receive
the same work item offer.

See also user and roles directory [p 26], profile [p 25].

Related concept User and roles directory [p 435].
Related Java API Role™.

administrator

A predefined role that has access to the technical administration and configuration of EBX.

user and roles directory

A directory defining the methods available for authentication when accessing the repository, all
available roles, and the users authorized to access the repository with their role assignments.

See also user [p 25], role [p 26].

Related concept User and roles directory [p 435].

1

Related Java API birectory™, DirectoryHandler™.

user session

A repository access context that is associated with a user after being authenticated against the user
and roles directory.

Related concept User and roles directory [p 435].

Related Java API session™.

3.2 Data modeling

Main documentation section Data models [p 36]

data model

A structural definition of the data to be managed in the EBX repository. A data model includes detailed
descriptions of all included data, in terms of organization, data types, and semantic relationships. The
purpose of data models is to define the structure and characteristics of datasets, which are instances
of data models that contain the data being managed by the repository.

See also dataset [p 28].

Related concept Data models [p 36].
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field

A data model element that is defined with a name and a simple datatype. A field can be included in the
data model directly or as a column of a table. In EBX, fields can be assigned basic constraints, such as
length and size, as well as more complex validation rules involving computations. Automated value
assignment using field inheritance or computations based on other data can also be defined for fields.
Aggregated lists can be created by setting the cardinality of a field to allow multiple values in the
same record. Fields can be arranged into groups to facilitate structural organization in the data model.

By default, fields are denoted by the icon =.

See also record [p 28], group [p 27], table (in data model) [p 27], validation rule [p 28],
inheritance [p 29].

Related concepts Structure elements properties [p 53], Controls on data fields [p 67].

Related Java API schemaNode™.

The former name (prior to version 5) of "field" was "attribute".

primary key
A field or a composition of multiple fields used to uniquely identify the records in a table.

Primary keys are denoted by the icon &=,

Related concept Tables definition [p 5311.

foreign key

A field or a composition of multiple fields in one table whose field values correspond to the primary
keys of another table. Foreign keys are used to reference records in one table from another table.

Foreign keys are denoted by the icon ==,

See also primary key [p 27].
Related concept Foreign key [p 536].

table (in data model)

A data model element that is composed of fields and/or groups of fields. Every table must define at
least one field to act as the unique identifier, or primary key, of records. A table in a data model can
be used to create a reusable type based on the table's structure, which can then be used to create other
elements of the same structure in the data model.

Tables are represented by the icon :=:]
See also record [p 28], primary key [p 27], reusable type [p 28].

group

A classification entity used to facilitate the organization of a data model. A group can be used to
collect fields, other groups, and tables. If a group contains tables, the group cannot be included within
another table, as the constraint that tables cannot be nested must be respected. A group can be used to
create a reusable type based on the group's structure, which can then be used to create other elements
of the same structure in the data model.

Groups are represented by the icon [,
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See also reusable type [p 28].
Related Java API schemaNode™.

reusable type

A shared simple or complex type definition that can be used to define other elements in the data model.

validation rule

An acceptance criterion defined on a field or a table. Data is considered invalid if it does not comply
with all imposed validation rules.

The former name (prior to version 5) of "validation rule" was "constraint".

data model assistant (DMA)

The EBX user interface includes a tool that aids the implementation of data models. It allows defining
the structure of data models, creating and editing elements, as well as configuring and publishing data
models.

See also Data models [p 36].

3.3 Datasets

Main documentation section Datasets [p 112]

record

A set of field values in a table, uniquely identified by a primary key. A record is a row in the table.
Each record follows the data structure defined in the data model. The data model drives the data types
and cardinality of the fields found in records.

See also table (in dataset) [p 28], primary key [p 27].

The former name (prior to version 5) of "record" was "occurrence".

table (in dataset)

A set of records (rows) of the same structure containing data. Each record is uniquely identified by
its primary key.

Tables are represented by the icon .
See also record [p 28], primary key [p27].

dataset

A data-containing instance of a data model. The structure and behavior of a dataset are based upon
the definitions provided by the data model that it is implementing. Depending on its data model, a
dataset contains data in the form of tables, groups, and fields.

Datasets are represented by the icon .

See also table (in dataset) [p 28], field [p 271, group [p 271, Views [p 291.

Related concept Datasets [p 112].

The former name (prior to version 5) of "dataset" was "adaptation instance".
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inheritance

A mechanism by which data can be acquired by default by one entity from another entity. In EBX,
there are two types of inheritance: dataset inheritance and field inheritance.

When enabled, dataset inheritance allows a child dataset to acquire default data values from its parent
dataset. This feature can be useful when designing a data model where data declared in a parent scope
will be used with the same value by default in nested child scopes. Values that are inherited from the
parent can be overridden by the child. By default, dataset inheritance is disabled. It can be enabled
during the data model definition.

Inheritance from the parent dataset is represented by the icon “a.

Field inheritance is defined in the data model to automatically fetch a field value from a record in
another table.

Inherited fields are represented by the icon .

Related concept Inheritance and value resolution [p 270].

views

A customizable display configuration that may be applied to viewing tables. A view can be defined
for a given user or role, in order to specify whether records are displayed in a tabular or hierarchical
format, as well as to set record filtering criteria.

The hierarchical view type offers a tree-based representation of the data in a table. Nodes in the tree can
represent either field values or records. A hierarchical view can be useful for showing the relationships
between the model data. When creating a view that uses the hierarchical format, dimensions can
be selected to determine the structural representation of data. In a hierarchical view, it is possible
to navigate through recursive relationships, as well as between multiple tables using foreign key
relationships.

See also

Views [p 121]

Hierarchies [p 123]

recommended view

A recommended view can be defined by the dataset owner for each target profile. When a user logs
in with no view specified, their recommended view (if any) is applied. Otherwise, the default view
is applied.

The "Manage recommended views' action allows defining assignment rules for recommended views
depending on users and roles.

Related concept Recommended views [p 125].

favorite view

When displaying a table, the user can choose to define the current as their favorite view through the
"View' menu toolbar.

Once it has been set as the favorite, the view will be automatically applied each time this user accesses
the table.

Related concept 'View' menu toolbar [p 125].
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3.4 Data management life cycle

Main documentation section Dataspaces [p 94]

dataspace

A container entity composed of datasets. It is used to isolate different versions of datasets or to organize
them.

Child dataspaces may be created based on a given parent dataspace, initialized with the state of the
parent. Datasets can then be modified in the child dataspaces in isolation from their parent dataspace
as well as each other. The child dataspaces can later be merged back into their parent dataspace or
compared against other dataspaces.

See also inheritance [p 29], repository [p 25], dataspace merge [p 30].

Related concept Dataspaces [p 941.

The former name (prior to version 5) of "dataspace" was "branch" or "snapshot".

reference dataspace

The root ancestor dataspace of all dataspaces in the EBX repository. As every dataspace merge must
consist of a child merging into its parent, the reference dataspace is never eligible to be merged into
another dataspace.

See also dataspace [p 30], dataspace merge [p 30], FepOSitory [p 25].

dataspace merge

The integration of the changes made in a child dataspace since its creation into its parent dataspace.
The child dataspace is closed after the merge has completed successfully. To perform a merge, all the
differences identified between the source dataspace and the target dataspace must be reviewed, and
conflicts must be resolved. For example, if an element has been modified in both the parent and child
dataspace since the creation of the child dataspace, the conflict must be resolved manually by deciding
which version of the element should be kept as the result of the merge.

Related concept Merge [p 102].

snapshot

A static copy of a dataspace that captures its state and all of its content at a given point in time for
reference purposes. A snapshot may be viewed, exported, and compared to other dataspaces, but it
can never be modified directly.

Snapshots are represented by the icon 8,
Related concept Snapshot [p 107]

The former name (prior to version 5) of "snapshot" was "version" or "home".

3.5 History

Main documentation section History [p 251]
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historization

A mechanism that can be enabled at the table level to track modifications in the repository. Two history
views are available when historization is activated: table history view and transaction history view.
In all history views, most standard features for tables, such as export, comparison, and filtering, are
available.

Activation of historization requires the configuration of a history profile. The historization of tables
is not enabled by default.

See also table history view [p 31], transaction history view [p 31], history profile [p 31].

history profile

A set of preferences that specify which dataspaces should have their modifications recorded in the
table history, and whether transactions should fail if historization is unavailable.

See also history profile [p 31].

table history view

A view containing a trace of all modifications that are made in a given table, including record creations,
updates, and deletions. Each entry includes transactional information, such as a timestamp and the
user performing the action, as well as the data at the conclusion of the transaction. This information
can also be consulted at a record or dataset level.

Related technical reference History [p 251].

transaction history view

A view displaying the technical and authentication data of transactions, either globally at the repository
level, or at the dataspace level. As a single transaction can perform multiple actions and affect multiple
tables in one or more datasets, this view shows all the modifications that have occurred across the
given scope for each transaction.

Related technical reference History [p 251].

3.6 Workflow modeling

Main documentation section Workflow models [p 150]

workflow model

A procedural definition of operations to be performed on data. A workflow model describes the
complete path that the data must follow in order to be processed, including its states and associated
actions to be taken by human users and automated scripts.

Related concept Workflow models [p 150].

The former name (prior to version 5) of "workflow model" was "workflow definition".

Workflow models are represented by the icon T3,
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script task

A data workflow task performed by an automated process, with no human intervention. Common
script tasks include dataspace creation, dataspace merges, and snapshot creation.

Script tasks are represented by the icon .

See also workflow model [p 31].

user task

A data workflow task that is made up of one or more work items performed concurrently by human
users. User task work items are offered or assigned to users, depending on the workflow model. The
progression of a data workflow beyond a user task depends on the satisfaction of the task termination
criteria defined in the workflow model.

User tasks are represented by the icon &,

See also workflow model [p 31].

workflow condition

A decision step in a data workflow. A data workflow condition describes the criteria used to decide
which step will be executed next.

Workflow conditions are represented by the icon Q.

sub-workflow invocation

A step in a data workflow that pauses the current data workflow and launches one or more other data
workflows. If multiple sub-workflows are invoked by the same sub-workflow invocation step, they
will be executed concurrently, in parallel.

wait task

A step in a data workflow that pauses the current workflow and waits for a specific event. When the
event is received, the workflow is resumed and automatically goes to the next step.

data context

A set of data that may be shared between steps throughout a data workflow to ensure continuity
between steps.

3.7 Data workflows
Main documentation section Data workflows [p 180]

workflow publication

An instance of a workflow model that has been made available for execution to users with the
appropriate permissions.

The former name (prior to version 5) of "workflow publication" was "workflow".
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data workflow

An executed instance of a workflow model, which runs the data processing steps that are defined in
the model, including user tasks, script tasks, and conditions.

See also workflow model [p 31].

Related concept Data workflows [p 180].

The former name (prior to version 5) of "data workflow" was "workflow instance".

work list

A list of all published data workflows that the current user has the permissions to view. Users with
the permissions to launch data workflows do so from their "Work List'. All outstanding work items
requiring action from the user appear under their published workflows in the work list. Additionally,
if the user is the administrator of data workflows, they are able to view the state of execution of those
data workflows in their "Work List', and may intervene if necessary.

work item

An action that must be performed by a human user as a part of a user task.

Allocated work items are represented by the icon &,

See also user task [p 32].

token

Tokens are used during data workflow management, and are visible to repository administrators.

3.8 Data services

Main documentation section Data services [p 200]

data service

EBX shares master data according to the Service-oriented architecture (SOA) by using XML web
services. Since all data services are generated directly from models or built-in services they can be
used to access part of the features available from the user interface.

Data services offer:

+ a WSDL model-driven and built-in generator to build a communication interface. It can be
produced through the user interface or the HTTP(S) connector for a client application. XML
messages are communicated to the EBX entry point.

» a SOAP connector or entry point component for SOAP messages which allows external systems
interacting with the EBX repository. This connector responds to requests coming from the WSDL
produced by EBX. This component accepts all SOAP XML messages corresponding to the EBX
WSDL generator.

+ A RESTful connector, or entry point for the select operations, allows external systems
interrogating the EBX repository. After authenticating, it accepts the request defined in the URL
and executes it according to the permissions of the authenticated user.
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lineage

A mechanism by which access rights profiles are implemented for data services. Access rights profiles
are then used to access data via WSDL interfaces.

Related concept: Generating a WSDL for lineage [p 205].

3.9 Cross-domain

node

A node is an element of a tree view or a graph. In EBX, 'Node' can carry several meanings depending
on the context of use:

+ In the workflow model [p 31] context, a node is a workflow step or condition.

« In the data model [p 26] context, a node is a group, a table or a field.
« In the hierarchy [p 29] context, a node represents a value of a dimension.
» In an adaptation tree [p 29, a node is a dataset.

« In a dataset [p 28], a node is the node of the data model evaluated in the context of the dataset
or the record.
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CHAPTER 4

Introduction to data models

This chapter contains the following topics:
1. Overview

2. Using the Data Models area user interface

4.1 Overview

What is a data model?

The first step towards managing data in TIBCO EBX is to develop a data model. The purpose of a data
model is to provide the detailed structural definition of the data that will be managed in the repository,
in terms of organization, data types, and semantic relationships.

In order to implement a data model in the repository, you will first create a new data model, then
define the details of the structure of its component table, field, and group elements, as well as their
behavior and properties. When you have completed the entry or import of your data model structure in
the repository, you will publish it to make it available for use by datasets. Once you have a publication
of your data model, you and other users can create datasets based upon it to contain the data that is
managed by the EBX repository.

Basic concepts used in data modeling
A basic understanding of the following terms is necessary to proceed with the creation of data models:
« fieldp27]
» primary key [p27]
» foreign key [p27]
« table (in data model) [p 27]
e group[p27]
+ reusable type [p 28]

« validation rule [p 28]
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4.2 Using the Data Models area user interface

Navigating within the Data Model Assistant

Data models can be created, edited or imported, and published in the Data Models area of the user
interface. The EBX data model assistant (DMA) facilitates the development of data models.

Note

This area is available only to authorized users in the 'Advanced perspective'.

80 &€

Data models : = Actions menu | ?

Book Store  ~ _ﬁ Data model selector |

- Configuration

+ Data structure
= [ Books publications
v BEH Titles
v B Publishers Workspace
v B Authors
» B Royaltes
v EH Contracts

Simple data types

Navigation pane
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The navigation pane is organized into the following sections:

Configuration

The technical configuration of the data model.

Global properties

Defines the global properties of the data model.

Included data models

Defines the data models included in the current model. All
types defined in included data models can be reused in the
current model.

Component library

Defines the Java components available in the model. These
provide programmatic features that will be available for the
model, such as programmatic constraints, functions, and Ul
beans.

Add-ons

Specifies which add-ons are used by the data model.
These add-ons will have the capacity to enrich the current
data model after the publication by adding properties and
constraints to the elements of the data model.

Data structure

The structure of the data model. Defines the relationship
between the elements of the data model and provides access
to the definition of each element.

Simple data types

Simple reusable types defined in the current data model.

Complex data types

Complex reusable types defined in the current data model.

Included simple data types

Simple reusable types defined in an included external data
model.

Included complex data types

Complex reusable types defined in an included external data
model.

Extensions

Extensions available in the current data model.

Toolbars

The toolbars available to use in the data model.

User services

Declares the user services using the API available before
release 5.8.0. From release 5.8.0, it is advised to use the
new UserService API (these services are directly registered
through the Java API, hence no declaration is required for
them in the data model assistant)..
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Data services Specifies the WSDL operations' suffixes that allow to refer
to a table in the data service operations using a unique name
instead of its path.

Replications This table defines the replication units of the data model. A
replication unit allows the replication of a source table in
the relational database, so that external systems can access
this data by means of plain SQL requests and views.

Ajax components Defines the available Ajax components in the model.

Java bindings The bindings specify what Java types have to be generated
from the model.

See also

Implementing the data model structure [p 47]

Configuring the data model [p 43]

Reusable types [p 49]
Data model extensions [p 75]

Data model element icons
= field p271
€= primary key [p 27]

= foreign key [p 27]
EH table [p27]

O3 group p27)

Related concepts

Dataspaces [p 94]
Datasets [p 112]
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CHAPTER B

Creating a data model

This chapter contains the following topics:

1. Creating a new data model

5.1 Creating a new data model

To create a new data model, click the Create button in the pop-up, and follow through the wizard.
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CHAPTER O

Configuring the data model

This chapter contains the following topics:

1.

Information associated with a data model

2. Permissions

3. Data model properties

4,

5. Add-ons used by the data model

Included data models

6.1 Information associated with a data model

To view and edit the owner and documentation of your data model, select 'Tnformation' from the data
model 'Actions' [p 37] menu for your data model in the navigation pane.

Note

This area is available only to authorized users in the 'Advanced perspective'.

Unique name The unique name of the data model. This name cannot be

modified once the data model has been created.

Owner Specifies the data model owner, who will have permission to

edit the data model's information and define its permissions.

Localized documentation Localized labels and descriptions for the data model.

6.2 Permissions

To define the user permissions on your data model, select 'Permissions' from the data model 'Actions'
[p 371 menu for your data model in the navigation pane.

The configuration of the permissions of a data model are identical to the options for the permissions
of a dataset, as explained in Permissions [p 141].
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6.3 Data model properties

In the navigation pane, under Configuration > Data model properties, you can access the following

technical properties:

Module name

Defines the module that contains the resources that will be
used by this data model. This is also the target module used
by the data model publication if publishing to a module.

Module path

Physical location of the module on the server's file system.

Sources location

The source path used when configuring Java components
in the 'Component library'. If this path is relative, it will be
resolved using the 'Module path' as the base path.

Publication mode

Whether to publish the data model as an XML Schema
Document within a module or as a publication completely
embedded in the TIBCO EBX repository. Embedded data
models offer additional functionality such as versioning and
rollback of publications.

See Publication modes [p 89] for more information.

Model path in module: Defines the target file for the data
model generation. It must start with '/'.

Dataset inheritance

Specifies whether dataset inheritance is enabled for this data
model. Dataset inheritance is disabled by default.

See Dataset inheritance [p 145] for more information.

Documentation

Documentation of the data model defined by a Java class.
This Java class can programmatically specify labels and
descriptions for the elements of the data model. The labels
and descriptions defined in this Java class are displayed in
associated datasets in preference to the ones defined locally
on an element.

See Dynamic labels and descriptions [p 5741 for more
information.

Special extensions

Access permissions defined by programmatic rules in a Java
class.

Disable auto-increment checks

Specifies whether to disable if the check of an auto-
incremented field value in associated datasets regarding to
the "max value" found in the table being updated.

See Auto-incremented values [p 571] for more information.
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Enable user services (old API) Specifies if user services using the API available before
release 5.8.0 can be declared. If 'No', the section
'Configuration > User services' is not displayed (except if
at least service has been already declared in this section).
From release 5.8.0, it is advised to use the new UserService
Java API (these services are directly registered through the
Java API, hence no declaration is required in the data model
assistant).

APT

See UserServiceDeclaration™ for more information.

6.4 Included data models

You can use data types in the current model that are defined in another data model by adding an entry
for the other data model in the table under Configuration > Included data models.

When you access the record of an included model in this table, you will find technical information
about the model under the Information tab. As an included data model could eventually have
validation errors, for example, due to deleted Java resources, this view will provide information
regarding those issues.

It is only possible to include data models that have no validation errors and have been defined and
published as an embedded data model or packaged in a module.

The names of data types must be unique across both locally defined and included type definitions.
That is, included data types must not have names that coincide with those of data types defined in the
current data model or other included data models.

See alsolncluding external data models [p 529]

6.5 Add-ons used by the data model

On any data model, it is possible to specify the add-ons used by the current data model. These add-
ons will have the capacity to enrich the current data model after the publication by adding properties
and constraints to the data model elements.

To define an add-on to be used by the data model through the user interface, create a new record in
the 'Add-ons' table under the data model configuration in the navigation pane. A record of this table
defines the following properties:

Name Add-on public name.
Version Add-on version.
Activated Indicates if the add-on is activated. The add-on must be

activated in order to be used.
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CHAPTER 7

Implementing the data model
structure

To work with the structural definition of your data model, select the data model you are working with
in the navigation pane.

You can then access the structure of your data model in the navigation pane under 'Data structure', to
define the structure of fields, groups, and tables.

This chapter contains the following topics:

1. Common actions and properties

2. Reusable types
3. Data model element creation details

4. Modifying existing elements

7.1 Common actions and properties

Adding elements to the data model

The following elements are available to describe the structure of your data model:

fields

groups
tables
primary keys
foreign keys

associations

Add a new element relative to any existing element in the data structure by clicking the down arrow ™
to the right of the existing entry, and selecting an element creation option from the menu. Depending
on whether the existing element is a field, group, or table, you have the choice of creating the new
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element as a child of the existing element, or before or after the existing element at the same level.
You can then follow the element creation wizard to create the new element.

Note

The element root is always added upon data model creation. If this element must be
renamed, it can be deleted and recreated with a new name.

Names, labels, descriptions, and information

Whenever you create a new element in your data model, you must provide a name for the field 'Name'
that is unique in its level of the data structure. This name is assigned once the element is created and
cannot be changed subsequently.

You have the option to provide localized user-friendly labels to be displayed in the user interface
instead of the unique name of the element, as well as brief localized descriptions of the element. Unlike
the unique name, the labels and descriptions are modifiable after creation. According to the language
preference of each user, TIBCO EBX will display the corresponding localized label and description
of the element.

Deleting elements of the data model

Any element can be deleted from the data structure using the down arrow ~ corresponding to its
entry.

When deleting a group or table that is not using a reusable type, the deletion is performed recursively,
removing all its nested elements.

Duplicating existing elements

To duplicate an element, click the down arrow ~ corresponding to its entry. You must provide a
name for the duplicated element that is unique at its level of the data structure. All other properties
are copied from the source element.

The duplicated element is added to the data model at the same level as the element from which it was
copied, appended after the existing elements. If you are duplicating a table or group containing other
elements, all nested elements are copied with their original names.

Note

If you duplicate a primary key field, the properties of the field are maintained, but the
new field is not automatically added to the primary key.

Moving elements

-

To reorder an element within its current level of the data structure, click the down arrow
corresponding to its entry and select 'Move'. Then, select the left-arrow button corresponding to the
field before which you want to move the current element.

Note

It is not possible to move an element to a position outside of its level in the data structure.
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7.2 Reusable types

Reusable types are shared element definitions that are created once and can be reused in different
places in the data model.

Note

If you modify the definition of a reusable type in the 'Simple data types' or 'Complex
data types' section, you will modify the structure of all elements based on that reusable
type. The structure of a groups or table using a reusable type is shown as read-only. To
edit the structure of the associated reusable type, you have to access the type from the
'Simple data types' or 'Complex data types' section.

Defining a reusable type

From the down arrow ~ menu of 'Simple data types' and 'Complex data types' in the navigation pane,
you can define simple and complex reusable types that will be available for creating more elements
which share the same structural definition and properties. Alternatively, you can convert existing tables

and groups into reusable types using their corresponding down arrow T menus.

It is possible to see the elements that are using a reusable type by selecting 'References to this type' on
the specific page of each data type, under 'Simple data types' and 'Complex data types' in the navigation
pane. A table then displays all elements that are based on this type. If a data type is not used by any

elements, you can select the 'Delete type' from its down arrow ™ menu to delete the reusable type.

Using a reusable type

The structure of new elements can be defined using reusable types. To do so, select an existing reusable
type in the element creation form. The created element will then share the type definition of the
reusable type.

Including data types defined in other data models

You can also share reusable types between multiple data models. By configuring the inclusion of an
external data model, you can use the data types defined in that data model to create new elements in
the data structure the same way as using locally defined reusable types.

Note

As the names of data types must be unique across all locally defined as well as all included
types, you cannot create new reusable types with the same name as a data type in an
included data model. Similarly, you cannot include an external data model that defines a
data type with the same name as a locally defined reusable type or a data type in another
included data model.

Included data types appear in the sections 'Included simple data types' and 'Included complex data
types' in the navigation panel. You can view the details of these included reusable types; however,
they can only be edited locally in their original data models.

See Included data models [p 45] for more information.
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7.3 Data model element creation details

Creating fields

When creating a new field, you must select its data type, which will define the data type of the values
based upon this field. The data type of the field cannot be changed once the field has been created.

While creating a field, it is also possible to designate it as a foreign key, a mandatory field, and, if
created under a table, a primary key.

Creating tables

While creating a table, you have the option to create the new table based on an existing reusable type.
See Reusable types [p 49] for more information.

Every table requires specifying at least one primary key field, which you can create as a child element
of the table from the navigation pane.

Creating groups

While creating a group, you have the option to create the new group based on an existing reusable
type. See Reusable types [p 49] for more information.

Creating primary key fields

At least one primary key is required for every table. You can create a primary key field for a table by
creating it as a child element under the table's entry in the 'Data structure' tree.

Besides creating a new field directly as a primary key, you can add any existing child field of a table
to the definition of its primary key on the 'Primary key' tab of the table's 'Advanced properties'.

Creating or defining foreign key fields

Foreign key fields have the data type 'String'. You can create a foreign key field for a table by creating
it as a child element under the table's entry in the 'Data structure' tree. You can also convert an existing
field of type 'String' into a foreign key. To convert an existing field of type 'String' into a foreign key,
enable 'Foreign key constraint' in the field's 'Advanced controls' and define the associated parameters.

Whether creating a foreign key directly or from an existing field, you must define the table that
contains the records to be referenced.

Creating associations

An association allows defining semantic links between tables. You can create an association by
creating it as a child element under the table's entry in the 'Data structure' tree and by selecting
'association' in the form for creating a new element. An association can only be defined inside a table.
It is not possible to convert an existing field to an association.

When creating an association, you must specify the type of association. Several options are available:

« Inverse relationship of a foreign key. In this case, the association element is defined in a source
table and refers to a target table. It is the counterpart of the foreign key field, which is defined in
the target table and refers back the source table. You must define the foreign key that references
the parent table of the association.
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Over a link table. In this case, the association element is defined in a source table and refers
to a target table that is inferred from a link table. This link table defines two foreign keys: one
referring to the source table and another one referring to the target table. The primary key of the
link table must also refer to auto-incremented fields and/or the foreign key to the source or target
table of the association. You must define the link table and these two foreign keys.

Using an XPath predicate. In this case, the association element is defined in a source table and
refers to a target table that is specified using a path. An XPath expression is also defined to specify
the criteria used to associate a record of the current table to records of the target table. You must
define the target table and an XPath expression.

In all types of association, we call associated records the records in the target table that are
semantically linked to records in the source table.

Once you have created an association, you can specify additional properties. For an association, it is
then possible to:

Filter associated records by specifying an additional XPath filter. It is only possible to use fields
from the source and the target table when defining an XPath filter. That is, if it is an association
other a link table it is not possible to use fields of the link table in the XPath filter. You can use
the available wizard to select the fields that you want to use in your XPath filter.

Configure a tabular view to define the fields that must be displayed in the associated table. It is
not possible to configure or modify an existing tabular view if the target table of the association
does not exist. If a tabular view is not defined, all columns that a user is allowed to view according
to the granted access rights are displayed.

Define how associated records are to be rendered in forms. You can specify that associated records
are to be rendered either directly in the form or in a specific tab. By default, associated records
are rendered in the form at the same position of the association in the parent table.

Hide/show associated records in data service 'select' operation. By default associated records are
hidden in data service 'select' operation.

Specify the minimum and maximum numbers of associated records that are required. In associated
datasets, a validation message of the specified severity is added if an association does not comply
with the required minimum or the maximum numbers of associated records. By default, the
required minimum and the maximum numbers of associated records are not restricted.

Add validation constraints using XPath predicates to restrict associated records. It is only possible
to use fields from the source and the target table when defining an XPath predicate. That is, if
it is an association over a link table it is not possible to use fields of the link table in the XPath
predicate. You can use the available wizard to select the fields that you want to use in your XPath
predicate. In associated datasets, a validation message of the specified severity is added when an
associated record does not comply with the specified constraint.

7.4 Modifying existing elements

Removing a field from the primary key

Any field that belongs to the primary key can be removed from the primary key on the 'Primary key'
tab of the table's 'Advanced properties'.

See primary key [p 27] in the glossary.

TIBCO EBX® Product Documentation 6.0.5 51



Documentation > User Guide > Data models > Implementing data models > Implementing the data model structure

TIBCO EBX® Product Documentation 6.0.5 52



Documentation > User Guide > Data models > Implementing data models > Properties of data model elements

CHAPTER 8

Properties of data model elements

After the initial creation of an element, you can set additional properties in order to complete its
definition.

See alsoData validation controls on elements [p 67]

This chapter contains the following topics:

1. Basic element properties

2. Advanced element properties
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8.1 Basic element properties

Common basic properties

The following basic properties are shared by several types of elements:

Information

Additional non-internationalized information associated
with the element.

Minimum number of values

Minimum number of values for an element.

As primary keys cannot be multi-valued, they must have this
property set to '1' or 'undefined'. The minimum number of
values is automatically set to '0' when defining the field as
a selection node.

Maximum number of values

Maximum number of values for an element. When set to a
value greater than 'l’, the element becomes multi-valued.

As primary keys cannot be multi-valued, they must have this
property set to '1' or 'undefined'.

For tables, the maximum number of values is automatically
set to 'unbounded' upon creation. The maximum number of
values is automatically set to '0' when defining the field as
a selection node.

Validation rules

This property is available for tables and fields in tables
except Password fields, reusable types, fields in complex
reusable types, and selection nodes. Used to define powerful
and complex validation rules with the help of the provided
XPath 1.0 criteria editor.

See Criteria editor [p 295] for more information.

This can be useful if the validation of the value depends on
complex criteria or on the value of other fields.

It is also possible to indicate that a rule defines a verification
for a value that is mandatory under certain circumstances. In
this case a value is mandatory if the rule is not satisfied. See
Constraint on null' values [p 561] for more information.

Using the associated wizard, you can define localized labels
for the validation rule, as well as define a localized message
with severity to be displayed if the criteria is not met.

When defining the severity of the validation message it is
possible to indicate whether an input that would violate a
validation rule will be rejected or not when submitting a
form. The error management policy is only available on
validation rules defined on a field and when the severity is
set to 'error'. If the validation rule must remain valid, then
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any input that would violate the rule will be rejected and the
values will remain unchanged. If errors are allowed, then
any input that would violate the rule will be accepted and
the values will change. If not specified, the validation rule
always blocks errors upon the form submission by default.

If a validation rule is defined on a table, it will be considered
as a 'constraint on table' and each record of the table will be
evaluated against it at runtime. See Constraints on table [p
562] for more information.

Basic properties for fields

The following basic properties are specific to fields:

Default value

Default value assigned to this field. In new data creation
forms, the default value appears automatically in the user
input field. The default value must comply with the defined
type of the field.

See Default value [p 579] for more information.

Conversion error message

Internationalized messages to display to users when they
enter a value that is invalid for the data type of this field.

Computation rule

This property is available for fields in tables, except in
reusable types. Defines a rule for computing the value of the
field using the provided XPath 1.0 editor.

See criteria editor [p 295]

This can be useful if the value depends on other values
in the same record, but does not require a programmatic
computation.

The following limitations exist for computation rules:

« Computation rules can only be defined on simple fields
inside a table.

« Computation rules cannot be defined on fields of type
OResource Or Password.

« Computation rules cannot be defined on selection nodes
and primary key fields.

« Computation rules cannot be defined when accessing
an element from the validation report.
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8.2 Advanced element properties

Common advanced properties

The following advanced properties are shared by several types of elements:

Default view and tools >
Visibility

Specifies whether or not this element is shown in the default
view of a dataset, in the text search of a dataset or in the data

service "select" operation.

Model-driven view

Specifies whether or not the current element is shown
in the default tabular view of a table, the default record
form of a table, and in the default view of a dataset
if the current element is a table. Default dataset view,
tabular view and default record form generated from
the structure of the data model. If the current element
is inside a table, then setting the property to 'Hidden'
will hide the element from the default tabular view and
default record form of the table without having to define
specific access permissions. Current element will still
be displayed in the view configuration wizard to be able
to create a custom view that displays this element. If
the current element is a table, then setting the property
to 'Hidden' will hide the table from the default view
of a dataset without having to define specific access
permissions. This property is ignored if it is set on an
element that is neither a table nor in a table.

All views

Specifies whether or not the current element is shown
in all views of a table in a dataset. Setting the property
to 'Hidden in all views' will hide the element in all
views of the table, whether tabular (default tabular
view included) or hierarchical, without having to define
specific access permissions. The current element will
also be hidden in the view configuration wizard. That
is, it won't be possible to create a custom view that will
display this element. This property is ignored if it is
set on an element that is not in a table. This property
is not applied on forms. That is, setting the property
to 'Hidden in all views' will not hide the element in a
record form but only in views.

Structured search tool

Specifies whether or not the current element is shown
in a dataset structured search tool. Setting the property
to 'Hidden in structured search' will hide the element
in the structured search tool of a dataset. The element
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will remain searchable in the quick search tool. This
property is ignored if it is set on an element that is not
in a table.

« Data services

Specifies whether or not the current element is shown
in the data service select operation. Setting the property
to 'Excluded from Data Services' will hide the element
in the data service "select" operation. This property is
ignored if it is set on an element that is not in a table.

See Default view [p581] in the Developer Guide.

Default view and tools > Widget

Defines the widget to be used. A widget is an input
component that is displayed in forms in associated datasets.
If undefined, a default widget is displayed in associated
datasets according to the type and properties of the current
element. It is possible to use a built-in widget or a custom
widget. A custom widget is defined using a Java API to
allow the development of rich user interface components
for fields or groups. Built-in and custom widgets cannot be
defined on a table or an association. It is forbidden to define
both a custom widget and a Ul bean. It is forbidden to define
on a foreign key field both a custom widget and a combo-
box selector.

API

See UIwidgetFactory™ for more information.

Default view and tools > Combo-
box selector

Specifies the name of the published view that will be used
in the combo-box selection of the foreign key. A selection
button will be displayed at the bottom right corner of the
drop-down list. When defining a foreign key, this feature
allows accessing an advanced selection view through the
'Selector' button that opens the advanced selection view,
from where sorting and searching options can be used. If no
published view is defined, the advanced selection view will
be disabled. If the path of the referenced table is absolute
then only the published views corresponding to this table
will be displayed. If the path of the referenced table is
relative then all the published views associated with the data
model containing the target table will be displayed. This
property can only be set if no custom widget is defined.

See Defining a view for the combo box selector of a foreign
key [p 583] in the Developer Guide.

UI bean

Attention

From version TIBCO EBX 5.8.0, it is recommended to
use widgets instead of UI Beans. Widgets provide more
features than UI Beans, and no further evolution will

TIBCO EBX® Product Documentation 6.0.5

57



Documentation > User Guide > Data models > Implementing data models > Properties of data model elements

be made on UI beans. See _widget [p 571 for more
information.

This property is available for all elements except tables and
associations. Specifies a Java class to customize the user
interface associated with this element in a dataset. A UI bean
can display the element differently and/or modify its value
by extending the uiBeantditor™ class in the Java API.

Transformation on export

This property is available for fields and for groups that
are terminal nodes. Specifies a Java class that defines
transformation operations to be performed when exporting
an associated dataset as an archive. The input of the
transformation is the value of this element.

See NodeDataTransformer™ for more information.

Access properties

Defines the access mode for the current element, that is, if
its data can be read and/or written.

+ 'Read & Write' corresponds to the mode Rw in the data
model XSD.

« 'Read only' corresponds to the mode R- in the data
model XSD.

« 'Not a dataset node' corresponds to the mode cc in the
data model XSD.

« 'Non-terminal node' corresponds to the mode - - in the
data model XSD.

See Access properties [p 579] in the Developer Guide.

Comparison mode

Defines the comparison mode associated with the element,
which controls how its differences are detected in a dataset.

« 'Default' means the element is visible when comparing
associated data.

« 'Ignored' implies that no changes will be detected when
comparing two versions of modified content (records
or datasets).

During a merge, the data values of ignored elements
are not merged even if the content has been modified.
However, values of ignored data sets or records being
created during the operation are merged.

During an archive import, values of ignored elements
are not imported when the content has been modified.
However, values of ignored datasets or records being
created during the operation are imported.

See Comparison mode [p 584] in the Developer Guide.
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Apply last modifications policy Defines if this element must be excluded from the service
allowing to apply the last modifications that have been
performed on a record to the other records of the same table.

« 'Default’ means that the last modification on this
element can be applied to other records.

» 'Ignored' implies that the last modification on this
element cannot be applied to other records. This
element will not be visible in the apply last
modifications service.

See Apply last modifications policy [p 584] in the
Developer Guide.

Node category Defines a category for this element. Categories allow
controlling the visibility of data in a dataset to users. A node
with the category 'Hidden' is hidden by default. Restriction:
category specifications other than 'Hidden' do not apply to
table record nodes.

See Categories [p 585] in the Developer Guide.

Advanced properties for fields

The following advanced properties are specific to fields.

Check null input

Implements the property osd: checkNullInput. This property is used to activate and check a constraint
on null at user input time.

By default, in order to allow for temporarily incomplete input, the check for mandatory elements is not
performed upon user input, but only upon dataset validation. If a mandatory element must be checked
immediately upon user input, set this property to 'true'.

Note

A value is considered mandatory if the 'Minimum number of values' property is set to
'l" or greater. For terminal elements, mandatory values are only checked in activated
datasets. For non-terminal elements, the values are checked regardless of whether the
dataset is activated.

See Constraints, triggers and functions [p 566] in the Developer Guide.

Trim whitespaces
Trim white spaces

Implements the property osd:trim. This property is used to indicate whether leading and trailing white
spaces must be trimmed upon user input. If this property is not set, leading and trailing white spaces
are removed upon user input.

See Whitespace handling upon user input [p 567] in the Developer Guide.
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Ul bean

See Common advanced properties [p 571.

Function (computed value)

This property is available for non-primary key fields. Specifies a Java class that computes the value
of this field programmatically. This can be useful if the value of the field depends on other values in
the repository, or if the computation of the value needs to retrieve data from a third-party system.

A function can be created by implementing the valueFunction™ interface.

Disable validation

Specifies if the constraints defined on the field must be disabled. This property can only be defined
on function fields. If true, cardinalities, simple and advanced constraints defined on the field won't be
checked when validating associated datasets.

Transformation on export

See Common advanced properties [p 58].

Access properties

See Common advanced properties [p 58].

Auto-increment

This property is only available for fields of type 'Integer’ that are contained in a table. When set, the
value of the field is automatically calculated when a new record is created. This can be useful for
primary keys, as it generates a unique identifier for each record. Two attributes can be specified:

Start value Value with which to begin the auto-increment. If this
attribute is not specified, the default value is '1".

Increment step Amount the value is incremented based on the previous
value of the auto-increment. If this attribute is not specified,
the default is value is '1".

Disable auto-increment checks Specifies whether to disable the check of the auto-
incremented field value in associated datasets against the
maximum value in the table being updated.

Auto-incremented values have the following behavior:

« The computation and allocation of the field value are performed whenever a new record is inserted
and the field value is yet undefined.

+ No allocation is performed if a programmatic insertion already specifies a non-null value.
Consequently, the allocation is not performed for a record insertion in occulting or overwriting
modes.

« If an archive import specifies the value, the imported value takes precedence.

« Whenever possible, the newly allocated value is unique in the scope of the repository.
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That is, the uniqueness of the allocation spans over all datasets based upon this data model, in any
dataspace in the repository. The uniqueness across different dataspaces facilitates the merging of
child dataspaces parent dataspaces while reasonably avoiding conflicts when a record's primary
key includes the auto-incremented value.

Despite this policy, a specific limitation exists when a mass update transaction assigning specific
values is performed concurrently with a transaction that allocates an auto-incremented value on
the same field. It is possible that the latter transaction will allocate a value that has already been
set in the former transaction, as there is no locking between different dataspaces.

See Auto-incremented values [p 571] in the Developer Guide.

Default view

See Common advanced properties [p 56].

Node category

See Common advanced properties [p 59].

Inherited field

Defines a relationship from the current field to a field in another table in order to automatically fetch
its field value.

Source record A foreign key or white space-separated sequence of foreign
keys that leads from the current element to the record from
which to inherit this field's value. If this property is not
specified, the current record is used as the source record for
the inheritance.

Source element XPath of the element in the source record from which
to inherit this field's value. The source element must be
terminal, belong to the record described by 'Source record',
and its type must match the type of this field. This property
is mandatory when using field inheritance.

See inheritance [p 29] in the glossary.

For more information, see also Inherited fields [p 272].

Advanced properties for tables

The following advanced properties are specific to tables.
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Table

Primary key

A list of fields in the table that compose the table's primary
key. You can add or remove primary key fields here, as in
the 'Data structure' view.

Each primary key field is denoted by its absolute XPath
notation that starts under the table's root element.

If there are several elements in the primary key, the list is
white-space delimited. For example, "/name /startDate".

Presentation

Specifies how records are displayed in the user interface of
this table in a dataset.

Presentation > Record labeling

Defines the fields to provide the default and localized labels
for records in the table.

Can also specify a Java class to set the label
programmatically, or set the label in a hierarchy. This
Java class must implement either the uILabelRenderer™
interface or the uILabelRendererForHierarchy™ interface.

Attention: Access rights defined on associated datasets
are not applied when displaying record labels. Fields that
are usually hidden due to access rights restrictions will be
displayed in labels.

Presentation > Default rendering
for groups in forms

Specifies the default display rendering mode of the groups
contained in this table. If nothing is defined here, the default
policy set in the Administration area will be used to display
groups.

See Record form: rendering mode for nodes [p 415] in the
Administration Guide.

Enabled rendering for groups

Specifies a display rendering mode to be enabled for
groups in the table in addition to the modes 'expanded'
and 'collapsed’, which are always available. Tabs must be
enabled on the table to have the option to display groups as
tabs. Similarly, links must be enabled to have the option to
display groups as links.

Default rendering for groups

Specifies the default display rendering mode to use for the
groups contained in this table. If a group does not specify
a default mode then the default mode defined for this table
will be used. Links must be enabled to define the default
rendering mode as 'Link'. Select a rendering mode according
to network and browser performance. Link mode is lighter
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as its content is not displayed on the same page, whereas the
expanded and collapsed modes are heavier.

Note: When the tabs view is enabled on a table, any groups
that would otherwise have used links are automatically
converted to collapsed mode. This is done to avoid the
inherent display layout complexities that would arise from
links and tabs coexisting in the same user interface.

Presentation > Specific Defines a specific rendering for customizing the record form
rendering of forms in a dataset.

T

See urlForm™ and UserServiceRecordFormFactory” for
more information.

Toolbars Defines the toolbars to use in this table.

Toolbars can be edited in the Configuration > Toolbars
section.

Tabular view top: Defines the toolbar to use on top of the
default table view.

Tabular view row: Defines the toolbar to use on each row
of the default table view.

Record top: Defines the toolbar to use in the record form.

Hierarchy top: Defines the toolbar to use in the default
hierarchy view of the table.

See Toolbars [p 771 for more information.

History Specifies when historization is to be performed, and the
level of guarantee requested. The available history profiles
can be edited in Administration > History and logs.

See History configuration in the repository [p 251] for more

information.
Specific filters Defines record display filters on the table.
Actions Specifies the actions that are allowed on the table in

associated datasets. By default, all actions are allowed
unless specific access rights are defined in a dataset.

Uniqueness constraints

Indicates which fields or set of fields must be unique across the table.

Triggers

Specifies Java classes that defines methods to be automatically executed when modifications are
performed on the table, such as record creation, updates, deletion, etc.

A built-in trigger for starting data workflows is included by default.
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See Triggers [p 570] in the Developer Guide.

Access properties

See Common advanced properties [p 58].

Default view

See Common advanced properties [p 56].

Node category

See Common advanced properties [p 59].

Advanced properties for groups

The following advanced properties are specific to groups.

Value container class (JavaBean)

Specifies a Java class to hold the values of the children of this group. The Java class must conform
to the JavaBean standard protocol. That is, each child of the group must correspond to a JavaBean
property in the class, and all properties must have getter and setter accessors defined.

Ul bean

See Common advanced properties [p 571.

Transformation on export

See Common advanced properties [p 58].

Access properties

See Common advanced properties [p 58].

Default view

Visibility See Common advanced properties [p 56].

Rendering in forms Defines the rendering mode of this group. If this property
is not set, then the default view for groups specified by the
container table will be used. 'Tab' and 'Link' are each only
available when the container table enables it.

Tab position

This attribute specifies the position of the tab with respect
to all the tabs defined in the model. This position is used for
determining tab order. If a position is not specified, the tab
will be displayed according to the position of the group in
the data model.
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Node category

See Common advanced properties [p 59].

Related conceptsData validation controls on elements [p 67]
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CHAPTER 9

Data validation controls on elements

After the initial creation of an element, you can set additional controls in order to complete its
definition.

See alsoProperties of data model elements [p 53]

This chapter contains the following topics:

1. Simple content validation

2. Advanced content validation
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9.1 Simple content validation

Using the following static controls on a field, you can establish simple validation rules on its content.
The controls available for a given field are dependent on its data type.

Fixed length

The exact number of characters required for this field.

Minimum length

The minimum number of characters allowed for this field.

Maximum length

The maximum number of characters allowed for this field.

Pattern

A regular expression pattern that the value of the field must
match. It is not possible to simultaneously define a pattern
for both a field and its data type.

Decimal places

The maximum number of decimal places allowed for this
field.

Maximum number of digits

The maximum total number of digits allowed for this integer
or decimal field.

Enumeration

Defines a list of predefined possible values for this field. If
enumerations are defined in both a field and its type, then the
enumeration of this field in associated datasets is replaced
by the intersection of these two enumerations.

Greater than [constant]

Defines the minimum value allowed for this field.

Less than [constant]

Defines the maximum value allowed for this field.

See XML schema supported facets [p 553].

9.2 Advanced content validation

Using the following dynamic and contextual controls on an element, you can establish advanced
validation rules of its content. The controls available for a given element are dependent on the type
of element and its data type, if it has one.
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See alsoDynamic constraints [p 557]

Foreign key constraint

Table Defines the table referenced by the foreign key. A foreign
key references a table in the same dataset by default. It
can also reference a table in another dataset in the same
dataspace, or a dataset in a different dataspace.

Mode Location of the table referenced by the foreign key.
'Default': current data model.
'Other dataset': different dataset, in the same dataspace.

'Other dataspace': dataset in a different dataspace.

Referenced table XPath expression describing the location of the table. For
example, /root/MyTable.

Referenced dataset Required if the table is located in another dataset. The
unique name of the dataset containing the referenced table.

Referenced dataspace Required if the table is located in another dataspace. The
unique name of the dataspace containing the referenced
table.

Label Defines fields to provide the default and localized labels for

records in the table. Allows as well to customize the display
of the specified label in breadcrumb.

Can also specify a Java class to set the label
programmatically if 'XPath expression' is set to 'No'. This
Java class must implement the TableRefDisplay™” interface
of the Java API.

Attention: Access rights defined on associated datasets
are not applied when displaying record labels. Fields that
are usually hidden due to access rights restrictions will be
displayed in labels.

Filter Defines a foreign key filter using an XPath expression.

Can also specify a Java class that implements the
TableRefFilter™ interface of the Java API.

Greater than [dynamic] Defines a field to provide the minimum value allowed for
this field.
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Less than [dynamic]

Defines a field to provide the maximum value allowed for
this field.

Fixed length [dynamic]

Defines a field to provide the exact number of characters
required for this field.

Minimum length [dynamic]

Defines a field to provide the minimum number of
characters allowed for this field.

Maximum length [dynamic]

Defines a field to provide the maximum number of
characters allowed for this field.

Excluded values

Defines a list of values that are not allowed for this field.

Excluded segment

Defines an inclusive range of values that are not allowed for
this field.

Minimum excluded value: Lowest value not allowed for
this field.

Maximum excluded value: Highest value not allowed for
this field.

Specific constraint (component)

Specifies one or more Java classes that implement the
Constraint™ interface of the Java API. See Programmatic
constraints [p 560] for more information.

Specific enumeration
(component)

Specifies a Java class to define an enumeration. The class
must define an ordered list of values by implementing the
ConstraintEnumeration™ interface of the Java API.

Enumeration filled by another
node

Defines the possible values of this enumeration using a
reference to another list or enumeration element.

Dataspace set configuration

Define the dataspaces that can be referenced by a field
of the type Dataspace identifier (osd:dataspaceKey). If a
configuration is not set, then only opened branches can be
referenced by this field by default.

« Includes

Specifies the dataspaces that can be referenced by this
field.

Pattern: Specifies a pattern that filters dataspaces. The
pattern is checked against the name of the dataspaces.

Type: Specifies the type of dataspaces that can be
referenced by this field. If not defined, this restriction
is applied to branches.
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Include descendants: Specifies if children or
descendants of the dataspaces that match the specified
pattern are included in the set. If not defined, this
restriction is not applied to child dataspaces. If "None"
then neither children nor descendants of the dataspaces
that match the specified pattern are included. If "All
descendants" then all descendants of the dataspaces
that match the specified pattern are included. If "All
descendant branches" then all descendant branches
of the dataspaces that match the specified pattern
are included. If "All descendant snapshots" then all
descendant snapshots of the dataspaces that match the
specified pattern are included. If "Child branches" then
only direct branches of the dataspaces that match the
specified pattern are included. If the current dataspace
is a version, includes the branches that are the direct
children of this version; if the current dataspace is
a branch, includes the branches that are the direct
children of the versions which are children of this
branch. If "Child snapshots" then only direct snapshots
of the dataspaces that match the specified pattern are
included. If the current dataspace is a branch, includes
the snapshots that are the direct children of this branch;
if the current dataspace is a version, includes the
versions that are the direct children of the branches
which are children of this version.

« Excludes

Specifies the dataspaces that cannot be referenced by
this field. Excludes are ignored if no includes are
defined.

Pattern: Specifies a pattern that filters dataspaces. The
pattern is checked against the name of the dataspaces.

Type: Specifies the type of dataspaces that can be
referenced by this field. If not defined, this restriction
is applied to branches.

Include descendants: Specifies if children or
descendants of the dataspaces that match the specified
pattern are included in the set. If not defined, this
restriction is not applied to child dataspaces. If "None"
then neither children nor descendants of the dataspaces
that match the specified pattern are included. If "All
descendants" then all descendants of the dataspaces
that match the specified pattern are included. If "All
descendant branches" then all descendant branches
of the dataspaces that match the specified pattern
are included. If "All descendant snapshots" then all
descendant snapshots of the dataspaces that match the
specified pattern are included. If "Child branches" then
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only direct branches of the dataspaces that match the
specified pattern are included. If the current dataspace
is a version, includes the branches that are the direct
children of this version; if the current dataspace is
a branch, includes the branches that are the direct
children of the versions which are children of this
branch. If "Child snapshots" then only direct snapshots
of the dataspaces that match the specified pattern are
included. If the current dataspace is a branch, includes
the snapshots that are the direct children of this branch;
if the current dataspace is a version, includes the
versions that are the direct children of the branches
which are children of this version.

Dataspace filter

Specifies a filter to accept or reject dataspaces in the
context of a dataset or a record. This filter is only used
in the dedicated input component that is associated to
this field. That is, this filter is not used when validating
this field. A specific constraint can be used to perform
specific controls on this field. A filter is defined by a
Java class that implements the DataspaceSetFilter™
interface of the Java API.

Dataset set configuration

Define the datasets that can be referenced by a field of the

type Dataset identifier (osd:datasetName).

Includes

Specifies the datasets that can be referenced by this
field.

Pattern:Specifies a pattern that filters datasets. The
pattern is checked against the name of the datasets.

Include descendants: Specifies if children or
descendants of the datasets that match the specified
pattern are included in the set.

Excludes

Specifies the datasets that cannot be referenced by this
field. Excludes are ignored if no includes are defined.

Pattern: Specifies a pattern that filters datasets. The
pattern is checked against the name of the datasets.

Include descendants: Specifies if children or
descendants of the datasets that match the specified
pattern are included in the set.

Filter

Specifies a filter to accept or reject datasets in the
context of a dataset or record. This filter is only used
in the dedicated input component that is associated to
this field. That is, this filter is not used when validating
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this field. A specific constraint can be used to perform
specific controls on this field. A filter is defined by
a Java class that implements the DatasetSetFilter™
interface of the Java API.

Validation properties

Each constraint not using a specific Java class can define localized validation messages with a severity
using the following properties:

Validation Defines a localized validation message with a user-defined
severity level.

Severity Defines the severity level of the validation message.
Possible values are 'Error', "'Warning', and 'Information'.

Error management Specifies the behavior of the constraint when validation
policy errors occur. It is possible to specify that the constraint
must always remain valid after an operation (dataset update,
record creation, update or deletion), or when a user submits
a form. In this case, any input or operation that would
violate the constraint will be rejected and the values will
remain unchanged. If not specified, the constraint only
blocks errors upon form submission by default, except for
foreign key constraints in relational data models where
errors are prevented for all operations by default. This
option is only available upon static controls, exclude values,
exclude segment and foreign key constraints. On foreign
key constraints the error management policy does not
concern filters. That is, a foreign key constraint is not
blocking if a referenced record exists but does not satisfy
a foreign key filter. In this case updates are not rejected
and a validation error occurs. It is not possible to specify
an error management policy on structural constraints that
are defined in relational data models, when table history or
replication is activated. That is, setting this property on fixed
length, maximum length, maximum number of digits and
decimal place constraints will raise an error at data model
compilation because of the underlying RDBMS blocking
constraints validation policy. This property is ineffective
when importing archives. That is, all blocking constraints,
excepted structural constraints, are always disabled when
importing archives.

Message Defines the message to display if the value of this field in
a dataset does not comply with this constraint. If specifying
a custom message, you may optionally provide localized
variants.
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Related conceptsProperties of data model elements [p 53]
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cHAPTER 10

Data model extensions

This chapter contains the following topics:

1. Extensions used by the data model

. Indexing and search strategies

2

3. Toolbars

4. Data services
5

. Replication of data to relational tables

10.1 Extensions used by the data model

On any data model, it is possible to specify some extensions to be used. These extensions will have
the capacity to define additional features around the data model and to enrich the current data model
after the publication by adding properties and constraints to the data model elements. Data model
extensions are displayed in the navigation pane under the section 'Extensions'.

The following extensions are automatically enabled on new data models:
« Toolbars [p 76]
« Data services [p 82]

« Replications [p 83]
« Indexing and search strategies [p 76]

o Custom forms [p591]
« Functions [p907]

« Record permissions [p 894]
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Some extensions are optional and defined in dedicated datasets. These extensions can be disabled or
enabled through the user interface.

Optional data model extension can be disabled by selecting the action 'Disable extension' from the

menu T to the left of extension to disable.

Note

When disabling an extension its dedicated dataset is also deleted and it is not possible
to recover it after its deletion

From the down arrow ~ to the left of 'Extensions' entry in the navigation pane, you can enable
an extension by selecting the action 'Enable an extension'. This option is only displayed if some
extensions are available. When selecting this action a form displays the available data model
extensions.

Once a data model extension is activated then it is displayed under the entry 'Extensions' in the
navigation pane and can be edited as a regular dataset. That is, the configuration of an extension is
embedded in a dedicated dataset that benefits of all EBX features available on datasets.

10.2 Indexing and search strategies

This feature is documented in the chapter Search [p 2971.

10.3Toolbars

A toolbar allows to customize the buttons and menus that are displayed when viewing tables or records
in a dataset. The customization of toolbars can be performed in the data model via the 'Configuration'
section.

Add a toolbar from the Toolbars section of the navigation pane, by clicking on the arrow ~ located
to the right of [ All elements ], then selecting the Create toolbar option. Follow the creation wizard
to create a toolbar. A toolbar defines the following information:

Name Toolbar's name. The name of the toolbar must be unique in
the context of the data model. That is, it is not allowed to
create several toolbars with the same name.

Label and description Internationalized labels and descriptions to be displayed to
end users.

Default template Allows to create a toolbar with the structure of a default
toolbar.

Locations Specifies the locations where the toolbar can be used in

associated datasets.
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Defining the structure of a toolbar
A toolbar can define the following elements:
« Action button [p 78]

« Menu button [p 79]

« Separator [p 79]

« Menu group [p 80]
o Action menu item [p 81]

o Sub menu item [p 81]
Add one of these elements under a toolbar or to an existing element by clicking on the arrow

located to the right of the existing element, and by selecting a creation option in the menu. Then,
follow the creation wizard to create an element.
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Action button

This type of element allows to associate an action to a button in a toolbar. The action will be triggered
when the user clicks on the associated button in one of the toolbars. A Action button type element

defines the following information:

Service

Defines the service that will be executed when the user
clicks on the button. It is possible to select a built-in service,
or a user service defined in a module or in the current data
model. If the "Web component' target is selected, the service
will have to be declared as available as a web component
for toolbars.

Label and description

Internationalized labels and descriptions to be displayed to
end users.

Layout

Defines how this element will be displayed in datasets using
the toolbar. It is possible to display: the icon only, the text
only, text with the icon to the left or text with the icon to
the right.

Icon

Icon to display. It is possible to use an icon to choose from
a set of suggested icons, or to refer to an icon using a URL.

Relief

Defines how this button will display. The button can be
displayed as embossed or flat.

Is highlighted

Indicates if the button should be highlighted by default.

Note

A Action button type element can only be created under a toolbar type element.
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Menu button

This type of element allows to define a menu that will be displayed when the user clicks on the
associated button in a toolbar. An element of the Menu button type defines the following information:

Label and description Internationalized labels and descriptions to be displayed to
end users.
Layout Defines how this element will be displayed in datasets using

the toolbar. It is possible to display: the icon only, the text
only, text with the icon to the left or text with the icon to
the right.

Icon Icon to display. It is possible to use an icon to choose from
a set of suggested icons, or to refer to an icon using a URL.

Relief Defines how this button will display. The button can be
displayed as embossed or flat.

Is highlighted Indicates if the button should be highlighted by default.

Note

An element of the Menu button type can only be created under an element of the toolbar
type.

Separator

This type of element allows to insert a separator in the form of spacing between two elements of a
toolbar.

Note

An element of the Separator type can only be created under an element of the toolbar
type.
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Menu group

This type of element allows to define a group of elements in a menu. An element of the Menu group
type defines the following information:

Label and description

Internationalized labels and descriptions to be displayed to
end users.

Group type

Specifies the type of menu group to create: - 'Local' allows
to create an empty fully customizable menu group. - 'Service
group' allows to assign an existing service group to this
menu group. - 'Menu builder' allows to assign a predefined
menu content to this menu group. Once created, it is not
possible to change the type of this menu group.

Service group name

Specifies an existing group of services to reuse. A group
is declared in a module and can include other groups
of services. All services contained in this group will be
displayed to end users in associated datasets.

Menu builder name

Specifies the predefined menu content to assign to this menu
group: - 'Default menu "Actions" has the same content as
the default toolbar 'Actions' menu. Standard and custom
services are displayed without distinction. - 'Default menu
"Actions" (with separator)' has the same menu content as
above, but displays differently since standard and custom
services are separated (standard services first, then custom
services).

Excluded services

Indicates the services to exclude from the group of reused
services. These services will not be displayed to end users
in associated datasets.

Excluded service groups

Indicates the groups to exclude from the group of services
to reuse. Services in excluded groups will not be displayed
to end users in associated datasets.

Filtering policy

In case of "Smart filtering", services that are configured in
direct access, i.e. via an action button or an action menu
item, will be removed from the automatic generation of this

group.

Note

An element of the Menu group type can only be created under the following elements:

« Menu button
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« Sub menu item

Action menu item

This type of element allows to associate an action to a menu item in a toolbar. The action will be
triggered when the user clicks on the corresponding item in a menu. An element of the Action menu
item type defines the following information:

Label and description Internationalized labels and descriptions to be displayed to
end users.
Service Defines the service that will be executed when the user

clicks on the button. It is possible to select a built-in service,
or a user service defined in a module or in the current data
model. If the "'Web component' target is selected, the service
will have to be declared as available as a web component
for toolbars.

Note

An element of the Action menu item type can only be created under a Menu group type
element.

Sub menu item

This type of element allows to add a sub menu to a toolbar menu. Un Sub menu item defines the
following information:

Label and description Internationalized labels and descriptions to be displayed to
end users.

Note

An element of the Sub menu item type can only be created under an element of the Menu
group type.

Deleting elements

All the elements of a toolbar can be deleted from it by using the arrow ™ located to the right of the
element to be deleted.

If an element containing other elements is deleted, then the deletion is recursively performed on all
elements located below the deleted element.

Duplicating existing elements

To duplicate an element, click on the arrow ™ located to the right of the element to duplicate. Specify
the name and properties of the duplicated element. All the source element properties are duplicated.
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The duplicated element is added on the same level than the original element, in the final position.
When an element containing other elements is duplicated, all the sub-elements are duplicated with
their properties.

Moving elements

In order to move an element, click on the arrow ™ and select the moving option to be used.

Associate with existing tables

To associate a toolbar with existing tables, click on the arrow ™ located to the right of the toolbar
and select the option Associate to tables. This service allows to set the toolbar has the default toolbar
of several tables in one shot. To do so, specify the target locations of the toolbar and select the tables
or complex data types, that define table properties, to be associated with the toolbar.

Exporting the toolbars

It is possible to export the toolbars defined in the model into an XML document. To do so, select
the XML export option available in the Actions menu of the 'Toolbars' section. Follow the wizard to
export the toolbars.

Note

A selection of toolbars can be exported by selecting in the "Toolbars' section the toolbars
to be exported and then by selecting the XML export option available in the Actions menu.
The toolbars can also be exported by using the data model export service. It can be found
in the Data model 'Actions’ [p 371 menu in the navigation pane.

See alsoData model import and export [p 85]

Importing toolbars

It is possible to import existing toolbars from an XML document. To do so, select the XML import
option available in the Actions menu of the "Toolbars' section. Then follow the wizard to import the
toolbars.

Note

The toolbars can also be imported by using the data model import service accessible via
the Data model 'Actions’ [p 37) menu in the navigation pane.

See alsoData model import and export [p 85]

See also_Use of toolbars [p 63]

10.4Data services

It is possible to refer to tables in Data Service operations using unique names instead of their paths
by defining suffixes for WSDL operations. A WSDL suffix is the association between a table path
and a name.
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To define a WSDL suffix through the user interface, create a new record in the 'Data services' table
under the data model configuration in the navigation pane. A record of this table defines the following

properties:
Table path Specifies the path of the table in the current data model that
is to be referred by the WSDL operation suffix.
WSDL operation suffix This name is used to suffix all the operation names of the

concerned table. If undefined for a given table, the last
element of the table path is used instead. This name must be
unique in the context of this data model.

See alsoData services [p 587]

10.5 Replication of data to relational tables

In any data model, it is possible to define replication units for data in the repository to be mirrored
to dedicated tables in the relational database. These tables then enable direct access to the data by
SQL requests and views.

To define a replication unit through the user interface, create a new record in the 'Replications' table
under the extensions' section in the navigation pane. Each replication unit record is associated with a

TIBCO EBX® Product Documentation 6.0.5 83



Documentation > User Guide > Data models > Implementing data models > Data model extensions

particular dataset in a given dataspace. A single replication unit can cover multiple tables, as long as
they are in the same dataset. A replication unit defines the following information:

Name

Name of the replication unit. This name identifies a
replication unit in the current data model. It must be unique.

Dataspace

Specifies the dataspace relevant to this replication unit. It
cannot be a snapshot.

Dataset

Specifies the dataset relevant to this replication unit.

Refresh policy

Specifies the data synchronization policy. The possible
policies are:

« On commit: The replicated table content in the
database is always up to date with respect to its source
table. Every transaction that updates the EBX source
table triggers the corresponding insert, update, and
delete statements on the replicated table.

« On demand: The replicated table in the database is
only updated when an explicit refresh operation is
performed.

Tables

Specifies the tables in the data model to be replicated in the
database.

Table path: Specifies the path of the table in the current
data model that is to be replicated to the database.

Table name in database: Specifies the name of the table in
the database to which the data will be replicated. This name
must be unique amongst all replications units.

Aggregated lists

Specifies the properties of the aggregated lists in the table
that are replicated in the database.

Path: Specifies the path of the aggregated list in the table
that is to be replicated to the database.

Table name in database: Specifies the name of the table
in the database to which the data of the aggregated list
will be replicated. This name must be unique amongst all
replications units.

See alsoReplication [p 259]
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cHAPTER 11

Working with an existing data model

Once your data model has been created, you can perform a number of actions that are available from
the data model 'Actions’ [p 37] menu in the workspace.

This chapter contains the following topics:

1. Validating a data model

2. Data model import and export

3. Duplicating a data model

4. Deleting a data model

11.1 Validating a data model

To validate a data model at any time, select Actions > Validate from the navigation pane. The
generated report provides the results of the validation. From the validation report, you have the option
to update the reported validation status by clicking the Revalidate button, or to click the Reinitialize
validation report button to clear the current validation report associated with the data model in order
to be able to rerun a full validation from scratch.

Note

The validation process checks basic data model integrity, but more complex checks are
only performed at publication time. More messages may be reported when you try to
publish your data model.

See Validation [p 304] for detailed information on incremental data validation.

11.2 Data model import and export

TIBCO EBX includes built-in data model services to import from and export to XML Schema
Document (XSD) files or to archive files (zip). Imports and exports can be performed from the data
model 'Actions’ [p 37] menu of the target data model in the navigation pane. An import or export is
always performed in the context of a single data model. That is, during imports, the structure of the
target data model is completely replaced with the content of the imported data model (XSD or archive).
Similarly, during exports, the entire data model is included in the XSD or archive file.

When importing a data model, the corresponding XSD file must be well-formed and must comply with
EBX validation rules. If this document declares resources that are located in a module, the module
must also be declared in the configuration of the data model. If the module has not been declared,
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you will not be able to import the data model. See Data model properties [p 441 for more information
on declaring modules.

To perform an import select Tmport data model' from the data model 'Actions’ [p 371 menu of the data
model into which you are importing.

You can import an XML Schema Document (XSD) or an archive (zip file) from the local file system.
To do so, click the 'From a local document' button in the import wizard and follow the next step:

» Document name: path on the local file system of the XSD or archive file to import.

Note

When importing an archive it must contain only one XML Schema Document (XSD)
at its root. XML documents related to data model extensions must also be located
at the root of the archive. These XML documents are automatically imported if they
comply with the naming of the extensions supported and registered in EBX.

You can also import a data model in an XSD that is packaged in a module. The import of a data model
in XSD format from a module uses the following properties:

Module Module in which the data model is packaged.

Module path Path to the module containing the data model.

Source path Path to Java source used to configure business objects and
rules.

This property is required if the data model being imported
defines programmatic elements.

Model The data model in the module to import.

Note
Imported XSD files must be encoded in 'UTF-8'. Exported XSD files are always encoded
in 'UTF-8'.

To perform an export select 'Export data model' from the data model 'Actions' [p 37] menu of the data
model you want to export.

11.3 Duplicating a data model

To duplicate a data model, select 'Duplicate’ from the data model 'Actions’ [p 371 menu for that data
model. You must give the new data model a name that is unique in the repository.

11.4 Deleting a data model

To delete a data model, select 'Delete’ from the data model 'Actions' [p 37] menu for that data model.
When you delete a data model, all of its existing publications will remain and continue to be accessible
to their associated datasets. If you recreate a new data model with the same name as one that was
previously deleted, the new data model will be reassociated with all the existing publications in the
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repository. At publication time of the new data model, you will have the opportunity to confirm the
replacement of an existing publication.

Note

Only an administrator can clean up the publications of deleted data models in the
'Administration' area.

See Publishing data models [p 89] for more information on the publication process.
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CHAPTER 12

Publishing a data model

This chapter contains the following topics:

1. About publications

2. Publication modes

3. Embedded publication mode

12.1 About publications

Each dataset based on an embedded data model in the TIBCO EBX repository is associated with a
publication of a data model, rather than directly to the data model itself. The first time you publish
a data model using the Publish button in the navigation pane, a publication is created. Once the
publication exists, datasets can be created based upon it.

Note

The Publish button is only displayed to users who have permission to publish the data
model. See Data model permissions [p 43] for more information.

As datasets are based on publications, any modifications you make to a data model will only take effect
on existing datasets when you republish to the publication associated with those datasets. When you
republish a data model to an existing publication, all existing datasets associated with that particular
publication are updated.

12.2 Publication modes

You can publish a data model using either 'Embedded' mode or 'In module' mode. The 'Embedded’
publication mode generates a publication that is managed and persisted within the EBX repository and
thus has associated versioning and rollback functionality. The 'Tn module' publication mode creates an
XML Schema Document contained in a module that is not managed or versioned within the repository.

Depending on the configuration of the data model, EBX automatically determines the publication
process to use when you click the Publish button in the navigation pane. When a data model specifies
the publication mode 'In module' and provides a target XSD to be generated, the publication process
generates an XSD file contained in the module defined in the configuration.
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12.3 Embedded publication mode

The first time you publish a given embedded data model, a new publication with the same name as
your data model is automatically created in the repository. If more than one publication has already
been created for this model, you will need to select a target publication for this process.

See Viewing and creating publications [p 90] for more information on the use of different
publications.

During the publication process, you have the opportunity to review the structural differences being
introduced by the current publication in a side-by-side comparison view, if the data model has
previously been published.

The publication process also offers the option to create a read-only snapshot of the current state of
the data model for reference purposes. This snapshot can be useful if the data model ever needs to be
rolled back to the current state after other modifications have been made.

Note

Snapshots, which are static archives of the state of the data model, must not be confused
with data model versions, which act instead as parallel evolving branches of the data
model. See Versioning embedded data models [p 911 for more information on data
model versions.

Viewing and creating publications

To access the publications that exist for the current data model, select "Manage publications' from its
data model 'Actions’ [p 371 menu in the navigation pane. From there, you can view the details of the
publications and create new publications.

In certain cases, it may be necessary to employ several publications of the same data model, in order
to allow datasets to be based on different states of that data model. Multiple publications must be
handled carefully, as users will be asked to select an available publications to target when publishing
if more than one exists. The action to create a new publication is only available to users who belong
to the 'Administrator’ role.

To create a new publication, select 'Manage publications' from the data model 'Actions’ [p 37] menu
of the data model in the navigation pane, then click the Create publication button. The name you
give to the publication must unique in the repository.
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CHAPTER 13

Versioning a data model

This chapter contains the following topics:
1. About versions

2. Accessing versions

3. Working with versions

4. Known limitations on data model versioning

13.1 About versions

You can create versions for data models that evolve in parallel. Versions are not to be confused with
data model snapshots, which are taken at publication time and kept strictly for historical read-only
reference.

13.2 Accessing versions

To see the existing versions of your data model, select 'Manage versions' from the data model
'Actions’ [p 371 menu of the data model.

The existing versions are represented in a tree format according to their parent-child relationships.
Every data model has a root version by default, with the same name as the data model.
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13.3 Working with versions

In the workspace, using the down arrow ™ menu next to each version, you can perform the following
actions:

Access data model version Go to the corresponding version of the data model.

Create version Creates a new version based on the contents of the selected
version. The new version is added as a child of the selected
version, though its contents bear no relation to those of its
parent version after creation.

Set as default version Sets the selected version as the default version opened when
users access the data model.

Export archive Exports the selected data model version to an archive
containing the version's content, including its permissions
and information. The exported archive is located in
the archives directory, which is accessible to repository
administrators. Exporting to an existing archive name will
overwrite the existing file.

See Archives directory [p 400] for more information.

Import archive Imports the content of an archive into the selected version.
The archive to import must contain a data model with the
same name as the data model associated with the version.

A version can be deleted by clicking the X button to the right of its entry. A version cannot be deleted
if it is linked to a publication or if it has child versions. The root version of a data model also cannot
be deleted.

Two versions of the same data model can be compared in the workspace by selecting their checkboxes,
then selecting Actions > Compare selected versions. The side-by-side comparison shows structural
differences between the version of the data model, with the older version on the left and the newer
version on the right.

13.4 Known limitations on data model versioning

+ It is not possible to merge two versions of a data model.
« The comparison interface does not display updates on fields, only additions and deletions.
 Versioning of data models packaged in modules is not supported.

« Resources packaged in a module that are used by an embedded data model are not versioned when
a version is created. That is, only the reference of the resources are saved during the creation of
a version, and it is the responsibility of developers to ensure that the content of the referenced
resources are compatible with any versions that may be using them.
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CHAPTER 14

Introduction to dataspaces

This chapter contains the following topics:
1. Overview

2. Using the Dataspaces area user interface

14.1 Overview

What is a dataspace?

The life cycle of data can be complex. It may be necessary to manage a current version of data while
working on several concurrent updates that will be integrated in the future, including keeping a trace
of various states along the way. In TIBCO EBX, this is made possible through the use of dataspaces
and snapshots.

A dataspace is a container that isolates different versions of datasets and organizes them. A dataspace
can be branched by creating a child dataspace, which is automatically initialized with the state of
its parent. Thus, modifications can be made in isolation in the child dataspace without impacting its
parent or any other dataspaces. Once modifications in a child dataspace are complete, that dataspace
can be compared with and merged back into the parent dataspace.
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Snapshots, which are static, read-only captures of the state of a dataspace at a given point in time,
can be taken for reference purposes. Snapshots can be used to revert the content of a dataspace later,

if needed.
Snapshot Snapshot
DataSpace 2
[ Compare
— & Merge
' Snapshot
— o
Master Data Reference DataSpace
Repository -
N Snapshot Compare
& Merge
DataSpace 1
Compare

& Merge

DataSpace 1.1

Basic concepts related to dataspaces
A basic understanding of the following terms is beneficial when working with dataspaces:
« dataspace [p 30]

« snapshot [p 30]
« dataset [p 28]

» dataspace merge [p 30]

« reference dataspace [p 30]

14.2 Using the Dataspaces area user interface

Dataspaces can be created, accessed and modified in the Dataspaces area.

Note

This area is available only to authorized users in the 'Advanced perspective'.
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The navigation pane displays all existing dataspaces, while the workspace displays information about
the selected dataspace and lists its snapshots.

Dataspace D-5593 ?
» Master Data - Reference
Create a dataspace Actions -
¥ Samples
:
» Workflow Identifier Tutorial
Dynamic data hierarchy Type Dataspace
Dynarmic data hierarchy - res Creation on 07/10/2013 at 12:32:34 by Doc. Adn
Status Open
History purge Marked for history purge by Doc. Admini
Owner Doc. Administrator (admin)
Loading strategy On-demand loading and unloading
Child merge policy Allows validation errors in result
Child dataspace sort policy By creation date (asc) .
1 »
See also

Creating a dataspace [p 97]

Snapshots [p 107]

Related conceptsDatasets [p 112]
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CHAPTER 15

Creating a dataspace

This chapter contains the following topics:

1. Overview

2. Properties

15.1 Overview

To create a new dataspace, select an existing dataspace on which to base it, then click the Create a
dataspace button in the workspace.
Note
This area is available only to authorized users in the 'Advanced perspective'.
The new dataspace will be a child dataspace of the one from which it was created. It will be initialized

with all the content of the parent at the time of creation, and an initial snapshot will be taken of this
state.

Aside from the reference dataspace, which is the root of all dataspaces in the repository, dataspaces
are always a child of another dataspace.

15.2 Properties

The following information is required at the creation of a new dataspace:

Identifier Unique identifier for the dataspace.

Owner Owner of the dataspace, who is, by default, allowed to
modify its information and permissions. The owner does not
necessarily have to be the creator of the dataspace.

Label Localized label and description associated with the
dataspace.
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CHAPTER 16

Working with existing dataspaces

This chapter contains the following topics:

1. Dataspace information

Dataspace permissions

Merging a dataspace
Comparing a dataspace

Validating a dataspace

Dataspace archives

N ok DN

Closing a dataspace
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16.1 Dataspace information

Certain properties associated with a dataspace can be modified by selecting Actions > Information
from the navigation panel in the Dataspaces area.

Documentation Localized labels and descriptions associated with the
dataspace.
Loading strategy Only administrators can modify this setting.

+ On demand loading and unloading: The main
advantage of this strategy is the ability to free memory
when needed. Its disadvantage is the performance cost
associated with a resource being accessed for the first
time since server startup, or accessed after having been
unloaded. This is the default mode.

« Forced loading: This mode is recommended for
dataspaces and snapshots used heavily or demanding in
terms of response time.

+ Forced loading and prevalidation: This mode
is recommended for dataspaces and snapshots used
heavily or demanding in terms of response time, and
where the validation process can be time-intensive.

Note: Whenever the loading strategy is changed, you must
restart the server for the new setting to take effect.

Child merge policy This merge policy only applies to user-initiated merge
processes; it does not apply to programmatic merges, for
example, those performed by workflow script tasks.

The available merge policies are:

« Allows validation errors in result: Child dataspaces
can be merged regardless of the validation result. This
is the default policy.

« Pre-validating merge: A child dataspace can only be
merged if the result would be valid.

Current Owner Owner of the dataspace, who is, by default, allowed to
modify its information and permissions. The owner does not
necessarily have to be the creator of the dataspace.

Child dataspace sort policy Defines the display order of child dataspaces in dataspace
trees. If not defined, the policy of the parent dataspace is
applied. Default is 'by label'.
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Change owner Whether the current owner of the dataspace is allowed
to give ownership to another profile by modifying its
'Current owner' property. If the value is 'Forbidden', only an
administrator can modify the owner.

Change permissions Whether the current owner of the dataspace is allowed to
modify its permissions. If the value is 'Forbidden', only an
administrator can modify the permissions of the dataspace.

16.2 Dataspace permissions

General permissions
Dataspace id The dataspace to which the permissions will apply.
Profile selection The profile to which the rule applies.
Restriction policy Whether these permissions restrict the permissions assigned
to a given user through policies defined for other profiles.
See Restriction policy [p 286].
Dataspace access The global access permission on the dataspace.

Read-only

« Can see the dataspace and its snapshots, as well as child
dataspaces, according to their permissions.

« Can see the contents of the dataspace depending on
their permissions; cannot make modifications.

Write

« Can see the dataspace and its snapshots, as well as child
dataspaces, according to their permissions.

« Can modify the contents of the dataspace depending on
their permissions.

Hidden
« Cannot see the dataspace nor its snapshots directly.

« From a child dataspace, the current dataspace can be
seen but not selected.

« Cannot access the contents of the dataspace.

« Cannot perform any actions on the dataspace.
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Allowable actions

Users can be allowed to perform the following actions:

Create a child dataspace Whether the profile can create child dataspaces.

Create a snapshot Whether the profile can create snapshots from the
dataspace.

Initiate merge Whether the profile can merge the dataspace with its parent.

Export archive Whether the profile can perform exports.

Import archive Whether the profile can perform imports.

Close dataspace Whether the profile can close the dataspace.

Close snapshot Whether the profile can close snapshots of the dataspace.

Rights on services Specifies the access permissions for services.

Permissions of child dataspaces  Specifies the default access permissions for child dataspaces
when created that are created from the current dataspace.

16.3 Merging a dataspace

When the work in a given dataspace is complete, you can perform a one-way merge of the dataspace
back into the dataspace from which it was created. The merge process is as follows:

1. Both the parent and child dataspaces are locked to all users, except the user who initiated the
merge and administrator users. These locks remain for the duration of the merge operation. When
locked, the contents of a dataspace can be read, but they cannot be modified in any way.

Note: This restriction on the parent dataspace means that, in addition to blocking direct
modifications, other child dataspaces cannot be merged until the merge in progress is finished.

2. Changes that were made in the child dataspace since its creation are integrated into its parent
dataspace.

3. The child dataspace is closed.

4. The parent dataspace is unlocked.

Initiating a merge
To merge a dataspace into its parent dataspace:
1. Select that dataspace in the navigation pane of the Dataspaces area.

2. In the workspace, select Merge dataspace from the Actions menu.
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Reviewing and accepting changes

After initiating a dataspace merge, you must review the changes that have been made in the child
(source) dataspace since its creation, to decide which of those changes to apply to the parent (target)
dataspace.

Note

This change set review and acceptance stage is bypassed when performing merges
using data services or programmatically. For automated merges, all changes in the child
dataspace override the data in the parent dataspace.

The change acceptance process uses a side-by-side comparison interface that recapitulates the changes
that require review. Two change set columns are obtained by taking the relevant changes from the
following dataspace state comparisons:

+ The current child dataspace compared to its initial snapshot.
» The parent dataspace compared to the initial snapshot of the child dataspace.

By default, all detected changes are selected to be merged. You may deselect any changes that you
want to omit from the merge. You can view the changes relevant to different scopes in your data model
by selecting elements in the navigation pane.

In order to detect conflicts, the merge involves the current dataspace, its initial snapshot and the parent
dataspace, because data is likely to be modified both in the current dataspace and its parent.

The merge process also handles modifications to permissions on tables in the dataspace. As with other
changes, access control changes must be reviewed for inclusion in the merge.

When you have decided which changes to merge for a given scope, you must click the button Mark
difference(s) as reviewed to indicate that you have reviewed all the changes in that scope. All changes
must be reviewed in order to proceed with the merge.

Types of modifications

The merge process considers the following changes as modifications to be reviewed:
» Record and dataset creations
» Any changes to existing data
« Record, dataset, or value deletions

» Any changes to table permissions

Types of conflicts

This review interface also shows conflicts that have been detected. Conflicts may arise when the same
scope contains modifications in both the source and target dataspaces.

Conflicts are categorized as follows:
« A record or a dataset creation conflict
« An entity modification conflict
« A record or dataset deletion conflict

« All other conflicts
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Finalizing a merge

Once you have reviewed all changes and decided which to include in the merge result, click on the
Merge >> button in the navigation pane.

Depending on the child merge policy that is configured on the parent dataspace in your merge, the
subsequent process may differ. By default, merges are finalized even if the result would contain
validation errors. The administrator of the parent dataspace in your merge can set its child merge policy
so that merges of its children are only finalized if the result would not contain any validation errors.

If, however, the administrator of the parent dataspace has set its child merge policy to 'Pre-validating
merge', a dedicated dataspace is first created to hold the result of the merge. When the result is valid,
this dedicated dataspace containing the merge result is automatically merged into the parent dataspace,
and no further action is required.

In the case where validation errors are detected in the dedicated merge dataspace, you only have access
to the original parent dataspace and the dataspace containing the merge result, named "[merge] <
name of child dataspace >". The following options are available to you from the Actions > Merge
in progress menu in the workspace:

« Cancel, which abandons the merge and recuperates the child dataspace in its pre-merge state.

« Continue, which you can use to reattempt the merge after you have made the necessary
corrections to the dedicated merge dataspace.

Setting the child merge policy of a dataspace

As the administrator of a dataspace, you can block the finalization of merges of its child dataspaces
through the user interface when the merges would result in a dataspace with validation errors. To do
so, select Actions > Information from the workspace of the parent dataspace. On the dataspace's
information page, set the Child merge policy to Pre-validating merge. This policy will then be
applied to the merges of all child dataspaces into this parent dataspace.

Note

When the merge is performed through a Web Component, the behavior of the child
merge policy is the same as described; the policy defined in the parent dataspace is
automatically applied when merging a child dataspace. However, this setting is ignored
during programmatic merge, which includes script tasks in data workflows.

See alsoChild merge policy [p 104]

Abandoning a merge

Merges are performed in the context of a user session, and must be completed in a single operation.
If you decide not to proceed with a merge that you have initiated, you can click the Cancel button
to abandon the operation.

If you navigate to another page after initiating a merge, the merge will be abandoned, but the locks
on the parent and child dataspaces will remain until you unlock them in the Dataspaces area.

You may unlock a dataspace by selecting it in the navigation pane, and clicking the Unlock button
in the workspace. Performing the unlock from the child dataspace unlocks both the child and parent
dataspaces. Performing the unlock from the parent dataspace only unlocks the parent dataspace, thus
you need to unlock the child dataspace separately.
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16.4 Comparing a dataspace

You can compare the contents of a dataspace to those of another dataspace or snapshot in the repository.
To perform a comparison, select the dataspace in the navigation pane, then select Actions > Compare
from the workspace.

The comparison wizard prompts you to select the dataspace or snapshot with which to compare the
current dataspace.

For a faster comparison that ignores fields with inherited and computed values, select the filter
'Persisted values only'.

See alsoCompare contents [p 229]

16.5 Validating a dataspace

To perform a global validation of the contents of a dataspace, select that dataspace in the navigation
panel, then select Actions > Validate in the workspace.

Note

This service is only available in the user interface if you have permission to validate
every dataset contained in the current dataspace.

16.6 Dataspace archives

The content of a dataspace can be exported to an archive or imported from an archive.

Exporting

To export a dataspace to an archive, select that dataspace in the navigation panel, then select Actions
> Export in the workspace. Once exported, the archive file is saved to the file system of the server,
where only an administrator can retrieve the file.

Note

See Archives directory [p 400] in the Administration Guide for more information.
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In order to export an archive, the following information must be specified:

Name of the archive to create

The name of the exported archive.

Export policy

Required.

The default export policy is 'The whole content of the
dataspace', which exports all selected data to the archive.

It may be useful to export only the differences between the
dataspace and its initial snapshot using a change set. There
are two different export options that include a change set:
'"The updates with their whole content' and 'The updates
only'. The first option exports all current data and a change
set containing differences between the current state and the
initial snapshot. The second option only exports the change
set. Both options lead to a comparison page, where you
can select the differences to include in this change set.
Differences are detected at the table level.

Datasets to export

The datasets to export from this dataspace. For each
dataset, you can export its data values, permissions, and/or
information.

Importing

To import content into a dataspace from an archive, select that dataspace in the navigation panel, then

select Actions > Import in the workspace.

If the selected archive does not include a change set, the current state of the dataspace will be replaced

with the content of the archive.

If the selected archive includes the whole content as well as a change set, you can choose to apply the

change set in order to merge the change set differences with the current state. Applying the change

set leads to a comparison screen, where you can then select the change set differences to merge.

If the selected archive only includes a change set, you can select the change set differences to merge

ona comparison screein.

16.7 Closing a dataspace

If a dataspace is no longer needed, it can be closed. Once it is closed, a dataspace no longer appears
in the Dataspaces area of the user interface, nor can it be accessed.

An administrator can reopen a closed dataspace as long as it has not been cleaned from the repository.

To close a dataspace, select Actions > Close this dataspace .

See alsoClosing unused dataspaces and snapshots [p 401]
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CHAPTER 17

Snapshots

This chapter contains the following topics:

1. Overview of snapshots

Creating a snapshot

Viewing snapshot contents

Snapshot information

Comparing a snapshot

Validating a snapshot

Export
Closing a snapshot

©® N ek~ N

17.1 Overview of snapshots

A snapshot is a read-only copy of a dataspace. Snapshots exist as a record of the state and contents
of a dataspace at a given point in time.

See alsoSnapshot [p 30]

17.2 Creating a snapshot

A snapshot can be created from a dataspace by selecting that dataspace in the navigation pane of the
Dataspaces area, then selecting Actions > Create a Snapshot in the workspace.

The following information is required:

Identifier Unique identifier for the snapshot.
Label Localized labels and descriptions associated with the
snapshot.
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17.3 Viewing snapshot contents

To view the contents of a snapshot, select the snapshot, then select Actions > View datasets from
the workspace.

17.4 Snapshot information

You can modify the information associated with a snapshot by selecting Actions > Information.

Documentation Localized labels and descriptions associated with the
snapshot.
Loading strategy Only administrators can modify this setting. See Loading

strategy [p 100].

Current Owner Owner of the snapshot, who is, by default, allowed to
modify its information and permissions. The owner does not
necessarily have to be the creator of the snapshot.

Change owner Whether the current owner of the snapshot is allowed
to give ownership to another profile by modifying its
'Current owner' property. If the value is 'Forbidden', only an
administrator can modify the owner.

17.5 Comparing a snapshot
You can compare the contents of a snapshot to those of another snapshot or dataspace in the repository.
To perform a comparison, select the snapshot, then select Actions > Compare from the workspace.

The comparison wizard prompts you to select the dataspace or snapshot with which to compare the
current snapshot.

For a faster comparison that ignores fields with inherited and computed values, select the filter
'Persisted values only'.

See alsoCompare contents [p 229]

17.6 Validating a shapshot

To perform a global validation of the contents of a snapshot, select Actions > Validate in the
workspace.

Note

In order to use this service, you must have permission to validate every dataset contained
in the snapshot.
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17.7 Export

To export a snapshot to an archive, open that snapshot, then select Actions > Export in the workspace.
Once exported, only an administrator can retrieve the archive.

Note

See Archives directory [p 400] in the Administration Guide for more information.

In order to export an archive, the following information must be specified:

Name of the archive to create The name of the exported archive.

Datasets to export The datasets to export from this snapshot. For each
dataset, you can choose whether to export its data values,
permissions, and information.

17.8 Closing a shapshot

If a snapshot is no longer needed, it can be closed. Once it is closed, a snapshot no longer appears
under its associated dataspace in the Dataspaces area, nor can it be accessed.

An administrator can reopen a closed dataspace as long as it has not been cleaned from the repository.

To close a snapshot, select Actions > Close this snapshot.

See alsoClosing unused dataspaces and snapshots [p 401]
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CHAPTER 18

Introduction to datasets

This chapter contains the following topics:
1. Overview

2. Using the Data user interface

18.1 Overview

What is a dataset?

A dataset is a container for data that is based on the structural definition provided by its underlying data
model. When a data model has been published, it is possible to create datasets based on its definition. If
that data model is later modified and republished, all its associated datasets are automatically updated
to match.

In a dataset, you can consult actual data values and work with them. The views applied to tables allow
representing data in a way that is most suitable to the nature of the data and how it needs to be accessed.
Searches and filters can also be used to narrow down and find data.

Different permissions can also be accorded to different roles to control access at the dataset level.
Thus, using customized permissions, it would be possible to allow certain users to view and modify
a piece of data, while hiding it from others.

Basic concepts related to datasets
A basic understanding of the following terms is beneficial when working with datasets:
« dataspace [p 30]
« dataset [p 28]
« record [p 28]
« fieldp27]
» primary key [p27]
«+ foreign key [p27]
« table (in dataset) [p 28]

e group [p27]
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18.2 Using the Data user interface

Datasets can be created, accessed and modified in the Data area using the Advanced perspective [p 19]
or from a specifically configured perspective. Only authorized users can access these interfaces.

I -

D-S 593 - -;-:‘: Dataspace selector | ?

OB B & & /S

F 5

Book store __ Dataset selector ‘_.|

N Y
Actions ~ [ Dataset actions &
7| services menu

Titles
Publishers
Authors
Royalties
Workspace

Contracts

Navigation pane

Select or create a dataset using the 'Select dataset' menu in the navigation pane. The data structure of
the dataset is then displayed in the navigation pane, while record forms and table views are displayed
in the workspace.

When viewing a table of the dataset in the workspace, the button Q displays searches and filters that
can be applied to narrow down the records that are displayed.

Operations at the dataset level are located in the Actions menu in the navigation pane (services are
available at the bottom of the list).

See also

Creating a dataset [p 115]

Quick Search [p 118]

Working with records in the user interface [p 127]

Inheritance [p 29]

Related concepts

Data model [p 36]

Dataspace [p 94]

TIBCO EBX® Product Documentation 6.0.5 113



Documentation > User Guide > Datasets > Introduction to datasets

TIBCO EBX® Product Documentation 6.0.5 114



Documentation > User Guide > Datasets > Creating a dataset

CHAPTER 19

Creating a dataset

This chapter contains the following topics:

1. Creating a root dataset

2. Creating an inheriting child dataset

19.1 Creating a root dataset

To create a new root dataset, that is, one that does not inherit from a parent dataset, select the 'Select

dataset[p113]' T menu in the navigation pane, click the 'Create a dataset' button in the pop-up, and
follow through the wizard.

Note

This area is available only to authorized users in the 'Advanced perspective' or from a
specifically configured perspective.

The wizard allows you to select one of three data model packaging modes on which to base the new
dataset: packaged, embedded, or external.

» A packaged data model is a data model that is located within a module, which is a web application.

+ An embedded data model is a data model that is managed entirely within the TIBCO EBX
repository.

« An external data model is one that is stored outside of the repository and is referenced using its
URL

After locating the data model on which to base your dataset, you must provide a unique name, without
spaces or special characters. Optionally, you may provide localized labels for the dataset, which will
be displayed to users in the user interface depending on their language preferences.

Attention
Table contents are not copied when duplicating a dataset.
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19.2 Creating an inheriting child dataset

The inheritance mechanism allows datasets to have parent-child relationships, through which default
values are inherited from ancestors by descendants. In order to be able to create child datasets, dataset
inheritance must be enabled in the underlying data model.

To create a child dataset, select the 'Select dataset [p113]' ~ menu in the navigation pane, then click
the * button next to the desired parent dataset.

As the dataset will automatically be based on the same data model as the parent dataset, the only
information that you need to provide is a unique name, and optionally, localized labels.

See alsoDataset inheritance [p 145]
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cHAPTER 20

Viewing data

TIBCO EBX offers different ways to list records. This chapter presents how to sort, search, and display
records in varying ways, and according to different user profiles, through to the concept of 'Views'.

This chapter contains the following topics:
1. 'View' menu

Sorting data

Quick Search

Searching and filtering data
Views

Views management

Grid edit
History

N e kN

20.1 'View' menu

The 'View' drop-down menu allows accessing all available views and management features.

Views are managed directly in the 'View' menu toolbar, available on each listed view: 'View' menu
toolbar [p 125].

Views can also be grouped. An administrator has to beforehand define groups in 'Views configuration'
under the 'Groups of views' table. The end-user can then set a view as belonging to a group, through
the field "View group' upon creation or modification of the view. See 'View description' [p 122] for
more information.

20.2 Sorting data

Sort criteria control the order in which records are presented.
Use the 'Select and Sort' button at the top left of the table to define specific sorting criteria.
There are two types of sorting:

« sorting by relevance, used in the quick search [p 118],

+ sorting by column.
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Sorting by column
The 'Sorting criteria' dialog box offers:
« on the left, the list of sorted columns,
« on the right, the list of unsorted columns.
Use the — — arrow buttons to toggle columns from one list to another.
Use the 1 | arrow buttons to change the priority order of the column.

To change the sort order of a column, use the 'ASC' (ascending) or 'DESC' (descending) button that
appears on the mouse-over.

20.3 Quick Search

Table

+ Actions = (C'\ V)

= Id ~  Legal Id MName Business Description Category Parent

The quick search is used to easily find a result in a tabular or hierarchical view.

It does not differentiate between upper and lower case. It allows you to search for several terms at
once (separated by spaces). By default, the records found are sorted by relevance.

See alsoSearch [p 297]
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Special characters

The quick search offers special characters to refine your search.

+... required Makes it required that the word be present in the result.
Prevents the search engine from excluding this word from
the search.

Note

Works with +"phrase" or +(group).
Example:
+flute +bach

L Finds results with required flute and required bach.
Results with only flute or only bach will be ignored.

-... hot Excludes the word from the result.

Note

Works with -"phrase" or - (group).

Example:

bach -flute

L Find results with bach, but without flute.

«.~fuzzy Specifies that the search can change 2 characters of the word
to find it.

To allow for a single character to change, use ~1.

Note
Works with "phrase"~, to change 2 words in
the phrase.

Example:

handel~

L. Find results with a word that is handel, with 1 or 2 letters
differing.

2single joker Replaces an unknown character.
Example:

?2uttle

L Finds results with a word starting with any character, and
ending with uttle.
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*extended joker Replaces several unknown characters.

Example:

rachmanino*

L Find results with a word beginning with rachmanino.

"..."phrase Find the exact match of the phrase.

Note

Can be surrounded by +-~.

Example:

"Johann Sebastian Bach"

L. Find results containing exactly Johann Sebastian Bach.

(...)group Allows grouping words to apply a special character + or -
to them.

Note

You can make groups of groups.
Example:
bach +(flute piano)

L Find the results with possibly bach, and necessarily flute
or piano.

Note

These special characters can also be used in the documentation search engine.

20.4 Searching and filtering data

The search pane is hidden by default and accessible via the ™ icon located to the right of the quick
search in the table toolbar or the hierarchical view.

The quick search and the criteria lines combine to narrow the search (restricting the result to fewer
and fewer records).

It is possible to deactivate a criteria line by unchecking it. The deactivated criteria are not kept during
a save.
The trashcan button W at the end of the line of each criterion permanently deletes the criterion.

To save the filter applied to a search, use the 'Save' button. Saving takes into account the quick search
and all active criteria.

To recall a saved filter, use the '"Load' button. Loading replaces the quick search and the whole criteria
panel. Click on the 'Apply' button to start the new search.
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When a view is applied, it ensures that it is displayed according to its configuration. All existing
criteria in the search panel are therefore removed. The view can contain a set of search criteria, which
are applied together with the at the same time as the view.

Some operators (such as 'matches’) allow to use Lucene regular expressions. See _technical
specifications of Lucene's regex pattern for more information.

Search on a field

All searchable fields are available.

Validation filter

In field selection, the validation criteria display the records as of the last validation performed.

Note

This filtering only applies to records of the table that have been validated at least once
by selecting Actions > Validate at the table level from the workspace, or at the dataset
level from the navigation pane.

To filter on the validation severity level (independent from validation Message), use the 'Severity'
validation criterion. Available levels are: 'Errors', 'Warnings' and 'Information’'.

To filter on the validation message (independent from validation Severity level), use the 'Message'
validation criterion.

Custom table searches
For backward compatibility, the feature for custom searching and filtering records is still operational

and accessible via the icon Y in the workspace. The icon and feature are only available when at least
one custom filter exists.

Additional custom filters can be specified for each table in the data model.

See alsoCustomizing table filter [p 642]

20.5 Views

It is possible to customize the display of tables in EBX according to the target user. There are two
types of views: tabular [p 122] and hierarchical [p 123].

A view can be created by selecting View > Create a new view in the workspace. To apply a view,
select it in View > name of the view.

Two types of views can be created:
 'Simple tabular view": A table view to sort and filter the displayed records.

« 'Hierarchical view": A tree view that links data in different tables based on their relationships.
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View description
When creating or updating a view, the first page allows specifying general information related to the
view.
Documentation Localized label and description associated with the view.
Owner Name of the owner of the view. This user can manage and
modify it. (Only available for administrators and dataset
owners)
Share with Other profiles allowed to use this view from the 'View'
menu.
Note
Requires a permission, see Views permissions
[p 422].
View mode Simple tabular view or hierarchical view.
View group Group to which this view belongs (if any).

Simple tabular views

Simple tabular views offer the possibility to define criteria to filter records and also to select the
columns that will be displayed in the table.

Displayed columns

Specifies the columns that will be displayed in the table.

Sorted columns

Specifies the sort order of records in the table. See Sorting
data [p 1171.

Filter

Defines filters for the records to be displayed in the table.

See Criteria editor [p 295].

Pagination limit

Forces a limit to the number of visible records.

Grid edit

If enabled, users of this view can switch to grid edit, so that
they can edit records directly from the tabular view.

Disable create and duplicate

If "Yes', users of this view cannot create nor duplicate
records from the grid edit.
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Hierarchical views

A hierarchy is a tree-based representation of data that allows visualizing relationships between tables.
It can be structured on several relationship levels called dimension levels. Furthermore, filter criteria
can be applied, to define which records will be displayed in the view.

Hierarchy dimension

A dimension defines dependencies in a hierarchy. For example, a dimension can be specified to display
products by category. You can include multiple dimension levels in a single view.

Hierarchical view configuration options

This form allows configuring the hierarchical view options.

Display records in a new window If 'Yes', a new window will be opened with the record.
Otherwise, it will be displayed in a new page of the same
window.

Prune hierarchy If "Yes', hierarchy nodes that have no children and do not
belong to the target table will not be displayed.

Display orphans If "Yes', hierarchy nodes without a parent will be displayed.

Display root node If 'No', the root node of the hierarchy will not be displayed
in the view.

Root node label Localized label of the hierarchy root node.

Toolbar on top of hierarchy Allows setting the toolbar on top of the hierarchy.

Detect cycle Allow cycle detection and display in a recursive case,

the oldest node record will be chosen as the cycle root.
Limitation: does not work in search or pruned mode.

Detect leaf Allows detecting whether the member is a leaf or not. The
leaf detection is very costly for large volumes of data. Thus,
it is recommended to disable this option when the query
response is delayed to display the hierarchy view. This
property is always disabled for orphans' parent members.

Labels

For each dimension level that references another table, it is possible to define localized labels for the
corresponding nodes in the hierarchy. The fields from which to derive labels can be selected using
the built-in wizard.

Filter

The criteria editor allows creating a record filter for the view.
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See alsoCriteria editor [p 295]

Sort strategy

For each dimension level, it is possible to choose one of the following sort strategies:

Default

Nodes are sorted by label in alphabetical order

Sort by columns

Nodes are sorted by selected column(s). The direction
(ascending/descending) can be chosen for each column.

Sort by ordering field

Nodes are sorted by a hidden numeric field, which allows
users to dynamically change the order of sibling nodes in
the hierarchy view. This strategy is available only if there is
at least one 'Hidden' numeric field in the table.

In order to enable this option, you must designate an eligible
ordering field defined in the table on which the hierarchical
view is applied. An ordering field must have the 'Integer'
data type and have a 'Hidden' default view mode in its
advanced properties in the data model definition.

Except when the ordering field is in 'read-only' mode or
when the hierarchy is filtered, any field can be repositioned.

Attention

Do not designate a field that is meant to contain data as
an ordering node, as the data will be overwritten by the
hierarchical view.

Actions on hierarchy nodes

Each node in a hierarchical view has amenu ™ containing contextual actions.

Leaf nodes can be dissociated from their parent record, using 'Detach from parent'. The record then

becomes an orphan node in the tree, organized under a container "unset" node.

Leaf nodes can also change parent nodes, using 'Attach to another parent'. If, according to the data
model, a node can have relationships to multiple parents, the node will be both under the current
parent and added under the other parent node. Otherwise, the leaf node will be moved under the other

parent node.

View sharing

Users having the 'Share views' permission on a view are able to define which users can display this

view from their 'View' menu.

To do so, simply add profiles to the 'Share with' field of the view's configuration screen.
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View publication
Users having the 'Publish views' permission can publish views present in their 'View' menu.

A published view is then available to all users via Web components, workflow user tasks, data services
and perspectives. To publish a view, go to the 'View menu', click on the Edit button displayed on the
mouseover of a listed view and add a 'Publication name' to the view.

20.6 Views management

Manage recommended views

When a user logs in with no view specified, their recommended view (if any) is applied. Otherwise,
the default view is applied. The '"Manage recommended views' action allows defining assignment rules
of recommended views depending on users and roles.

Available actions on recommended views are: change order of assignment rules, add a rule, edit
existing rule, delete existing rule.

Thus, for a given user, the recommended views are evaluated according to the user's profile: the applied
rule will be the first that matches the user's profile.

Note

The '"Manage recommended view' feature is only available to dataset owners.

'View' menu toolbar

The 'View' menu toolbar offers the following actions:

Edit Click on the 'Edit' button of the targeted view's toolbar to
access the editable form.

Duplicate Click on the 'Duplicate' button of the targeted view's toolbar
to duplicate the view. The new view creation form pre-
populates the field values from the view being duplicated.

Delete Click on the 'Delete' button of the targeted view's toolbar to
delete the view.

Define this view as my favorite Click on the "Define this view as my favorite' button of the
targeted view's toolbar. The favorite view will automatically
be applied when accessing the table. Click a second time on
the button to remove the view as the user's favorite view.

20.7 Grid edit

The grid edit feature allows modifying data in a table view. This feature can be accessed by clicking
on the £ button.
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Accessing the grid edit from a table view requires that the feature be previously activated in the view
configuration.

See alsoGrid edit [p 122]

Copy/paste

The copy/paste of one or more cells into another one in the same table can be done through the Edit
menu. It is also possible to use the associated keyboard shortcuts Ctrl+C and Ctrl+V.

This system does not use the operating system clipboard, but an internal mechanism. As a
consequence, copying and pasting a cell in an external file will not work. Conversely, pasting a value
into a table cell won't work either.

All simple type fields using built-in widgets are supported.

20.8 History

The history feature allows tracking changes on master data.

The history feature must have been previously enabled at the data model level. See Advanced
properties for tables [p 61] for more information.

To view the history of a dataset, select Actions > History in the navigation pane.

To view the history of a table or of a selection of records, select Actions > View history in the
workspace.

Several history modes exist, which allow viewing the history according to different perspectives:

History in current dataspace The table history view displays operations on the current
branch. This is the default mode.

History in current dataspace The table history view displays operations on the current
and ancestors branch and on all its ancestors.

History in current dataspace The table history view displays operations on the current
and merged children branch and on all its merged children.

History in all dataspaces The table history view displays operations on the whole

branch hierarchy.

In the history view, use the VIEW menu in order to switch to another history mode.

See alsoHistory [p 251]
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CHAPTER 21

Editing data

This chapter contains the following topics:

1. Working with records in the user interface

2. Importing and exporting data

3. Restore from history

21.1 Working with records in the user interface

Record editing takes place in the workspace portion of the user interface.

Note

This action is available only to authorized users in the 'Advanced perspective' or from
a specifically configured perspective.

Creating a record

In a tabular view, click the * button located above the table.

In a hierarchical view, select 'Create a record' from the menu of the parent node under which to create
the new record.

Next, enter the field values in the new record creation form. Mandatory fields are indicated by
asterisks.

Updating an existing record
Double-click the record to update, then edit the field values in the record form.

To discard any changes in progress and restore the fields to their values before editing, click the Revert
button.

Duplicating a record
To duplicate a selected record, select Actions > Duplicate.

A new record creation form pre-populates the field values from the record being duplicated. The
primary key must be given a unique value, unless it is automatically generated (as is the case for auto-
incremented fields).
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Deleting records

To delete one or more selected records, select Actions > Delete.

Comparing two records

To compare two selected records, select Actions > Compare.

Note

The content of complex terminal nodes, such as aggregated lists and user defined
attributes, are excluded from the comparison process. That is, the compare service
ignores any differences between the values of the complex terminal nodes in the records.

21.2 Importing and exporting data

In a table, records can be exported to or imported from CSV or XML format.

You can either manually select certain records of the table to export, or you can export the whole table.

See also
CSV Services [p 135]

XML Services [p 129]

21.3 Restore from history

When history is enabled on a table, it is possible to restore a record to a previous state, based on its
registered history. If the record (identified by its primary key) still exists in the table, it will be updated
with the historized values to be restored. Otherwise, it will be created.

In order to restore a record to a previous state, select a record in the history table view, and the select
Actions > Restore from history in the workspace. A summary screen is displayed with the details
of the update or creation to be performed.

The restore feature is available only on one record at a time.

If a table trigger must have a specific behavior on restore, different from the one on regular create and
update, the developer can use the method TableTriggerExecutionContext.isHistoryRestore™.
Note

This feature has limitations linked to the limitations of the history feature:

« the 'restore from history' feature is not available on tables containing lists that are not
supported by history. See Data model limitations [p 256].

» computed values, encrypted values and fields on which history has been disabled are
ignored when restoring a record from history, since these fields are not historized.

See alsoHistory [p 251]

TIBCO EBX® Product Documentation 6.0.5 128



Documentation > User Guide > Datasets > File import and export services > XML import and export

CHAPTER 22

XML import and export

This chapter contains the following topics:

1. Introduction

. Imports
. Exports

2
3
4, Handling of field values
5. Known limitations

22.1 Introduction
XML imports and exports can be performed on tables through the user interface using the Actions
menu in the workspace.
Both imports and exports are performed in the context of a dataset.
Imports and exports can also be done programmatically.

Default import and export option values can be set in the Administration area, under User interface
> Graphical interface configuration > Default option values > Import/Export.

22.2 Imports

Attention

Imported XML documents must be encoded in UTF-8 and its structure must conform to the
underlying data model of the target dataset.
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Import mode

When importing an XML file, you must specify one of the following import modes, which will dictate
how the import procedure handles the source records.

Insert mode Only record creations are allowed. If a record exists in
the target table with the same primary key as the source
record, an error is returned and the whole import operation
is cancelled.

Update mode Only modifications of existing records are allowed. If no
record exists in the target table with the same primary key as
the source record, an error is returned and the whole import
operation is cancelled.

Update or insert mode If a record with the same primary key as the source record
already exists in the target table, that record is updated.
Otherwise, a new record is created.

Replace (synchronization) mode If a record with the same primary key as the source record
already exists in the target table, that record is updated.
Otherwise, a new record is created. If a record exists in the
target table but is not present in the source XML file, that
record is deleted from the table.

Insert and update operations

The mode 'by delta' allows ignoring data model elements that are missing from the source XML
document. This mode can be enabled through data services or the Java API. The following table
summarizes the behavior of insert and update operations when elements are not present in the source
document.
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State in source XML document

Behavior

Element does not exist in the source document

If 'by delta’ mode is disabled (default):
Target field value is set to one of the following:

« If the element defines a default value, the target field value
is set to that default value.

« If the element is of a type other than a string or list, the
target field value is set to null.

« If the element is an aggregated list, the target field value is
set to an empty list.

« If the element is a string that distinguishes null from an
empty string, the target field value is set to null. If it is a
string that does not distinguish between the two, an empty
string.

« If the element (simple or complex) is hidden in data
services, the target value is not changed.

See alsoHiding a field in Data Services [p 582]

Note: The user performing the import must have the
permissions necessary to create or change the target field value.
Otherwise, the value will remain unchanged.

If 'by delta’ mode has been enabled through data services or
the Java API:

« For the update operation, the field value remains
unchanged.

« For the insert operation, the behavior is the same as when
byDelta mode is disabled.

Element exists but is empty (for example, <fieldA/>)

« For nodes of type xs:string (or one of its sub-types), the
target field's value is set to null if it distinguishes null
from an empty string. Otherwise, the value is set to empty
string.

« For non-xs:string type nodes, an exception is thrown in

conformance with XML Schema.

See alsoTIBCO EBX whitespace management for data
types [p 566]

Element is present and null (for example, <fieldA
xsi:nil="true"/>)

The target field is always set to null except for lists, for which
it is not supported.

In order to use the xsi:nil="true" attribute, you must
import the namespace declaration xmlns:xsi="http://
www.w3.0rg/2001/XMLSchema-instance".

Set missing values as null

1

When updating existing records, if a node is missing or empty in the XML file: if this option is "yes",
it will be considered as null. If this option is "no", it will not be modified.
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Ignore extra columns

It may happen that the XML document contains elements that do not exist in the target data model.
By default, in this case, the import procedure will fail. It is possible, however, to allow users to launch
import procedures that will ignore the extra columns defined in the XML files. This can be done in
the configuration parameters of the import wizard for XML. The default value of this parameter can
be configured in the 'User interface' configuration under the 'Administration’ area.

Optimistic locking

If the technical attribute ebxd:lastTime exists in the source XML file, the import mechanism
performs a verification to prevent an update operation on a record that may have changed since the
last read. In order to use the ebxd:lastTime attribute, you must import the namespace declaration
xmlns:ebxd="urn:ebx-schemas:deployment_1.0. The timestamp associated with the current record
will be compared to this timestamp. If they are different, the update is rejected.

22.3 Exports

Note
Exported XML documents are always encoded in UTF-8.

When exporting to XML, if the table has filters applied, only the records that correspond to the filter
are included in the exported file.
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The XML export options are as follows:

Download file name

Specifies the name of the XML file to be exported. This field
is pre-populated with the name of the table from which the
records are being exported.

User-friendly mode

Specifies whether exported values will be represented in
a user-friendly way, or in the standard XML raw format.
For example, in user-friendly mode, dates and numbers are
formatted according to the user's locale, and foreign keys
and enumerated values display their associated labels.

Note: If this option is selected, the exported file will not be
able to be re-imported.

Include technical data

Specifies whether internal technical data will be included in
the export.

Note: If this option is selected, the exported file will not be
able to be re-imported.

Is indented

Specifies whether the file should be indented to improve its
readability by a human.

Omit XML comment

Specifies whether the generated XML comment that
describes the location of data and the date of the export
should be omitted from the file.

22.4 Handling of field values

Date, time & dateTime format

The following date and time formats are supported:

Type Format Example
xs:date yyyy-MM-dd 2007-12-31
xs:time HH:mm:ss or HH:mm:ss.SSS 11:55:00

xs:dateTime

yyyy-MM-ddTHH:mm:ss or yyyy-MM-

ddTHH:mm:ss.SSS

2007-12-31T11:55:00
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22.5 Known limitations

Association fields

The XML import and export services do not support association values.
Exporting such fields will not cause any error, however, no value will be exported.

Importing such fields will cause an error, and the import procedure will be aborted.

Selection nodes

The XML import and export services do not support selection values.
Exporting such fields will not cause any error, however, no value will be exported.

Importing such fields will cause an error, and the import procedure will be aborted.
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CHAPTER 23

CSV import and export

This chapter contains the following topics:

1. Introduction

. Exports
. Imports

2
3
4, Handling of field values
5. Known limitations

23.1 Introduction

CSV imports and exports can be performed on tables through the user interface using the Actions
menu in the workspace.

Both imports and exports are performed in the context of a dataset.

Imports and exports can also be done programmatically.

Default import and export option values can be set in the Administration area, under User interface
> Graphical interface configuration > Default option values > Import/Export.

See alsoDefault option values [p 416]

23.2 Exports

When exporting to CSV, if the table has filters applied, only the records that correspond to the filter
are included in the exported file.
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The CSV export options are as follows:

Download file name Specifies the name of the CSV file to be exported. This field
is pre-populated with the name of the table from which the
records are being exported.

File encoding Specifies the character encoding to use for the exported file.
The default is UTF-8.

Enable inheritance In order to consider the inheritance [p 29] during a CSV
export, the option has to be defined in the model.

For more information on inheritance, see Inheritance and
value resolution [p 270].

Specifies if inheritance will be taken into account during a
CSV export.

If inheritance is enabled, resolved values of fields are
exported with the technical data that define the possible
inheritance mode of the record or the field.

If inheritance is disabled, resolved values of fields are
exported and occulted records are ignored.

By default, this option is disabled.

Note: Inheritance is always ignored, if the table dataset has
no parent or if the table has no inherited field.

User-friendly mode Specifies whether exported values will be represented in a
user-friendly way, or in a raw format. For example, in user-
friendly mode, dates and numbers are formatted according
to the user's locale, and foreign keys and enumerated values
display their associated labels.

Note: If this option is selected, the exported file will not be
able to be re-imported.

Include technical data Specifies whether internal technical data will be included in
the export.

Note: If this option is selected, the exported file will not be
able to be re-imported.

Column header Specifies whether or not to include column headers in the
CSV file.

« No header

« Label: For each column in the spreadsheet, the CSV
displays its label. Each label is localized according to
the locale preference of the current session. If no user-
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friendly label is defined for a node, the technical name
of the node is used.

« XPath: For each column in the spreadsheet, the CSV
displays the path to the node in the table.

Field separator Specifies the field separator to use for exports. The
default separator is comma, it can be modified under
Administration > User interface.

List separator Specifies the separator to use for values lists. The
default separator is line return, it can be modified under
Administration > User interface.

APT

Programmatic CSV exports are performed using the classes ExportSpec* and ExportImportCSVSpec™

in the Java API.
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23.3 Imports

Download file name Specifies the name of the CSV file to be imported.

Import mode When importing a CSV file, you must specify one of the
following import modes, which will control the integrity of
operations between the source and the target table.

+ Insert mode: Only record creation is allowed. If a
record exists in the target table with the same primary
key as the source record, an error is returned and the
whole import operation is cancelled.

« Update mode: Only modifications of existing records
are allowed. If no record exists in the target table with
the same primary key as the source record, an error is
returned and the whole import operation is cancelled.

« Update or insert mode: If a record with the same
primary key as the source record already exists in the
target table, that record is updated. Otherwise, a new
record is created.

+ Replace (synchronization) mode: If a record with the
same primary key as the source record already exists in
the target table, that record is updated. Otherwise, a new
record is created. If a record exists in the target table
but is not present in the source XML file, that record is
deleted from the table.

File encoding Specifies the character encoding to use for the exported file.
The default is UTF-8.

Enable inheritance In order to consider the inheritance [p 29] during a CSV
import, the option has to be defined in the model.

For more information on inheritance, see Inheritance
and value resolution [p 270] and ExportImportCSVSpec.

APT

setInheritanceEnabled .

Specifies whether the inheritance will be taken into account
during a CSV import. If technical data in the CSV file define
an inherit mode, corresponding fields or records are forced
to be inherited. If technical data define an occult mode,
corresponding records are forced to be occulted. Otherwise,
fields are overwritten with values read from the CSV file.
By default, this option is disabled.

Note: Inheritance is always ignored if the dataset of the table
has no parent or if the table has no inherited field.
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Column header Specifies whether or not to include column headers in the
CSV file.

+ No header

« Label: For each column in the spreadsheet, the CSV
displays its label. Each label is localized according to
the locale preference of the current session. If no user-
friendly label is defined for a node, the technical name
of the node is used.

« XPath: For each column in the spreadsheet, the CSV
displays the path to the node in the table.

Field separator Specifies the field separator to use for exports. The
default separator is comma, it can be modified under
Administration > User interface.

List separator Specifies the separator to use for values lists. The
default separator is line return, it can be modified under
Administration > User interface.

APT

Programmatic CSV imports are performed using the classes ImportSpec™ and ExportImportCSVSpec™

in the Java API.

23.4 Handling of field values

Aggregated lists

The CSV import and export services support multi-valued fields, namely aggregated lists. This is only
supported for simple typed lists, such as lists of string, date, or int, and for foreign keys. If a table
reference is linked to a composite primary key, each item in the list is a formatted string, for example,
"true|99". Aggregated lists of groups are not exported.

At export, the items in the list are separated using line separators. In cases where the exported field
already contains a line separator, for example in an osd:html or an osd:text, the code _crnl_ is
inserted in place of the field value's line separators. The same formatting is expected at import, with
the whole field value surrounded by quotes.

Hidden fields

Hidden fields are exported as ebx-csv:hidden strings. An imported hidden string will not modify a
field's content.

‘Null" value for strings

Using CSV import and export services, a string with a value set to null is exported as an empty string.
Therefore, a round trip export-import procedure will end up replacing null string values with empty
strings.

Using programmatic services, the specific value ebx-csv:nil can be assigned to strings with values
set to null. If this is done, the null string values will not be replaced by empty strings during round
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trip export-import procedures. See ExportImportCSVSpec.setNullStringEncoded™ in the Java API
for more information.

Date, time & dateTime format

The following date and time formats are supported:

Type Format Example

xs:date yyyy-MM-dd 2007-12-31

xs:time HH:mm:ss or HH:mm:ss.SSS 11:55:00

xs:dateTime yyyy-MM-ddTHH:mm:ss or yyyy-MM- 2007-12-31T11:55:00
ddTHH:mm:ss.SSS

23.5 Known limitations

Aggregated lists of groups

The CSV import and export services do not support multi-valued groups, that is, aggregated lists of
complex type elements. Exporting such nodes will not cause any error, however, no value will be
exported.

Terminal groups

In a CSV file, it is impossible to differentiate a created terminal group that contains only empty fields
from a non-created one.

As a consequence, some differences may appear during comparison after performing an export
followed by an import. To ensure the symmetry of import and export, use XML import and export
instead. See XML import and export [p 129].

Column label headers

If two columns share the same label header, an export of the table can be performed successfully, but
exported data cannot later be re-imported.

Association fields
The CSV import and export services do not support association values, i.e. the associated records.
Exporting such fields will not cause any error, however, no value will be exported.

Importing such fields will cause an error and the import procedure will be aborted.

Selection nodes
The CSV import and export services do not support selection values, i.e. the selected records.
Exporting such fields will not cause any error, however, no value will be exported.

Importing such fields will cause an error and the import procedure will be aborted.
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CHAPTER 24

Working with existing datasets

This chapter contains the following topics:

1. Validating a dataset

. Duplicating a dataset

2
3. Deactivating a dataset
4

. Managing dataset permissions

24.1 Validating a dataset

To validate a dataset at any time, select Actions > Validate from the navigation pane. A generated
report provides the results of the validation. From the validation report, you have the option to update
the reported validation status by clicking the Revalidate button, or to click the Reinitialize validation
report button to clear the current validation report associated with the dataset in order to be able to
rerun a full validation from scratch.

Validations of data can also be run at the table level by navigating to the desired table from the
navigation pane, then selecting Actions > Validate from the workspace.

See Validation [p 304] for detailed information about incremental data validation.

24.2 Duplicating a dataset

To duplicate an existing dataset, select it from the 'Select dataset [p 113]' ~ menu in the navigation
pane, then select Actions > Duplicate.

24.3 Deactivating a dataset

When a dataset is activated, it will be subject to validation. That is, all mandatory elements must be
defined in order for the dataset to be valid. If a dataset is active and validated, it can be safely exported
to external systems or to be used by other Java applications.

If a dataset is missing mandatory elements, it can be deactivated by setting the property 'Activated'
to 'No' from Actions > Information.

24.4 Managing dataset permissions

Dataset permissions can be accessed by selecting Actions > Permissions in the navigation pane.
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Permissions are defined using profile records. To define a new permissions profile, create a new record
in the 'Access rights by profile' table.
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See alsoProfile [p 25]

Profile

Defines the profile to which these permissions apply.

Restriction policy

If 'Yes', indicates that when the permissions defined here
are more strict than otherwise defined, these permissions
are respected. This is contrary to the default where the most
permissive rights defined take precedence.

See Resolving user-defined rules [p 286].

Dataset actions

Specifies the permissions for actions on the dataset.

Create a child dataset

Indicates whether the profile can create a child dataset.
Inheritance also must be activated in the data model.

Duplicate the dataset

Indicates whether the profile can duplicate the dataset.

Delete the dataset

Indicates whether the profile can delete the dataset.

Activate/deactivate the
dataset

Indicates whether the profile can modify the Activated
property in the dataset information. See Deactivating a
dataset [p 141].

Create a view

Indicates whether the profile can create views and
hierarchies in the dataset.

Tables policy

Specifies the default permissions for all tables. Specific
permissions can also be defined for a table by clicking the
'+' button.

Create a new record

Indicates whether the profile can create records in the table.

Overwrite inherited record

Indicates whether the profile can override inherited records
in the table. This permission is useful when using dataset
inheritance.

Occult inherited record

Indicates whether the profile can occult inherited records
in the table. This permission is useful when using dataset
inheritance.

Delete a record

Indicates whether the profile can delete records in the table.

Values access policy

Specifies the default access permissions for all the nodes
of the dataset and allows the definition of permissions for
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specific nodes. The default access permissions are used if
no custom permissions have been defined for a node.

The specific policy selector allows granting specific
access permissions for a node. The links "ReadOnly",
"ReadWrite", and "Hidden" set the corresponding access
levels for the selected nodes.

It is possible to remove custom access permissions using the
"(default)" link.

Rights on services This section specifies the access permissions for services. A
service is not accessible to a profile if it is crossed-out.
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CHAPTER 25

Dataset inheritance

Using the concept of dataset inheritance, it is possible to create child datasets that branch from a parent
dataset. Child datasets inherit values and properties by default from the parent dataset, which they can
then override if necessary. Multiple levels of inheritance can exist.

An example of using dataset inheritance is to define global default values in a parent dataset, and
create child datasets for specific geographical areas, where those default values can be overridden.

Note

By default, dataset inheritance is disabled. It must be explicitly activated in the
underlying data model.

See alsoData model configuration [p 44]

This chapter contains the following topics:

1. Dataset inheritance structure

2. Value inheritance

25.1 Dataset inheritance structure

Once the root dataset has been created, create a child dataset from it using the * button in the dataset
selector in the navigation pane.

Note

« A dataset cannot be deleted if it has child datasets. The child datasets must be deleted first.

« If a child dataset is duplicated, the newly created dataset will be inserted into the existing
dataset tree as a sibling of the duplicated dataset.

25.2 Value inheritance

When a child dataset is created, it inherits all its field values from the parent dataset. A record can
either keep the default inherited value or override it.

In tabular views, inherited values are marked in the top left corner of the cell.

The ™a button can be used to override a value.
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Record inheritance

A table in a child dataset inherits the records from the tables of its ancestor datasets. The table in the
child dataset can add, modify, or delete records. Several states are defined to differentiate between
types of records.

Root A root record is a record that was created in the current
dataset and does not exist in the parent dataset. A root record
is inherited by the child datasets of the current dataset.

Inherited An inherited record is one that is defined in an ancestor
dataset of the current dataset.

Overwritten An overwritten record is an inherited record whose values
have been modified in the current dataset. The overwritten
values are inherited by the child datasets of the current
dataset.

Occulted An occulted record is an inherited record which has been
deleted in the current dataset. It will still appear in the
current dataset as a record that is crossed out, but it will not
be inherited in the child datasets of the current dataset.

When the inheritance button % is toggled on, it indicates that the record or value is inherited from the
parent dataset. This button can be toggled off to override the record or value. For an occulted record,
toggle the button on to revert it to inheriting.
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The following table summarizes the behavior of records when creating, modifying or deleting a record,

depending on its initial state.

State

Create

Modify value

Delete

Root

Standard new record creation.
The newly created record will
be inherited in child datasets
of the current dataset.

Standard modification of an
existing record. The modified
values will be inherited in the
child datasets of the current
dataset.

Standard record deletion. The
record will no longer appear
in the current dataset and the
child datasets of the current
dataset.

Inherited

If a record is created using
the same primary key as an
existing inherited record, that
record will be overwritten
and its value will be the one
submitted at creation.

An inherited record must first
be marked as overwritten in
order to modify its values.

Deleting an inherited record
changes it state to occulted.

Overwritten

Not applicable. Cannot create
a new record if the primary
key is already used in the
current dataset.

An overridden record can be
returned to the inherited state,
but its modified value will be
lost.

Individual values in an
overridden record can be
set to inheriting or can be
modified.

Deleting an overwritten
record changes its state to
occulted.

Occulted

If a record is created using
the primary key of an existing
occulted record, the record
state will be changed to
overwritten and its value
modified according to the one
submitted at creation.

Not applicable. An occulted
record cannot be modified.

Not applicable. An occulted
record is already considered
to be deleted.

See alsoRecord lookup mechanism [p 272]

TIBCO EBX® Product Documentation 6.0.5

147



Documentation > User Guide > Datasets > Dataset inheritance

TIBCO EBX® Product Documentation 6.0.5 148



Documentation > User Guide

Workflow models

TIBCO EBX® Product Documentation 6.0.5 149



Documentation > User Guide > Workflow models > Introduction to workflow models

CHAPTER 206

Introduction to workflow models

This chapter contains the following topics:
1. Overview

2. Using the Workflow Models area user interface

3. Generic message templates

4. Limitations of workflows

26.1 Overview

What is a workflow model?

Workflows in TIBCO EBX facilitate the collaborative management of data in the repository. A
workflow can include human actions on data and automated tasks alike, while supporting notifications
on certain events.

The first step of realizing a workflow is to create a workflow model that defines the progression of
steps, responsibilities of users, as well as other behavior related to the workflow.

Once a workflow model has been defined, it can be validated and published as a workflow publication.
Data workflows can then be launched from the workflow publication to execute the steps defined in
the workflow model.

See also

Workflow model (glossary) [p 31]

Data workflow (glossary) [p 33]

Basic concepts related to workflow models

A basic understanding of the following terms is necessary to proceed with the creation of workflow
models:

o script task [p 32]
o user task [p32]
o work item [p 33]

« workflow condition [p 32]

« sub-workflow invocation [p 32]
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o wait task [p 32]

« data context [p 32]

26.2 Using the Workflow Models area user interface

Workflow models i Workflow modeling ?

. Actions menu |

New product process ~

. Workflow model selector |
Actions - m . ’

= Workflow modeling

I Workflow model configuration

Waorkflow model steps

Workspace

Navigation pane

Note

This area is available only to authorized users in the 'Advanced perspective'. Only
authorized users can access these interfaces.

26.3 Generic message templates

Notification emails can be sent to inform users of specific events during the execution of data
workflows.

Generic templates can be defined and reused by any workflow model in the repository. To work with
generic templates, select 'Message templates' from the Workflow Models area Actions menu.

These templates, which are shared by all workflow models, are included statically at workflow model
publication. Thus, in order to take template changes into account, you must update your existing
publication by re-publishing the affected models.

Please note that, if you want to export those templates in an archive, you will have to select the dataset
"configuration" as it is the one containing the message templates.

When creating a new template, two fields are required:
+ Label & Description: Specifies the localized labels and descriptions associated with the template.

« Message: Specifies the localized subjects and bodies of the message.
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The message template can include data context variables, such as ${variable.name}, which are
replaced when notifications are sent. System variables that can be used include:
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system.time

System time of the repository.

system.date

System date of the repository.

workflow.lastComment

Last comment on the previous user task. (Note:
this variable refers to the last user task, not the
current one. Also the current task is the one on
which the workflow is positioned, and it also
includes the completion notification of a user
task).

workflow.lastDecision

Last decisions made on the previous user task.
(Note: this variable refers to the last user task,
not the current one. Also the current task is the
one on which the workflow is positioned, and
it also includes the completion notification of a
user task).

user.fullName

Full name of the notified user.

user.login

Login of the notified user.

workflow.process.label

Label of the current workflow.

workflow.process.description

Description of the current workflow.

workflow.workItem.label

Label of the current work item.

workflow.workItem.description

Description of the current work item.

workflow.workItem.offeredTo

Role to which the current work item has been
offered.

workflow.workItem.allocatedTo

User to whom the current work item has been
allocated.

workflow.workItem.link

Link to access the current work item in the work
item inbox, using the Web Component API.

This link can only be computed if a current
work item is defined and if the URL is
configured in Workflow-executions, in the
email configuration.
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workflow.workItem.link.allocateAndStart Link to access the current work item in the work
item inbox, using the Web Component API. If
the target work item has not yet been started, it
will be automatically allocated to and started by
the user clicking the link.

This link can only be computed if a current
work item is defined and if the URL is
configured in Workflow-executions, in the
email configuration.

workflow.currentStep.label Label of the current step.
workflow.currentStep.description Description of the current step.
Example

Generic template message:

Today at ${system.time}, a new work item was offered to you

Resulting email:

Today at 15:19, a new work item was offered to you

26.4 Limitations of workflows

The following functionality is currently unsupported in EBX:
+ Scheduled tasks, task executed as soon as its turn comes, and whose execution cannot be delayed.

« Event tasks, allowing the workflow to move forward upon receiving an event, such as a web
service call.

« Time limitation on a task duration.

« User profile names can be up to 64 characters, otherwise compatibility is not guaranteed.

Related conceptsData workflows [p 180]
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CHAPTER 27

Creating and implementing a
workflow model

This chapter contains the following topics:

1. Creating a workflow model

Implementing the steps

User tasks
Script tasks
Conditions

Sub-workflow invocations

Wait tasks

©® N ek~ N

Editing the workflow diagram

27.1 Creating a workflow model

A new workflow model can be created in the Workflow Models area. The only required information
at creation is a name that is unique in the repository.

The steps of the workflow model are initialized with a single transition. In order to fully implement
the workflow model, you must define the sequence of steps beyond this initial transition.

27.2 Implementing the steps

A workflow model defines steps that correspond to different operations that must be performed on
data, and associated conditions. The following types of steps exist:

« User task

« Script task

« Condition

» Sub-workflow invocation
«  Wait task

A data context is linked to each data workflow. This data context can be used to define variables that
can be used as input and output variables in the steps of the workflow.
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Progress strategy of the next step

For each step type (excluding user task with multiple work items), a property is available to define
which progress strategy has to be applied for the next step. Upon step completion, this strategy is
evaluated in order to define the navigation when the workflow is executed. By default, the progress
strategy is set to 'Display the work items table'. In that case, after the step has been executed, the work
items table (work items inbox or monitoring > work items) is automatically displayed, in order to
select the following work item.

Another strategy can be selected: 'Automatically open the next step'. This strategy allows the user to
keep working on this workflow and to directly execute the next step. If, following to this execution, a
work item is reached and the connected user can start it, then the work item is automatically opened (if
several work items are reached, the first created is opened). Otherwise, the next step progress strategy
is evaluated. If no work item has been reached, the work items table will be displayed.

This strategy is used to execute several steps in a row without going back to the work items inbox.

There are some limitations that will lead to disregard this strategy. In that case, the work items table is
automatically displayed. This property will be disregarded when: the current step is a user task with
more than one work item.

In the case of conditions, two other strategies are available: 'If true, automatically open the next step'
and 'If false, automatically open the next step'. These strategies allow choosing which strategy will
be applied according to the condition result.

In the case of sub-workflows invocation, a dedicated property « Foreground sub-workflow » is
available to precise the progress strategy. For the previous progress strategy « Open directly the next
step », a foreground sub-workflow must be selected. Only the steps and associated progress strategy
included in this foreground sub-workflow will be evaluated. Please note the following specific rules
about the foreground sub-workflow property :

« If only one sub-workflow is launched, it is automatically considered in the foreground,

« The foreground sub-workflow property will be ignored if the previous step has not selected the
progress strategy « Automatically open the next step »,

+ When all the sub-workflow are completed, and if the last completed sub-workflow is the
foreground one, then the progress strategy defined on the sub-workflow invocation step is
evaluated: if the progress strategy is « automatically open the next step », the next step can be
opened without displaying the inbox. In all cases, the progress strategy of the last step of the sub-
workflow is always ignored.

Hidden in progress view

For each step type, a property is available to define which steps must be hidden in the workflow
progress view by default.

If this property is enabled, the step will be automatically hidden in the workflow progress view for
non-administrator users (neither built-in administrator nor workflow administrator). Hidden steps can
be displayed on demand.

27.3 User tasks

User tasks are steps that involve actions to be performed by human users. Their labels and descriptions
can be localized.
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Mode

For backward compatibility reasons, two user task modes are available: the default mode and the
legacy mode.

By default, a user task generates a single work item. This mode offers more features, such as offering
a work item to a list of profiles or directly displaying the avatars in the workflow progress view.

In the legacy mode, a user task can generate several work items.

By default, the user task creation service is hidden in legacy mode. To display it, a property should
be enabled in the ebx.properties file. For more information, see Disabling user task legacy mode
[p 3681.

List of profiles

The definition of the profiles of a user task may vary depending on the user task mode.

[Default] Offered to the following profiles

The defined profiles are the roles or the users to whom the user task is being offered. When executing
the user task, a single work item is generated. If a single user is defined, the work item is automatically
assigned to this user. If a role is defined, the work item is offered to the members of the role. If several
users and roles are defined, the work item is offered simultaneously to these users and to the members
of these roles.

[Legacy mode] Participants

The participants are the roles or the users to whom the user task is intended. By default, when executing
the user task, a work item is generated by profile. If a profile refers to a user instead of a role, the work
item is directly allocated to that user. If a profile is a role, the work item is offered to the members
of the role.

For more information

See alsoExtension [p 159]

Service
TIBCO EBX includes the following built-in services:
» Access a dataspace
+ Access data (default service)
» Access the dataspace merge view
« Compare contents
» Create a new record
» Duplicate a record.
« Export data to a CSV file
« Export data to an XML file
+ Import data from a CSV file
+ Import data from an XML file
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+ Merge a dataspace

+ Validate a dataspace, a snapshot or a dataset

See alsoEBX built-in services [p 219]

Configuration

Main options > Enable reject
By default, only the accept action is offered to the user when saving a decision.

It is possible to also allow users to reject the work item by setting this field to 'Yes'.

Main options > Enable confirmation request

By default, a confirmation request is displayed after user task execution when the user saves the
decision by clicking the 'Accept' or 'Reject' button.

To disable this confirmation prompt, set this field to 'Yes'.

Main options > Enable comments

By default, comments are enabled. When a work item is open, a 'Comments' button is displayed and
allows the user to enter a comment.

It is possible to hide this 'Comments' button by setting this property to No.

Main options > Comments required
By default, it is optional to submit a comment associated with a work item.

It is possible to require the user to enter a comment before saving the decision by setting this field to
the desired validation criteria. Comments can be set to be always required, required only if the work
item has been accepted, or required only if the work item has been rejected.

Main options > Customized labels

When the user task is run, the user can accept or reject the work item by clicking the corresponding
button. In the workflow model, it is possible for a user task to define a customized label and
confirmation message for these two buttons. This can be used to adapt the buttons to a more specific
context.

[Legacy mode] Termination > Task termination criteria

A single user task could be assigned to multiple participants and thus generate multiple work items
during workflow execution. When defining a user task in the workflow model, you can select one of
the predefined methods for determining whether the user task is finished, based on the statuses of its
component work items. When the user task's exit requirement has been satisfied, the data workflow
will move on to the next step defined in its model.

For example, for the case of a user task where a product record needs to be approved, you could
designate three potential participants. The task termination criteria can specify whether the product
record needs to be approved by all three users, or only the first user to respond.
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The default user task termination criteria is "When all work items have been accepted.'

Note

If you  specify a  service extension overriding the  method
UserTask.handleworkItemCompletion to handle the determination of the user task's
completion, it is up to the developer of the extension to verify from within their code
that the task termination criteria defined through the user interface has been met. See
UserTask.handleworkItemCompletion™ in the JavaDoc for more information

[Legacy mode] Termination > Reject tolerance

By default, if a user rejects a work item during workflow execution, the user task is placed into an
error state and the workflow progress is halted. When the user task is in an error state, a workflow
administrator must intervene by replaying the step where the error occurred in order to continue the
workflow execution.

In order to change this default behavior, it is possible to define a certain number of work item
rejections to tolerate. While within the limit of tolerated rejections, no error will occur and it is the
task termination criteria that determines when to end the user task.

The following task termination criteria automatically tolerate all rejections:
« 'When all work items have been either accepted or rejected'

«+ 'Either when all work items have been accepted, or as soon as one work item has been rejected'

Extension

A custom class can be specified in order for the task to behave dynamically in the context of a given
data workflow. For example, this can be used to create work items or complete user tasks differently
than the default behavior.

APT

The specified rule is a JavaBean that must extend the UserTask™ class.

Attention

If a rule is specified and the handleworkItemCompletion method is overridden, the completion
strategy is no longer automatically checked. The developer must check for completion within this
method.

Notification

A notification email can be sent to users when specific events occur. For each event, you can specify
a content template.

It is possible to define a monitor profile that will receive all emails that are sent in relation to the
user task.

See alsoGeneric message templates [p 151]

Reminder

Reminder emails for outstanding offered or allocated work items can be periodically sent to the
concerned users. The recipients of the reminder are the users to whom the work item is offered or
allocated, as well as the recipients on copy.

TIBCO EBX® Product Documentation 6.0.5 159



Documentation > User Guide > Workflow models > Creating and implementing a workflow model

The content of the reminder emails is determined by the current state of the work item. That is, if the
work item is offered, the notification will use the "Offered work items" template; if the work item is
allocated, the notification will use the "Allocated work items" template.

Deadline

Each user task can have a completion deadline. If this date passes and associated works items are not
completed, a notification email is sent to the concerned users. This same notification email will then
be sent daily until the task is completed.

There are two deadline types:
o Absolute deadline: A calendar date.

» Relative deadline: A duration in hours, days or months. The duration is evaluated based on the
reference date, which is the beginning of the user task or the beginning of the workflow.

27.4 Script tasks

Script tasks are automatic tasks that are performed without human user involvement.

Two types of script tasks exist, which, once defined, can be used in workflow model steps:

Library script task EBX includes a number of built-in library script tasks,
which can be used as-is.

Any additional library script tasks must be declared in a
module.xml file. A library script task must define its label,
description and parameters. When a user selects a library
script task for a step in a workflow model, its associated
parameters are displayed dynamically.

Specific script task Specifies a Java class that performs custom actions. The
associated class must belong to the same module as
the workflow model. Its labels and descriptions are not
displayed dynamically to users in workflow models.

Packaging TIBCO EBX modules [p 497]

Library script tasks
EBX includes the following built-in library script tasks:
+ Create a dataspace
+ Create a snapshot
» Merge a dataspace
« Import an archive
« Close a dataspace
» Set a data context variable
» Send an email

« Delete records (Note: this script can remove several records)
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APT

Library script tasks are classes that extend the class ScriptTaskBean™. Besides the built-in library
script tasks, additional library script tasks can be defined for use in workflow models. Their labels
and descriptions can be localized.

API

The method ScriptTaskBean.executeScript™ is called when the data workflow reaches the

corresponding step.

Attention

The method scriptTaskBean.executeScript” must not create any threads because the data
workflow moves on as soon as the method is executed. Each operation in this method must therefore
be synchronous.

See the example [p 630].

It is possible to dynamically set variables of the library script task if its implementation follows the
Java Bean specification. Variables must be declared as parameters of the bean of the library script task
in module.xml. The workflow data context is not accessible from a Java bean.

Note

Some built-in library script tasks are marked as "deprecated" because they are not
compatible with internationalization. It is recommended to use the new script tasks that
are compatible with internationalization.

Specific script tasks

Specific script tasks are classes that extend the class Sample of ScriptTask [p 630].

The method ScriptTask.executeScript™ is called when the data workflow reaches the corresponding
step.

Attention

The method ScriptTask.executeScript™ must not create any threads because the data workflow
moves on as soon as the method is executed. Each operation in this method must therefore be
synchronous.

See the example [p 630].

It is not possible to dynamically set the variables of the bean for specific script tasks. However, the
workflow data context is accessible from the Java bean.

27.5 Conditions

Conditions are decision steps in workflows.
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Two types of conditions exist, which, once defined, can be used in workflow model steps:

Library condition EBX includes a number of built-in library conditions, which
can be used as-is.

Any additional library script tasks must be declared in a
module.xml file. A library condition must define its label,
description and parameters. When a user selects a library
condition for a step in a workflow model, its associated
parameters are displayed dynamically.

Specific condition Specifies a Java class that implements a custom condition.
The associated class must belong to the same module as
the workflow model. Its labels and descriptions are not
displayed dynamically to users in workflow models.

Packaging TIBCO EBX modules [p 497]

Library conditions
EBX includes the following built-in library conditions:
» Dataspace modified?
» Data valid?
« Last user task accepted?
« Value null or empty?
« Values equals?

Library conditions are classes that extend the class ConditionBean®. Besides the built-in library
conditions, additional library conditions can be defined for use in workflow models. Their labels and
descriptions can be localized.

See the example [p 633].

It is possible to dynamically set variables of the library condition if its implementation follows the
Java Bean specification. Variables must be declared as parameters of the bean of the library condition
in module.xml. The workflow data context is not accessible from a Java bean.

Specific conditions
Specific conditions are classes that extend the class condition™.
See the example [p 632].

It is not possible to dynamically set the variables of the bean for specific conditions. However, the
workflow data context is accessible from the Java bean.

27.6 Sub-workflow invocations

Sub-workflow invocation steps in workflow models put the current workflow into a waiting state and
invoke one or more workflows.

It is possible to include another workflow model definition in the current workflow by invoking it
alone in a sub-workflow invocation step.
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If multiple sub-workflows are invoked by a single step, they are run concurrently, in parallel. All sub-
workflows must be terminated before the original workflow continues onto the next step. The label
and description of each sub-workflow can be localized.

The property « Foreground sub-workflow » is useful to precise the progress strategy when several
sub-workflows are launched. If the previous step progress strategy is « directly open the next step
», this property defines which sub-workflow should be considered in the foreground (only one sub-
workflow can hold this behavior). Only the work items which have been generated in this foreground
sub-workflow will be able to be opened automatically without passing by the inbox. If only one sub-
workflow is defined, this property is ignored (the single sub-workflow is automatically considered in
the foreground). For further information, refer to the progress strategy:Progress strategy of the next
step [p 156]

Two types of sub-workflow invocations exist:

Static Defines one or more sub-workflows to be invoked each
time the step is reached in a data workflow. For each
sub-workflow, it is possible to set its localized labels
and descriptions, as well as the input and output variable
mappings in its data context.

This mode is useful when the sub-workflows to be launched
and the output mappings are predetermined.

Dynamic Specifies a Java class that implements a custom sub-
workflow invocation. All workflows that could be
potentially invoked as sub-workflows by the code must be
declared as dependencies.

The workflow data context is directly accessible from the
Java bean.

Dynamic sub-workflow invocations must be declared in a
module.xml file.

This mode is useful when the launch of sub-workflows is
conditional (for example, if it depends on a data context
variable), or when the output mapping depends on the
execution of the sub-workflows.

27.7 Wait tasks

Wait task steps in workflow models put the current workflow into a waiting state until a specific event
is received.

When a wait task is reached, the workflow engine generates a unique resume identifier associated
with the wait task. This identifier will be required to resume the wait task, and as a consequence the
associated workflow.

A wait task specifies which profile is authorized to resume the wait task; and a Java class that

T

implements a wait task bean: waitTaskBean™.
The workflow data context is directly accessible from the Java bean.

Wait task beans must be declared in a module.xml file.
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First, the wait task bean is called when the workflow starts waiting. At this time, the generated resume
identifier is available to call a web service for example. Then, the wait task bean is called when the wait
task is resumed. In this way, the data context may be updated according to the received parameters.

Note

The built-in administrator always has the right to resume a workflow.

27.8 Editing the workflow diagram

About
A workflow model is displayed in a BPMN-like editable diagram.

This view provides full editing capabilities and can help modelers have a clear view of the workflow
model they are designing.

Please also note that, although the diagram is derived from BPMN standards, it is not a strict
representation of BPMN since EBX workflow concepts are slightly different.

Saving the layout

It is possible to save the modified layout. Please note that this is not a user-based save: it will be
shared by all the users.

Actions
Export as PNG Creates a PNG image.
Export as SVG Creates an SVG image.
Export as PDF Creates a PDF document from the workflow model. Several

properties are available to custom your export. You can
configure the orientation of the pdf pages (Landscape or
Portrait), the size (A3, Letter, etc ...). There is also two
properties that might provide more details to your model:

o Display identifiers (default value is true): Same
behavior with "Show steps identifiers" in the workflow
diagram toolbar but restricted to the pdf export. It will
show the step identifiers for each step.

+ Add index (default value is true): At the end of the pdf,
an index recording all the steps of the diagram will be
added. It might be useful in the case where several steps
title are too long to be fully displayed.

For this property, we recommend showing the steps
identifiers as it will help in recognizing which index line
corespond to which step.
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View

Layout > Default layout

Applies the default layout to the diagram.

Display > Show/Hide grid

Shows the grid if the grid is not visible, hides it otherwise.

Display > Zoom In

A zoom in is executed on the diagram. To go faster you can
use "Ctrl, Up mouse wheel" with the mouse pointing the
diagram boundary.

Display > Zoom Out

A zoom out is executed on the diagram. To go faster you
can use "Ctrl, Down mouse wheel" with the mouse pointing
the diagram boundary.

Display > Show/Hide steps
identifiers

Show/hide a badge displaying the identifier of a workflow
step.

Plan view > Hierarchy

Shows the hierarchical view of a given workflow model if
enabled.

Buttons

Save layout

Saves the current layout.

Save layout and close

Saves the current layout and closes the service.

Revert

Reverts changes and reloads a previously saved layout.

Close

Closes the service.
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Edit

Create

Hovering over a link or selecting it, makes '+' appear. It is
used to create a new step.

Delete

DEL

Pressing 'DEL' key will remove the selected node.

Please note that this action cannot be undone.

Node toolbar

Hovering on a node or directly selecting it makes a toolbar
appear. It is used to either:

Edit a step.

Remove a step.

Duplicate a step.

Relink to an existing step.

Show or hide in progress view.

Edit a node

Double click on a node in order to quick edit a step.
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Features

The diagram view offers useful additional features

Undo last action CTRL + Z
Please note that it cannot be done after the following actions:
« Create/Remove/Edit/Duplicate a step
« Relink
« Show/Hide in progress view

« Revert

Zoom in/Zoom out. Mouse middle button then mouse wheel / CTRL then mouse
wheel. Also see View [p 165]

Multiple selection Click on the nodes or links selected holding down the CTRL
button / Draw a selection rectangle (you will need to hold
down the left click for 1 second before drawing the area).

Customizing links drawing When clicking on a link, you can either move the segments
by dragging the squares which appear on the corners, or
separate a specific segment by moving the circle in the

middle.
Edit a step Double clicking on a step will display an edition form.
Overview A panel is now available with a miniature workflow diagram

view which can be used to navigate within it. This panel
can be collapsed, expanded and dragged inside the area
allocated for the workflow diagram view.
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CHAPTER 28

Configuring the workflow model

This chapter contains the following topics:

1.

N ok DN

Information associated with a workflow model

Workflow model properties

Data context

Custom workflow execution views

Permissions on associated data workflows

Workflow model snapshots

Deleting a workflow model

28.1 Information associated with a workflow model

To view and edit the owner and documentation of your workflow model, select 'Information’ from the
workflow model 'Actions' [p 1511 menu for your workflow model in the navigation pane.

Owner Specifies the workflow model owner, who will have the

rights to edit the workflow model's information and define
its permissions.

Localized documentation Localized labels and descriptions for the workflow model.

Activated This property is deprecated. Whether the workflow model

is activated. A workflow model must be activated in order
to be able to be published.
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28.2 Workflow model properties

Configuration for a workflow model is accessible in the navigation pane under "Workflow model
configuration'.

Module name Module containing specific Java resources (user task
extensions, specific scripts and conditions).

Notification of start The list of profiles to which to send notifications, based on
a template, when a data workflow is launched.

See Generic message templates [p 151].

Notification of completion The list of profiles to which to send notifications, based
on a template, when a data workflow is completed.
The notification is only sent if the workflow has been
completed under normal circumstances, that is, not due to
an administration action.

See Generic message templates [p 151].

Notification of error The list of profiles that will receive notifications, based on
a template, when a data workflow is in error state.

See Generic message templates [p 151].

Priority By default, each workflow associated with this model will
be launched with this priority. Setting a priority is optional.
If no priority is defined here, and a default priority is set for
the repository, the repository default priority will be used
for any associated workflow with no priority assigned. See
Work item priorities [p 191] for more information.

Note: Only users who are defined as workflow
administrators will be able to manually modify the priority
level of any associated data workflows.

Activate quick launch By default, when a workflow is launched, the user is
prompted to enter a documentation for the new workflow
in an intermediate form. This documentation is optional.
Setting the 'Activate quick launch' property to 'Yes' allows
skipping this documentation step and proceeding directly to
the workflow launch.

Automatically open the first step Allows determining the navigation after a workflow is
launched. By default, once a workflow is launched,
the current table (workflow launchers or monitoring >
publications) is automatically displayed.
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Enabling this property will allow the workflow user to
keep working on the launched workflow. If, after the first
workflow step is executed, a work item is reached, and this
work item can be started by the workflow creator, then the
work item is automatically opened (if several work items
are reached, the first created is opened). This will save the
user from selecting the corresponding work item from the
work items inbox.

If no work item has been reached, the next step progress
strategy is evaluated.

If no work item has been opened, the table from which the
workflow has been launched is displayed.

Limitation: This property will be ignored if the first step is
a sub-workflow invocation.

Workflow trigger Component that intercepts the main events of a workflow.

This bean must be declared in a module.xml file. See the
example [p 636].

Permissions Permissions on actions related to the data workflows
associated with the workflow model.

This bean must be declared in a module.xml file. See the
example [p 635].

Programmatic action Defines a custom component that handles the permissions
permissions of the workflow. If set, this overrides all permissions defined
in the property 'Permissions'.

28.3 Data context

The data context configuration can be accessed from the navigation pane.

Each workflow has its own data context, thus allowing to have its own local dataspace during its
execution. This gives the possibility to store and to vary values that will direct the workflow execution.
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The data context is defined by a list of variables. Each variable has the following properties:

Name Identifier of the variable.

Default value If defined, the variable will be initialized with this default
value.

Input parameter "Yes' must be checked in order to define this variable as an

input parameter.

Output parameter "Yes' must be checked in order to define this variable as an
output parameter. Else, this variable will not be displayed in
the list of output parameters, in the task definition interface.

28.4 Custom workflow execution views

The workflow execution views customization can be accessed from the navigation pane.

The customization allows configuring the specific columns of the work items and workflow views
(inbox, work items monitoring, active workflows monitoring and completed workflows). For each
specific column, it is possible to associate an expression that can contain data context variables that
will be evaluated upon display of the workflow.
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28.5 Permissions on associated data workflows

Workflow administration Defines the profile that is allowed to perform administration
actions on the workflows. The administration actions
include the following: replay a step, resume a
workflow, terminate a workflow, disable a publication
and unpublish. In order to perform these actions, this
profile is automatically granted the "Visualize workflows"
permission. The built-in administrator always has the
workflow administration rights.

Workflow administration > Defines the profile that is allowed to replay a workflow step.

Replay a step In order to perform this action, this profile is automatically
granted the "Visualize workflows" permission. A button in
the "Monitoring > Active workflows" section is available to
replay a step. A profile with the "Workflow administration"
permission is automatically allowed to perform this specific
action. The built-in administrator always has the rights to
replay a step.

Workflow administration > Defines the profile that is allowed to terminate and
Terminate workflow clean a workflow. In order to perform this action, this
profile is automatically granted the "Visualize workflows"
permission. A button in the "Monitoring > Active
workflows" section is available to terminate and clean an
active workflow. A button in the "Completed workflows"
section is available to delete a completed workflow. A
profile with the "Workflow administration" permission is
automatically allowed to perform this specific action. The
built-in administrator always has the rights to terminate a

workflow.
Workflow administration > Defines the profile that is allowed to force resuming a
Force a workflow to resume waiting workflow. In order to perform this action, this

profile is automatically granted the "Visualize workflows"
permission. A button in the "Monitoring > Active
workflows" section is available to resume a workflow. A
profile with the "Workflow administration" permission is
automatically allowed to perform this specific action. The
built-in administrator always has the right to resume a

workflow.
Workflow administration > Defines the profile that is allowed to disable a workflow
Disable a publication publication. In order to perform this action, this profile

is automatically granted the "Visualize workflows"
permission. A button in the "Monitoring > Publications"
section is available to disable a publication. It is only
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displayed on active publications. A profile with the
"Workflow administration” permission is automatically
allowed to perform this specific action. The built-in
administrator always has the rights to disable a publication.

Workflow administration > Defines the profile that is allowed to unpublish a

Unpublish workflow publication. In order to perform this action, this
profile is automatically granted the "Visualize workflows"
permission. A button in the "Monitoring > Publications"
section is available to unpublish disabled publications only.
A profile with the "Workflow administration" permission is
automatically allowed to perform this specific action. The
built-in administrator always has the unpublish rights.

Allocation management Defines the profile that is allowed to manage work items
allocation. The allocation actions include the following:
allocate work items, reallocate work items and deallocate
work items. In order to perform these actions, this
profile is automatically granted the "Visualize workflows"
permission. The built-in administrator always has the
allocation management rights.

Allocation management > Defines the profile that is allowed to allocate work items. In

Allocate work items order to perform these actions, this profile is automatically
granted the "Visualize workflows" permission. A button
in the "Monitoring > Work items" section is available
to allocate a work item. It is only displayed on offered
work items. A profile with the "Allocation management"
permission is automatically allowed to perform this specific
action. The built-in administrator always has the work items
allocation rights.

Allocation management > Defines the profile that is allowed to reallocate work items.

Reallocate work items In order to perform this action, this profile is automatically
granted the "Visualize workflows" permission. A button
in the "Monitoring > Work items" section is available to
reallocate a work item. It is only displayed on allocated
work items. A profile with the "Allocation management"
permission is automatically allowed to perform this specific
action. The built-in administrator always has the work items
reallocation rights.

Allocation management > Defines the profile that is allowed to deallocate work items.
Deallocate work items In order to perform this action, this profile is automatically
granted the "Visualize workflows" permission. A button
in the "Monitoring > Work items" section is available to
deallocate a work item. It is only displayed on allocated
work items. A profile with the "Allocation management"
permission is automatically allowed to perform this specific

TIBCO EBX® Product Documentation 6.0.5 174



Documentation > User Guide > Workflow models > Configuring the workflow model

action. The built-in administrator always has the work items
deallocation rights.

Launch workflows Defines the profile that is allowed to manually launch new
workflows. This permission allows launching workflows
from the active publications of the "Workflow launchers"
section. The built-in administrator always has the launch
workflows rights.

Visualize workflows Defines the profile that is allowed to visualize workflows.
By default, the end-user can only see work items that
have been offered or allocated to him in the "Inbox"
section. This permission also allows visualizing the
publications, workflows and work items associated with
this workflow model in the "Monitoring" and "Completed
workflows" sections. This profile is automatically granted
the "Visualize completed workflows" permission. The built-
in administrator always has the visualize workflows rights.

Visualize workflows > The If enabled, the workflow creator has the permission to

workflow creator can visualize it view the workflows he has launched. This restricted
permission grants access to the workflows he launched and
to the associated work items in the "Monitoring > Active
workflows", "Monitoring > Work items" and "Completed
workflows" sections. The default value is 'No'.

Visualize workflows > Visualize = Defines the profile that is allowed to visualize completed

completed workflows workflows. This permission allows visualizing completed
workflows in the "Completed workflows" section and
accessing their history. A profile with the "Visualize
workflows" permission is automatically allowed to perform
this action. The built-in administrator always has the
visualize completed workflows rights.

Note

A user who has no specific privileges assigned can only see work items associated with
this workflow that are offered or allocated to that user.

See alsoWorkflow administration [p 195]

28.6 Workflow model snhapshots

The history of workflow model snapshots can be managed from Actions > View publications history.

The history table displays all snapshots which contain the selected workflow model and indicates if
a workflow model is published. For each snapshot, the Actions button allows you to export or view
the corresponding workflow model.
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28.7 Deleting a workflow model

Workflow model can be deleted, however any associated publications remain accessible in the Data
Workflows area. If a new workflow model is created with the same name as a deleted workflow model,
publishing will prompt to replace the old publication.

See alsoPublishing workflow models [p 177]
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CHAPTER 29

Publishing workflow models

This chapter contains the following topics:

1. About workflow publications

2. Publishing and workflow model snapshots

3. Sub-workflows in publications

29.1 About workflow publications

Once a workflow model is defined, it must be published in order to enable authorized users to launch
associated data workflows. This is done by clicking the Publish button in the navigation pane.

If no sub-workflow invocation steps are included in the current workflow model, you have the option
of publishing other workflow models at the same time on the publication page. If the current workflow
model contains sub-workflow invocation steps, it must be published alone.

Workflow models can be published several times. A publication is identified by its publication name

29.2 Publishing and workflow model snapshots

When publishing a workflow model, a snapshot is taken of its current state. A label and a description
can be specified for the snapshot to be created. The default snapshot label is the date and time of the
publication. The default description indicates the user who published the workflow model.

For each workflow model being published, the specified publication name must be unique. If a
workflow model has already been published, it is possible to update an existing publication by reusing
the same publication name. The names of existing workflow publications associated with a given
workflow model are available in a drop-down menu. In the case of a publication update, the old version
is no longer available for launching data workflows, however it will be used to terminate existing
workflows. The content of different versions can be viewed in the workflow model snapshot history.

See alsoWorkflow model snapshots [p 175]

29.3 Sub-workflows in publications

When publishing a workflow model containing sub-workflow invocation steps, it is not necessary to
separately publish the models of the sub-workflows. From an administration standpoint, the model
of the main workflow (the one currently published by a user) and the models of the sub-workflows
are published as a single entity.
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The system computes the dependencies to workflow models used as sub-workflows, and automatically
creates one publication for each dependent model. These technical publications are dedicated to the
workflow engine to launch sub-workflows, and are not available in the Workflow Data area.

The multiple publication is not available for a workflow model containing sub-workflow invocation
steps. This is why the first step of the publication (selection of workflow models to publish) is not
offered in this case.

Republishing the main workflow model automatically updates the invoked sub-workflow models.

Although a sub-workflow model can be published separately as a main workflow model, this will not
update the version used by an already published main workflow model using this sub-workflow.
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CHAPTER 30

Introduction to data workflows

This chapter contains the following topics:

1. Overview

30.1 Overview

A data workflow is an executed step-by-step data management process, defined using a workflow
model publication. It allows users, as well as automated procedures, to perform actions collaboratively
on a set of data. Once a workflow model has been developed and published, the resulting publication
can be used to launch a data workflow to execute the defined steps.

Depending on the workflow user permissions defined by the workflow model, a user may perform
one or more of the following actions on associated data workflows:

« As auser with default permissions, work on and complete an assigned work item.

« As a user with workflow launching permissions, create a new data workflow from a workflow
model publication.

+ As a workflow monitor, follow the progress of ongoing data workflows and consult the history
of completed data workflows.

» As a manager of work item allocation, modify work item allocations manually for other users
and roles.

« As a workflow administrator, perform various administration actions, such as replaying steps,
terminating workflows in progress, or rendering publications unavailable for launching data
workflows.

See also
Work items [p 187]

Launching and monitoring data workflows [p 193]

Administration of data workflows [p 195]

Permissions on associated data workflows [p 173]

Related conceptsWorkflow models [p 150]
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CHAPTER 31

Using the Data Workflows area user
interface

This chapter contains the following topics:

1. Navigating within the interface

Navigation rules

Custom views

Specific columns

Filtering items in views

O e

Workflow progress view
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31.1 Navigating within the interface

Data workflow functionality is located in the Data Workflows area of the TIBCO EBX user interface.

e & * /

Data workflows Inbox

g - Actions =

Woarkflow launchers
o 1-210f21 ~ T View «
» Monitoring
Publications
Active workflows
Work items

Completed workflows

Workspace

Navigation pane

Note

This area is available only to authorized users in the 'Advanced perspective' or from a
specifically configured perspective. Only authorized users can access these interfaces.
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The navigation pane is organized into several entries. These entries are displayed according to their
associated global permission. The different entries are:

Work items inbox All work items either allocated or offered to you, for which
you must perform the defined task.

Workflow launchers List of workflow model publications from which you are
allowed to launch data workflows, according to your user
permissions.

Monitoring Monitoring views on the data workflows for which you have

the necessary viewing permissions.

Publications Publications for which you have the necessary viewing
permissions. If you have additional administrative
permissions, you can also disable the ability to launch data
workflows from specific publications from this view.

Active workflows Data workflows in the process of execution for which
you have the necessary viewing permissions. If you have
additional administrative permissions, you can also perform
actions such as replaying steps of data workflows, and
terminating the execution of data workflows from this view.

Work items Work items for which you have the necessary viewing
permissions. If you have additional administrative
permissions, you can also perform actions relevant to
work item administration, such as allocating work items to
specific users or roles from this view.

Completed workflows Data workflows that have completed their execution, for
which you have the necessary viewing permissions. You can
view the history of the executions of the data workflows.
If you have additional administrative permissions, you can
also clean completed workflows from the repository from
this view.

Note

Each section can be accessed through Web Components, for example, for portal integration,
or programatically using the servicekey class in the Java API.

See also

Using TIBCO EBX as a Web Component [p 211]

Servicekey”
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31.2 Navigation rules

Work items inbox
By default, once a work item has been executed, the work items inbox is displayed.

This behavior can be modified according to the next step progress strategy, which can allow to execute
several steps in a row without going back to the work items inbox.

See the progress strategy of a workflow step [p 156] in workflow modeling.

Workflow launchers
By default, once a workflow has been launched, the workflow launchers table is displayed.

This behavior can be modified according to the model configuration, which can allow to directly open
the first step without displaying the workflow launchers table.

See the automatic opening of the first workflow step [p 170] in workflow modeling.

31.3 Custom views

It is possible to define views on workflow tables and to benefit from all associated mechanisms
(publication included).

Permissions to create and manage workflow table views are the same as the permissions for data table
views. It may thus be necessary to change the permissions in the 'Administration' section in order to
benefit from this feature, by selecting Workflow management > Workflows.

See the Views [p 121] for more information.

31.4 Specific columns

By default, specific columns are hidden in the views that can benefit from it (inbox, work items
monitoring, active workflows monitoring and completed workflows).

A custom view should be created and applied in order to display the specific columns. For each
work item or workflow, the matching defined in the associated workflow model is then applied. If an
expression is defined for a column and contains data context variables, these variables are evaluated
upon display. If the expression contains built-in expressions which depend on the locale, the expression
is evaluated in the default locale.
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31.5 Filtering items in views

In certain tables, such as the 'Work item inbox', you can narrow down the entries displayed in the
tables by viewing only the entries of a certain state. In such views, there is a menu from which you
can select a state to see its corresponding items.

Inbox

Actions -

¢ BShow all
@hOffered
B Allocated  d start

EpStarted @
1d start

31.6 Workflow progress view

Whether as a user with a work item to perform, or as a data workflow monitor or administrator, you

can view the progress or the history of a data workflow execution by clicking the 'Preview’ @l button
that appears in the 'Data workflow' column of tables throughout the data workflows user interface.
This opens a pop-up displaying an interactive progress view of the data workflow's execution. In this
view, you can see the overall progress of the execution, as well as click on an individual step to view
the details of its information.

If steps have been defined as hidden in the workflow modeling, they are automatically hidden in the
workflow progress view for non-administrator users (non built-in administrators and non workflow
administrators). A button is available to display hidden steps. The choice of users (show or hide steps)
is saved by user, by publication during the user session.

For user tasks performed using the new mode (single work item), the main information about the
single work item is directly displayed in the workflow progress view, when applicable: the avatar
of the user associated with the work item, and the decision that has been taken for the work item
(accepted or rejected).
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CHAPTER 32

Work items

This chapter contains the following topics:

1. About work items

2. Working on work items as a participant

3. Work item priorities

32.1 About work items

A work item is a unit of work that must be performed by a human user as a part of a user task.
By default, when a workflow model defines a user task, data workflows that are launched from that
model's publications will generate an individual work item for each of the participants listed in the
user task.

See alsoOverview [p 643]

Work item states

When the data workflow spawns a work item for a modelled user task during execution, the work item
passes through several possible states: offered, allocated, started, and completed.

Creation of work items

Default mode
By default, a single work item is generated regardless of the list of defined profiles.

By default, if a single user is defined in the list of profiles, the created work item is in the allocated
state.

By default, in other cases, the created work item is in the offered state.

Note

The default behavior described above can be overridden by a programmatic extension
defined in the user task. In this case, work items may be generated programmatically and
not necessarily based on the user task's list of participants.

Legacy mode

By default, for each user defined as a participant of the user task, the data workflow creates a work
item in the allocated state.
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By default, for each role defined as a participant of the user task, the data workflow creates a work
item in the offered state.

Note

The default behavior described above can be overridden by a programmatic extension
defined in the user task. In this case, work items may be generated programmatically and
not necessarily based on the user task's list of participants.

Variations of the work item states

When the work item is in the allocated state, the defined user can directly start working on the allocated
work item with the 'Take and start' action. The work item's state becomes started.

When the work item is in the offered state, any user or member of the roles to whom the work item is
offered can take the work item with the 'Take and start' action'. The work item's state becomes started.

Before a user has claimed the offered work item, a workflow allocation manager can intervene to
manually assign the work item to a single user, thus moving the work item to the allocated state. Then,
when that user begins work on the work item by performing the action 'Start work item', the work
item progresses to the started state.

Finally, after the user who started the work item has finished the assigned action, the concluding accept
or reject action moves the work item to the completed state. Once a user completes a work item, the
data workflow automatically progresses onto the next step defined in the workflow model.
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Diagram of the work item states
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32.2 Working on work items as a participant

All work items relevant to you as a user (either offered or allocated to you), appear in your work
items inbox. When you begin working on a work item, you can add an associated comment that will
be visible to other participants of the data workflow, as well as administrators and monitors of the
workflow. As long as you are still working on the work item, you can go back and edit this comment.

After you have performed all the necessary actions assigned for the work item, you must signal its
completion by clicking either the Accept or Reject button. The labels of these two buttons may differ
depending on the context of the work item.

To review the current progress of a data workflow for which you have a waiting work item in your

work item inbox, click its 'Preview’ A button in the Data workflow’ column of the table. A pop-
up will show an interactive progress view of the data workflow up until this point and the upcoming
steps. You can view the details of a step by clicking on that step.

Note

If you interrupt the current session in the middle of a started work item, for example by
closing the browser or by logging out, the current work item state is preserved. When
you return to the work item, it continues from the point where you left off.
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32.3 Work item priorities

Work items may carry a priority value, which can be useful for sorting and filtering outstanding work
items. The priority of a work item is set at the level of its data workflow, rather than being specific to
the individual work item itself. Thus, if a data workflow is considered urgent, all its associated open
work items are also considered to be urgent. By default, there are six priority levels ranging from 'Very
low' to "'Urgent', however the visual representation and naming of the available priority levels depend
on the configuration of your TIBCO EBX repository.

See alsouser task (glossary) [p 321

Related conceptsUser tasks [p 156]
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CHAPTER 33

Launching and monitoring data
workflows

This chapter contains the following topics:

1. Launching data workflows

2. Monitoring activities

3. Managing work item allocation

33.1 Launching data workflows

If a workflow model has given you the permissions to launch data workflows from its publications,
you can create new data workflows from the "Workflow launchers' entry in the navigation pane. To
create a new data workflow from a workflow model publication, click the Launch button in the entry
of the publication.

You can optionally define localized labels and descriptions for the new data workflow you are
launching.

33.2 Monitoring activities

If a workflow model's permissions have configured your user or role for workflow monitoring, you
have the ability to follow the progress of data workflows that are currently executing. You can access
your monitoring views from the 'Monitoring' section of the navigation panel. If you have additional
workflow management permissions, you can also perform the associated actions from these views.

Once the data workflows that you monitor have completed execution, they appear under 'Completed
data workflows', where you can consult their execution history.

33.3 Managing work item allocation

If a workflow model defines special allocation management permissions for you or a role that you
belong to, you have the ability to manually intervene for work item allocations during the execution
of associated data workflows. In this case, you are able to perform one or more of the actions listed
below on work items.
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Select 'Work items' in the 'Monitoring' section of the navigation pane. The actions that you are able
to perform appear in the Actions menu of the work item's entry in the table, depending on the current
state of the work item.

Allocate Allocate a work item to a specific user. This action is
available for work items in the offered state.

Deallocate Reset a work item in the allocated state to the offered state.

Reallocate Modify the user to whom a work item is allocated. This
action is available for work items in the allocated state.

See also
Work items [p 187]

Permissions on associated data workflows [p 173]

Related conceptsWorkflow models [p 150]
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CHAPTER 34

Administration of data workflows

If you have been given permissions for administration activities associated with data workflows, any
relevant publications, active data workflows, and work items, will appear under the entries of the
'Monitoring' section in the navigation panel. From these monitoring views, you can directly perform
administrative tasks from the Actions menus of the table entries.

Note

When a workflow model gives you administrative rights, you automatically have
monitoring permissions on all of the relevant aspects of data workflow execution, such
as publications, active data workflows, and work items.

This chapter contains the following topics:

1. Overview of data workflow execution

2. Data workflow administration actions

34.1 Overview of data workflow execution

When a data workflow is launched, a token that marks the step currently being executed is created
and positioned at the start of the workflow. As each step is completed, this token moves on to the next
step as defined in the workflow model on whose publication the data workflow is based.

At any given point during the execution of a data workflow, the token is positioned on one of the
following:

 a script task, which is run automatically and requires no user interaction. The script task is
completed when the defined actions finish running.

« auser task, which spawns one or more work items to be performed manually by users. Each work
item is completed by an explicit 'Accept' or 'Reject’ action from a user, and the completion of the
umbrella user task is determined according to the task termination criteria defined for the user
task in the workflow model.

« a condition, which is evaluated automatically in order to determine the next step in the execution
of the data workflow.

« a sub-workflows invocation, which launches associated sub-workflows and waits for the
termination of the launched sub-workflows.

+ await task, which pauses the workflow until a specific event is received.

The token can be in the following states:
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+ To execute: The token is the process of progressing to the next step, based on the workflow model.
» Executing: The token is positioned on a script task or a condition that is being processed.
» User: The token is positioned on a user task and is awaiting a user action.

» Waiting for sub-workflows: The token is positioned on a sub-workflow invocation and is
awaiting the termination of all launched sub-workflows.

» Waiting for event: The token is positioned on a wait task and is waiting for a specific event to
be received.

« Finished: The token has reached the end of the data workflow.

« Error: An error has occurred.

See alsoWorkflow management [p 445]

34.2 Data workflow administration actions

Actions on publications

Disabling a workflow publication

To prevent new data workflows from being launched from a given workflow publication, you can
disable it. Select the 'Publications' entry from the navigation pane, then select Actions > Disable in
the entry for the publication you want to disable.

Once disabled, the publication will no longer appear in the "Workflow launchers' view of users, but
any data workflows already launched that are in progress will continue executing.

Note

Once a publication has been disabled, it cannot be re-enabled from the Data Workflows
area. Only a user with the built-in repository 'Administrator' role can re-enable a disabled
publication from the Administration area, although manually editing technical tables
is not generally recommended, as it is important to ensure the integrity of workflow
operations.

Unpublishing a workflow publication

If a workflow publication is no longer required, you can remove it completely from the views in the
Data Workflows area by unpublishing it. To do so,

1. Disable the workflow publication to prevent users from continuing to launch new data workflows
from it, as described in Disabling a workflow publication [p 196].

2. Unpublish the workflow publication by selecting Actions > Unpublish from the workflow
publication's entry in the same table of publications.

Note

When you choose to unpublish a workflow publication, you will be prompted to confirm
the termination and cleaning of any data workflows in progress that were launched from
this workflow publication, and any associated work items. Any data that is lost as a result
of forcefully terminating a data workflow cannot be recovered.
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Actions on data workflows

From the tables of data workflows, it is possible to perform actions from the Actions menu in the
record of a given data workflow.

Replaying a step

In the event of an unexpected failure during a step, for example, an access rights issue or unavailable
resources, you can "replay" the step as a data workflow administrator. Replaying a step cleans the
associated execution environment, including any related work items and sub-workflows, and resets
the token to the beginning of the current step.

To replay the current step in a data workflow, select Actions > Replay the step from the entry of the
workflow in the 'Active workflows' table.

Terminating and cleaning an active data workflow
In order to stop and clean a data workflow that is currently in progress, select Actions > Terminate
and clean from the entry of the workflow in the 'Active workflows' table. This will stop the execution
of the data workflow and clean the data workflow and all associated work items and sub-workflows.
Note

This action is not available on workflows in the 'Executing' state, and on sub-workflows

launched from another workflow.

Note

Workflow history data is not deleted.

Forcing termination of an active data workflow
In order to stop a data workflow that is currently in progress, select Actions > Force termination
from the entry of the workflow in the 'Active workflows' table. This will stop the execution of the
data workflow and clean any associated work items and sub-workflows.
Note

This action is available for sub-workflows, and for workflows in error blocked on the

last step.

Note

Workflow history data is not deleted.

Forcing resumption of a waiting data workflow
In order to resume a data workflow that is currently waiting for an event, select Actions > Force
resumption from the entry of the workflow in the 'Active workflows' table. This will resume the data
workflow. Before doing this action, it is the responsibility of the administrator to update the data
context in order to make sure that the data workflow can execute the next steps.

Note

This action is only available for workflows in the 'waiting for event' state.
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Cleaning a completed data workflow

When a data workflow has completed its execution, its history is viewable by monitors and
administrators of that workflow in the view 'Completed workflows'. To remove the completed
workflow, you can perform a clean operation on it. To do so, select Actions > Clean from the entry
of the workflow in the 'Completed workflows' table.

When cleaned a workflow is no longer visible in the view 'Completed workflows' but its history is
still available from the technical administration area.

Note

This action is not available on sub-workflows launched from another workflow.

See alsoWorkflow management [p 445]

Modifying the priority of a data workflow

After a data workflow has been launched, an administrator of the workflow can alter its priority level.
Doing so changes the priority of all existing and future work items created by the data workflow. To
change the priority level of a data workflow, select Actions > Modify priority from the entry of the
workflow in the 'Active workflows' table.

See alsoPermissions on associated data workflows [p 173]
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CHAPTER 35

Introduction to data services

This chapter contains the following topics:
1. Overview

2. Using the Data Services area user interface

35.1 Overview

What is a data service?
A data service [p 33] is:
« a standard Web service that interacts with TIBCO EBX.

SOAP data services can be dynamically generated based on data models from the 'Data Services'
area.

« a REST service that allows interrogating the EBX repository.

The built-in RESTful service does not require a service interface, it is self-descriptive through
the returned metadata.

They can be used to access some of the features available through the user interface.

See also
WSDL/SOAP [p 676]
REST [p 730]

Lineage

Lineage [p 34] is used to establish user permission profiles for non-human users, namely data services.
When accessing data using WSDL interfaces, data services use the permission profiles established
through lineage.

Glossary

See alsoData services [p 33]
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35.2 Using the Data Services area user interface

A

(1)

B 0 U B g/

Data services Lineage ?

Data

Dataspace

Data workflow Sclcc_t a_sccurlty p_roﬁlc for w_hc-m the WSDL will be _crcated_
Permissions for this profile will be applied to the available contents and

Lineage actions.

Others
Security profile ® Mona Lisa (joconde) -

Navigation pane Workspace

Note

This area is available only to authorized users in the 'Advanced perspective'.

Related concepts

Dataspace [p 94]
Dataset [p 112]

Data workflows [p 180]

Introduction [p 676]
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CHAPTER 306

Generating data service WSDLs

This chapter contains the following topics:

1. Generating a WSDL for operations on data

Generating a WSDL for dataspace operations

Generating a WSDL for data workflow operations

Generating a WSDL for lineage

Generating a WSDL for administration
Generating a WSDL to modify the default directory

O e

36.1 Generating a WSDL for operations on data

To generate a WSDL for accessing data, select 'Data’ in the navigation panel in the Data Services
area, then follow through the steps of the wizard:

1. Choose whether the WSDL will be for operations at the dataset level or at the table level.

2. Identify the dataspace and dataset on which the operations will be run

3. Select the tables on which the operations are authorized, as well as the operations permitted.
4. Download the generated WSDL file by clicking the button Download WSDL.

Operations on datasets

The following operations can be performed using the WSDL generated for operations at the dataset
level:

+ Select dataset content for a dataspace or snapshot.
» Get dataset changes between dataspaces or snapshots

» Replication unit refresh

Operations on tables

The following operations, if selected, can be performed using the WSDL generated for operations at
the table level:

« Insert record(s)

« Select record(s)
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« Update record(s)

+ Delete record(s)

+ Count record(s)

» Get changes between dataspace or snapshot
» Get credentials

« Run multiple operations on tables in the dataset

See also

WSDL download from HTTP protocol [p 689]

Operations generated from a data model [p 695]

36.2 Generating a WSDL for dataspace operations

To generate a WSDL for dataspace-level operations, selecting 'Dataspace' in the navigation panel
of the Data Services area. The generated WSDL is generic to all dataspaces, thus no additional
information is required.

Download the generated WSDL file by clicking the button Download WSDL.

Operations on dataspaces

The following operations can be performed using the WSDL generated for operations at the dataspace
level:

« Create a dataspace

+ Close a dataspace

+ Create a snapshot

« Close a snapshot

+ Merge a dataspace

« Lock a dataspace

« Unlock a dataspace

« Validate a dataspace or a snapshot

« Validate a dataset

See also

WSDL download from HTTP protocol [p 689]

Operations on datasets and dataspaces [p 716]

36.3 Generating a WSDL for data workflow operations

To generate a WSDL to control data workflows, select 'Data workflow' from the Data Services
area. The generated WSDL is not specific to any particular workflow publication, thus no additional
information is required.

Download the generated WSDL file by clicking the button Download WSDL.
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Operations on data workflows
« Start a data workflow
« Resume a data workflow

« End a data workflow

See also

WSDL download from HTTP protocol [p 689]

Operations on data workflows [p 722]

36.4 Generating a WSDL for lineage

To generate a WSDL for lineage, select 'Lineage' from the Data Services area. It will be based
on authorized profiles that have been defined by an administrator in the 'Lineage' section of the

Administration area.

The operations available for accessing tables are the same as for WSDL for operations on data [p 2031.

Steps for generating the WSDL for lineage are as follows:

1. Select the profile whose permissions will be used. The selected user or role must be authorized

for use with lineage by an administrator.

2. Identify the dataspace and dataset on which the operations will be run

3. Select the tables on which the operations are authorized, as well as the operations permitted.

4. Download the generated WSDL file by clicking the button Download WSDL..

See alsoLineage [p 200]

36.5 Generating a WSDL for administration

This action is only available to administrators.
To generate a WSDL for:

« managing the user interface

« getting system information

select 'Administration' from the Data Services area.

Operations for administration
» Close user interface
+ Open user interface

« Get system information

See also

WSDL download from HTTP protocol [p 689]

User interface operations [p 726]

System information operation [p 726]
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36.6 Generating a WSDL to modify the default directory

This action is only available to administrators, and only if using the default directory.

To generate a WSDL to update the default directory, select 'Directory' from the Data Services area.

Operations on the default directory

The operations available for accessing tables are the same as for WSDL for operations on data [p 203].

See also

WSDL download from HTTP protocol [p 689]

Directory services [p 725]
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CHAPTER 37

Overview of integration and
extension

Several service and component APIs allow you to develop custom extensions for TIBCO EBX and
integrate it with other systems.

This chapter contains the following topics:

1. User interface customization and integration

. Data services

2
3. XML and CSV import/export services
4. Programmatic services

37.1 User interface customization and integration

The EBX graphical interface can be customized through various EBX APIs.

It can also be integrated into any application that is accessible through a supported web browser [p
316].

See Interface customization [p 640] for more information.

37.2 Data services

The data services module provides a means for external systems to interact with EBX using one of
following:

»  Web Services Description Language (WSDL/SOAP) standard
« Representational state transfer (REST)

See also

WSDL/SOAP data services [p 676]

REST data services [p 730]
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37.3 XML and CSV import/export services

EBX includes built-in services for importing data from and export data to XML and CSV formats.
Imports and exports for XML and CSV can be performed using the user interface, data services, or
the Java APIL.

See also

XML import and export [p 129]

CSV import and export [p 135]

37.4 Programmatic services

Programmatic services allow executing procedures in a well-defined context, for example in a
scheduled task or in a batch.

Some examples of programmatic services include:

Importing data from an external source,
Exporting data to multiple systems,
Data historization, launched by a supervisory system

Optimizing and refactoring data if EBX  built-in
AdaptationTreeOptimizerSpec™ are not sufficient.

I

See alsoProgrammaticService”

optimization services
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CHAPTER 38

Using TIBCO EBX as a Web
Component

This chapter contains the following topics:
1. Overview

Integrating EBX Web Components into applications

Repository element and scope selection

Combined selection

Request specifications

O e

Example calls to an EBX Web Component

38.1 Overview

EBX can be used as a user interface Web Component, called through the HTTP protocol. An EBX
Web Component can be integrated into any application that is accessible through a supported web
browser. This method of access offers the major benefits of EBX, such as user authentication, data
validation, and automatic user interface generation, while additionally providing the ability to focus
user navigation on specific elements of the repository.

Typical uses of EBX Web Components include integrating them into the intranet frameworks of
organizations or into applications that manage the assignment of specific tasks to users.

See alsoSupported web browsers [p 316]

38.2 Integrating EBX Web Components into applications

A web application that calls an EBX Web Component can be:
1. A non-Java application, the most basic being a static HTML page.

In this case, the application must send an HTTP request that follows the EBX Web Component
request specifications [p 213].

2. A Java application, for example:

« A Javaweb application running on the same application server instance as the EBX repository
it targets or on a different application server instance.
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« An EBX User service [p 640] or a Custom widget [p 641], in which case, the new session
will automatically inherit from the parent EBX session.

Note

In Java, the recommended method for building HTTP requests that call EBX web
components is to use the class UTHt tpManagerComponent™ in the API.

38.3 Repository element and scope selection

When an EBX Web Component is called, the user must first be authenticated in the newly instantiated
HTTP session. The Web Component then selects a repository element and displays it according to the
scope layout parameter defined in the request.

The parameter firstCallbisplay may change this automatic display according to its value.
The repository elements that can be selected are as follows:

» Dataspace or snapshot

« Dataset

+ Node

+ Table or a published view

+ Table record

The scope determines how much of the user interface is displayed to the user, thus defining where the
user is able to navigate in the session. The default scope that the Web component uses is the smallest
possible depending on the entity or service being selected or invoked by the request.

See alsoScope [p 216]

See alsofirstCallDisplay [p 216]

It is also possible to select a specific perspective as well as a perspective action.
By default, the selection of the element is done in the context of the perspective of the user if the
scope is "full".

See alsoPerspective [p 19]

38.4 Combined selection

A URL of a Web component can specify a perspective and an action or an entity (dataspace, dataset,
etc). Thus, for a Web component that has specified in its URL a perspective and an entity (but no
action), if an action of the perspective matches this entity, then this action will be automatically
selected.

Otherwise, if no action matches this entity, no action will be selected but the entity is opened
regardless.

If an action is specified at the same time than an entity, this last is ignored and the action will be
selected.
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Specific case

If the target entity is a record and if an action is on the table that contains this record, then this action
will be selected and the record will be opened inside the action.

In the same way, if a workflow work item is targeted by the web component, and if an action on « inbox
» exists in the perspective, then this action will be selected and the work item will be opened inside it.

Known limitations

If the Web component specifies a predicate to filter a table, the perspective action must specify the
exact same predicate to be selected.

In the same way, if the perspective action specifies a predicate to filter a table, the Web component
must specify the exact same predicate to establish the match.

38.5 Request specifications

Base URL

In a default deployment, the base URL must be of the following form:
http://<host>[:<port>]/ebx/

Note

The base URL must refer to the servlet FrontServlet, defined in the deployment
descriptor /WEB-INF/web.xml of the web application ebx.war.

User authentication and session information parameters

Parameter Description Required
login and password, Specifies user authentication properties. If neither a login and password pair nor No
or a user directory- a user directory-specific token is provided, user will be required to authenticate
specific token through the repository login page.
See Directory™ for more information.
trackingInfo Specifies the tracking information of the new session. Tracking information is No
logged in history tables. Additionally, it can be used to programmatically restrict
access permissions.
See AccessRule™ for more information.
redirect The URL to which the user will be redirected at the end of the component session, No
when they click on the button 'Close'. The close button is always displayed for
record selections, but whether or not it is displayed for all other cases must be
specified using the parameter closeButton.
For more information, see Exit policy (p 411).
locale Specifies the locale to use. Value is either en-Us or fr-FR. No, default

is the locale
registered for
the user.
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Entity and service selection parameters

Parameter

Description

Required

branch

Selects the specified dataspace.

No

version

Selects the specified snapshot.

No

instance

Selects the specified dataset. The value must be the reference of
a dataset that exists in the selected dataspace or snapshot.

Only if xpath or
viewPublication is
specified.

viewPublication

Specifies the publication name of the tabular or hierarchical
view to apply to the selected content.

This publication name is the one declared during the
publication of the view. It can be found in the 'Administration’
area under Views configuration > Views.

All settings of the view, that is, its filters, sort order, and
displayed columns, are applied to the result. A dataspace

and a dataset must be selected in order for this view to be
applied. The target table selection is not necessary, as it can be
automatically determined based on the definition of the view.
This parameter can be combined with the predicate specified in
the xpath parameter as a logical 'AND' operation.

No

xpath

Specifies a node selection in the dataset.

Value may be a valid absolute path located in the selected
dataset. The notation must conform to a simplified XPath, with
abbreviated syntax.

It can also be a predicate surrounded by "[" and "]" (to be
encoded using %5B and %5F respectively) if a table can be
automatically selected using other Web Component parameters
(for example, viewPublication or workflowView).

For XPath syntax, see XPath supported syntax p 233]

APT

See UIHttpManagerComponent .setPredicate™ for more

information.

service

Specifies the service to access.

For more information on built-in User services, see Built-in
Services [p 219].

In the Java API, see Servicekey™ for more information.

workflowView

Specifies the workflow section to be selected.

APT

See Workflowview" for more information.

perspectiveName

Specifies the name of the perspective to be selected.

If this parameter is specified, the scope parameter can have
only two values: full and data.

Only if
perspectiveActionId or
perspectiveActionName is
specified.

perspectiveActionId

Deprecated. Please consider using perspectiveActionName
instead.

Specifies the identifier of the perspective action to be selected.

No.
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Parameter

Description

Required

perspectiveActionName

Specifies the unique name of the perspective action to be
selected.

No.
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Layout parameters
Parameter Description Required
scope Specifies the scope to be used by the web component. Value can be full, data, No, default will
dataspace, dataset or node. be computed to
See UIHttpManagerComponent .Scope™” for more information. be thg smallest
possible
according to the
target selection.
firstCallDisplay Specifies which display must be used instead of the one determined by the No, default will
combination of selection and scope parameter. be computed
Possible values are: according to, the
target selection.
« auto: The display is automatically set according to the selection.
- view: Forces the display of the tabular view or of the hierarchical view.
« record: If the predicate has at least one record, forces the display of the first
record in the list.
For example,
firstCallDisplay=view
firstCallDisplay=view:hierarchyExpanded
firstCallDisplay=record
firstCallDisplay=record:{predicate}
See UIHttpManagerComponent.setFirstCallDisplay™” for more information.
See UIHttpManagerComponent.setFirstCallDisplayHierarchyExpanded™ for
more information.
See UIHttpManagerComponent .setFirstCallDisplayRecord™ for more
information.
closeButton Specifies how to display the session close button. Value can be logout or cross. No. If scope
See UIHttpManagerComponent.CloseButtonSpec™ for more information. Is not full,
no close
button will be
displayed by
default.
dataSetFeatures Specifies which features to display in a UT service at the dataset level or a form No.
outside of a table.
These options pertain only to features in the workspace. It is recommended to use
this property with the smallest scope possible, namely dataset or node.
Syntax:
<prefix> ":" <feature> [ "," <feature>]*
where
o <prefix> is hide or show,
« <feature>is services, title, save, or revert.
For example,
hide:title
show:save, revert
See UIHttpManagerComponent .DataSetFeatures™ for more information.
viewFeatures Specifies which features to display in a tabular or a hierarchy view (at the table No.
level).
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Parameter Description Required
These options pertain only to features in the workspace. It is recommended to use
this property with the smallest scope possible, namely dataset or node.
Syntax:
<prefix> ":" <feature> [ "," <feature>]*
where
o <prefix>ishide or show,
. <feature>is create, views, selection, filters, services, refresh, title,
or breadcrumb.
For example,
hide:title, selection
show:service, title, breadcrumb
See UIHttpManagerComponent.ViewFeatures™ for more information.
recordFeatures Specifies which features must be displayed in a form at the record level. No.
These options pertain only to features in the workspace. It is recommended to use
this property with the smallest scope possible, namely dataset or node.
Syntax:
<prefix> ":" <feature> [ "," <feature>]*
where
o <prefix>is hide or show,
« <feature>is services, title, breadcrumb, save, saveAndClose, close, or
revert.
For example,
hide:title
show: save, saveAndClose, revert
See UIHttpManagerComponent .RecordFeatures™ for more information.
pageSize Specifies the number of records that will be displayed per page in a table view No.
(either tabular or hierarchical).
startwWorkItem Specifies a work item must be automatically taken and started. Value can be true or | No. Default
false. value is false,
See ServiceKey.WORKFLOW" for more information. where‘ the target
work item
state remains
unchanged.

38.6 Example calls to an EBX Web Component

Minimal URI:

http://localhost:8080/ebx/

Logs in as the user 'admin’' and selects the 'Reference’ dataspace:

http://localhost:8080/ebx/?login=admin&password=admin&branch=Reference

Selects the 'Reference' dataspace and accesses the built-in validation service:

http://localhost:8080/ebx/?
login=admin&password=admin&branch=Reference&service=@validation

Selects the roles table in the default directory:

http://localhost:8080/ebx/?login=admin&password=admin&branch=ebx-
directory&instance=ebx-directory&xpath=/directory/roles
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Selects the record 'admin' in the default directory:
http://localhost:8080/ebx/?login=admin&password=admin&branch=ebx-
directory&instance=ebx-directory&xpath=/directory/user[./login="admin"]

Note

For clarity purposes, the above URLs are not encoded and this can make them incompatible with some
application servers.

Accesses the interface for creating a new user in the default directory:

http://localhost:8080/ebx/?login=admin&password=admin&branch=ebx-
directory&instance=ebx-directory&xpath=/directory/useré&service=@creation

Compares the record 'admin' in the default directory with the record 'jSmith':

Compares the record 'R1' in the dataset 'instanceld’ in the dataspace 'Reference’ with the record 'RO":

http://localhost:8080/ebx/?login=admin&password=admin&branch=ebx-
directory&instance=ebx-directory&xpath=/directory/user[./
login="admin"]&service=@compare&compare.branch=ebx-directory&compare.instance=ebx-
directory&compare.xpath=/directory/user[./login="jSmith"]

Note

For clarity purposes, the above URLs are not encoded and this can make them incompatible with some
application servers.
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CHAPTER 39

Buillt-in user services

EBX includes a number of built-in user services. Built-in user services can be used:

when defining workflow model tasks [p 156]

when defining perspective action menu items [p 20]

as extended user services when used with service extensions [p 667]

when using EBX as a Web Component [p 211]

This reference page describes the built-in user services and their parameters.

This chapter contains the following topics:

1.

£ L N s N

Access data (default service)

Create a new record

Duplicate a record

Export data to an XML file

Export data to a CSV file

Import data from an XML file

Import data from a CSV file

Access a dataspace

Validate a dataspace, a snapshot or a dataset

10.Merge a dataspace

11.Access the dataspace merge view

12.Compare contents

13.Data workflows

39.1 Access data (default service)

By default, workflows automatically consider this service as complete. That is, the 'Accept' button
is always available.

This is the default service used if no service is specified.
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Input parameters

Parameter Label Description

branch Dataspace The identifier of the specified dataspace -
A dataspace is required for this service.

disableAutoComplete Disable Accept at start By default, the interaction associated
with this service is directly considered as
complete. Therefore, the Accept button
is automatically displayed at the opening
of the work item. This parameter is
useful to disable this behavior. If the
value is 'true’, the developer will be in
charge of completing the interaction by
using SessionInteraction in a user service
or a trigger, for example. The default
value is 'false'. Perspectives do not use
this parameter.

firstCallDisplay First call display mode Defines the display mode that must be
used when displaying a filtered table or
a record upon first call. Default (value
='auto'): the display is automatically set
according to the selection. View (value =
'view"): forces the display of the tabular
view or of the hierarchical view. Record
(value = 'record'): if the predicate has at
least one record, forces the display of the
record form.

instance Dataset The value must be the reference of
a dataset that exists in the selected
dataspace.

scope Scope Defines the scope of the user navigation
for this service, namely, the entities

that the user is able to select during
their session. If left blank, the default
value will be used. For perspectives,

the default value is always 'node'. For
workflows, the default value depends on
the selected entities or service.

trackingInfo Tracking information Tracking information is logged into
'history' logs. It may also be used for
any other purpose like access control or
additional export information.

version Snapshot The identifier of the specified snapshot -
A dataspace is required for this service.

viewPublication View The publication name of the view to
display. The view must be configured for
the selected table.

xpath Dataset node (XPath) The value must be a valid absolute
location path in the selected dataset. The
notation must conform to a simplified
XPath, in its abbreviated syntax.
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39.2 Create a new record

For a workflow, the creation service is considered complete when the first successful submit is
performed (record has been created). If this service is called whereas it is already complete, the created
record is displayed in update or read-only mode (depending on the user rights).

Service name parameter: service=@creation

Input parameters

Parameter Label Description

branch Dataspace The identifier of the specified dataspace -
This field is required for this service.

instance Dataset The value must be the reference of

a dataset that exists in the selected
dataspace - This field is required for this
service.

scope Scope Defines the scope of the user navigation
for this service, namely, the entities

that the user is able to select during
their session. If left blank, the default
value will be used. For perspectives,

the default value is always 'node'. For
workflows, the default value depends on
the selected entities or service.

trackingInfo Tracking information Tracking information is logged into
'history' logs. It may also be used for
any other purpose like access control or
additional export information.

xpath Dataset table (XPath) The value must be a valid absolute
location path of a table in the selected
dataset. The notation must conform to
a simplified XPath, in its abbreviated
syntax - This field is required for this
service.

Output parameters

Parameter Label Description

created Created record Contains the XPath of the created record.

39.3 Duplicate a record

For a workflow, the duplicate service is considered complete when the first successful submit is
performed (record has been created). If this service is called whereas it is already complete, the created
record is displayed in update or read-only mode (depending on the user rights).

Service name parameter: service=@duplicate
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Input parameters

Parameter Label Description

branch Dataspace The identifier of the specified dataspace -
This field is required for this service.

instance Dataset The value must be the reference of

a dataset that exists in the selected
dataspace - This field is required for this
service.

scope Scope Defines the scope of the user navigation
for this service, namely, the entities

that the user is able to select during
their session. If left blank, the default
value will be used. For perspectives,

the default value is always 'node'. For
workflows, the default value depends on
the selected entities or service.

trackingInfo Tracking information Tracking information is logged into
'history" logs. It may also be used for
any other purpose like access control or
additional export information.

xpath Record to duplicate (XPath) The value must be a valid absolute
location path of an existing record. The
notation must conform to a simplified
XPath, in its abbreviated syntax - This
field is required for this service.

Output parameters

Parameter Label Description

created Created record Contains the XPath of the created record.

39.4 Export data to an XML file

The exportToXML service is considered complete when export is done and file downloaded.

Service name parameter: service=@exportToXML
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Input parameters

Parameter Label Description

branch Dataspace The identifier of the specified dataspace -
A dataspace is required for this service.

instance Dataset The value must be the reference of

a dataset that exists in the selected
dataspace - This field is required for this
service.

scope Scope Defines the scope of the user navigation
for this service, namely, the entities

that the user is able to select during
their session. If left blank, the default
value will be used. For perspectives,

the default value is always 'node'. For
workflows, the default value depends on
the selected entities or service.

trackingInfo Tracking information Tracking information is logged into
'history" logs. It may also be used for
any other purpose like access control or
additional export information.

version Snapshot The identifier of the specified snapshot -
A dataspace is required for this service.

xpath Dataset table to export (XPath) The value must be a valid absolute
location path of a table in the selected
dataset. The notation must conform to
a simplified XPath, in its abbreviated
syntax - This field is required for this
service.

39.5 Export data to a CSV file

Workflows consider the exportToCSV service as complete when export is done and file downloaded.

Service name parameter: service=@exportToCSV
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Input parameters

Parameter Label Description

branch Dataspace The identifier of the specified dataspace -
A dataspace is required for this service.

instance Dataset The value must be the reference of

a dataset that exists in the selected
dataspace - This field is required for this
service.

scope Scope Defines the scope of the user navigation
for this service, namely, the entities

that the user is able to select during
their session. If left blank, the default
value will be used. For perspectives,

the default value is always 'node'. For
workflows, the default value depends on
the selected entities or service.

trackingInfo Tracking information Tracking information is logged into
'history" logs. It may also be used for
any other purpose like access control or
additional export information.

version Snapshot The identifier of the specified snapshot -
A dataspace is required for this service.

xpath Dataset table to export (XPath) The value must be a valid absolute
location path of a table in the selected
dataset. The notation must conform to
a simplified XPath, in its abbreviated
syntax - This field is required for this
service.

39.6 Import data from an XML file

Workflows consider the importFromXML service as complete when import is performed.

Service name parameter: service=@importFromXML
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Input parameters

Parameter Label Description

branch Dataspace The identifier of the specified dataspace -
A dataspace is required for this service.

instance Dataset The value must be the reference of

a dataset that exists in the selected
dataspace - This field is required for this
service.

scope Scope Defines the scope of the user navigation
for this service, namely, the entities

that the user is able to select during
their session. If left blank, the default
value will be used. For perspectives,

the default value is always 'node'. For
workflows, the default value depends on
the selected entities or service.

trackingInfo Tracking information Tracking information is logged into
'history" logs. It may also be used for
any other purpose like access control or
additional export information.

xpath Dataset table to import (XPath) The value must be a valid absolute
location path of a table in the selected
dataset. The notation must conform to
a simplified XPath, in its abbreviated
syntax - This field is required for this
service.

39.7 Import data from a CSV file

Workflows consider the importFromCSV service as complete when import is performed.

Service name parameter: service=@importFromCSV
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Input parameters

Parameter Label Description

branch Dataspace The identifier of the specified dataspace -
A dataspace is required for this service.

instance Dataset The value must be the reference of

a dataset that exists in the selected
dataspace - This field is required for this
service.

scope Scope Defines the scope of the user navigation
for this service, namely, the entities

that the user is able to select during
their session. If left blank, the default
value will be used. For perspectives,

the default value is always 'node'. For
workflows, the default value depends on
the selected entities or service.

trackingInfo Tracking information Tracking information is logged into
'history" logs. It may also be used for
any other purpose like access control or
additional export information.

xpath Dataset table to import (XPath) The value must be a valid absolute
location path of a table in the selected
dataset. The notation must conform to
a simplified XPath, in its abbreviated
syntax - This field is required for this
service.

39.8 Access a dataspace

A workflow automatically considers that the dataspace selection service is complete.

Service name parameter: service=@selectDataSpace
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Input parameters

Parameter

Label

Description

branch

Dataspace

The identifier of the specified dataspace -
A dataspace is required for this service.

scope

Scope

Defines the scope of the user navigation
for this service, namely, the entities

that the user is able to select during
their session. If left blank, the default
value will be used. For perspectives,

the default value is always 'node'. For
workflows, the default value depends on
the selected entities or service.

trackingInfo

Tracking information

Tracking information is logged into
'history' logs. It may also be used for
any other purpose like access control or
additional export information.

version

Snapshot

The identifier of the specified snapshot -
A dataspace is required for this service.

39.9 Validate a dataspace, a shapshot or a dataset

Workflows automatically consider the validation service as complete.

Service name parameter: service=@validation

Input parameters

Parameter

Label

Description

branch

Dataspace

The identifier of the specified dataspace
- A dataspace or snapshot is required for
this service.

instance

Dataset

The value must be the reference of
a dataset that exists in the selected
dataspace.

scope

Scope

Defines the scope of the user navigation
for this service, namely, the entities

that the user is able to select during
their session. If left blank, the default
value will be used. For perspectives,

the default value is always 'node'. For
workflows, the default value depends on
the selected entities or service.

trackingInfo

Tracking information

Tracking information is logged into
'history' logs. It may also be used for
any other purpose like access control or
additional export information.

version

Snapshot

The identifier of the specified snapshot
- A dataspace or snapshot is required for
this service.
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Output parameters

Parameter Label Description

hasError Found errors Contains 'true' if validation has produced
eITors.

hasFatal Found fatal errors Contains 'true' if validation has produced
fatal errors.

hasInfo Found informations Contains 'true' if validation has produced
informations.

hasWarning Found warnings Contains 'true' if validation has produced
warnings.

39.10 Merge a dataspace

Workflows consider the merge service as complete when merger is performed and dataspace is closed.

Service name parameter: service=@merge

Input parameters

Parameter

Label

Description

branch

Dataspace

The identifier of the specified dataspace -
A dataspace is required for this service.

scope

Scope

Defines the scope of the user navigation
for this service, namely, the entities

that the user is able to select during
their session. If left blank, the default
value will be used. For perspectives,

the default value is always 'node'. For
workflows, the default value depends on
the selected entities or service.

trackingInfo

Tracking information

Tracking information is logged into
'history' logs. It may also be used for
any other purpose like access control or
additional export information.

Output parameters

Parameter

Label

Description

mergeResult

Merge success

Contains 'true’ if merge succeeded,
otherwise 'false'.

mergeState

Merge state

Contains the return code of the merge.

It is strongly recommended to parse this
value by using the InteractionMergeState
UIHttpManagerComponentReturnCode.
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39.11 Access the dataspace merge view

The merge.view service is automatically considered complete.

Service name parameter: service=@merge.view

Input parameters

Parameter Label Description

branch Dataspace The identifier of the specified dataspace -
A dataspace is required for this service.

scope Scope Defines the scope of the user navigation
for this service, namely, the entities

that the user is able to select during
their session. If left blank, the default
value will be used. For perspectives,

the default value is always 'node'. For
workflows, the default value depends on
the selected entities or service.

trackingInfo Tracking information Tracking information is logged into
'history' logs. It may also be used for
any other purpose like access control or
additional export information.

39.12 Compare contents

Workflows automatically consider the compare service as complete.

Service name parameter: service=@compare
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Input parameters

Parameter

Label

Description

branch

Dataspace

The identifier of the specified dataspace -
A dataspace or snapshot and a dataspace
or snapshot to compare to are required
for this service.

compare.

branch

Dataspace to compare

The identifier of the dataspace to
compare - A dataspace or snapshot and a
dataspace or snapshot to compare to are
required for this service.

compare.

filter

Comparison filter

To ignore inheritance and function fields
in the comparison (disable resolved
mode), the filter "persistedValuesOnly"
must be specified. By default, when no
filter is defined, the comparison uses
resolved mode.

compare.

instance

Dataset to compare

The value must be the reference of
a dataset that exists in the selected
dataspace to compare.

compare

.version

Snapshot to compare

The identifier of the snapshot to
compare - A dataspace or snapshot and a
dataspace or snapshot to compare to are
required for this service.

compare.

xpath

Table or record to compare (XPath)

The value must be a valid absolute
location path of a table or a record in the
selected dataset to compare. The notation
must conform to a simplified XPath, in
its abbreviated syntax.

instance

Dataset

The value must be the reference of
a dataset that exists in the selected
dataspace.

scope

Scope

Defines the scope of the user navigation
for this service, namely, the entities

that the user is able to select during
their session. If left blank, the default
value will be used. For perspectives,

the default value is always 'node'. For
workflows, the default value depends on
the selected entities or service.

trackingInfo

Tracking information

Tracking information is logged into
'history' logs. It may also be used for
any other purpose like access control or
additional export information.

version

Snapshot

The identifier of the specified snapshot -
A dataspace or snapshot and a dataspace
or snapshot to compare to are required
for this service.

xpath

Table or record (XPath)

The value must be a valid absolute
location path of a table or a record in
the selected dataset. The notation must
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Parameter Label Description

conform to a simplified XPath, in its
abbreviated syntax.

39.13 Data workflows

This service provides access to the data workflows user interfaces.

Service name parameter: service=@workflow

This service is for perspectives only.

Input parameters

Parameter Label Description

scope Scope Defines the scope of the user navigation
for this service.

viewPublication View publication Defines the publication name of the view
to apply for this service.

workflowview Workflow view Specifies the workflow view type. Value
can be one of the following: "inbox",
"launcher", "monitoringPublications",
"monitoringWorkflows",
"monitoringWorkItems" or

"completedWorkflows".

xpath Filter (XPath) An optional filter. The syntax should
conform to an XPath predicate
surrounded by "[" and "]".
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cHAPTER 40

Supported XPath syntax

This chapter contains the following topics:
1. Overview

. Example expressions

2
3. Syntax specifications for XPath expressions
4

. Java API

40.1 Overview

The XPath notation used in TIBCO EBX must conform to the abbreviated syntax of the XML
Path Language (XPath) Version 1.0 standard, with certain restrictions. This document details the
abbreviated syntax that is supported.

40.2 Example expressions

The general XPath expression is:
path[predicate]

Absolute path
/library/books/

Relative paths

./Author
../Title

Root and descendant paths
//books

Table paths with predicates

../../books/[author_id = 0101 and (publisher = 'harmattan')]
/library/books/[not(publisher = 'dumesnil')]

Complex predicates
starts-with(col3, 'xxx') and ends-with(col3, 'yyy') and osd:is-not-null(./col3))
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contains(col3 , 'xxx') and ( not(coll=100) and date-greater-than(col2, '2007-12-30') )

Predicates with parameters

author_id = $paraml and publisher = $param2 where the parameters $paraml and $param2 refer
respectively to 8101 and 'harmattan'

coll < $paraml and col4 = $param2 where the parameters $paraml and $param2 refer respectively
to 100 and 'true'

contains(col3, $paraml) and date-greater-than(col2,$param2) where the parameters $paraml
and $param2 refer respectively to 'XXX' and '2007-12-30'

Note

The use of this notation is restricted to the Java API since the parameter values can only
be set by the method Request.setxPathParameter™ of the Java API.

Search predicate
+ syntax: osd:search(fields, queryString[, templateKey])
« Examples:

- osd:search('coll', 'xxx')

- osd:search('coll,col2', 'xxx"')

- osd:search('"', 'xxx")

» osd:search(coll, 'xxx', myTemplate@myModule)

The osd: search function tries to match a term, or a list of terms, against the set of fields of the current
table. This function is generic, handling every field datatype supported by EBX. When no fields are
specified, it searches against all fields for current table. For a more advanced usage, the query string
supports specialized operators, see Special characters [p 119] for more information.

For any concerned field, if a label exists, the search targets the label, rather than the value; however,
this is not yet supported in some cases. See Limitations [p 298] for more information.

The predicate osd: search is localized.

Note

API

The locale can be set by the methods of the Java API Request.setLocale™ orrRequest.

setSession™ .

Note

The identifier of a search template searchTemplate™ can be specified, to customize the
behavior of the search.

Predicates for validation search
osd:has-validation-item()
osd:has-validation-item('error,info')
osd:contains-validation-message( 'xxx")
osd:contains-validation-message('xxx"', 'info,warning')
« XPath functions for validation search cannot be used on XPath predicates defined on associations
and foreign key filters.
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» The predicates osd:label, osd:contains-record-label and osd:contains-validation-message

are localized.

Note

The locale can be set by the methods of the Java API Request.setLocale™ or

Request.setSession™.

1

Attention

To ensure that the search is performed on an up-to-date validation report, it is necessary to perform
an explicit validation of the table just before using these predicates.

40.3 Syntax specifications for XPath expressions

Overview

Expression

Format

Example

XPath expression

<container path>[predicate]

/books[title="xxx"]

<container path>

<absolute path> or <relative path>

<absolute path>

/a/bor//b

//books

<relative path>

../../b, ./borb

../../books
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Predicate specification

Expression

Format

Notes/Example

<predicate>

Example: A and (B or not(C)) A,B,C:
<atomic expression>

Composition of: logical operators
parentheses, not() and atomic
expressions.

<atomic expression>

<path><comparator><criterion> or
method(<path>,<criterion>)

royalty = 24.5
starts-with(title, 'Johnat')

booleanvalue = true

<path>

<relative path> or osd:label(<relative
path>)

Relative to the table that contains it:

../authorstitle

<comparator>

<boolean comparator>, <numeric
comparator> or <string comparator>

<boolean comparator>

<numeric comparator>

<string comparator>

<method>

<date method>, <string method>,
osd:is-null method or osd:is-not-
null method

<date, time & dateTime method>

date-less-than, date-equal or date-
greater-than

<string method>

matches, starts-with, ends-with,
contains, osd:is-empty, osd:is-
not-empty, osd:is-empty-or-nil,
osd:is-neither-empty-nor-nil,
osd:is-equal-case-insensitive,
osd:starts-with-case-insensitive,
osd:ends-with-case-insensitive,
osd:contains-case-insensitive,
osd:contains-record-label
,orosd:search

<criterion>

<boolean criterion>, <numeric
criterion>, <string criterion>, <date
criterion>, <time criterion>, or
<dateTime criterion>

<boolean criterion>

true ,false

<numeric criterion>

An integer or a decimal

<string criterion>

Quoted character string

'azerty'
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Expression Format Notes/Example

<date criterion> Quoted and formatted as 'yyyy-MM-dd' '2007-12-31"

<time criterion> Quoted and formatted as 'HH:mm:ss' or '11:55:00"
'HH:mm:ss.SSS'

<dateTime criterion> Quoted and formatted as 'yyyy- '2007-12-31711:55:00"
MM-ddTHH:mm:ss' or 'yyyy-MM-
ddTHH:mm:ss.SSS'

XPath 1.0 formula

It is possible to use an XPath 1.0 formula in the criterion value part of an atomic predicate expression
(right-hand side).

For example, instead of [./a=3], you may use the expression [./a=(floor(./d)+ 2.0)].

Due to the strong dependence of predicates on the data model node and the node type of the criterion,

the path portion of the atomic predicate expression (left-hand side) must be a node path and cannot
be an XPath formula. For example, the expression /table[floor(./a) > ceiling(./d)] is not valid.

Predicate on label

The osd:1abel() function can be applied to the path portion of the atomic predicate, in order to resolve
the predicate on the label instead of the value. In this case, only string operators and string criteria can
be used, i.e. ends-with(osd:label(./price), '99").

A predicate on label is localized, so the criterion must be expressed in the same
locale as the predicate-filtered request. For example: request.setlLocale(Locale.FRENCH);
request.setXPathFilter("osd:label(./delivery_date)='30/12/2014'");

Note
It is forbidden to use the osd:label function if the right part of the predicate is a
contextual value.

Note

If the osd: 1abel function is used in a data model, for example on a selection or in the filter
predicate of a table reference node, the default locale of the data model (as defined in its
module declaration) must be used for the criterion format (even though this is generally
not recommended).

T

See alsoSchemaNode.displayOccurrence”

TIBCO EBX® Product Documentation 6.0.5 237



Documentation > Reference Manual > Integration > Supported XPath syntax

Contextual values

For predicates that are relative to a selected node, the criterion value (that is, the right-hand side of
the predicate) can be replaced with a contextual path using the syntax ${<relative-path>} where
<relative-path> is the location of the element relative to the selected node.

Note

When calling a method, the criterion is the second parameter, and the first parameter
cannot be a relative value.

Aggregated lists

For predicates on aggregated lists, the predicate returns true regardless of the comparator if one of
the list elements verifies the predicate.

Note
Special attention must be paid to the comparator !=. For example, for an aggregated
list, ./1ist 1= 'a' is not the same as not(./list = 'a'). Where the list contains the
elements (e1,e2, ..), the first predicate is equivalent to e1 !'= 'a' or e2 '= 'a' ...,
while the second is equivalenttoe1 != 'a' and e2 != 'a'

'Null' values

Null values must be explicitly treated in a predicate using the operators osd:is-null and osd:is-
not-null.

For example, /root/products[./price<100] or /root/products[./price!=100] will not return any
products whose prices are not set (null). For the latter case to return unset values as well, the predicate
must instead be: /root/products[./price!=100 or osd:is-null(./price)].

How to manage single and double quotes in literal expressions

By default, a literal expression is delimited by single quotes ('). If the literal expression contains single
quotes and no double quotes, the expression must be delimited by double quotes ("). If the literal
expression contains both single and double quotes, the single quotes must be doubled.

The method xPathExpressionHelper.encodelLiteralStringwithDelimiters™ in the Java API
handles this.

Examples of using encodeLiteralStringwWithDelimiters

Value of Literal Expression Result of this method

'Coeur’'
Coeur

Coeur d'Alene Coeur d'Alene

He said: "They live in Coeur d'Alene". He said: "They live in Coeur d''Alene".

Extraction of foreign keys

In EBX, the foreign keys are grouped into a single field with the osd: tableRef [p536] declaration.
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The standard XPath syntax has been extended so as to extract the value of any targeted primary key
field.

Example

If the table /root/tableA has an osd: tableref field named 'fkB' whose target is /root/tableB and the
primary key of tableB has two fields, id of type xs:int and date of type xs:date, then the following
expressions would be valid:

/root/tableA[ fkB = '123|2008-01-21' ], where the string "123|2008-01-21" is a representation
of the entire primary key value.

See Syntax of the internal String representation of primary keys pPrimarykey.syntax™ for
more information.

/root/tableA[ fkB/id = 123 and date-equal(fkB/date, '2008-01-21') ], where this predicate
is a more efficient equivalent to the one in the previous example.

/root/tableA[ fkB/id >= 123 ], where any number operator could be used, as the targeted
primary key field is of type xs:int.

/root/tableA[ date-greater-than( ./fkB/date,'2007-01-01' ) ], where any date operator
could be used, as the targeted primary key field is of type xs:date;

/root/tableA[ fkB = "" ] is not valid as the targeted primary key has two columns.

/root/tableA[ osd:is-null(fkB) ] checks if a foreign key is null (not defined).

40.4 Java API

Using the XPath in the Java API:

In the Java API, the xPathFilter class allows to define XPath predicates and to execute requests on
them.

The xPathExpressionHelper class provides utilitarian methods to handle XPath predicates and paths.
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CHAPTER 41

Labeling and localization

This chapter contains the following topics:
1. Overview

2. Value formatting policies

3. Syntax for locales

41.1 Overview

TIBCO EBX offers the ability to handle the labeling and the internationalization of data models.

Localizing user interactions
In EBX, language preferences can be set for two scopes:
1. Session: Each user can select a default locale from the user pane.

2. Data model: If a data model has been localized into other languages than those natively supported
by EBX, the user can select one of those languages for that particular data model. See Extending
TIBCO EBX internationalization [p 245] for more information.

Textual information

In EBX, most master data entities can have a label and a description, or can correspond to a user
message. For example:

» Dataspaces, snapshots and datasets can have their own label and description. The label is
independent of the unique name, so that it remains localizable and modifiable;

» Any node in the data model can have a static label and description;
» Values can have a static label when they are enumerated;

« Validation messages can be customized, and permission restrictions can provide text explaining
the reason;

« FEach record is dynamically displayed according to its content, as well as the context in which it
is being displayed (in a hierarchy, as a foreign key, etc.);

All this textual information can be localized into the locales that are declared by the module.

See also

Labels and messages [p 573]
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Tables declaration [p 531]

Foreign keys declaration [p 536]

41.2 Value formatting policies

When a value is displayed to the user, it is formatted according to its type and the formatting policy
of the current locale. For example, a date will be displayed in some locales as "dd/MM/yyyy" and
"MM/dd/yyyy" in others.

A formatting policy is used to define how to display the values of simple types [p 518].

For each locale declared by the module, its formatting policy is configured in a file located at /weB-
INF/ebx/{locale}/frontEndFormattingPolicy.xml. For instance, to define the formatting policy for
Greek (el), the engine looks for the following path in the module:

/WEB-INF/ebx/el/frontEndFormattingPolicy.xml

If the corresponding file does not exist in the module, the formatting policy is looked up in the class-
path of EBX. If the locale-specific formatting policy is not found, the formatting policy of en_us is
applied.

The content of the file frontEndFormattingPolicy.xml is as follows:

<?xml version="1.0" encoding="UTF-8"?>

<formattingPolicy xmlns="urn:ebx-schemas:formattingPolicy 1.0"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemaLocation="urn:ebx-schemas:formattingPolicy_1.0 ../schema/ebx-reserved/formattingPolicy_1.0.xsd">
<date pattern="dd/MM" />

<time pattern="HH:mm:ss" />

<dateTime pattern="dd/MM/yyyy HH:mm" />

<decimal pattern="00,00,00.000" groupingSeparator="|" decimalSeparator="A"/>
<int pattern="000,000" groupingSeparator=" "/>
</formattingPolicy>

The elements date, dateTime and time are mandatory.

The group and decimal separators that appear in the formatted numbers can be modified by defining
the attributes groupingSeparator and decimalSeparator for the elements decimal and int.

41.3 Syntax for locales

There are two ways to express a locale:

1. The XML recommendation follows the IETF BCP 47 recommendation, which uses a hyphen '-'
as the separator.

2. The Java specification uses an underscore '_' instead of a hyphen.
In any XML file (XSD, formatting policy file, etc.) read by EBX, either syntax is allowed.
For a web path, that is, a path within the web application, only the Java syntax is allowed. Thus,

formatting policy files must be located in directories whose locale names respect the Java syntax.

See alsoExtending TIBCO EBX internationalization [p 245]

TIBCO EBX® Product Documentation 6.0.5 243


https://tools.ietf.org/html/bcp47#page-1-4

Documentation > Reference Manual > Localization > Labeling and localization

TIBCO EBX® Product Documentation 6.0.5 244



Documentation > Reference Manual > Localization > Extending TIBCO EBX internationalization

CHAPTER 42

Extending TIBCO EBX
Internationalization

This chapter contains the following topics:

1. Overview of the native EBX localization

2. Extending EBX user interface localization

3. Localized resources resolution

4. Known limitations

42.1 Overview of the native EBX localization
By default, the EBX built-in user interface is provided in English (en-US) and French (fr-FR).

Localization consists of a formatting policy and a set of message files (resource bundle):

» For English, localization is provided by a formatting policy and a set of message files with no
locale defined,

» For French, localization is provided by a formatting policy and a set of message files with locale
set to "fr".

EBX provides an option to add locales in order to extend the localization of the user interface and to
internationalize the documentation of data models and associated services.

42.2 Extending EBX user interface localization

EBX supports the localization of its user interface into any compatible language and region.

Note

Currently, Latin & Cyrillic characters are supported. Locales that use other character sets
may be usable, but are not supported.

Adding a new locale
In order to add a new locale, the following steps must be followed:
+ Declare the new locale in the EBX main configuration file. For example:

ebx.locales.available=en-US, fr-FR, xx
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« The first locale is always considered the default.
« The built-in locales, en-US and fr-FR, can be removed if required.

See Configuring EBX localization [p 359].

» Deploy the following files in the EBX class-path:

« A formatting policy file,
com.orchestranetworks.il18n.frontEndFormattingPolicy_xx.xml,

+ A set of localized message files (*_xx.mxml) in a resource bundle.

Note

The files must be ending with ".mxml".

42.3 Localized resources resolution

named

Since version 5.7.0, localized resources are resolved on a locale-proximity base, with the following

lookup mechanism:

non non non

+ resourceName +"_" + language +

non non

« resourceName + + language + + country + ".mxml"

+ resourceName + "_" + language + ".mxml"

« resourceName + ".mxml"

Note

+ country + "_" + variant + ".mxml"

The resolution is done at the localized message level. It is therefore possible to define
one or more files for a locale that only includes messages for which specific localization

is required.

42 .4 Known limitations

Non extendable materials
Localization of the following cannot be extended:
« EBX product documentation,
« EBX HTML editor and viewer.
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CHAPTER 43

Overview of persistence

This chapter is an introduction to history tables and replicated tables.

Note
The term mapped mode [p 249] refers to any tables that are stored as-is, and thus whose
contents can be accessed directly in the database.
This chapter contains the following topics:

1. Primary persistence of managed master data

2. Historization

3. Replication
4. Mapped mode

43.1 Primary persistence of managed master data

Data that is modeled in and governed by the EBX repository are primarily persisted in the relational
database, using generic tables (common to all datasets and data models).

43.2 Historization

Master data tables can activate historization in order to track modifications to their data, regardless
of whether they are replicated.

The history itself is in mapped mode, meaning that it can be consulted directly in the underlying
database.

See alsoHistory [p 251]

43.3 Replication

Replication enables direct SQL access to tables of master data, by making a copy of data in the
repository to replica tables in the relational database. Replication can be enabled on any table
regardless of whether it has history activated.

The replica tables are persisted in mapped mode, as their primary purpose is to make master data
accessible to direct queries outside of EBX.
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See alsoReplication [p 259]

43.4 Mapped mode

Overview of mapped mode

Mapped mode refers to cases where tables are persisted in the underlying relational database in a
format that allows their data to be accessed directly, outside of EBX. History tables and replica tables
are all examples of tables in mapped mode.

All cases of mapped mode involve automatic alterations of the database schema (the database tables,
indexes, etc.) when necessary, by automatically executing required DDL statements in the background.
Such procedures are always triggered at data model compilation time and the data model compilation
report notifies of any resulting errors.

Another general consideration regarding mapped modes is that, in most cases, when a data model
entity is removed, its corresponding database object is not deleted immediately. Instead, it is marked
as disabled, which leaves the possibility of later re-enabling the object. In order to definitively drop
the object and its associated data and resources from the database, it must be marked for purge. The
removal then takes place during the next global purge.

See also

Database mapping administration [p 441]

Data model evolutions [p 265]

Structural constraints

When a mapped mode is set, some EBX data model constraints will generate a "structural constraint"
on the underlying RDBMS schema. This concerns the following constraining facets:

» facets xs:maxLength and xs:length on string elements;
o facets xs:totalDigits and xs:fractionDigits on xs:decimal elements.

Databases do not support as tolerant a validation mode as EBX. Hence, the above constraints
become blocking constraints. A blocking constraint means that updates are rejected if they do
not comply: when a transaction does not comply with a blocking constraint, it is cancelled and a
ConstraintViolationException™ is thrown.

See alsoBlocking and non-blocking constraints [p 563]

Data model restrictions due to mapped mode

Due to the nature of persisting directly in the underlying database, some restrictions apply to all tables
stored in mapped mode:

« Limitations of supported databases [p 320]

+ Unlimited-length strings: All string fields, except foreign keys, of type xs:string, its derived
types, and xs:anyURI must define a 'maxLength’ or 'length' facet. Since a foreign key field is
composed of the final primary key field(s) of its target table(s), this facet requirement applies
to each of those final primary key fields instead of the foreign key field itself. Additionally,
limitations of the underlying database concerning the maximum length of its character types apply,
such as VARCHAR and NVARCHAR?2.
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+ Large lists of columns might not be indexable. Example for Oracle: the database enforces a limit
on the maximum cumulated size of the columns included in an index. For strings, this size also
depends on the character set. If the database server fails to create the index, you should consider
redesigning your indexes, typically by using a shorter length for the concerned columns, or by
including fewer columns in the index. The reasoning is that an index leading to this situation
would have headers so large that it could not be efficient anyway.

+ Fields of type type="o0sd:password" are ignored.

» Terminal complex types are supported; however, they cannot be globally set to null at record-
level.

More generally, tables in mapped mode are subject to any limitations of the underlying RDBMS. For
example, the maximum number of columns in a table applies (1000 for Oracle, 1600 for PostgreSQL).
Note that a history table contains twice as many fields as declared in the schema (one functional field,
plus one generated field for the operation code).

Data model evolutions may also be constrained by the underlying RDBMS, depending on the existing
data model.

See alsoData model evolutions [p 265]
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CHAPTER 44

History

This chapter contains the following topics:
1. Overview

. Configuring history

. History views and permissions

2
3
4. SQL access to history
5

. Impacts and limitations of historized mode

44.1 Overview

History is a feature allowing to track all data modifications on a table (records creation, update and
deletion).

It is an improvement over the deprecated XML audit trail [p 455].
See also

History [p 30]

Replication [p 259]
Data model evolutions [p 265]

44.2 Configuring history

In order to activate historization for a table, a history profile has to be set for the table in the data
model. This section describes history profiles and the way they are associated with tables.

Configuring history in the repository

A history profile specifies when the historization is to be created. In order to edit history profiles,
select Administration > History and logs.

A history profile is identified by a name and defines the following information:
» An internationalized label.

« A list of dataspaces (branches) for which history is activated. It is possible to specify whether
direct children and/or all descendants should also be concerned.
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Some profiles are already created when installing the repository. These profiles can neither be deleted
nor modified.

Profile Id Description

ebx-referenceBranch This profile is activated only on the reference dataspace.

ebx-allBranches This profile is activated on all dataspaces.

ebx-instanceHeaders This profile historizes dataset headers. However, this profile
will only be setup in a future version, given that the internal
data model only defines dataset nodes.

Configuring history in the data model

Activating table history

History can be activated on a table either through the data model assistant, or by editing the underlying
data model.

To activate history by editing the data model, a history profile should be declared on the table using
the historyProfile element.

<osd:table>

<primaryKeys>/key</primaryKeys>

<historyProfile>historyProfileForProducts</historyProfile>
</osd:table>

The data model assistant allows you to view the historization profiles defined in the repository.

Historization must be activated for each table separately. See model design [p 514] documentation
for more details.

Disabling history on a specific field or group

For a historized table, the default behavior is to historize all its supported elements (see Impacts and
limitations of historized mode [p 256]).

It is possible to disable history for a given field or group, either through the data model assistant, or
by editing the underlying data model.

To disable the history of a field or group by editing the data model, use the element osd:history with
the attribute disable="true".

<xs:element name="longDescription" type="xs:string">
<xs:annotation>
<xs:appinfo>
<osd:history disable="true" />
</xs:appinfo>
</xs:annotation>
</xs:element>

To disable the history of a field or group through the data model assistant, use the History property
in the Advanced properties of the element.
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When this property is defined on a group, history is disabled recursively for all its descendants. Once
a group disables history, it is not possible to specifically re-enable history on a descendant.
Note

If the table containing the field or group is not historized, this property will not have any effect.

It is not possible to disable history for primary key fields.

Integrity

If problems are detected at data model compilation, warning messages or error messages will be added
to the validation report associated with this data model. Furthermore, if any error is detected, each
associated instance (dataset) will be inaccessible. The most common error cases are the following:

+ A table references a profile that is not defined in the repository.
A history profile that is referenced in the data model mentions a non-defined or closed dataspace
in the current repository.
Note

Deploying a data model on a repository that does not have the expected profiles requires
the administrator to add them.

44.3 History views and permissions

Table history view

When the history has been activated on a table in the data model, it is possible to access the history
view from various locations in the user interface: record, selection of records, table and dataset.

The next section explains how permissions are resolved.

For more information, see table history view [p 31] section. To access the table history view from Java,
the method AdaptationTable.getHistory™ must be invoked.

Permissions for table history

Data permissions are also applied to data history. History permissions are resolved automatically as
the most restricted permission between data permissions and read-only access right.

This is true for user-defined permission rules and also for programmatic permission rules.

When defining a programmatic rule, it may be required to distinguish between the functional dataset
context and the history view context, either because the expected permissions are not the same, or
because some fields are not present in the history structure. This is the case for dataset fields, computed
values and fields for which history has been disabled [p 252]. The methods Adaptation.isHistory™
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and AdaptationTable.getHistory™ can then be used in the programmatic rule in order to implement
specific behavior for history.

Note

There is currently a limitation when a table has a scripted permission rule on record
specified: for security reason access to the table history is totally disabled for everyone
but the built-in administrator profile. Access for other users will be allowed in a future
version.

Transaction history views

The transaction history view gives access to the executed transactions, independently of a table, a
dataset or a data model, directly from the user interface.

To see the 'Transaction history' table, navigate to the Administration area and select 'History and logs'
using the down arrow menu in the navigation pane. Transaction history can also be accessed from the
Dataspaces area by selecting a historized dataspace and using the Actions menu in the workspace.

For more information, see transaction history view [p 31].

44.4 SQL access to history

This section describes how to directly access the history data by means of SQL.

Access restrictions

The database tables must be accessed only in read-only mode. It is up to the database administrator
to forbid write access except for the database user used by TIBCO EBX, as specified in the section
Rules for the database access and user privileges [p 3971.

Relational schema overview
Here is a description of the history tables in the database.

The database schema contains (see also the diagram in the next section):

Common and generic tables The main table is Hv_Tx; each record of this table represents
a transaction. Only transactions that involve at least one
historized table are recorded.

These common tables are all prefixed by "HV".

Specific generated tables For each historized table, a specific history table is
generated. This table contains the history of the data
modifications on the table.

In the EBX user interface, the name of this table in database
can be obtained by clicking on the table documentation pane
(advanced mode). All the specific history tables are prefixed
with "HG".
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Example of a generated history table

In the following example, we are historizing a table called product. Let us assume this table declares
three fields in EBX data model:

Product
+ productld: int
 price: int
» beginDate: Date

The diagram below shows the resulting relational schema:

HV_USER HW_ACTION
E B H&_proeduct
user i int action id . int HV_INSTANCE
name : vaichar built_in_action_name : varchar B ﬂ »init.
procedure_name instance id L int 1 0. |instanee id:int
TEfErEnce | Warchan
flcuser_i 1 content_type : varchar f: instance_id op:e_ud A
1 = o productld : int
fi: action_id Dpraductid : char
1 # Instance_ld price | HUMBER
0.* a." 0. Oprice : char
beginDate : DATE
HV_TX HY_TXA_STAT DbeginDate : char
1 =
e id ¢ int == 1 2. b id ¢ int T
usai_id ; int | ot instanea_id ; int 1
action_id : int s s int DL generated table, one per E8X table
nhome_id : meanchar nb_ereates : int 1o histonze.
session_id @ mearchar nb_updates ! int Here the EBX table is"product snd defines
timestamp : int nb_deletes : ink the columns produsild, price and beginD ate.
wuid ; warchas
execution_inde ;| nvarehar :
Fravides salistiss aboul the
g, ™zessian_id| 4 actually updated tables, so asto
fie: home_id 1 q awoid to lookup them in all the database,
HY_HOM Hw_SESSION
home id:int sogmion id :int

hame_name : varchar
home_type @ vanchar
mesuAdtr | int

session_type : warchar
Ip_address : varchar
http_id : warchar
tracking_info : mearchar

Activating history on this table generates the HG_product table shown in the history schema structure
above. Here is the description of its different fields:

e tx_id: transaction ID.

» instance: instance ID.

« op: operation type - C (create), U (update) or D (delete).

e productId: productId field value.

+ OproductId: operation field for productid, see next section.
« price: price field value.

» Oprice: operation field for price, see next section.

o beginbDate: date field value.

» ObeginDate: operation field for beginDate, see next section.

Combination of operations

If several operations are combined in the same transaction, the operation field is resolved as follows:
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e C+ U ->C
D+U->D
D+C ->U

C + D -> {} (no entry in history)

Values for operation fields

For each functional field, an additional operation field is defined, composed of the field name prefixed
by the character 0. This field specifies whether the functional field has been modified. It is set to one
of the following values:

« null: if the functional field value has not been modified (and its value is not INHERIT).
« M: if the functional field value has been modified (not to INHERIT).
 D: if record has been deleted.
If inheritance [p 270] is enabled, the operation field can have three additional values:
« T:if the functional field value has not been modified and its value is INHERIT.
« 1I:if the functional field value has been set to INHERIT.
+ 0: if the record has been set to OCCULTING mode.

44.5 Impacts and limitations of historized mode

The history feature has some impacts and known limitations, which are listed in this section. If
using historized mode, it is strongly recommended to read these limitations carefully and to contact
TIBCO Software Inc. support in case of questions.

Validation

Some EBX data model constraints become blocking constraints when table history is activated. For
more information, see the section Structural constraints [p 249].

Data model restrictions for historized tables
Some restrictions apply to data models containing historized tables:

« Data model restrictions due to mapped mode [p 249]

» Limitations exist for two types of aggregated lists: aggregated lists under another aggregated list,
and aggregated lists under a terminal group. Data models that contain such aggregated lists can
be used, however these lists will be ignored (not historized).

» Computed values are ignored.
 Linked fields are ignored.
» User-defined attributes on historized tables result in data model compilation errors.
Data model evolutions may also be constrained by the underlying RDBMS, depending on the data

already contained in the concerned tables.

See alsoData model evolutions [p 265]
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Other limitations of historized mode

No data copy is performed when a table with existing data is activated for history.

Global operations on datasets are not historized (create an instance and remove an instance), even
if they declare a historized table.

Default labels referencing a non-historized field are not supported for historized tables.

As a consequence, default labels referencing a computed field are not supported for historized
tables.

The workaround is to implement the uLabelRenderer interface and adapt the label computation
for history.

D3: the history can be enabled in the delivery dataspace of a primary node, but in the delivery
dataspace of the replica nodes, the historization features are always disabled.

Recorded user in history: for some specific operations, the user who performs the last operation
and the one recorded in the corresponding history record may be different.

This is due to the fact that these operations are actually a report of the data status at a previous state:

« Archive import: when importing an archive on a dataspace, the time and user of the last
operation performed in the child dataspace are preserved, while the user recorded in history
is the user who performs the import.

« Programmatic merge: when performing a programmatic merge on a dataspace, the time and
user of the last operation performed in the child dataspace are preserved, while the user
recorded in history is the user who performs the merge.

« D3: for distributed data delivery feature, when a broadcast is performed, the data from the
primary node is reported on the replica node and the time and user of the last operation
performed in the child dataspace are preserved, while the user recorded in history is 'ebx-
systemUser' who performs the report on the replica node upon the broadcast.
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CHAPTER 45

Replication

This chapter contains the following topics:
1. Overview

. Configuring replication

. Accessing a replica table using SQL

2
3
4. Requesting an 'onDemand' replication refresh
5

. Impact and limitations of replication

45.1 Overview

Data stored in the TIBCO EBX repository can be mirrored to dedicated relational tables to enable
direct access to the data by SQL requests and views.

Like history, this data replication is transparent to end-users and client applications. Certain actions
trigger automatic changes to the replica in the database:

» Activating replication at the model-level updates the database schema by automatically executing
the necessary DDL statements.

» Data model evolutions that impact replicated tables, such as creating a new column, also
automatically update the database schema using DDL statements.

« When using the 'onCommit' refresh mode: updating data in the EBX repository triggers the
associated inserts, updates, and deletions on the replica database tables.

See also

History [p 251]

Data model evolutions [p 265]

Repository administration [p 396]

Note

replicated table: refers to a primary data table that has been replicated

replica table (or replica): refers to a database table that is the target of the replication
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45.2 Configuring replication

Enabling replication

To define a replication unit on a data model, use the element osd:replication under the elements
annotation/appinfo. Each replication unit specifies tables in a single dataset in a specific dataspace.

The nested elements are as follows:

Element

Description

Required

name

Name of the replication unit. This name identifies a replication
unit in the current data model. It must be unique.

Yes

dataSpace

Specifies the dataspace relevant to this replication unit. It
cannot be a snapshot.

dataSet

Specifies the dataset relevant to this replication unit.

refresh

Specifies the data synchronization policy. The possible policies
are:

« oncommit: The replica table content in the database is
always up to date with respect to its source table. Every
transaction that updates the EBX source table triggers the
corresponding insert, update, and delete statements on the
replica table.

« onbDemand: The replication of specified tables is only
done when an explicit refresh operation is performed. See

Requesting an 'onDemand' replication refresh (p 2621.

table/path

Specifies the path of the table in the current data model that is
to be replicated to the database.

table/nameInDatabase

Specifies the name of the table in the database to which the
data will be replicated. This name must be unique amongst all
replications units.

table/element/path

Specifies the path of the aggregated list in the table that is to be
replicated to the database.

table/element/
nameInDatabase

Specifies the name of the table in the database to which the data
of the aggregated list will be replicated. This name must be
unique amongst all replications units.

Yes

For example:

<xs:schema>
<xs:annotation>
<xs:appinfo>
<osd:replication>

<name>ProductRef</name>

<dataSpace>ProductReference</dataSpace>
<dataSet>productCatalog</dataSet>
<refresh>onCommit</refresh>

<table>

<path>/root/domainl/tableA</path>
<nameInDatabase>PRODUCT_REF_A</nameInDatabase>

</table>
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<table>
<path>/root/domainl/tableB</path>
<nameInDatabase>PRODUCT_REF_B</nameInDatabase>
<element>
<path>/retailers</path>
<nameInDatabase>PRODUCT_REF_B_RETAILERS</nameInDatabase>
</element>
</table>
</osd:replication>
</xs:appinfo>
</xs:annotation>

<};é:schema>
Notes:

« See Data model restrictions for replicated tables [p 262]

« If, at data model compilation, the specified dataset and/or dataspace does not exist in the current
repository, a warning is reported, but the replica table is created in the database. Once the specified
dataspace and dataset are created, the replication becomes active.

» At data model compilation, if a table replication is removed, or if some of the above properties
has changed, the replica table is dropped from the database, and then recreated with the new
definition if needed.

Disabling replication on a specific field or group

For a replicated table, the default behavior is to replicate all its supported elements (see Data model
restrictions for replicated tables [p 262]).

It is possible to disable replication for a specific field or group, either through the data model assistant,
or by editing the underlying data model.
To disable the replication of a field or group by editing the data model, use the element
osd:replication with the attribute disable="true".
<xs:element name="longDescription" type="xs:string">
<xs:annotation>
<xs:appinfo>
<osd:replication disable="true" />
</xs:appinfo>

</xs:annotation>
</xs:element>

To disable the replication of a field or group through the data model assistant, use the Replication
property in the Advanced properties of the element.

When this property is defined on a group, replication is disabled recursively for all its descendents.
Once a group disables replication, it is not possible to specifically re-enable replication on a
descendant.

Note
If the table containing the field or group is not replicated, this property will not have any effect.

It is not possible to disable replication for primary key fields.

45.3 Accessing a replica table using SQL

This section describes how to directly access a replica table using SQL.

See alsoSQL access to history [p 254]
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Finding the replica table in the database

For every replicated EBX table, a corresponding table is generated in the RDBMS. Using the EBX
user interface, you can find the name of this database table by clicking on the documentation pane
of the table.

Access restrictions

The replica database tables must only be directly accessed in read-only mode. It is the responsibility
of the database administrator to block write-access to all database users except the one that EBX uses.

See alsoRules for the database access and user privileges [p 397]

SQL reads

Direct SQL reads are possible in well-managed, preferably short-lived transactions. However, for such
accesses, EBX permissions are not taken into account. As a result, applications given the privilege to
perform reads must be trusted through other authentication processes and permissions.

45.4 Requesting an 'onDemand' replication refresh

The 'onDemand' refresh policy requires an explicit request to refresh the replicated table data.
There are several ways to request a replication refresh:

» User interface: In the dataset actions menu, use the action '"Refresh replicas' under the group
"Replication' to launch the replication refresh wizard.

« Data services: Use the replication refresh data services operation. See Replication refresh [p 722]
for data services for more information.

API

- Java API: Call the Replicationunit.performRefresh™ methods in the Replicationunit API to
launch a refresh of the replication unit.

45.5 Impact and limitations of replication

The replication feature has some known limitations and side-effects, which are listed below.
If using replication, it is strongly recommended to read this section carefully and to contact
TIBCO Software Inc. support in case of questions.

See Supported databases [p 320] for the databases for which replication is supported.

Validation

Some EBX data model constraints become blocking constraints when replication is enabled. For more
information, see Structural constraints [p 249].

Data model restrictions for replicated tables
Some restrictions apply to data models containing tables that are replicated:

« Data model restrictions due to mapped mode [p 249]

« Dataset inheritance is not supported for the 'onCommit' refresh policy if the specified dataset is
not a root dataset or has not yet been created. See dataset inheritance [p271] for more information.
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Field inheritance is also only supported for the 'onDemand' refresh policy. This means that, at
data model compilation, an error is reported if the refresh mode is 'onCommit' and the table to be
replicated has an inherited field. See inherited fields [p 272] for more information.

Computed values are ignored.
Linked fields are ignored.

Limitations exist for two types of aggregated lists: aggregated lists under another aggregated list,
and aggregated lists under a terminal group. Data models that contain such aggregated lists can
be used, however these lists will be ignored (not replicated).

User-defined attributes are not supported. A compilation error is raised if they are included in a
replication unit.

Data model evolutions may also be constrained by the underlying RDBMS, depending on the data
already contained in the concerned tables.

See alsoData model evolutions [p 265]

Database configuration

The refresh operation is optimized to transmit only the rows of the source table that have been modified
(with respect to creation and deletion) since the last refresh. However, depending on the volume of
data exchanged, this can be an intensive operation, requiring large transactions. In particular, the first
refresh operation can concern a large number of rows. It is necessary for the database to be configured
properly to allow such transactions to run under optimal conditions.

For instance, with Oracle:

It is mandatory for the bulk of all replica tables in a replication unit to fit into the 'UNDO'
tablespace.

It is recommended to provide enough space in the buffer cache to allow those transactions to run
with minimal disk access.

It is recommended to provision 'REDQ' log groups big enough to avoid those transactions to wait
for the 'db_writer' process.

Distributed data delivery (D3)

Replication is available on both D3 primary and replica delivery dataspaces. On the primary dataspace,
the replication behavior is the same as in a standard semantic dataspace, but on replica dataspaces,
the replicated content is that of the last broadcast snapshot.

In a replica delivery dataspace, some restrictions occur:

The refresh policy defined in the data model has no influence on the behavior described above:
replication always happens on snapshot.

The action item Refresh replicas is not available.

It is not allowed to invoke the Replicationunit.performRefresh™ method.

See alsoD3 overview [p 462]

Other limitations of replication

Limitations of supported databases [p 320]
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« For inheritance, a replica record field cannot hold the "inherit value" flag
(Adaptationvalue.INHERIT_VALUE). It only holds the inherited value in such cases. More
generally, it is not possible to distinguish inheriting state from overwriting state.
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CHAPTER 46

Data model evolutions

This chapter describes the modifications that are possible on data models, as well as potential
limitations.

Attention

Whenever the data modeler performs an evolution on the primary key of a table, the resulting
definition is considered as a new table. In such cases, if existing data must be preserved in some
ways, a data migration plan must be set up and operated before the new data model is published or
deployed. It can also be noted that data is not destroyed immediately after the data model evolution;
if the data model is rolled back to its previous state, then the previous data is retrieved.

Note

Certain types of data model evolutions cannot be performed directly in the user interface,
and thus the data model must be exported, modified in XSD format, then re-imported.
For changes to a data model that impact its configuration, not just its structure, the
XSD must be imported into TIBCO EBX from a module. Otherwise, the configuration
modifications are not taken into account.

See alsoMapped mode [p 249]

This chapter contains the following topics:

1. Types of permitted evolutions

2. Limitations/restrictions

46.1 Types of permitted evolutions

This section describes the possible modifications to data models after their creation.

Model-level evolutions
The following modifications can be made to existing data models:

» Replication units can be added to the data model. If their refresh policy is 'onCommit’, the
corresponding replica tables will be created and refreshed on next schema compilation.

» Replication units can be removed from the data model. The corresponding replica tables will be
dropped immediately.
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« The data model can be deleted. If it declares replication units, the corresponding replica tables
will be dropped immediately. If it contains historized tables, this change marks the associated
mapped tables as disabled. See Database mapping [p 441] for the actual removal of associated
database objects.

Table-level evolutions
The following modifications can be made to a data model at the table-level:
+ A new table can be added. Upon creation, the table can also declare one or more mapped modes.

» An existing table can be deleted. If it declares replication units, the corresponding replica tables
will be dropped immediately. If it historized, this change marks the mapped table as disabled. See
Database mapping [p 441] for the actual removal of associated database objects.

» History can be enabled or disabled on a table. History will not take into account the operations
performed while it is disabled.

» A table can be renamed. Data should be manually migrated, by exporting then re-importing an
XML or archive file, because this change is considered to be a combination of deletion and
creation.

Field-level evolutions
The following modifications can be made to a data model at the field-level:
+ A new field can be added.

+ An existing field can be deleted. The data of the deleted field will be removed from each record
upon its next update. For a replica table, the corresponding column is automatically removed. In
history mode, the field is marked as disabled.

+ A field can be specifically disabled from the history or replication which applies to its containing
table, by using the attribute disable="true". For a replica table, the corresponding column is
automatically removed. For a history table, the column remains but is marked as disabled. See
Disabling history on a specific field or group [p 252] and Disabling replication on a specific field
or group [p 261].

» The facets of a field can be modified, except for the facets listed under Limitations/restrictions
[p 266].

The following changes are accepted, but they can lead to a loss of data. Data should be migrated
manually, by exporting then re-importing an XML or archive file, since these changes are considered
to be a combination of deletion and creation:

« A field can be renamed.

« The type of a field can be changed.

46.2 Limitations/restrictions

Limitations related to primary key evolutions
When a primary key definition is modified:

» The content of the table will be reset to an empty content, in all datasets and dataspaces.
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If the new primary key has been used in the past, the content of the table will be reset to the
previous data existing at the time this primary key was used, in all datasets and dataspaces.

The modification will be rejected if the table has - or has had - history activated in the existing
dataspaces. A possible workaround: first drop the history table associated with the dedicated table,
then proceed to modifying the primary key. For the procedure to purge mapped table database
resources, see Database mapping [p 441].

Note

If the modified primary key is referenced in the primary key of another table, all the
limitations mentioned above apply to the target table.

Limitations related to foreign key evolutions

When the declaration of a osd: tableRef facet is added or modified, or when the primary key of
its target table is modified, the existing values will restart from empty (except if this modification
is reverting to a previous definition; in this case, the previous content will be retrieved).

In replication mode, the structure of a foreign key field is set to match that of the target primary
key. A single field declaring an osd:tableRef constraint may then be split into a number of
columns, whose number and types correspond to that of the target primary key. Hence, the
following cases of evolutions will have an impact on the structure of the mapped table:

+ declaring a new osd: tableRef constraint on a table field;
« removing an existing osd: tableRef constraint on a table field;

 adding (resp. removing) a column to (resp. from) a primary key referenced by an existing
osd:tableRef constraint;

« modifying the type or path for any column of a primary key referenced by an existing
osd: tableRef constraint.

These cases of evolution will translate to a combination of field deletions and/or creations.
Consequently, the existing data should be migrated manually.

Limitations related to field-level evolutions

When changing the type of a field to an incompatible type or cardinality, the field will be considered
as a new one, and start with an empty content. The previous content will be retrieved if the model is
rolled back to a previous definition.

The following types are fully inter-convertible (meaning these types have the same exact
persistent representation, and can be substituted to each other in the following charts):

e Xxs:string

e osd:color

e osd:datasetName
e osd:dataspaceKey
e osd:email

e osd:html

e osd:local

e osd:resource
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XS

XS

:nmtoken

:nmtokens

osd: text

XS

XS

ranyUri

hame

« The following conversions are fully supported (that is, regardless of their cardinalities):

XS

XS

XS

XS

XS

XS

XS

XS

XS

XS

:decimal to xs:string

:datetime to xs:string

:date to xs:string

;integer to xs:string

:int to xs:decimal

:integer to xs:decimal

:decimal to xs:integer (losing the decimal part)
:int to xs:integer

:datetime to xs:date (losing the time part)

:date to xs:datetime (defaulting the time part to 0)

» The following conversions are possible only if the original type is single-valued:

XS

XS

XS

XS

:boolean to xs:string
:time to xs:string
:int to xs:string

:long to xs:string

The cardinality of a type can be changed; when the conversion is supported, it has the following
behavior:

«  When changing a single element to an aggregated list, the previous single value is preserved and
added to the new aggregated list.

« When changing an aggregated list to a single element, only the last value of the aggregated list
is preserved in the single element. Other values are lost.

Attention

Groups and complex types do not support conversion to (and from) any other types. Moreover, when
a group or complex type changes between single-occurrenced and multi-occurrenced, the conversion
is supported only if the group or complex type is terminal.
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CHAPTER 47

Inheritance and value resolution

This chapter contains the following topics:
1. Overview

2. Dataset inheritance

3. Inherited fields
4. Optimize & Refactor service

47.1 Overview

The principle of inheritance is to mutualize resources that are shared by multiple contexts or
entities. TIBCO EBX offers mechanisms for defining, factorizing and resolving data values: dataset
inheritance and inherited fields.

Furthermore, functions can be defined to compute values.

Note

Inheritance mechanisms described in this chapter should not be confused with "structural
inheritance", which usually applies to models and is proposed in UML class diagrams
for example.

See alsolnheritance (glossary) [p 29]

Dataset inheritance

Dataset inheritance is particularly useful when data applies to global enterprise contexts, such as
subsidiaries or business partners.

Given a hierarchy of datasets, it is possible to factorize common data into the root or intermediate
datasets and define specialized data in specific contexts.

The dataset inheritance mechanisms are detailed below in Dataset inheritance [p 271].

Inherited fields

Contrary to dataset inheritance, which exploits global built-in relationships between datasets, inherited
fields exploit finer-grained dependencies that are specific to the data structure. It allows factorizing
and specializing data at the business entities-level.
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For example, if the model specifies that a '"Product' is associated with a 'FamilyOfProducts', it
is possible that some attributes of 'Product’ inherit their values from the attributes defined in the
associated 'FamilyOfProducts'.

Note

When using both inheritance mechanisms in the same dataset, field inheritance has
priority over dataset inheritance.

Computed values (functions)

In the data model, it is also possible to specify that a node holds a computed value. In this case, the
specified JavaBean function will be executed every time the value is requested.

The function is able to take into account the current context, such as the values of the current record
or computations based on another table, and to send requests to third-party systems.

See alsoComputed values [p 569]

47.2 Dataset inheritance

Dataset inheritance declaration

The dataset inheritance mechanism is declared as follows in a data model:

<xs:schema xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
xmlns:ebxbnd="urn:ebx-schemas:binding_1.0">
<xs:annotation>
<xs:appinfo>
<osd:inheritance>
<dataSetInheritance>all</dataSetInheritance>
</osd:inheritance>
</xs:appinfo>
</xs:annotation>

</xs:schema>

The element osd:inheritance defines the property dataSetInheritance to specify the use of
inheritance on datasets based on this data model. The following values can be specified:

« all, indicates that inheritance is enabled for all datasets based on the data model.
« none, indicates that inheritance is disabled for all datasets based on the data model.

If not specified, the inheritance mechanism is disabled.

Value lookup mechanism
The dataset inheritance lookup mechanism for values proceeds as follows:
1. If the value is locally defined, it is returned.
It can be explicitly null.

2. Otherwise, looks up the first locally defined value according to the built-in child-to-parent
relationship of the dataset in the hierarchy of datasets.

3. If no locally defined value is found, the default value is returned.
If no default value is defined, null is returned.
Note: Default values cannot be defined on:

+ A single primary key node
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« Auto-incremented nodes

« Nodes defining a computed value

Record lookup mechanism

Like values, table records can also be inherited as a unit by multiple contexts, but they can also be
partially redefined (overwritten), defined for a specific context (root mode), or be occulted.

Formally, a table record has one of four distinct definition modes:

root record Locally defined in the table and has no parent. This means
that no record with the same primary key exists in the parent
table, or that this parent is an occulting record.

overwriting record Locally defined in the table and has a parent record. This
means that a record with the same primary key exists in the
parent table, and that this parent is not an occulting record.
The overwriting record inherits its values from its parent,
except for the values that it explicitly redefines.

inherited record Not locally defined in the current table and has a parent
record. All values are inherited.

Functions are always resolved in the current record context
and are not inherited.

occulting record Specifies that, if a parent with the same primary key is
defined, this parent will not be visible in table descendants.

See alsoDataset inheritance [p 145]

Defining inheritance behavior at the table level

It is also possible to specify management rules in the declaration of a table in the data model.

See alsoProperties related to dataset inheritance [p 535]

47.3 Inherited fields

The specific inheritance mechanism allows fetching a value of a field according to its relationship
to other tables.

Field inheritance declaration

Specific inheritance must be specified on terminal nodes in the underlying data model and is declared
as follows:

<xs:element name="sampleInheritance" type="xs:string">
<xs:annotation>
<xs:appinfo>
<osd:inheritance>
<sourceRecord>
/root/tablel/fkTable2, /root/table2/fkTable3
</sourceRecord>
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<sourceNode>color</sourceNode>
</osd:inheritance>

</xs:appinfo>
</xs:annotation>
</xs:element>

The element sourceRecord is an expression that describes how to look up the record from which the
value is inherited. It is a foreign key, or a sequence of foreign keys, from the current element to the
source table.

If sourceRrecord is not defined in the data model, the inherited fields are fetched from the current
record.

The element sourceNode is the path of the node from which to inherit in the source record.

The following conditions must be satisfied for specific inheritance:

The element sourceNode is mandatory.

The expression for the path to the source record must be a consistent path of foreign keys, from
the current element to the source record. This expression must involve only one-to-one and zero-
to-one relationships.

The sourceRecord cannot contain any aggregated list elements.
Each element of the sourceRecord must be a foreign key.

If the inherited field is also a foreign key, the sourceRecord cannot refer to itself to get the path
to the source record of the inherited value.

Every element of the sourceRecord must exist.

The source node must belong to the table containing the source record.

The source node must be terminal.

The source node must be writeable.

The source node type must be compatible with the current node type.

The source node cardinalities must be compatible with those of the current node.

The source node cannot be the same as the inherited field if the fields to inherit from are fetched
into the same record.

Value lookup mechanism

The lookup mechanism for inherited fields values proceeds as follows:

1. If the value is locally defined, it is returned.

It can be explicitly null

2. Otherwise, looks up the source record and value to inherit from, according to the properties that

are defined in the data model.

3. The process is recursive; if the source node does not locally define a value, it is then looked up

according to the inheritance behavior of the source node.

47.4 Optimize & Refactor service

EBX provides a built-in user service for optimizing the dataset inheritance in the hierarchy of datasets.
This service performs the following functions:
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« Handles duplicated values: Detects and removes all parameter values that are duplicates of the
inherited value.

+  Mutualizes common values: Detects and mutualizes the common values among the descendants
of a common ancestor.

Procedure details

Datasets are processed from the bottom up, which means that if the service is run on the dataset at
level N, with N+1 being the level of its children and N+2 being the level of its children's children, the
service will first process the datasets at level N+2 to determine if they can be optimized with respect
to the datasets at level N+1. Next, it would proceed with an optimization of level N+1 against level N.

Note
» These optimization and refactoring functions do not handle default values that are
declared in the data model.

» The highest level considered during the optimization procedure is always the dataset on
which the service is run. This means that optimization and refactoring are not performed
between the target dataset and its own ancestors.

« Table optimization is performed on records with the same primary key.
+ Inherited fields are not optimized.

» The optimization and refactoring functions do not modify the resolved view of a dataset,
if it is activated.

Service availability

The 'Optimize & Refactor' service is available on datasets that have child datasets and have the
'Activated' property set to 'No' in their dataset information.

The service is available to any profile with write access on current dataset values. It can be disabled
by setting restrictive access rights on a profile.

Note

For performance reasons, access rights are not verified on every node and table record.
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CHAPTER 48

Permissions

Permissions dictate the access each user has to data and actions.
This chapter contains the following topics:
1. Overview

Important considerations about permissions

Defining user-defined rules

Defining dynamic rules
Resolving permissions on data

Resolving permissions on services

N o ok WD

Resolving permissions on actions

48.1 Overview

Permissions are related to whether actions are authorized or not. They are also related to access rights,
that is, whether an entity is hidden, read, or read-write. The main entities controlled by permissions are:

» Dataspace
« Dataset

+ Table

« Group

» Field

Users, roles and profiles

The definition and resolution of permissions make extensive use of the notion of profiles, which is
the generic term applied to users or roles.

Each user can participate in several roles, and a role can be shared by several users.

These relationships are defined in the user and roles directory. See Users and roles directory [p 4351.
Special definitions:
A built-in administrator is a member of the built-in role 'ADMINISTRATOR'.
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« An owner of a dataset is a member of the owner attribute specified in the information of a root
dataset. In this case, the built-in role 'OWNER' is activated when permissions are resolved in the
context of the dataset.

« An owner of a dataspace is a member of the owner attribute specified for a dataspace. In this
case, the built-in role 'OWNER' is activated when permissions are resolved in the context of the
dataspace.

Permission rules
A permission rule defines the authorization granted to a profile for a particular entity.

User-defined permission rules are created through the user interface. See the section Defining user-
defined rules [p 280].

Dynamic permission rules can be either programmatic rules created by developers, or scripted rules
created by administrators. See the section Defining dynamic rules [p 2841.

Resolution of permissions

Permissions are always resolved in the context of an authenticated user session, thus permissions are
mainly based on the user profiles.

In general, resolution of permissions is performed restrictively between a given level and its parent
level. Thus, at any given level, a user cannot have a higher permission than the one resolved at a
parent level.

Dynamic permissions are always considered to be restrictive.

Note
In the Java API, the class SessionPermissions™ provides access to the resolved
permissions.
See also

Resolving permissions on data [p 286]

Resolving permissions on services [p 289]

Resolving permissions on actions [p 291]

Owner and administrator special permissions

On a dataset
A built-in administrator or owner of a dataset can perform the following actions:
« Manage its permissions

» Change its owner, if the dataset is a root dataset

TIBCO EBX® Product Documentation 6.0.5 276



Documentation > Reference Manual > Other > Permissions

« Change its general information (localized labels and descriptions)

Attention

While the definition of permissions can restrict a built-in administrator or dataset owner's right to
view data or perform certain actions, it remains possible for them to modify their own access, as
they will always have access to permissions management.

On a dataspace
To be a super owner of a dataspace, a user must either:
« Own the dataspace and be allowed to manage its permissions, or

+ Own a dataspace that is an ancestor of the current dataspace and be allowed to manage the
permissions of that ancestor dataspace.

A built-in administrator or super owner of a dataspace can perform the following actions:
« Manage its permissions of dataspace.
« Change its owner
» Lock it or unlock it
« Change its general information (localized labels and descriptions)

Furthermore, in a workflow, when using a "Create a dataspace" or "Create a snapshot" built-in script
task, resolved permissions are computed using the owner defined in the script task's configuration,
rather than the current session. This is because, in these cases, the current session is associated with
a system user.

Attention

While the definition of permissions can restrict a built-in administrator or dataspace owner's right
to view data or perform certain actions, it remains possible for them to modify their own access, as
they will always have access to permissions management.

Impact of merge on permissions

When a dataspace is merged, the permissions of the child dataset are merged with those of the parent
dataspace if and only if the user specifies to do so during the merge process. The permissions of its
parent dataspace are never impacted.

If some elements are hidden for the profile attempting to perform a merge, it will not be possible to
proceed as the impacts of the merge on data will not be fully visible.

48.2 Important considerations about permissions

In this section are listed some very important information that must be kept in mind while working
with permissions.

Actions and user services granting high privileges

The following actions and their related user services must only be allowed to trusted administrators:
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« 'Create dataspace' (gives the 'owner' role, which grants the right to define the dataspace
permissions)

» 'Create dataset' (gives the 'owner' role, which grants the right to define the dataset permissions)

+ 'Import archive' (allows writing the archive content regardless of any permission)

Note

See the Owner and administrator special permissions [p 276] section for more
information about the privileges granted to these profiles.

API access without permission checks

Developers and administrators must be aware that some parts of the API can run without any
permission check. In general if the code run in a context with a session™ provided, it means that
permissions will be checked. Here are some specific cases where permissions are not checked:

« When a Java procedure disables all permission checks by using ProcedureContext.

1

setAllPrivileges™.

« When accessing EBX data by directly querying your database, in the case a table enables the
replication mode [p 248], or the historization [p 248]. This is because EBX permissions are not
"translated" in the underlying database. As a consequence, either the database access must be
globally restricted or proper permissions must be defined in it.

Using permission for hiding information in the Ul

Using the permissions only to hide in the UI some non sensitive information is highly unadvised,
especially if this information is likely to be used for filtering / joining / sorting in some queries. In such
cases, Ul-only hiding methods should be used instead. For instance by setting the field as hidden for
default views [p 581] in the datamodel property and/or by creating views [p 421] for the concerned
users.

Limitations of the permission checks in Query API

The permission check performed when specifying a session in a Query™ or Request™ will throw a
QueryPermissionException™ if any field used in the query is hidden for the current user. However
there are some specificities to know that are described hereafter:

« Fields belonging to primary keys are not checked and are always considered as usable.

» AccessRule™ set on fields which are record-dependent are ignored by this permission check.
In other words, method AccessRule.getPermission™ is only called with the dataset as the
aDataSetOrRecord parameter, never with a record.

As a consequence to the last point, it is recommended be very vigilant when using this kind of rules
because a malicious user could "guess" sensitive information by filtering or sorting on these nodes
when using a component relying on these API. For instance, a developer could decide to prevent
the query to run as soon as a field has an AccessRule™ defined on it, to remove such criteria before
executing the query, or to completely hide the records for which some fields are confidential.
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Scripted permission rules on records and table history

There is currently a limitation when a table has both the history activated and a scripted permission
rule on record specified: for security reason access to the table history is totally disabled for everyone.
Access to history will be allowed in a future version.

Using hidden fields in custom display labels

Resolution of custom display labels for tables (‘defaultLabel' property) and relationships (‘display’
property) takes into account permission. As soon as an hidden field is detected in the label, the primary
key will be displayed instead.

Note

This is not the case when using API like TableRefDisplay”™ or Adaptation.
getLabelorName™. Since the provided contexts do not contain the current session, no
permission check can be performed. As a consequence, developer should make sure that
no confidential data is exposed when using these APIs.

Note

Also note that quick search will ignore nodes with hidden fields in custom display label
in the context of history view and/or in a child dataset.

Because of this behavior it is highly discouraged to use labels for filtering in a query. When labels
with hidden fields are used, it will be replaced by the pk value and the filter will become inconsistent.

Linked field permission check

When a linked field [p 5491 access permission is computed, the result is the minimum between the
permission applying to the node in the main table and the node in the target table. Practically it means
that if a field is hidden in a table, all linked fields pointing on it in other tables will also be hidden.

Table action permission related limitations

When performing actions on a table (create, delete, overwrite or occult) in a procedure, the current user
session access right on the table node is ignored during the permission resolution. Should this check
be performed, the client code must explicitly call SessionPermissions.getNodeAccessPermission™
beforehand in the procedure.

Permission cache life cycle

To optimize the resolution of permissions for both data and user services, a dedicated cache is
implemented at the session level. All permissions are cached including dynamic rules, it means that
a rule result should not change for the duration of the cache which is explained below.

The session cache life cycle depends on the context, as described hereafter:

+ Inthe UI, the cache is cleared for every non-ajax event (i.e on page display, pop-up opening, etc.).
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+ In programmatic procedures, the cache lasts until the end of the procedure, unless explicitly
cleared (see below).

Attention

When modifying permissions in a procedure context (by importing an EBX archive or merging
a dataspace programmatically), the session cache must be cleared via a call to Session.
clearcache™. Otherwise, these modifications will not be reflected until the end of the procedure.

48.3 Defining user-defined rules

Each level has a similar schema, which allows defining permission rules for profiles.
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Defining dataspace user-defined rules

For a given dataspace, the allowable permissions for each profile are as follows:

Dataspace access

Authorization

Write « Can view the dataspace.

« Can access datasets according to dataset permissions.
Read-only « Can view the dataspace and its snapshots.

« Can view child dataspaces, if allowed by permissions.

« Can view contents of the dataspace, though cannot modify them.
Hidden « Can neither see the dataspace nor its snapshots.

« If allowed to view child dataspace, can see the current dataspace but cannot select it.
« Cannot access the dataspace contents, including datasets.

« Cannot perform any actions on the dataspace.

Restriction policy

Indicates whether this dataspace profile-permission
association should have priority over other permissions
rules.

Create a child dataspace Indicates whether the profile can create child dataspaces

from the current dataspace.

Create a child snapshot Indicates whether the profile can create snapshots of the

current dataspace.

Initiate merge

Indicates whether the profile can merge the current
dataspace with its parent dataspace.

Export archive

Indicates whether the profile can export the current
dataspace as an archive.

Import archive

Indicates whether the profile can import an archive into the
current dataspace.

Close a dataspace

Indicates whether the profile can close the current
dataspace.

Close a snapshot

Indicates whether the profile can close a snapshot of the
current dataspace.

Rights on services

Indicates if a profile has the right to execute services
on the dataspace. By default, all dataspace services are
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allowed. A built-in administrator or super owner of the
current dataspace or a given user who is allowed to
modify permissions on the current dataspace can modify
these permissions to restrict dataspace services for certain

profiles.
Permissions of child dataspace When a user creates a child dataspace, the permissions
when created of this new dataspace are automatically assigned to the

profile's owner, based on the permissions defined under
"Permissions of child dataspace when created' in the parent
dataspace. If multiple permissions are defined for the owner
through different roles, the owner's profile behaves like any
other profile and permissions are resolved [p 276] as usual.

Defining dataset user-defined rules

For a given dataset, the allowable permissions for each profile are as follows:

Actions on datasets

Restriction policy Indicates whether this dataset profile-permission
association should have priority over other permissions
rules.

Create a child dataset Indicates whether the profile has the right to create a child

dataset of the current dataset.

Duplicate dataset Indicates whether the profile has the right to duplicate the
current dataset.

Change the dataset parent Indicates whether the profile has the right to change the
parent dataset of a given child dataset.
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Actions on tables

The action rights on default tables are defined at the dataset level. It is then possible to override these
default rights for one or more tables. The allowable permissions for each profile are as follows:

Create a new record Indicates whether the profile has the right to create records
in the table.

Overwrite inherited record Indicates whether the profile has the right to overwrite
inherited records in the table.

Occult inherited record Indicates whether the profile has the right to occult inherited
records in the table.

Delete a record Indicates whether the profile has the right to delete records
in the table.

Access rights on node values

Permissions defined on specific terminal nodes override their default access rights.

Read-write Can view and modify node values.
Read Can view nodes, but cannot modify their values.
Hidden Cannot view nodes.

Permissions on services

A built-in administrator or an owner of the current dataspace can modify the service default permission
to either restrict or grant access to certain profiles.

Enabled Grants service access to the current profile.

Disabled Forbids service access to the current profile. It will not
be displayed in menus, nor will it be launchable via web
components.

Default Sets the service permission to enabled or disabled,
according to the default permission defined upon service
declaration.

See ActivationContext.setDefaultPermission™ for more
information.
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48.4 Defining dynamic rules

Dynamic rules give the possibility to define more precisely the conditions for accessing data or user
services depending on the context.

There are different types of programmatic rules:

APT

the AccessRule™, described in the section below Defining access rules on data [p 284].

the scripted record permission rule, described in the section below Defining scripted permission
rules on data [p 284].

the ServiceActivationRule [p 285], described in the section below Defining activation rules on
service [p 285].

the servicePermissionRule™’, described in the section below Defining permission rules on
service [p 285].

Defining scripted permission rules on data

scripted permission rules are rules that dynamically define, depending on the context, the read/write
rights on the records of a table.

To define such a rule, a record permission script [p 894] must be created in the DMA. A script editor
is available on the table node definition, in the "Extensions" tab.

Defining access rules on data

AccessRules are rules that programmatically define, depending on the context, the read/write rights
on a data model node or on the records of a table.

The definition of an AccessRule is performed as follows:

1. Creation of a rule in the form of a Java class implementing the AccessRule™ or

API

AccessRuleForcreate™ interface.

Assignment of this rule to concerned nodes in the schema extension: SchemaExtensions™.

According to the rule target (model node(s) or records) and type (AccessRule
or AccessRuleForCreate), several methods such as SchemaExtensionsContext.
setAccessRuleOnOccurrence™ or SchemaExtensionsContext.setAccessRuleForCreateOnNode™
can be used.

The rule thus assigned is said to be "local" and is only executed when the target entity is requested.
See Resolving permissions on data [p 286] for more information.

Attention

Only one AccessRule can be defined for each node, dataspace or record. Only one
AccessRuleForCreate can be defined for each table child node. The definition of a new
programmatic rule of one type will lead to the replacement of the existing one.
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Defining activation rules on service

The serviceActivationRules allow to specify if a service is activated or not for a given dataspace or
dataset. A service that has been deactivated through this rule is never available in the entity for which
it is deactivated, regardless of the current profile, for execution or display, even in permission screens.

The definition of a ServiceActivationRule is carried out as follows:

1. Creation of a rule in the form of a Java class implementing the
ServiceActivationRuleForDataspace™ interface or ServiceActivationRuleForDataset™,
depending on the service type.

2. Assignment of this rule to the impacted services at their declaration level, depending

on the service type, via the ActivationContextOnDataspace.setActivationRule or
ActivationContextWithDatasetSet.setActivationRule™ methods.

The resulting assigned rule will be evaluated during the service activation evaluation. See
Resolving permissions on services [p 289] for more information.

Defining permission rules on service

The servicePermissionRules are advanced rules allowing to dynamically define the display and
execution conditions of a service depending on the context (current session, selected entity, etc.). The
service should be activated for the current context beforehand for this type of rule to be triggered.

The definition of a ServicePermissionRule is carried out as follows:

1. Creation of a rule in the form of a Java class implementing the ServicePermissionRule™
interface.

2. Assignment of this rule to the impacted services:

o Either, for new services, at their declaration level via the ActivationContext.
setPermissionRule™ method.

The rule thus assigned is said to be "global" and is only executed when the service is activated
for the current context. See Resolving permissions on services [p 289] for more information.

« Or, for existing services, in the schema extension SchemaExtensions™
via the SchemaExtensionsContext.setServicePermissionRuleOnNode™ and
SchemaExtensionsContext.setServicePermissionRuleOnNodeAndAllDescendants”
methods. It is thus possible to assign a rule to any service, including standard services
provided by EBX, on one or more data model nodes: a table node, an association node, etc.

1

The rule thus assigned is said to be "local" and is only executed in the extended schema
context and when the node corresponds to the one specified. See Resolving permissions on
services [p 289] for more information.

Attention

Only one ServicePermissionRule can be defined for each model node. Thus, the definition
of a new programmatic rule will replace the existing one.
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48.5 Resolving permissions on data

Resolving user-defined rules

Access rights defined using the user interface are resolved on four levels: dataspace, dataset, record
(if applicable) and node.

If a profile is associated with restrictive access rights at a given level, the minimum of all restrictive
rights defined at that level is resolved. If no restrictions are defined at that level, the maximum of all
access rights defined at that level is resolved.

When a restrictive permission is defined for a profile, it takes precedence over the other permissions
potentially granted by the user's other roles. Generally, for all user-defined permission rules that match
the current user session:

« If some rules with restrictions are defined, the minimum permissions of these restricted rules are
applied.

+ If no rules having restrictions are defined, the maximum permissions of all matching rules are
applied.

Examples:

Given two profiles P1 and P2 concerning the same user, the following table lists the possibilities when
resolving that user's permission to a service.

P1 authorization P2 authorization Permission resolution

Enabled Enabled Enabled. Restrictions do not make any difference.

Disabled Disabled Disabled. Restrictions do not make any difference.
Enabled Disabled Enabled, unless P2's authorization is a restriction.

Disabled Enabled Enabled, unless P1's authorization is a restriction.

The same restriction policy is applied for data access rights resolution.

In another example, a dataspace can be hidden from all users by defining a restrictive association
between the built-in profile "Profile. EVERYONE" and the access right "hidden".

At any given level, the most restrictive access rights between those resolved at this level and higher
levels are applied. For instance, if a user's dataset access permissions resolve to read-write access,
but the container dataspace only allows read access, the user will only have read-only access to this
dataset.

Note

The dataset inheritance mechanism applies to both values and access rights. That is,
access rights defined on a dataset will be applied to its child datasets. It is possible to
override these rights in the child dataset.
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Access rights resolution example

In this example, there are three users who belong to the following defined roles and profiles:

User Profile

User 1 « userl
o r0le A

« 10le B

User 2 o user?2
« r0le A
« 10le B

o role C

User 3 e user3
. r0le A

e roleC

The access rights of the profiles on a given element are as follows:

Profile Access rights Restriction policy
userl Hidden Yes
user3 Read No
Role A Read/Write No
Role B Read Yes
Role C Hidden No

After resolution based on the role and profile access rights above, the rights that are applied to each
user are as follows:

User Resolved access rights
User 1 Hidden

User 2 Read

User 3 Read/Write
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Resolving dataspace and shapshot access rights
At dataspace level, access rights are resolved as follows:
« If a user has several rights defined through multiple profiles:

o If the rights include restrictions, the minimum of the restrictive profile-rights associations
is applied.

« Otherwise, the maximum of the profile-rights associations is applied.
o If the user has no rights defined:

o If the user is a built-in administrator or owner of the dataspace, read-write access is given
for this dataspace.

« Otherwise, the dataspace will be hidden.

Resolving dataset access rights

At the dataset level, the same principle applies as at the dataspace level. After resolving the access
rights at the dataset level alone, the final access rights are determined by taking the minimum rights
between the resolved dataspace rights and the resolved dataset rights. For example, if a dataspace is
resolved to be read-only for a user and one of its datasets is resolved to be read-write, the user will
only have read-only access to that dataset.

Resolving node access rights

At the node level, the same principle applies as at the dataspace and dataset levels. After resolving
the access rights at the node level alone, the final access rights are determined by taking the minimum
rights between the resolved dataset rights and the resolved node rights.

Specific access rights can be defined at the node level. If no specific access right is defined, the default
access right is used for the resolution process.

Note
The resolution procedure is slightly different for table and table child nodes.

Special case for table and table child nodes
This describes the resolution process used for a given table node or table record N.

For each user-defined permission rule that matches one of the user's profiles, the access rights for N
are either:

1. The locally defined access rights for N;
2. Inherited from the access rights defined on the table node;
3. Inherited from the default access rights for dataset values.

All matching user-defined permission rules are used to resolve the access rights for N. Resolution is
done according to the restriction policy [p 286].

The final resolved access rights will be the minimum between the dataspace, dataset and the resolved
access right for N.
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Resolving dynamic rules

There are three levels of resolution for dynamic access right rules: dataset, record and node. Since
only one programmatic access rule can be set for a given level, the last rule set is the one used by
the resolution procedure. However, a scripted rule can be specified on top of a programmatic rule at
the table level.

Rule resolution on dataset

For a dataset, the last rule set is considered as the resolved rule

Rule resolution on record

For a record, the resolved rule is the minimum between the resolved rule set on the dataset and the
rule set on this record.

APT

See SchemaExtensionsContext.setAccessRuleOnOccurrence” for more details.

Rule resolution on node

For a node that is a child node of a record, the resolved rule is the minimum between the resolved
rule on the record and the rule set on this node.

For a child node of a dataset, the resolved rule is the minimum between the resolved rule set on the
dataset and the rule set on this node.

API

See SchemaExtensionsContext .setAccessRuleOnNode™ for more details.

Display policy for foreign key drop-down menus

If a record is hidden due to access rules, it will not appear in foreign key drop-down menus.

Attention

The resolved access rights on a dataset or dataset node is the minimum between the resolved access
rights defined in the user interface and the resolved dynamic rules, if any.

48.6 Resolving permissions on services

User services give the possibility to execute specific and advanced features from the user interface.
Depending on their definition, these services can be called from a menu, as an action in a workflow,
as a perspective item, or can be executed directly from a URL as a Web component [p 214].

See alsoOverview [p 643]

The permissions of a service are resolved as the service is called from the user interface, namely:
« During the execution, just before the service is displayed.

If the permission resolved in the user context is not enabled, a restriction message is displayed
in place of the service.

» During the display of menus if the service is defined as displayable in menus.

If the permission resolved in the context for the user is not enabled, the service will not be
displayed in the menu.
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Thus, upon every request the resolution of permissions for a service is carried out as follows, in the
following order and as long as conditions are respected:

1. The

service activation has to correspond to the current context. This activation considers:

the selected entity type (dataset, table, record, etc.);

1

static activation rules defined within the userServicebeclaration.defineActivation®™
method;

the potential dynamic activation rule (ServiceActivationRule [p 285]) also defined within the
UserServiceDeclaration.defineActivation™ method.

2. When the service is activated for the current context, permissions for the user session will be
evaluated:

If permissions have been defined via the user interface for the current user (or for their roles),
their resolution must return enabled.

For more information, please refer to the Resolving user-defined rules [p 290] section.

If a global permission rule [p 285] is defined for the service, it must return enabled for the
context provided (see ServicePermissionRuleContext™).

If a local permission rule [p 285] is defined for the selected node, it must return enabled for
the context provided (see ServicePermissionRuleContext™).

Resolving user-defined rules

Example

In this example, there are two users belonging to different roles and profiles:

User Profiles

User 1 « userl
« role A
« role B

User 2 « roleC
« 10le D
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The permissions associated with the roles and profiles defined on the dataset level are as follows:

Profile Built-in Built-in Built-in Custom Custom Restriction
service create service service service 1 service 2 policy
(@creation) duplicate compare (custom1) (custom2)

(@duplicate) (@compare)

userl Enabled Disabled Enabled Disabled Enabled No
Role A Enabled Enabled Disabled Enabled Disabled Yes
Role B Enabled Disabled Enabled Enabled Disabled Yes
Role C Enabled Enabled Disabled Disabled Disabled No
Role D Enabled Disabled Disabled Enabled Disabled No

The services available to each user after permission resolution are as follows:

Users Available services

User 1 Built-in service create (@creation)

Custom service 1 (custom1)

User 2 Built-in service create (@creation)

Built-in service duplicate (@duplicate)

Custom service 1 (customi)

See alsoResolving user-defined rules [p 286]

48.7 Resolving permissions on actions

Actions are low-level operations for EBX object manipulation on which it is possible to define
execution rights for a profile. Unlike permissions on user services, which only impact the user
interface, these rights are also applicable when an operation is carried out programmatically (i.e. via
a Procedure™) or indirectly (for example during data import, actions on the table (create, override,
occult and delete) are evaluated).
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Here is the list of actions on which rights can be de

fined:

Action object

Available actions

Dataspace

Create a child dataspace

Create a snapshot

Launch a merge

Export an archive

Import an archive

Close the dataspace

Close the snapshot

Create a dataset

Dataset

Duplicate the dataset

Delete the dataset

Activate/deactivate the dataset

Create a view

Table

Create a new record

Override records

Occult records

Delete records

For the resolution of permissions on actions, only the permissions defined via the user interface for
the current user (or their roles) will be taken into account, the restriction policy being applied as for

any other permission defined via the user interface.

For more information, please refer to the Resolving user-defined rules [p 293] section.
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Resolving user-defined rules

Example

In this example, we have two users belonging to different roles and profiles:

User Profiles

User 1 « userl
. r0le A
« 10le B

User 2 « roleC
« 10le D

Rights associated with roles and profiles on the actions of a given table are as follows:

Profile Create a record Override a Occult a record Delete a record Restriction
record policy

userl No Yes No Yes No

Role A Yes No Yes No Yes

Role B No Yes Yes No Yes

Role C Yes No No No No

Role D No No Yes No No

The actions available to each user after resolving

the rights are as follows:

Users

Available actions

User 1

Occult a record

User 2

Create a record

Occult a record

See alsoResolving user-defined rules [p 286]
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CHAPTER 49

Criteria editor

This chapter contains the following topics:
1. Overview

2. Conditional blocks

3. Atomic criteria

49.1 Overview

The criteria editor is included in several different areas of the user interface. It allows defining table
filters, as well as validation and computation rules on data. This editor is based on the XPath 1.0 W3C
Recommendation.

Two types of criteria exist: atomic criteria and conditional blocks.

See alsoSupported XPath syntax [p 233]

49.2 Conditional blocks

Conditional blocks are made up of atomic criteria and other conditional blocks. They express a
condition based on the criteria. The following types of blocks exist:

« No criteria match: None of the criteria in the block match.
« Not all criteria match: At least one criterion in the block does not match.
o All criteria match: All criteria in the block match.

« At least one criterion matches: One or more of the criteria match.
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49.3 Atomic criteria

An atomic predicate is defined by a field, an operator, and an expression (either a value or an XPath

formula).
Field Specifies the field of the table to which the criterion applies.
Operator Specifies the operator used. Available operators depend on
the data type of the field.
Value Specifies the value or expression. See Expression [p 296]
below.
Code only If checked, specifies searching the underlying values for the
field instead of labels, which are searched by default.
Expression

The expression can either be a fixed value or a formula. When creating a filter, only fixed values are
authorized. During creation of a validation or computation rule, a formula can be created using the
wizard.

Known limitation: The formula field does not validate input values, only the syntax and path are
checked.

TIBCO EBX® Product Documentation 6.0.5 296



Documentation > Reference Manual > Other > Search

cHAPTER 50

Search

This chapter contains the following topics:
1. Overview
. Search strategies for string fields

2
3. Search strategy for primary key fields

4. Excluding a field from search ('Void' indexing)
5

. Assigning a search strategy to a field

50.1 Overview

A search strategy defines how a field is indexed and queried. Any field is associated with a default
search strategy, primarily based on its data type.
Search strategies are specified in the Data Model Assistant:

« when editing a field, its search strategies can be set in the 'Extensions' tab;

« at the data model level, custom search strategies can be specified, under 'Extensions > Search'’
element in the left pane;

See alsoQuick Search [p 118]

Value-labeling

Value-labeling is a global feature in EBX to display user-friendly labels instead of raw values. For
example, in the user interface, a foreign key field displays the label of the linked record, or a field
based on a static enumeration displays the localized label associated with the raw value, as specified
by the data model.

If a field supports value-labeling, the Quick search and the sort in the user interface usually apply on
the displayed label, to preserve an intuitive user interface.

There are some exceptions, where raw value is still used by the quick search and the sort operation:

« Programmatic labels and programmatic enumeration constraints (a foreign key specifying a
TableRefDisplay or whose display depends on a UILabelRenderer specified on the target table, or
a field constrained by a ConstraintEnumeration). It is recommended to use alternative solutions
(display patterns and foreign keys).

« Enumeration constraint defined using another node (<osd:enumeration osd:path=...). It is
recommended to use an alternative solution (a foreign key).
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Obviously, if a field is displayed through a uiwidget (or a UIBean), to preserve an intuitive user
interface, it is expected for the custom component to display the label (or the value, if this field does
not enable value-labeling).

Limitations

In general, the following fields are not included in the Quick search and they are not optimized for
other operators:

» computed fields with non-local dependency;
« inherited fields.

In the specific cases of inherited dataset, history view or mapped tables, legacy search is used. This
implies that the size of the table cannot be quickly estimated, and might not be presented in the UL
It also implies that Quick search:

« considers all searchable fields (including computed fields with non-local dependency);
+ behaves like a 'contains' (Lucene syntax cannot be used);

« does not support sort by relevancy;

« may perform poorly on tables with large volumes.

Regarding the Advanced Search pane, all fields will be available, except those of type osd:locale
which are not defined as enumerations, and those of type osd: resource.
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50.2 Search strategies for string fields

Basic built-in strategies for strings

"Text' The 'Text' search strategy is intended to contain multiple
words, such as descriptions, texts or comments. This
strategy supports full-text search and fuzzy search. Sorting,
and some functions such as the ‘equals’ and 'starts-with'
operators, are irrelevant and are not supported. This strategy
is lightweight, consuming little disk space.

See also Quick Search [p 118]

'Code’ The 'Code' search strategy is intended for codes and
identifiers. Values are considered as one single token,
allowing any kind of case-sensitive and case-insensitive
filter. Full-text search is irrelevant and is replaced by a
‘contains'.

'Name' The 'Name' search strategy is intended for names and labels
that contain only a few words. Besides having the same
search capabilities as "Text', Name' strategy also allows sort,
and supports the same filters as 'Code'. This strategy has
the most capabilities, but consumes more disk space. If the
purpose of the field allows it, it is advised to choose the
"Text', 'Code’ or 'Excluded from search' strategy, rather than
this one.

Default strategy for string fields
The 'Name' strategy is applied to string fields by default, except:
o If the field is part of the primary key, it is set by default to 'Code'.
« If the field is a foreign key, it is forced to 'Code’ and cannot be changed.

« If the field has a built-in datatype extending xs:string, then it has a strategy relevant to its
datatype; for instance osd: text, xs:Name, osd:email, osd:html, etc.

As the default strategy Name' can be irrelevant and consumes more disk space, the data model
compilation reports warnings for fields with the 'Name' strategy set as default, so as to ensure that
strategies are defined on purpose. We advise to choose the 'Text' strategy, when the length of the
expected values is greater than 80, as a rough estimate. Long values (> 32766 bytes once encoded into
UTF-8) will not be fully indexed with the 'Name' or 'Code' strategy. Quick search is not affected, but
sorting will consider only the first 1000 characters, and some operators (‘equals' and 'ends-with', ...)
will not return the correct results.
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Advanced custom strategies

Some strategies accept parameters, for example to define stop words, or a specific language. This is
done by creating a record in the 'Search strategies' table of the 'Search' data model extension. The new
parameterized strategy will be available for selection in the 'Extension' tab, for compatible fields.

50.3 Search strategy for primary key fields

Primary key fields must have a sortable search strategy. This excludes the "Void' strategy for all data
types, and the 'Text' strategy for strings.

50.4 Excluding a field from search ('Void' indexing)

The 'Excluded from search' (or void) strategy deactivates indexing, making filter, search, or sort
impossible. It is available for all data types, and is intended for fields that are never queried. Values
can still be accessed through their record. Disabling the indexing reduces the disk space consumed
and speeds up some operations like data import.

50.5 Assigning a search strategy to a field

A search strategy can be associated with a field, by means of a search template SearchTemplate™.
This is done in the 'Extension' tab of the field, in the Data Model Assistant. Assigning multiple search
strategies to a field requires registering additional search templates into a module. Only the addons
EBX Information Search and EBX Match and merge are concerned by additional search templates.
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CHAPTER B1

Performance and tuning

This chapter contains the following topics:
1. Environment

Database

Data modeling

Data validation

Accessing tables

O e

Performance checklist for other Java customizations
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51.1 Environment

Memory management

Memory allocated to the Since the query engine retrieves the necessary information

application server from persistent storage, the memory allocated to the Java
Virtual Machine (usually specified by the -Xmx parameter)
can be kept low. We recommend setting this figure to less
than 1/3rd of the total memory available on the OS. We also
advise to stay below 32 GB, which should fit all reasonable
use cases, and allow benefiting from the compressed Oops
feature.

Memory allocated to the On the OS running the application server, it is important to

operating system leave sufficient room to the OS cache, letting it optimize
access to the persistent Lucene indexes. Indeed, once these
have been loaded from the file system, the OS uses its
memory cache to speed up subsequent accesses to this same
data, and avoid reloading it every time from the disk. This
is only possible if sufficient RAM has been left for this
purpose.

It is also necessary to configure the OS so that the JVM
process can reserve the resources required by numerous
memory-mapped files (see this article for details). On
a Linux OS, this can be done by issuing the following
commands:

ulimit -n 512000
sysctl vm.max_map_count=262144

Memory monitoring Indications of EBX load activity are provided by monitoring
the underlying database, and also by the 'monitoring'
logging category [p 360].

If the numbers for cleared and built objects remain high for
a long time, this is an indication that EBX is swapping on
the application server. In that case, the memory allocated to
the application server should be increased.

Garbage collector Tuning the garbage collector can also benefit overall
performance. This tuning should be adapted to the use case
and specific Java Runtime Environment used.

Disk
The EBX repository data are indexed into Lucene indexes, stored on the disk under the root directory
[p 3571.
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Disk space: a rule of thumb for the disk size is to plan for 10 times the space occupied by the table
G_BLK in the relational database.

Disk latency: in order to maintain good overall performance, it is important for the disk storing the
Lucene indexes to have low latency.

See alsoSetting the EBX root directory [p 357]

Using the native LZ4 library

The L.Z4 library is used to store data to and retrieve data from the database. To speed up data access,
it is required to perform a ebx-1z4.jar native installation.

See Data compression library [p 324] for more information.

Scanning on server startup

To speed up the web applications server startup, the JAR files scanner [p 331] should be configured.

51.2 Database

Reorganizing database tables

As with any database, inserting and deleting large volumes of data may lead to fragmented data, which
can deteriorate performance over time. To resolve the issue, reorganizing the impacted database tables
is necessary. See Monitoring and cleanup of the relational database [p 401].

A specificity of EBX is that creating dataspaces and snapshots adds new entries to tables GRS_DTR and
GRS_SHR. When poor performance is experienced, it may be necessary to schedule a reorganization of
these tables, for large repositories in which many dataspaces are created and deleted.

See alsoMonitoring and cleanup of the relational database [p 401]

51.3 Data modeling

Aggregated lists

In a data model, when an element's cardinality constraint max0ccurs is greater than 1 and no osd: table
is declared on this element, it is implemented as a Java List. This type of element is called an
aggregated list [p 528], as opposed to a table.

It is important to consider that there is no specific optimization when accessing aggregated lists, in
terms of iterations, user interface display, etc. Besides performance concerns, aggregated lists are
limited with regard to many functionalities that are supported by tables. See tables introduction [p
531] for a list of these features.

Attention

For the reasons stated above, aggregated lists should be used only for small volumes of simple
data (one or two dozen records), with no advanced requirements for their identification, lookups,
permissions, etc. For larger volumes of data (or more advanced functionalities), it is recommended
to use osd: table declarations.
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51.4 Data validation

The internal validation framework will optimize the work required during successive requests to
update the validation report of a dataset or a table. The incremental validation process behaves as
follows:

The first call to a dataset or table validation report performs a full validation of the dataset or
the table.

The next call to the validation report will compute the changes performed since the last validation.
The validation report will be updated according to these changes.

Validation reports are stored persistently in the TIBCO EBX repository. This reduces the amount
of memory dedicated to validation reports when datasets have a large amount of validation
messages. Also, validation reports are not lost when the application server restarts.

Validation reports can be reset using the API or manually in the user interface by an administrator
user (this option is available from the validation report section in EBX). As a consequence,
resetting validation reports must be used with caution since associated datasets or tables will be
fully revalidated during the next call to their validation reports.

See Adaptation.resetvalidationReport™ for more information.

Certain constraints are systematically re-validated, even if no updates have occurred since the
last validation. These are the constraints with unknown dependencies. An element has unknown
dependencies if:

API =

It specifies a programmatic constraint Constraint™ in the default unknown dependencies mode.

It declares a computed value valueFunction™, or it declares a dynamic facet that depends on an

1

element that is itself a computed value valueFunction™.

It is an _inherited field [p 272] or it declares a dynamic facet that depends on a node that is itself
an inherited field [p 272].

Consequently, on large tables, it is recommended to:

Avoid constraints with unknown dependencies (or at least to minimize the number of
such constraints). For programmatic constraints, the developer is able to specify two
alternative modes that drastically reduce incremental validation cost: local dependency
mode and explicit dependencies. For more information, see Dependencies and validation
DependenciesDefinitionContext.dependencies™.

API

To use constraints on tables constraintonTable™ instead of programmatic constraints
constraint™ defined at field level. Indeed, if a table defines constraints at field level, then
the validation process will iterate over all the records to check if the value of the associated
field complies with the constraint. Using constraints on tables ConstraintonTable™ gives the
opportunity to execute optimized queries on the whole table.

Avoid the use of the facet pattern since its check is not optimized on large tables. That is, if a field
defines this facet then the validation process will iterate over all the records to check if the value
of the associated field complies with the specified pattern.
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51.5 Accessing tables

Functionalities

Tables are commonly accessed through EBX Ul, data services and also through the request™ and
Query”” APIs. This access involves a unique set of functions, including a dynamic resolution process.
This process behaves as follows:

+ Inheritance: Inheritance in the dataset tree takes into account records and values that are defined
in the parent dataset, using a recursive process. Also, in a root dataset, a record can inherit some
of its values from the data model default values, defined by the xs:default attribute.

+ Value computation: A node declared as an osd: function is always computed on the fly when

the value is accessed. See valueFunction.getvalue™.

i

, or a record-
** requires a

« Filtering: An XPath predicate [p 233], a programmatic filter AdaptationFilter”
level permission rule SchemaExtensionsContext.setAccessRuleOnOccurrence
selection of records.

« Sort: A sort of the resulting records can be performed.

Query on tables

Architecture and design

In order to improve the speed of operations on tables, persistent Lucene indexes are managed by the
EBX engine.

Attention

Faster access to tables is ensured if indexes are ready and maintained in the OS memory cache. As
mentioned above [p 302], it is important for the OS to have enough space allocated.

Performance considerations

The query optimizer favors the use of indexes when computing a request result. If a query cannot take
advantage of the indexes, it will be resolved in Java memory, and experience poor performance on
large volumes. The following guidelines apply:

Attention

o Only XPath predicates and SQL queries can benefit from index optimization.
« Some fields and some datasets cannot be indexed, as described in section Limitations [p 298].

« XPath predicates on a multivalued field cannot benefit from index optimization, except for the
osd:search function.

« XPath predicates using the osd: label function cannot benefit from index optimization

If indexes have not yet been built, additional time is required to build and persist the indexes, on the
first access to the table.
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Accessing the table data blocks is required when the query cannot be computed against any index
(whether for resolving a rule, filter or sort), as well as for building the index. If the table blocks are
not present in memory, additional time is needed to fetch them from the database.

It is possible to get information through the memory monitoring [p 3021 and request logging
categories.

Accessing and modifying a table
The following access lead to poor performance, and must be avoided:

» Access a table after a few modifications, repeatedly. It implies the index state to be refreshed after
each modification. The cost of refreshing makes this pattern ineffective. Instead, perform a single
query and apply the modification when browsing the results.

« If there is an ongoing access to the same table, concurrently to the previous case, it prevents
outdated index files to be deleted. As a consequence, the size of the index on disk increases, and
the server may run out of disk space in extreme cases. When the concurrent access is closed, the
index size is back to normal. This is usually a sign that a Request or a Query is not properly closed.

See also

T

RequestResult.close”

T

QueryResult.close”

Other operations on tables

The new records creations or record insertions depend on the primary key index. Thus, a creation
becomes almost immediate if this index is already loaded.

Setting a fetch size

In order to improve performance, a fetch size should be set according to the expected size of the result
of the request on a table. If no fetch size is set, the default value will be used.

« On a history table, the default value is assigned by the JDBC driver: 10 for Oracle and 0 for
PostgreSQL.

Attention

On PostgreSQL, the default value of 0 instructs the JDBC driver to fetch the whole result set
at once, which could lead to an outofMemoryError when retrieving large amounts of data. On
the other hand, using fetchSize on PostgreSQL will invalidate server-side cursors at the end of
the transaction. If, in the same thread, you first fetch a result set with a fetchsize, then execute a
procedure that commits the transaction, then, accessing the next result will raise an exception.

See also

T

Request.setFetchSize"”

API

RequestResult
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51.6 Performance checklist for other Java customizations

While TIBCO EBX is designed to support large volumes of data, several common factors can lead to
poor performance. Addressing the key points discussed in this section will solve the usual performance
bottlenecks.

Expensive programmatic extensions

For reference, the table below details the programmatic extensions that can be implemented.

Use case Programmatic extensions that can be involved

ApT

Validation « programmatic constraints Constraint

« computed values valueFunction™

Table access . record-level permission rules SchemaExtensionsContext.setAccessRuleOnOccurrence™

. programmatic filters AdaptationFilter™

EBX content display . computed values ValueFunction™

T

. UI Components UIBeanEditor”

APT

« node-level permission rules SchemaExtensionsContext.setAccessRuleOnNode

T

Data update . triggers Package com.orchestranetworks.schema.trigger”

For large volumes of data, using algorithms of high computational complexity has a serious impact on
performance. For example, the complexity of a constraint's algorithm is O(n °). If the data size is 100,
the resulting cost is proportional to 10 000 (this generally produces an immediate result). However, if
the data size is 10 000, the resulting cost will be proportional to 10 000 000.

Another reason for slow performance is calling external resources. Local caching usually solves this
type of problem.

If one of the use cases above displays poor performance, it is recommended to track the problem,
either by code analysis or by using a Java profiling tool.
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Unnecessary index refresh

Refreshing a Lucene index takes time. It should be avoided whenever possible.

When does a refresh happen? In the context of a transaction, an index refresh occurs when
the table has been modified and one of the conditions below
occurs:

1. For a lookup by primary key, the refresh is
always triggered if the searched key has been
"touched" (created, modified or deleted) in the current
Procedure (or TableTrigger).

2. For a standard Query (or Request), an index refresh is
always performed if the table has been modified in the
current Procedure (or TableTrigger).

Coding recommendations 1. To avoid triggering a refresh through a lookup
by primary key, the developer must register the
Adaptation object returned from the last call to
doCreateOccurrence Or doModifyContent, and reuse
this object instead of performing the lookup.

2. Avoid any lookup by primary key on a record that has
been deleted in the current procedure.

3. In the case of a query triggering the refresh, the
developer must ask the following question: can this
query be avoided in my procedure?

Transaction threshold for mass updates

It is generally not advised to use a single transaction when the number of atomic updates in the
transaction is beyond the order of 10 °. Large transactions require a lot of resources, in particular,
memory, from EBX and from the underlying database.

To reduce the transaction size, it is possible to:

« Specify the property ebx.manager.import.commit.threshold [p 367]. However, this property is
only used for interactive archive imports performed from the EBX user interface.

APT

» Explicitly specify a commit threshold ProcedureContext.setCommitThreshold™ inside the
batch procedure.

APT

« Structurally limit the transaction scope by implementing Procedure
executing it as many times as necessary.

for a part of the task and
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On the other hand, specifying a very small transaction size can also hinder performance, due to the
persistent tasks that need to be done for each commit.

Note

If intermediate commits are a problem because transactional atomicity is no longer
guaranteed, it is recommended to execute the mass update inside a dedicated dataspace.
This dataspace will be created just before the mass update. If the update does not
complete successfully, the dataspace must be closed, and the update reattempted after
correcting the reason for the initial failure. If it succeeds, the dataspace can be safely
merged into the original dataspace.

Triggers

If required, triggers can be deactivated using the method ProcedureContext.setTriggerActivation™.

Directory integration

Authentication and permissions management involve the user and roles directory [p 435].

If a specific directory implementation is deployed and accesses an external directory, it can be useful
to ensure that local caching is performed. In particular, one of the most frequently called methods is

APL

Directory.isUserInRole
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CHAPTER 52

Administration overview

The Administration section in TIBCO EBX is the main point of entry for all administration tasks. In
this overview are listed all the topics that an administrator needs to master. Click on your topic of
interest in order to access the corresponding chapter or paragraph in the documentation.

This chapter contains the following topics:

1. Repository management

. Disk space management

. Data model

2
3
4. Perspectives
5. Administrative delegation

52.1 Repository management

For storage optimization, it is recommended to maintain a repository (persistence RDBMS) to the
necessary minimum. To this end, it is recommended to regularly perform a purge of snapshots and
obsolete dataspaces and to consider using a backup file system.

See also Cleaning up dataspaces, snapshots, and history [p 401] and Deleting dataspaces, snapshots,
and history [p 402].
It is also possible to archive files of the file system type in order to reduce the storage costs, see EBX
monitoring [p 400].

Administration tasks can be scheduled by means of the task scheduler, using built-in tasks, see Task
scheduler [p 449].

Object cache

EBX maintains an object cache in memory. The object cache size should be managed on a case by case
basis according to specific needs and requirements (pre-load option and pre-validate on the reference
dataspaces, points of reference, and monitoring), while continuously monitoring the repository health
report.

See alsoMemory management [p 302]
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Obsolete contents

Keeping obsolete contents in the repository can lead to a slow server startup and slow responsiveness
of the interface. It is strongly recommended to delete obsolete content.

For example: datasets referring to deleted data models or undeployed add-on modules. See Deploying
and registering TIBCO EBX add-ons [p 377].

Workflow

Cleanup
The workflow history and associated execution data have to be cleaned up on a regular basis.

The workflow history stores information on completed workflows, their respective steps and contexts.
This leads to an ever-growing database containing obsolete history and can thus lead to poor
performance of the database if not purged periodically. See Workflow history [p 4481 for more
information.

Email configuration

It is required to configure workflow emails beforehand in order to be able to implement workflow
email notifications. See Configuration [p 446] for more information.

52.2 Disk space management

Purge of logs

The log file size will vary according to the log level (and to the selected severity level) and disk space
needs to be accordingly managed.

An automatic purge is provided with EBX, allowing to define how many days should log files be
stored. After the defined period, log files are deleted.

Any customized management of the purge of logs (backup, archiving, etc.) is the user's responsibility.

## Directory of log files 'ebxFile:'
## This property is used by special appender prefixed
## by 'ebxFile:' (see log section below)

ebx.logs.directory=${ebx.home}/ebxLog

# Daily rollover threshold of log files 'ebxFile:'

# Specifies the maximum number of backup files for daily rollover of 'ebxFile:' appenders.
# When set to a negative value, backup log files are never purged.

# Default value is -1.

ebx.log4j.appender.ebxFile.backup.Threshold=-1

Audit trail

EBX is provided with a default audit trail manager. Any customized management (including purge,
backups, etc.) is the user's responsibility.

If the audit trail is unwanted, it is possible to fully deactivate it. See Activating the XML audit trail
[p 3591 and Audit trail [p 455] for more information.
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52.3 Data model

Publication management

The management of publications of embedded data models [p 89]. See Data model administration [p
439] for more information on the management of these publications and the administration tasks that
can be performed (delete, import and export).

Refresh data models

It is possible to update the data models that are using XML Schema documents not managed by EBX.
See Data model refresh tool [p 509] for more information.

52.4 Perspectives

EBX offers extensive UI customization options. Simplified interfaces (Recommended perspectives)
[p 420] dedicated to each profile accessing the system can be parameterized by the administrator.
According to the profile of the user logging in, the interface will offer more or less options and menus.
This allows for a streamlined work environment.

See Advanced perspective [p 408] for more information.

52.5 Administrative delegation
EBX is provided with the built-in administrator profile by default. An administrator can delegate
administrative rights to a non-administrator user, either for specific actions or for all activities.

The administrative delegation is defined under 'Administration’ in the global permissions [p 407]
profile.

Access to the administration section can be granted to specific profiles via the global permissions in
order to delegate access rights on corresponding administration datasets.

If all necessary administrative rights have been delegated to non-administrator users, it becomes
possible to disable the built-in 'Administrator' role.

See alsoConfiguring the user and roles directory [p 358]
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CHAPTER 53

Supported environments

This chapter contains the following topics:

1. Browsing environment

2. Supported application servers

3. Supported databases
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53.1 Browsing environment

Supported web browsers
The TIBCO EBX web interface supports the following browsers:

Microsoft Edge chromium As Microsoft Edge chromium is updated frequently
and it is not possible to deactivate automatic updates,
TIBCO Software Inc. only tests and makes the best effort to
support the latest version available.

Microsoft Edge Minimum supported version is 44

Compatibility mode is not supported.

Microsoft Internet Explorer 11 Compatibility mode is not supported.

Performance limitations: page loading with IE11 is two
times slower. This issue is observed when forms have many
input components, and particularly many multi-occurrence
groups.

Graphical layout: graphical rendering in [E11 can slightly
differ from other browsers (for example, the alignment of
some labels, icons and other components can be off by a
few pixels).

Mozilla Firefox ESR 68 (see As  Mozilla  Firefox is updated frequently,
details) TIBCO Software Inc. only fully supports version ESR 68.
See Mozilla Firefox ESR for more details.

Google Chrome As Google Chrome is updated frequently and it
is not possible to deactivate automatic updates,
TIBCO Software Inc. only tests and makes the best effort to
support the latest version available.

Screen resolution

The minimum screen resolution for EBX is 1024x768.

Refreshing pages

Browser page refresh is not supported by EBX. When a page refresh is performed, the last user action
is re-executed, and therefore could cause issues. It is thus imperative to use the action buttons and
links offered by EBX instead of refreshing the page.
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'Previous' and 'Next' buttons

The 'previous' and 'next buttons of the browser are not supported by EBX. When navigating through
page history, an obsolete user action is re-executed, and therefore could cause issues. It is thus
imperative to use the action buttons and links offered by EBX rather than the browser buttons.

Browser configuration

The following features must be activated in the browser configuration, for the user interface to work
properly:

JavaScript

Ajax

Pop-ups

Attention

Avoid using any browser extensions or plug-ins, as they could interfere with the proper functioning
of EBX.

Limitations

Some browsers may have a limitation on the number of iframes that can be embedded. If this is the
case, it limits to the number of items that can be pushed in the breadcrumb. Please check the browser
documentation for more details.

53.2 Supported application servers

EBX supports the following configurations:

Java Runtime Environment: JRE 8, 11 or 17.

Note: JRE 8 will come out of support in an upcoming release. We advise to upgrade the runtime
to a recent LTS version, to take advantage of the performance improvements it offers.

Any Servlet/JSP container that complies with Servlet 3.0 (inclusive) up to 5.0 (exclusive): for
example Tomcat 7.0 (inclusive) up to 10.0 (exclusive). Any Java Application Server with Java
EE 8 (inclusive) to Jakarta EE 9 (exclusive): for example WebSphere Application Server Liberty
18 (inclusive) up to 21 (exclusive), WebLogic Application Server 14c or higher, JBoss EAP 7.4
or higher. See Java EE deployment overview [p 331].

The application server must support the JSON Processing 1.1 (JSR 374), or allow the uses of
the implementation embedded in the ebx. jar library. For example, Tomcat does not provide any
library to support this specification (only the embedded one can be used), WebSphere Application
Server allows reversing the classloading system (making the embedded one a priority), WebLogic
Application Server 14c or higher supports this specification, JBoss EAP allows including or
excluding the available libraries.

The application server must use UTF-8 encoding for HTTP query strings from EBX. This can
be set at the application server level.

For example, on Tomcat, you can set the server to always use the UTF-8 encoding, by setting
URIEncoding to 'UTF-8' on the <Connector> in the server.xml configuration file. Alternatively,
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you can instruct the server to use the encoding of the request body by setting the parameter
useBodyEncodingForURI to 'true' in server.xml.

Attention

« Limitations apply regarding clustering and hot deployment/undeployment:

Clustering: EBX does not include a cache synchronization mechanism, thus it cannot be
deployed into a cluster of active instances. See Technical architecture [p 3961 for more
information.

Hot deployment/undeployment: EBX does not support hot deployment/undeployment of web
applications registered as EBX modules, or of EBX built-in web applications.

« WebSphere Application Server's Java SDKs under version 8.0.4.10 are incompatible with the
embedded Apache Calcite third-party library. It is highly recommended to use the latest Java
SDK available and compatible with the application server.
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53.3 Supported databases

The EBX repository supports the relational database management systems listed below, with the
suitable JDBC drivers. It is important to follow the database vendor recommendations and update
policies regarding the database itself, as well as the JDBC driver.

Oracle Database 12c or higher The distinction of null values bears certain limitations.

(but excluding 18c). On simple xs:string elements, Oracle does not support
the distinction between empty strings and null values. See
Empty string management [p 568] for more information.

The user with which EBX connects to the database requires
the following privileges:

« CREATE SESSION,

« CREATE TABLE,

« ALTER SESSION,

« CREATE SEQUENCE,

« A non-null quota on its default tablespace.

PostgreSQL 10 or higher. The user with which EBX connects to the database needs
the CONNECT privilege on the database hosting the EBX
repository. Other than this, the default privileges on the
public schema of this database are suitable.

Also, see this limitation [p 267 regarding the evolution of
datamodels in mapped modes.

Amazon Aurora PostgreSQL 2.3 The comments in the above section for PostgreSQL apply.
(compatible with PostgreSQL
10.7) or higher.

Google Cloud SQL for The comments in the above section for PostgreSQL apply.
PostgreSQL 10 or higher.

SAP HANA Database 2.0 or When using SAP HANA Database as the underlying

Higher. database, certain schema evolutions are not supported. It is,
for example, impossible to reduce the length of a column;
this is a limitation of HANA, as mentioned in the SQL
reference guide: "For row table, only increasing the size of
VARCHAR and NVARCHAR type column is allowed."

Microsoft SQL Server 2012 SP4  When used with Microsoft SQL Server, EBX uses the
or higher. default database collation to compare and sort strings stored
in the database. This applies to strings used in the data
model definition, as well as data stored in history tables.
The default database collation can be specified when the
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database is created. Otherwise, the collation of the database
server is used. To avoid naming conflicts or unexpected
behaviors, a case- and accent-sensitive collation must be
used as the default database collation (the collation name is
suffixed by "CS_AS" or the collation is binary).

The default setting to enforce transaction isolation on SQL
Server follows a pessimistic model. Rows are locked to
prevent any read/write concurrent accesses. This may cause
liveliness issues for mapped tables (history or relational). To
avoid such issues, it is recommended to activate snapshot
isolation on your SQL Server database.

The user with which EBX connects to the database requires
the following privileges:

« CONNECT, SELECT and CREATE TABLE on the
database hosting the EBX repository,

« ALTER, CONTROL, UPDATE, INSERT, DELETE on
its default schema.

Microsoft Azure SQL Database = EBX has been qualified on Microsoft Azure SQL
Database v12 (12.00.700), and is regularly tested to verify
compatibility with the current version of the Azure database
service.

When used with Microsoft Azure SQL, EBX uses the
default database collation to compare and sort strings stored
in the database. This applies to strings used in the data
model definition, as well as data stored in history tables.
The default database collation can be specified when the
database is created. Otherwise, the database engine server
collation is used. To avoid naming conflicts or unexpected
behaviors, a case- and accent-sensitive collation must be
used as the default database collation (the collation name is
suffixed by "CS_AS" or the collation is binary).

The user with which EBX connects to the database requires
the following privileges:

+ CONNECT, SELECT and CREATE TABLE on the
database hosting the EBX repository,

« ALTER, CONTROL, UPDATE, INSERT, DELETE on
its default schema.

H2 v1.4.196 or higher. H2 is not supported for production environments.

The default H2 database settings do not allow consistent
reads when records are modified.
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For other relational databases, please contact the Support team at https://support.tibco.com.

Attention

In order to guarantee the integrity of the EBX repository, it is strictly forbidden to perform direct
modifications to the database (for example, using direct SQL writes).

See also

Repository administration [p 396]

Data source of the EBX repository [p 329]

Configuring the EBX repository [p 357]
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CHAPTER 54

Java EE deployment

This chapter contains the following topics:

1

N ok DN

Introduction

Software components

Embedded third-party libraries

Required third-party libraries

Web applications

Deployment details

Installation notes

54.1 Introduction

This chapter details deployment specifications for TIBCO EBX on a Java application server. For
specific information regarding supported application servers and inherent limitations, see Supported
environments. [p 316]

54.2 Software components

EBX uses the following components:

Library ebx. jar
Embedded [p 324] and required [p 324] third-party Java libraries

EBX built-in web applications [p 327] and optional custom web applications [p 327]

EBX main configuration file [p 355]

EBX repository [p 396]

Default user and roles directory [p 4351, integrated within the EBX repository, or a third-party
system (LDAP, RDBMS) for the user authentication

See alsoSupported environments [p 316]
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54.3 Embedded third-party libraries

To increase EBX independence and interoperability, it embeds its own third-party libraries. Even if
some of them have been modified, preventing conflicts, others must remain unchanged since they are
official Java APIs.

The ones that can produce conflicts are:
« Apache Geronimo JSON
« Javax Activation
« Javax Annotations
« Javax JSON Bind
« Javax SAAJ API
« Javax WS RS
« Javax XML Bind

For more information regarding the versions or the details of the Third-Party Library, please refer to
the: TIB_ebx_6.0.5_license.pdf.

Since those libraries are already integrated, custom web applications should not include them anew,
otherwise linkage errors can occur. Furthermore, they should not be deployed aside from the ebx. jar
library for the same reasons.

54.4 Required third-party libraries

EBX requires several third-party Java libraries. These libraries must be deployed and be accessible
from the class-loader of ebx.jar. Depending on the application server and the Java runtime
environment being used, these libraries may already be present or may need to be added manually.

Data compression library

The library named ebx-1z4.jar must be deployed separately from ebx.jar. It contains several
compression implementations: JNI dedicated architecture libraries and Java fallbacks. It is possible
to ensure optimal compression and decompression performance for EBX repository by following
prerequisites. If prerequisites can not be validated, EBX will function in Java fallbacks safe or unsafe,
but its performance will be degraded. The default location for ebx-1z4. jar library is beside ebx. jar.

To verify the compression implementation actually used by the EBX repository, please check the
value of 'Compression' in 'Administration > System Information', section 'Repository information'. It
should be 'INI - validated' for optimal performance. Otherwise, it will be 'Java[Safe|unsafe] -
validated' for Java fallbacks.

Performance prerequisites

The JNT access is allowed to the following operating system architectures: 1386, x86, amd64, x86_64,
aarché4 or ppcéale. To verify this value, please check the value of 'Operating system architecture' in
'Administration > System Information', section 'System information'.

To enable JNI access for ebx-1z4.jar, the library should be loaded by the system class loader
(also known as the application class loader). The deployment may be done by following the specific
instructions for your application server [p 331].
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Database drivers

The EBX repository requires a database. Generally, the required driver is configured along with a data

source, if one is used. Depending on the database defined in the main configuration file, one of the
following drivers is required. Keep in mind that, whichever database you use, the version of the JDBC
client driver must be equal to or higher than the version of the database server.

H2 Version 1.4.196 validated. Note that H2 is not supported in
production environments.
http://www.h2database.com/

Oracle JDBC Oracle database 21c is validated on their latest patch set

update.

Determine the driver that should be used according to the
database server version and the Java runtime environment
version. Download the ojdbc8.jar certified library with
JDK 8.

Oracle database JDBC drivers download.

SQL Server JDBC

SQL Server 2012 SP4 and greater, with all corrective and
maintenance patches applied, are validated.

Remember to use an up-to-date JDBC driver, as some
difficulties have been encountered with older versions.

Include the mssql-jdbc-8.4.1.jre8.jar or mssql-
jdbc-8.4.1.jrell.jar library, depending on the Java
runtime environment version you use.

Download Microsoft JDBC Driver 8.4.1 for SQL Server
(zip).

PostgreSQL PostgreSQL 10 and above validated
Include the latest JDBC driver version 4.2 released for your
database server and Java runtime environment.
PostgreSQL JDBC drivers download.
See also

Data source of the EBX repository [p 329]

Configuring the EBX repository [p 357]

SMTP and emails

According to the web application server being used, the library javaMail API for email management
may already be provided, or must be added manually.

EBX requires a library that is compatible with version 1.5.6 of this API. See Activating and
configuring SMTP and emails [p 362] for more information on the configuration.
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To facilitate manual installation, the javax.mail-1.5.6.jar has been provided and placed under the
ebx.software/lib/1ib-mail directory.
See alsoJavaMail
Secure Socket Layer (SSL)

These libraries are required if your web applications use SSL features.

e jsse.jar: https://www.oracle.com/java/technologies/jsse-v103-for-cdc-v102.html

o ibmjsse.jar: https://www.ibm.com/developerworks/java/jdk/security/

See alsoTIBCO EBX main configuration file [p 355]

Java Message Service (JMS)
When using JMS, version 1.1 or higher is required.

Depending on whether a Java EE application server or a Servlet/Java Server Pages (JSP)
implementation is being used, the library required is as follows:

 For an application server based on Java EE (Java Platform Enterprise Edition), the required JMS
provider library is available by default. See https://www.oracle.com/java/technologies/java-ee-
glance.html for more information.

« For a Servlet/Java Server Pages (JSP) implementation using Java SE (Java Platform Standard
Edition), for example Apache Tomcat, a JMS provider library such as Apache ActiveMQ may
need to be added. See https://www.oracle.com/java/technologies/java-se-glance.html for more
information.

Note

In EBX, the supported JMS model is exclusively Point-to-Point (PTP). PTP systems
allow working with queues of messages.

See alsoTIBCO EBX main configuration file [p 355]

XML Catalog API

A library holding the XML Catalog API, introduces by the JAVA SE 9, is required if your web
applications are running over a Java Runtime Environment 8 or below, except when a WebLogic 14c
application server is used. To ease the installation steps, the following library has been bundled aside
from ebx. jar, in the EBX CD.

o xml-apis-1.4.01.jar, version 1.4.01, from August 20, 2011

See Installation notes [p 331] for more information.

54.5 Web applications

EBX provides pre-packaged EARs that can be deployed directly if your company has no custom
EBX module web applications to add. If deploying custom web applications as EBX modules, it is
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recommended to rebuild an EAR containing the custom modules packaged at the same level as the
built-in web applications.

Attention

Web application deployment on / path context is no more supported. The path context must not
be empty nor equals to /. Moreover, web applications deployment on paths of different depth is
deprecated. Every web application path context must be set on the same path depth.

For more information, see the note on repackaging the EBX EAR [p 332] at the end of this chapter.

EBX built-in web applications

EBX includes the following built-in web applications.

‘Web application name Description Required
ebx EBX entry point, which handles the initialization on start up. See Deployment details p Yes
328 for more information.
ebx-root-1.0 EBX root web application. Any application that uses EBX requires the root web Yes
application to be deployed.
ebx-ui EBX user interface web application. Yes
ebx-manager EBX user interface web application. Yes
ebx-dma EBX data model assistant, which helps with the creation of data models through the user | Yes
interface.
Note: The data model assistant requires the ebx-manager user interface web application
to be deployed.
ebx-dataservices EBX data services web application. Data services allow external interactions with Yes
the EBX repository using the SOAP operations [p 6951 and Web Services Description
Language WSDL generation [p 6871 standards or using the Built-in RESTful servicesp
7391
Note: The EBX web service generator requires the deployment of the ebx-manager user
interface web application.

Custom web applications

It is possible to extend and customize the behavior of EBX by deploying custom web applications
which conform to the EBX module requirements.

See also

Packaging TIBCO EBX modules [p 497]

Declaring modules as undeployed [p 369]
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54.6 Deployment details

Introduction

This section describes the various options available to deploy the 'ebx' web application. These options
are available in its deployment descriptor (WEB- INF/web.xml) and are complemented by the properties
defined in the main configuration file.

Attention

For JBoss application servers, any unused resources must be removed from the WEB-INF/web.xml
deployment descriptor.

See also

TIBCO EBX main configuration file [p 355]

Supported application servers [p 318]

User interface and web access

The web application 'ebx' (packaged as ebx.war) contains the servlet FrontServlet, which handles
the initialization and serves as the sole user interface entry point for the EBX web tools.

Configuring the deployment descriptor for 'FrontServlet'

In the file weB-INF/web.xml of the web application 'ebx', the following elements must be configured
for FrontServlet:

/web-app/servlet/load-on- To ensure that FrontServlet initializes upon EBX start up,
startup the web . xm1 deployment descriptor must specify the element
<load-on-startup>1</load-on-startup>.

/web-app/servlet-mapping/url- FrontServlet must be mapped to the path '/'.
pattern

Configuring the application server for 'FrontServlet’
e FrontServlet must be authorized to access other contexts, such as ServletContext.

For example, on Tomcat, this configuration is performed using the attribute crosscontext in the
configuration file server.xml, as follows:

<Context path="/ebx" docBase="(...)" crossContext="true"/>
»  When several EBX Web Components are to be displayed on the same HTML page, for instance

using iFrames, it may be required to disable the management of cookies due to limitations present
in some Internet browsers.

For example, on Tomcat, this configuration is provided by the attribute cookies in the
configuration file server.xml, as follows:

<Context path="/ebx" docBase="(...)" cookies="false"/>
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Data source of the EBX repository

Note

If the EBX main configuration specifies the property ebx.persistence.url, then the
environment entry below will be ignored by EBX runtime. This option is only provided
for convenience; it is always recommended to use a fully-configurable datasource. In
particular, the size of the connection pool must be set according to the number of
concurrent users. See Configuring the EBX repository [p 3571 for more information on
this property.

The JDBC datasource for EBX is specified in the deployment descriptor WEB- INF/web . xm1 of the 'ebx'
web application as follows:

Reserved resource name Default JNDI name Description

jdbc/EBX_REPOSITORY Weblogic: EBX_REPOSITORY JDBC data source for EBX Repository.
JBoss: java:/ Java type: javax.sql.DataSource
EBX_REPOSITORY

See also

Configuring the EBX repository [p 357]

Rules for the database access and user privileges [p 397]

Mail sessions

Note

If the EBX main configuration does not set ebx.mail.activate to 'true', or if it specifies
the property ebx.mail.smtp.host, then the environment entry below will be ignored by
EBX runtime. See SMTP [p 362] in the EBX main configuration properties for more
information on these properties.

SMTP and email is declared in the deployment descriptor WEB-INF/web.xml of the 'ebx' web
application as follows:

Reserved resource name Default JNDI name Description

mail/EBX_MAIL_SESSION Weblogic: Java Mail session used to send emails from EBX.

EBX_MAIL_SESSION . . .
Java type: javax.mail.Session

JBoss: java:/
EBX_MAIL_SESSION
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JMS connection factory

Note

If the EBX main configuration does not activate JMS through the property
ebx.jms.activate, the environment entry below will be ignored by the EBX runtime.
See JMS [p 3631 in the EBX main configuration properties for more information on this
property.

The JMS connection factory is declared in the deployment descriptor wes-INF/web.xml of the 'ebx'
web application as follows:

Reserved resource name Default JNDI name Description Required
jms/EBX_JMSConnectionFactory Weblogic: JMS connection factory used by EBX Yes
EBX_JMSConnectionFactory to create connections with the JIMS

provider configured in the operational

JBoss: java:/ ) o
environment of the application server.

EBX_JMSConnectionFactory
Java type:
javax.jms.ConnectionFactory

Note

For deployment on WildFly, JBoss and WebLogic application servers with JNDI
capabilities, you must update EBX.ear or EBXForWebLogic.ear for additional mappings
of all required resource names to JNDI names.

JMS for data services

To configure data services to use JMS instead of the default HTTP, you must configure the JMS
connection factory [p 3301 and the following queues, declared in the WEB-INF/web.xml deployment
descriptor of the 'ebx' web application. This is the only method for configuring JMS for data services.

When a SOAP request is received, the SOAP response is optionally returned if the header field
JMSReplyTo is defined. If so, the fields JMScorrelationib and JMSType are retained.
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See JMS [p 363] for more information on the associated EBX main configuration properties.

Note

If the EBX main configuration does not activate JMS through the property
ebx.jms.activate, then the environment entries below will be ignored by EBX runtime.
See JMS [p 3631 in the EBX main configuration properties for more information on this

property.
Reserved resource name Default JNDI name Description Required
jms/EBX_QueueIn Weblogic: EBX_QueueIn JMS queue for incoming SOAP requests No
JBoss: java:/jms/ sent to EBX by other applications.
EBX_QueueIn Java type: javax.jms.Queue
jms/EBX_QueueFailure Weblogic: JMS queue for failures. It contains No
EBX_QueueFailure incoming SOAP requests for which an

error has occurred. This allows replaying

JBoss: java:/jms/ .
these messages if necessary.

EBX_QueueFailure
Java type: javax.jms.Queue

Note: For this property to be read, the
main configuration must also activate the
queue for failures through the property
ebx.jms.activate.queueFailure. See
JMS [p 3631 in the EBX main configuration
properties for more information on these
properties.

JAR files scanner

To speed up the web applications server startup, the JAR files scanner configuration should be
modified to exclude, at least, the ebx.jar and ebx-addons. jar libraries.

For example, on Tomcat, this should be performed in the
tomcat.util.scan.DefaultJarScanner.jarsToSkip property from the catalina.properties file.

54.7 Installation notes

EBX can be deployed on any Java EE application server that supports Servlet 3.0 up to 5.0 except.
The following documentation on Java EE deployment and installation notes are available:

« Installation note for JBoss EAP 7.1.X [p 333]

« Installation note for Tomcat 9.x [p 339]

« Installation note for WebSphere AS 9 [p 343]
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Installation note for WebLogic 14c [p 349]

Attention

The EBX installation notes on Java EE application servers do not replace the native
documentation for each application server.

These are not general installation recommendations, as the installation process is determined by
architectural decisions, such as the technical environment, application mutualization, delivery
process, and organizational decisions.

In these examples, no additional EBX modules are deployed. To deploy additional modules, the
best practice is to rebuild an EAR with the module as a web application at the same level as the
other EBX modules. The web application must declare its class path dependency as specified
by the Java™ 2 Platform Enterprise Edition Specification, v1.4:

J2EE.8.2 Optional Package Support

(...)

A JAR format file (such as a JAR file, WAR file, or RAR file) can reference a JAR file by naming the
referenced JAR file in a Class-Path header in the Manifest file of the referencing JAR file. The
referenced JAR file is named using a URL relative to the URL of the referencing JAR file. The Manifest
file is named META-INF/MANIFEST.MF in the JAR file. The Class-Path entry in the Manifest file is of the
form:

Class-Path: list-of-jar-files-separated-by-spaces

In an "industrialized" process, it is strongly recommended to develop a script that automatically
builds the EAR, with the custom EBX modules, the EBX web applications, as well as all the
required shared libraries.

In order to avoid unpredictable behavior, the guideline to follow is to avoid any duplicates of
ebx.jar or other libraries in the class-loading system.

In case of deployment on Oracle WebLogic server, please refer to the Module structure [p 497
section.
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CHAPTER BbH

Installation note for JBoss EAP 7.1.x

This chapter contains the following topics:

1.

£ LN e WD

Overview

Requirements

JBoss Application Server installation

EBX home directory configuration

JBoss Application Server and Java Virtual Machine configuration

JNDI entries configuration

Data source and JDBC provider configuration

EBX.ear application update

EBX.ear application deployment

10.EBX application start

55.1 Overview

Attention

This chapter describes a quick installation example of TIBCO EBX on JBoss Application Server.
It does not replace the documentation of this application server.

They are not general installation recommendations, as the installation process is determined by
architectural decisions, such as the technical environment, application mutualization, delivery
process, and organizational decisions.

The complete description of the components needed by EBX is given in chapter Java EE
deployment [p 323].

To avoid unpredictable behavior, the guideline to follow is to avoid any duplicates of ebx. jar,
ebx-1z4.jar or other libraries in the class-loading system.

55.2 Requirements

Java SE 8 or 11
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» JBoss Application Server EAP 7.1

« Database and JDBC driver

« EBXCD

« No CDI features in EBX's additional modules (since CDI will be automatically disable)

See alsoSupported environments [p 316]

55.3 JBoss Application Server installation

This quick installation example is performed for a Linux operating system.
1. Download JBoss EAP 7.1 Installer jar version 7.1.x from:

https://developers.redhat.com/products/eap/download/

2. Run the Installer using java -jar command line.
For further installation details, refer to the documentation .

3. Perform a standard installation:

—_

Select the language and click 'OK’,

Accept the License and click 'Next',

Choose the installation path and click 'Next',

Keep the 'Component Selection' as it is and click 'Next',
Enter 'Admin username', 'Admin password' and click 'Next',
On 'Installation Overview' click 'Next',

On 'Component Installation' click 'Next',

On 'Configure Runtime Environment' leave the selection as it is and click 'Next',

$ L N e WD

When 'Processing finished' appear, click 'Next',
10.Uncheck 'Create shortcuts in the start menu' and click 'Next',

11.Generate 'installation script and properties file' in the JBoss EAP 7.1 installation root
directory,

12.Click 'done'.

55.4 EBX home directory configuration

1. Create the EBX_HOME directory, for example /opt/ebx/home.

2. Copy from the EBX CD, the ebx.software/files/ebx.properties file to EBX_HOME. In our
example, we will have the following file:

/opt/ebx/home/ebx.properties.

3. If needed, edit the ebx.properties file to override the default database. By default the standalone
H2 database is defined. The property key ebx.persistence.factory must be uncommented for
other supported databases and the h2.standalone one must be commented.
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55.5 JBoss Application Server and Java Virtual Machine
configuration

1.

Open the standalone.conf configuration file, placed in <JB0SS_HOME>/bin (or jboss-eap.conf
file placed in <JB0SS_HOME>/bin/init.d for running the server as a service).

Add 'ebx.properties’ and 'ebx.home' properties to the 'JAVA_OPTS' environment variable
respectively set with ebx.properties file's path and EBX_HOME directory's path.

Set the 'JBOSS_MODULES_SYSTEM_PKGS' environment variable like the following:

JBOSS_MODULES_SYSTEM_PKGS="org.jboss.byteman, net.jpountz"

Copy from the EBX CD, the ebx.software/1lib/ebx-1z4.jar [p 324] Data compression library to
a dedicated directory (for example <JBOSS_HOME>/compress).

5. Open the standalone.sh script file, placed in <JBOSS_HOME>/bin.

Create a 'CLASSPATH' environment variable like the following:
CLASSPATH="<path_to_the_data_compression_library>:${JBOSS_HOME}/jboss-modules.jar:${CLASSPATH}"

# For our example
# CLASSPATH="${JBOSS_HOME}/compress/ebx-1z4.jar :${JBOSS_HOME}/jboss-modules. jar:${CLASSPATH}"

Replace the launch command options for foreground and background executions like the
following:

if [ "X$LAUNCH_JBOSS_IN_BACKGROUND" = "x" ]; then

# Execute the JVM in the foreground

eval \"$JAVA\" -D\"[Standalone]\" $JAVA_OPTS \
-cp "$CLASSPATH" \
\"-Dorg.jboss.boot.log.file="$JBOSS_LOG_DIR"/server.log\" \
\"-Dlogging.configuration=file:"$JBOSS_CONFIG_DIR"/logging.properties\" \
org.jboss.modules.Main \
$MODULE_OPTS \
-mp \""${JBOSS_MODULEPATH}"\" \
org.jboss.as.standalone \
-Djboss.home.dir=\""$JBOSS_HOME"\" \
-Djboss.server.base.dir=\""$JBOSS_BASE_DIR"\" \
"$SERVER_OPTS"
JBOSS_STATUS=$?

else

# Execute the JVM in the background

eval \"$JAVA\" -D\"[Standalone]\" $JAVA_OPTS \
-cp "$CLASSPATH" \
\"-Dorg.jboss.boot.log.file="$JBOSS_LOG_DIR"/server.log\" \
\"-Dlogging.configuration=file:"$JBOSS_CONFIG_DIR"/logging.properties\" \
org.jboss.modules.Main \
$MODULE_OPTS \
-mp \""${JBOSS_MODULEPATH}"\" \
org.jboss.as.standalone \
-Djboss.home.dir=\""$JBOSS_HOME"\" \
-Djboss.server.base.dir=\""$JBOSS_BASE_DIR"\" \
"$SERVER_OPTS" "&"

fi

55.6 JNDI entries configuration

1.
2.

Open the standalone-full.xml file placed in <JBOSS_HOME>/standalone/configuration.

Add, at least, the following lines to the server tag in messaging-activemq subsystem:

<connection-factory
name="jms/EBX_JMSConnectionFactory"
entries="java:/EBX_JMSConnectionFactory"
connectors="To Be Defined"/>
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<jms-queue
name="jms/EBX_D3ReplyQueue"
entries="java:/jms/EBX_D3ReplyQueue"
durable="true"/>

<jms-queue
name="jms/EBX_QueueIn"
entries="java:/jms/EBX_QueueIn"
durable="true"/>

<jms-queue
name="jms/EBX_QueueFailure"
entries="java:/jms/EBX_QueueFailure"
durable="true"/>

<jms-queue
name="jms/EBX_D3MasterQueue"
entries="java:/jms/EBX_D3MasterQueue"
durable="true"/>

<jms-queue
name="jms/EBX_D3ArchiveQueue"
entries="java:/jms/EBX_D3ArchiveQueue"
durable="true"/>

<jms-queue
name="jms/EBX_D3CommunicationQueue"
entries="java:/jms/EBX_D3CommunicationQueue"
durable="true"/>

Caution: the connectors attribute value, from the connection-factory element, has to be defined.
Since the kind of connectors is strongly reliant on the environment infrastructure, a default
configuration can not be provided.

See configuring messaging for more information.

3. Add, at least, the following line to mail subsystem:

<mail-session name="mail" debug="false" jndi-name="java:/EBX_MAIL_SESSION"/>

55.7 Data source and JDBC provider configuration

1. After the launch of the JBoss Server, run the management CLI without the use of '--connect' or
'-¢' argument.

2. Use the 'module add' management CLI command to add the new core module. Sample for
PostgreSQL configuration:

module add \
--name=org.postgresql \
--resources=<PATH_TO_JDBC_JAR> \
--dependencies=javaee.api, sun.jdk, ibm. jdk, javax.api, javax.transaction.api

3. Use the 'connect’ management CLI command to connect to the running instance.

4. Register the JDBC driver. When running in a managed domain, ensure to precede the command
with '/profile=<PROFILE_NAME>'. Sample for PostgreSQL configuration:

/subsystem=\
datasources/jdbc-driver=\
postgresqgl:add(\
driver-name=postgresql, \
driver-module-name=org.postgresql, \
driver-xa-datasource-class-name=org.postgresql.xa.PGXADataSource\

)

5. Define the datasource using the 'data-source add' command, specifying the appropriate argument
values. Sample for PostgreSQL configuration:

data-source add \
--name=jdbc/EBX_REPOSITORY \
--jndi-name=java:/EBX_REPOSITORY \
--driver-name=postgresql \
--connection-url=jdbc:postgresql://<SERVER_NAME>:<PORT>/<DATABASE_NAME> \
--user-name=<PERSISTENCE_USER> \
- -password=<PERSISTENCE_PASSWORD>
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55.8 EBX.ear application update

1. Copy from the EBX CD, the ebx.software/webapps/ear-packaging/EBX.ear file to your
working directory.

2. Uncompress the ear archive to add the application's specific required third-party libraries and
additional web modules.

Mail: see SMTP and emails [p 325] for more information.

SSL: see Secure Socket Layer (SSL) [p 326] for more information.

JMS: see Java Message Service (JMS) [p 326] for more information.
XML Catalog API: see XML Catalog API [p 326] for more information.

3. Update the /META-INF/application.xml and /META-INF/jboss-deployment-structure.xml files
according to the added additional web modules.

4. Compress anew the ear archive.

55.9 EBX.ear application deployment

1. Copy EBX.ear into the J80SS_HOME/standalone/deployments directory.

55.10 EBX application start

1. After the launch of the JBoss Application Server, with the <JB0SS_HOME>/bin/standalone.sh
-¢ standalone-full.xml command line or through the service command, run the EBX web
application by entering the following URL in the browser: http://localhost:8080/ebx/.

2. At first launch, EBX Wizard [p 375] helps to configure the default properties of the initial
repository.
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CHAPTER 56

Installation note for Tomcat 9.x

This chapter contains the following topics:

1.

©® N ek~ N

Overview

Requirements

Tomcat Application Server installation

EBX home directory configuration

Tomcat Application Server and Java Virtual Machine configuration

EBX and third-party libraries deployment

EBX web applications deployment

EBX application start

56.1 Overview

Attention

This chapter describes a quick installation example of TIBCO EBX on Tomcat Application
Server.

It does not replace the documentation of this application server.

They are not general installation recommendations, as the installation process is determined by
architectural decisions, such as the technical environment, application mutualization, delivery
process, and organizational decisions.

Tomcat 10.x is not supported.

The complete description of the components needed by EBX is given in chapter Java EE
deployment [p 323].

To avoid unpredictable behavior, the guideline to follow is to avoid any duplicates of ebx. jar,
ebx-1z4.jar or other libraries in the class-loading system.

The description below uses the variable name $CATALINA_HOME to refer to the Tomcat installation
directory, and from which most relative paths are resolved. However, if the $CATALINA BASE
directory has been set for a multiple instances configuration, it should be used for each of these
references.
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56.2 Requirements

« JavaSE 8or11

« Apache Tomcat 9.x

+ Database and JDBC driver
« EBXCD

See alsoSupported environments [p 316]

56.3 Tomcat Application Server installation

1. Download Tomcat 9.x core binary distributions from:
https://tomcat.apache.org/download-90.cgi

2. Run the installer or extract the archive and perform a standard installation with default options

56.4 EBX home directory configuration

1. Create EBX_HOME directory, for example C:\EBX\home, or /home/ebx

2. Copy from EBX CD the ebx.software/files/ebx.properties file to EBX_HOME. In our
example, we will have the following file:

C:\EBX\home\ebx.properties, or /home/ebx/ebx.properties

3. If needed, edit the ebx.properties file to override the default database. By default the standalone
H2 database is defined. The property key ebx.persistence.factory must be uncommented for
other supported databases and the h2.standalone one must be commented.

56.5 Tomcat Application Server and Java Virtual Machine
configuration

1. Modify $CATALINA_HOME/conf/server .xml (Or $CATALINA_BASE/conf/server .xml) file by adding
the following line to the <Host> element:

<Context path="/ebx" crossContext="true" docBase="ebx.war"/>
In our example, we will have:

<Host name=...>
<Context path="/ebx" crossContext="true" docBase="ebx.war"/>

</Host>

2. Modify the  $CATALINA_HOME/conf/catalina.properties (or  $CATALINA_BASE/conf/
catalina.properties) file by adding the following lines to the
tomcat.util.scan.DefaultJarScanner.jarsToSkip property:

ebx.jar,\
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ebx-addons.jar,\

ebx-1z4.jar,\

3. Configure the Java Virtual Machine properties

For Windows' Command Prompt launch

Set the environment variables by creating a setenv.bat file either into $CATALINA_HOME\bin
or $CATALINA_BASE\bin. This file will hold, at least, the following lines:

set EBX_HOME="<path_to_the_directory_ebx_home>"

set EBX_OPTS="-Debx.home=%EBX_HOME% -Debx.properties=%EBX_HOME%\ebx.properties"

set JAVA_OPTS="%EBX_OPTS% %JAVA_OPTS%"
set CLASSPATH="<$CATALINA_HOME_or_$CATALINA_BASE>\compress\ebx-1z4.jar ;%CLASSPATH%"

Where <$CATALINA_HOME_or_$CATALINA_BASE> must be replaced by
%CATALINA_HOME% Or %CATALINA_BASE% if they have been configured. Otherwise this piece of
text must be replaced by the Tomcat installation directory's path.

For Windows users that have installed Tomcat as a service
Set Java options through the Tomcat service manager GUI (Java tab).

Be sure to set options on separate lines in the Java Options field of the GUI:

-Debx.home=<path_to_the_directory_ebx_home>
-Debx.properties=<path_to_the_directory_ebx_home>\ebx.properties

Update the service using the //US// parameter to set the proper classpath value.

C:\> tomcat9 //US//Tomcat9 --Classpath=<$CATALINA_HOME_ or_$CATALINA_BASE>\compress\ebx-1z4.jar;
%CLASSPATH%

Where <$CATALINA_HOME_or_$CATALINA_BASE> must be replaced by

%CATALINA_HOME% Or %CATALINA_BASE% if they have been configured. Otherwise this piece of
text must be replaced by the Tomcat installation directory's path.

For Unix shell launch

Set the environment variables by creating a setenv.sh file either into $CATALINA_HOME/bin
or $CATALINA_BASE/bin. This file will hold, at least, the following lines:

EBX_HOME="<path_to_the_directory_ebx_home>"

EBX_OPTS="-Debx.home=${EBX_HOME} -Debx.properties=${EBX_HOME}/ebx.properties"

export JAVA_OPTS="${EBX_OPTS} ${JAVA_OPTS}"

export CLASSPATH="<$CATALINA_HOME_or_$CATALINA_BASE>/compress/ebx-1z4.jar:${CLASSPATH}"

Where <$CATALINA_HOME_or_$CATALINA_BASE> must be replaced by
${CATALINA_HOME} or ${CATALINA BASE} if they have been configured. Otherwise this piece
of text must be replaced by the Tomcat installation directory's path.

Caution: Accounts used to launch EBX must have create/update/delete rights on EBX_HOME
directory.

Note

<path_to_the_directory_ebx_home> is the directory where we copied
ebx.properties. In our example, it is C: \EBX\home, or /home/ebx.

Note

For a Data compression library [p 324] native installation, ensure to only reference it
in the CLASSPATH environment variable.
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56.6 EBX and third-party libraries deployment

1. Copy third-party libraries from the EBX CD to $CATALINA_HOME/1ib/ (Or $CATALINA_BASE/lib/)

directory, except for the Data compression library [p 3241. In our example, we will have:

$CATALINA_HOME/lib/javax.mail-1.5.6.jar coming from ebx.software/lib/1lib-mail

directory.

$CATALINA_HOME/lib/h2-1.4.196.jar (default persistence factory) coming from ebx.software/

1lib/1ib-h2 directory.

$CATALINA_HOME/lib/xml-apis-1.4.01.jar coming from ebx.software/lib/lib-xml-apis

directory.

The exact description of these components is given in chapter Software components [p 323].

Obviously, if those components are already deployed on the class-loading system, they do not

have to be duplicated.

2. Create a directory dedicated to the Data compression library [p 3241 (for example $CATALINA_HOME/

compress OF $CATALINA_BASE/compress) and copy it there.

Note

Ensure that the library is copied in the directory pointed out by the previously

updated CLASSPATH environment variable.

3. Copy from EBX CD the ebx.software/lib/ebx.jar file to $CATALINA_HOME/lib/ (or

$CATALINA_BASE/1lib/) directory. In our example, we will have:
$CATALINA_HOME/lib/ebx.jar

56.7 EBX web applications deployment

1. Copy from the EBX CD the war files in ebx.software/webapps/wars-packaging to the
$CATALINA_HOME/webapps/ (Or $CATALINA_BASE/webapps/) directory. In our example, we will

have:

$CATALINA_HOME/webapps/ebx.war: Initialization servlet for EBX applications

$CATALINA_HOME/webapps/ebx-root-1.0.war: Provides a common default module for data

models

$CATALINA_HOME/webapps/ebx-manager.war: Master Data Management web application

$CATALINA_HOME/webapps/ebx-dataservices.war: Data Services web application

$CATALINA_HOME/webapps/ebx-dma.war: Data Model Assistant web application

$CATALINA_HOME/webapps/ebx-ui.war: User Interface web application

56.8 EBX application start

1. After Tomcat launch, run EBX web application by entering the following URL in the browser:

http://localhost:8080/ebx/

2. At first launch, EBX Wizard [p 375] helps to configure the default properties of the initial

repository.
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CHAPTER B7

Installation note for WebSphere AS 9

This chapter contains the following topics:

1.

©® N ek~ N

Overview

Requirements
WebSphere Application Server installation

WebSphere Application Server and EBX home directory configuration

Data source and JDBC provider configuration

Java Virtual Machine configuration

EBX application deployment

EBX application start

57.1 Overview

Attention

This chapter describes a quick installation example of TIBCO EBX on WebSphere Application
Server.

It does not replace the documentation of this application server.

They are not general installation recommendations, as the installation process is determined by
architectural decisions, such as the technical environment, application mutualization, delivery
process, and organizational decisions.

The complete description of the components needed by EBX is given in chapter Java EE
deployment [p 323].

To avoid unpredictable behavior, the guideline to follow is to avoid any duplicates of ebx. jar,
ebx-1z4.jar or other libraries in the class-loading system.

57.2 Requirements

WebSphere Application Server 9
Database and JDBC driver
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EBX CD
No CDI features in EBX's additional modules (since CDI will be automatically disable)

See alsoSupported environments [p 316]

57.3 WebSphere Application Server installation

This quick installation example is performed for a Linux operating system.

1.

Download WebSphere AS 9 Installation Manager latest version from:

https://www.ibm.com/support/pages/node/609575

Run the Installation Manager and add the following repositories:

WebSphere Application Server V9.0:
http://www.ibm.com/software/repositorymanager/V9wWASBase
WebSphere Application Server Network Deployment V9.0:

http://www.ibm.com/software/repositorymanager/VOWASND

Install the webSphere Application Server Network Deployment

For further installation details, refer to the documentation.

Run the webSphere customization Toolbox and perform a standard installation with default
options:
1. Create profile: click 'Create’ then select 'Application Server', and click 'Next'

2.
3.

8.
9.

Profile Creation Options: select 'Advanced profile creation' and click "Next'
Optional Application Deployment: select those options:

« Deploy the 'Administrative Console'

« Deploy the 'Installation Verification Tool' application
Click Next'

Profile Name and Location: enter a profile name (example: 'EbxAppSrvProfile’) and a
directory. In our example, we will get:

/opt/IBM/WebSphere/AppServer/profiles/EbxAppSrvProfile
Further, it will correspond to <PROFILE_HOME>.

Click 'Next'

Node and Host Names: enter the node name (example: 'Nodel'), the server name (example:
'EbxServer'), the host name (example: "localhost'), and click 'Next'

Administrative Security: check 'Enable administrative security' option, enter the user name,
the password, and click 'Next'

Security Certificate (part 1): select 'Create a new default personal certificate' and 'Create a
new root signing certificate', and click 'Next'

Security Certificate (part 2): keep as default and click 'Next'

Port Value Assignment: keep as default and click 'Next'

10.Linux Service Definition: check 'Run the application server process as a Linux service'

option, enter the user name (example: 'ebx"), and click 'Next'
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11.Web Server Definition: keep as default and click 'Next'
12.Profile Creation Summary: keep as default and click 'Create'

13.Profile Creation Complete: uncheck 'Launch the First steps console’ option, and click 'Finish'

57.4 WebSphere Application Server and EBX home
directory configuration

1.
2.

Create the EBX_HOME directory, for example /opt/ebx/home

Copy from the EBX CD, the ebx.software/files/ebx.properties file to EBX_HOME. In our
example, we will have the following file:

/opt/ebx/home/ebx.properties.

If needed, edit the ebx.properties file to override the default database. By default the standalone
H2 database is defined. The property key ebx.persistence.factory must be uncommented for
other supported databases and the h2.standalone one must be commented.

Create the EBX_LIB directory, for example /opt/ebx/home/1ib

5. Copy third-party libraries, from the EBX CD or from other sources, to the EBX_LIB directory. In

our example, for a PostgreSQL database, we will get:
postgresql-X.X.X-driver.jar (coming from another source than the EBX CD).

xml-apis-1.4.01.jar (coming from the ebx.software/lib/lib-xml-apis/ directory of the EBX
CD).

ebx-1z4.jar (coming from the ebx.software/1ib/ directory of the EBX CD).

The complete description of these components is given in the chapter Java EE deployment [p 323].

If those components are already deployed on the class-loading system, they do not have to be
duplicated (ex: javax.mail-1.5.6.jar is already present on the WebSphere Application Server).

57.5 Data source and JDBC provider configuration

1.

Start the server with the following command line:
sudo <PROFILE_HOME>/bin/startServer.sh <serverName>
where:

<PROFILE_HOME> corresponds to the previously created profile home directory. In our
example, we will get: /opt/IBM/WebSphere/AppServer/profiles/EbxAppSrvProfile.

<serverName> corresponds to the server to start. In our example, we will get: Ebxserver.

Connect into the WwebSphere Integrated Solutions Console, using the user name and password
typed during the profile creation (Administrative Security step), by entering the following URL
in the browser:

https://localhost:9043/ibm/console

On the left menu, go to 'Resources > JDBC > Data Sources', choose the JDBC 'Scope' (for example
use 'Cell"), and click 'New'

4. Enter basic data source information:

« Data source name: EBX_REPOSITORY
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o JNDI name: jdbc/EBX_REPOSITORY
Click 'Next'
5. Select 'Create new JDBC provider', and click 'Next'
6. Create a new JDBC provider: (example with a PostgreSQL database)
« Database type: User-defined
« Implementation class name: org.postgresql.ds.PGConnectionPoolDataSource
« Name: PostgresQL
Click 'Next'
7. Enter database class path information: (example with a PostgreSQL database)
+ Class path: <eBx_LIB>/postgresql-X.X.X-driver.jar
In our example, <EBX_LIB> corresponds to /opt/ebx/home/1ib.
Click 'Next'
8. Keep database specific properties for the data source as default and click 'Next'
9. Keep setup security aliases as default and click 'Next'
10.Click 'Finish'
11.Save the master configuration
12.Click on 'Data Sources > EBX_REPOSITORY'

13.0n the right in the 'Configure additional properties' section, click on 'Additional Properties' and
define the database account access:

« Define the user value to the according user
« Define the password value to the according password
14.Save the master configuration

15.Test the connection

57.6 Java Virtual Machine configuration

Click on 'Application Servers'
Click on the server name (for example: 'EbxServer")
Click on 'Process definition' under 'Server infrastructure > Java Process Management'

Click on 'Java Virtual Machine' under 'Additional Properties'

Goihc e

Add 'ebx.properties' and 'ebx.home' properties, in the 'Generic JVM arguments' section,
respectively set to ebx.properties file's path and EBx_HOME directory's path.

6. Add, in the 'Classpath’ section, the paths to the third-party libraries placed in the EBX_L1B directory
except for the JDBC driver. In our example, we will get:

/opt/ebx/home/1ib/xml-apis-1.4.01.jar
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/opt/ebx/home/1ib/ebx-1z4.jar

Note

Every library's path declaration must be on a separate line.

7. Click 'Ok’

8. Save the master configuration

57.7 EBX application deployment

1. Copy from the EBX CD, the ebx.software/webapps/ear -packaging/EBX.ear to the <EBX_HOME>/
ear directory. In our example, we will get:

/opt/ebx/home/ear/EBX.ear

2. Connect into the webSphere Integrated Solutions Console, using the user name and password
typed during the profile creation (Administrative Security step), by entering the following URL
in the browser:

https://localhost:9043/ibm/console

3. Click on 'WebSphere enterprise applications' under 'Applications > Application Types'
4. Install the EBX.ear

1.
2.

o MW

Enterprise Applications: click on 'Install’

Preparing for the application installation: Browse to the EBX.ear file. In our example, it is
located under the /opt/ebx/home/ear directory.

Click 'Next'

How do you want to install the application?: Select 'Fast Path...', then click 'Next'
Select installation options: keep as default, then click 'Next'

Map modules to servers: select all modules, then click 'Next'

Map resource references to resources: copy the 'Resource Reference' value and paste it in the
'"Target Resource JNDI Name' field, for every modules, then click 'Next'

Warnings will appear related to JNDI:mail/EBX_MAIL_SESSION and JNDI:jms/
EBX_JMSConnectorFactory. This behavior is normal since these resources had not been
configured.

Click 'Continue'

Map resource environment references to resources: Copy the 'Resource Reference' value and
paste it to the "Target Resource JNDI Name' value, for every modules, then click 'Next'

Warnings will appear related to unavailable resources. This behavior is normal since these
resources had not been configured.

Click 'Continue'

10.Map virtual hosts for Web modules: select all modules and click 'Next'

11.Summary: keep as default, click 'Finish'

12.If installation succeeds, 'Application EBX installed successfully' is logged.

Click 'Save'
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5. On the left menu, go to 'Applications > Enterprise Applications'
6. Change EBX application's class loader policy
1. Click on EBX resource’s name

2. On the 'configuration' pane, under 'Detail Properties', click on 'Class loading and update
detection'

3. Under 'General Properties', change 'Class loader order' to 'Classes loaded with local class
loader first (parent last)' and click 'OK'

4, Save the master configuration
7. On the left menu, go to 'Applications > Enterprise Applications', select EBX, then click 'Start'

The EBX 'Application status' will changed to a green arrow.

57.8 EBX application start

1. After the launch of the WebSphere application Server, run the EBX web application by entering
the following URL in the browser:

http://localhost:9080/ebx/
or
https://localhost:9443/ebx/

2. At first launch, EBX Wizard [p 375] helps to configure the default properties of the initial
repository.
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CHAPTER 58

Installation note for WebLogic 14c

This chapter contains the following topics:

1.

£ LN e WD

Overview

Requirements

WebLogic Application Server installation

EBX home directory configuration

WebLogic Application Server and Java Virtual Machine configuration

EBX and third-party libraries deployment

Data source and JDBC provider configuration

EBX application deployment

EBX application start

58.1 Overview

Attention

This chapter describes a quick installation example of TIBCO EBX on WebLogic Application
Server.

It does not replace the documentation of this application server.

They are not general installation recommendations, as the installation process is determined by
architectural decisions, such as the technical environment, application mutualization, delivery
process, and organizational decisions.

The complete description of the components needed by EBX is given in chapter Java EE
deployment [p 323].

To avoid unpredictable behavior, the guideline to follow is to avoid any duplicates of ebx. jar,
ebx-1z4.jar or other libraries in the class-loading system.

58.2 Requirements

Certified Oracle Java SE 8 or 11
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+ WebLogic Server 14c
« Database and JDBC driver
« EBXCD

See alsoSupported environments [p 316]

58.3 WebLogic Application Server installation

1. Download WebLogic 14c latest version from:

https://www.oracle.com/middleware/technologies/fusionmiddleware-downloads.html

2. Run the oracle Fusion Middleware Weblogic installation wizard using a certified Oracle
JDK and the java -jar command line

3. Perform a standard installation with default options and choose the appropriate installation
directory

4. Leave the 'Automatically launch the Configuration Wizard' option activated to perform the next
steps:

1.

Create Domain: choose 'Create a new domain' and specify the domain home directory, then
click 'Next'

Templates: keep as default and click 'Next'

3. Administrator Account: enter a domain administrator username and password and click 'Next'

8.
9.

Domain Mode and JDK: choose the production mode and your JDK installation home and
click 'Next'

Advanced configuration: check 'Administration server' and "Topology'. That way, we create
two independent domain nodes: an administration one and an application one.

Click 'Next'

Administration Server: enter your administration node name (for example 'AdminServer')
and listen port (by default 7001), then click 'Next'

Managed Servers: add the application node name (for example 'EbxServer') and listen port
(for example 7003), then click 'Next'

Clusters: keep as default and click 'Next'

Server Templates: keep as default and click 'Next'

10.Machines: keep as default and click 'Next'

11.Configuration Summary: click 'Create’

12.Configuration Process: click 'Next'

13.End Of Configuration: click 'Finish'

58.4 EBX home directory configuration

1. Create EBX_HOME directory, for example C:\EBX\home, or /home/ebx

2. Copy from EBX CD the ebx.software/files/ebx.properties file to EBX_HOME. In our
example, we will have the following file:
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C:\EBX\home\ebx.properties, or /home/ebx/ebx.properties

3. If needed, edit the ebx.properties file to override the default database. By default the standalone
H2 database is defined. The property key ebx.persistence.factory must be uncommented for
other supported databases and the h2.standalone one must be commented.

58.5 WebLogic Application Server and Java Virtual
Machine configuration

1. Configure the launch properties for the Managed Server (for example 'EbxServer')

Edit the <DOMAIN_HOME>/bin/startManagedwebLogic. sh script file by adding the following lines:
EBX_HOME="<path_to_the_directory_ebx_home>"

EBX_OPTIONS="-Debx.home=${EBX_HOME} -Debx.properties=${EBX_HOME}/ebx.properties"
export JAVA_OPTIONS="${EBX_OPTIONS} ${JAVA OPTIONS}"

2. Edit the <DOMAIN_HOME>/bin/setDomainEnv.sh script file by adding the following line:
PRE_CLASSPATH="<path_to_the_data_compression_library>"

# For our example
# PRE_CLASSPATH="${DOMAIN_HOME}/compress/ebx-1z4.jar"

58.6 EBX and third-party libraries deployment

1. Copy third-party libraries from the EBX CD to the <DOMAIN_HOME>/1ib directory except for the
Data compression library [p 3241. In our example, for an H2 standalone data base, we will have:

<DOMAIN_HOME>/1ib/h2-1.4.196.jar (default persistence factory) coming from ebx.software/
1lib/1ib-h2 directory.

The complete description of the components needed by EBX is given in chapter Java EE
deployment [p 323]. Obviously, if those components are already deployed on the class-loading
system, they do not have to be duplicated (ex: javax.mail-1.5.6.jar and xml-apis-1.4.01.jar are
already present in the WebLogic Server).

2. Create a directory dedicated to the Data compression library [p 324] (for example <DOMAIN_HOME>/
compress) and copy it there.

Note

Ensure that the library is copied in the directory pointed out by the previously
updated PRE_CLASSPATH environment variable.

58.7 Data source and JDBC provider configuration

1. Start the 'Administration server' (for example 'AdminServer'), using:
<DOMAIN_HOME>/bin/startWebLogic.sh

2. Launch the 'WebLogic Server Administration Console' by entering the following URL in the
browser:

http://localhost:7001/console.

Log in with the domain administrator username and password
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3. Click on 'Services > Data sources' in the 'Domain Structure’ panel, then click on 'New > Generic
Data Source":

1. Set: Type Name: EBX_REPOSITORY, JNDI Name: EBX_REPOSITORY, Database Type: Your
database type

Click 'Next'

Choose your database driver type, and click 'Next'

Uncheck 'Supports Global Transactions', and click 'Next'
Setup your database 'Connection Properties' and click 'Next'
Click "Test Configuration' and then 'Finish'

Switch on the "Targets' tab and select all Servers, then click 'Save'

N o s WD

Restart the Administration server (for example 'AdminServer'), using:
<DOMAIN_HOME>/bin/stopWebLogic.sh

<DOMAIN_HOME>/bin/startWebLogic.sh

58.8 EBX application deployment

1. Copy from the EBX CD the ebx.software/webapps/ear -packaging/EBXForWebLogic.ear to the
EBX_HOME directory. In our example, we will have:

C:\EBX\home\EBXForWebLogic.ear, or /home/ebx/EBXForWebLogic.ear

2. Launch the 'WebLogic Server Administration Console' by entering the following URL in the
browser:

http://localhost:7001/console

3. Click on 'Lock and Edit' in the 'Change Center' panel
4. Click on 'Deployments' in the 'Domain Structure' panel, and click 'Install":

1. Install Application Assistant: Enter in 'Path’ the application full path to EBXForWebLogic.ear
file, located in c:\EBX\home\, or /home/ebx/ directory and click 'Next'

2. Choose the installation type and scope: Click on 'Install this deployment as an application’,
'Global' default scope and click 'Next'

3. Select the deployment targets: Select a node (for example 'EbxServer') from the 'Servers' list
and click 'Next'

4. Optional Settings: keep as default and click 'Finish'
5. Click on'Activate Changes', on the top left corner. The deployment status will change to 'prepared'

6. Switch to 'Control' tab, select the 'EBXForWebLogic' enterprise application, then click 'Start' >
'Servicing all requests'

7. Start the application node (for example 'EbxServer'), using:

<DOMAIN_HOME>/bin/startManagedwWeblLogic.sh EbxServer http://localhost:7001
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58.9 EBX application start

1. After WebLogic Application Server launch, run the EBX web application by entering the
following URL in the browser:

http://localhost:7003/ebx/

2. At first launch, EBX Wizard [p 375] helps to configure the default properties of the initial
repository.
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CHAPTER 59

TIBCO EBX main configuration file

This chapter contains the following topics:

1.

£ LN e WD

Overview

Setting automatic installation on first launch

Setting the EBX root directory

Configuring the EBX repository

Configuring the user and roles directory

Configuring EBX localization

Setting temporary files directories

Activating the XML audit trail

Configuring the EBX logs

10.Activating and configuring SMTP and emails

11.Configuring data services

12.Activating and configuring JMS

13.Configuring distributed data delivery (D3)

14.Configuring REST toolkit services

15.Configuring Web access from end-user browsers

16.Configuring failover

17.Tuning the EBX repositor
18.Miscellaneous

59.1 Overview

The EBX main configuration file, by default named ebx.properties, contains most of the basic
parameters for running EBX. It is a Java properties file that uses the standard simple line-oriented
format.

The main configuration file complements the Java EE deployment descriptor [p 328]. Administrators
can also perform further configuration through the user interface, which is then stored in the EBX
repository.
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See also

Deployment details [p 328]

UI administration [p 407]

Location of the file

The access path to the main configuration file can be specified in several ways. In order of descending
priority:

1. By defining the Java system property 'ebx.properties'. For example, this property can be set by
adding the option -Debx.properties=<filePath> to the java command-line command. See Java
documentation.

2. By defining the servlet initialization parameter 'ebx.properties'.

This standard Java EE setting must be specified in the web.xml file of
the web application 'ebx'. EBX accesses this parameter by calling the method
ServletConfig.getInitParameter("ebx.properties") in the servlet FrontServlet.

See getlnitParameter in the Oracle ServletConfig documentation.

3. By default, if nothing is specified, the main configuration file is located at WEB-INF/
ebx.properties of the web application 'ebx'.

Note

In addition to specifying properties in the main configuration file, it is also possible to
set the values of properties directly in the system properties. For example, using the -b
argument of the java command-line command.

Custom properties and variable substitution

The value of any property can include one or more variables that use the syntax ${propertyKey},
where propertyKey is either a system property, or a property defined in the main configuration file.

For example, the default configuration file provided with EBX uses the custom property ebx.home to
set a default common directory, which is then included in other properties.

59.2 Setting automatic installation on first launch

Repository can be automatically installed on first startup.

## Installation on first launch.
## All values are ignored if the repository is already installed.

## Enables repository installation on first startup (default is false).
ebx.install.enabled=true

## Following properties configure the repository. Values are optional and defaults are automatically generated.
ebx.install.repository.id=00275930BB88
ebx.install.repository.label=A Test

## Following properties specify the EBX administrator. These are ignored if a custom directory is defined.
ebx.install.admin.login=admin

ebx.install.admin.firstName=admin

ebx.install.admin.lastName=admin

ebx.install.admin.email=adamin@example.com

## Following property specifies the non-encrypted password used for the EBX administrator.

## It is ignored if a custom directory is defined. It cannot be set if property
ebx.install.admin.password.encrypted is set.

#ebx.install.admin.password=admin
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## Following property specifies the encrypted password used for the EBX administrator.

## It is ignored if a custom directory is defined. It cannot be set if property ebx.install.admin.password is
set.

## Password can be encrypted by using command:

## java -cp ebx.jar com.orchestranetworks.service.directory.EncryptPassword password_to_encrypt

ebx.install.admin.password.encrypted=8c6976e5b5410415bde908bd4deel5dfb167a9c873fc4bb8a81f6f2ab448a918

59.3 Setting the EBX root directory

The EBX root directory contains the Lucene indexes directory, the archives, the XML audit trail and,
when the repository is persisted on H2 standalone mode, the H2 database files.

## Path for EBX® XML repository

ebx.repository.directory=${ebx.home}/ebxRepository

See alsoMonitoring and clean up of the file system [p 403]

59.4 Configuring the EBX repository

Before configuring the persistence properties of the EBX repository, carefully read the section
Technical architecture [p 396] in the chapter 'Repository administration'.

The required library (driver) for each supported database is described in the chapter Database drivers
[p 325.

See also

Repository administration [p 396]

Rules for the database access and user privileges [p 397]

Supported databases [p 320]

Data source of the EBX repository [p 329]

Database drivers [p 325]

## The maximum time to set up the database connection,
## in milliseconds.

ebx.persistence.timeout=10000

## The prefix to add to all table names of persistence system.
## This may be useful for supporting multiple repositories in the relational database.
## Default value is 'EBX_'.

ebx.persistence.table.prefix=

## Case EBX® persistence system is H2 'standalone'.

ebx.persistence.factory=h2.standalone
ebx.persistence.user=sa
ebx.persistence.password=

## Case EBX® persistence system is H2 'server mode',

#ebx.persistence.factory=h2.server

## Specific properties to be set only only if you want to ignore the standard

## deployment process of 'ebx' web application in the target operational environment
## (see the deployment descriptor 'web.xml' of 'ebx' web application).
#ebx.persistence.url=jdbc:h2:tcp://127.0.0.1/ebxdb

#ebx.persistence.user=xxxxxxxxx

#ebx.persistence.password=yyyyyyyy
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## Case EBX® persistence system is Oracle database.

#ebx.persistence.factory=oracle

## Specific properties to be set only only if you want to ignore the standard

## deployment process of 'ebx' web application in the target operational environment
## (see the deployment descriptor 'web.xml' of 'ebx' web application).
#ebx.persistence.url=jdbc:oracle:thin:@127.0.0.1:1521:ebxDatabase
#ebx.persistence.driver=oracle.jdbc.OracleDriver

#ebx.persistence.user=xxxxxxxxx

#ebx.persistence.password=yyyyyyyy

## Activate to use VARCHAR2 instead of NVARCHAR2 on Oracle; never modify on an existing repository.
#ebx.persistence.oracle.useVARCHAR2=false

## Case EBX® persistence system is SAP Hana

#ebx.persistence.factory=hana

## Specific properties to be set only only if you want to ignore the standard

## deployment process of 'ebx' web application in the target operational environment
## (see the deployment descriptor 'web.xml' of 'ebx' web application).
#ebx.persistence.url=jdbc:sap://127.0.0.1:39041
#ebx.persistence.driver=com.sap.db.jdbc.Driver

#ebx.persistence.user=xxxXxXxXXXxx

#ebx.persistence.password=yyyyyyyy

## Case EBX® persistence system is Microsoft SQL Server.

#ebx.persistence.factory=sqlserver

## Specific properties to be set only only if you want to ignore the standard

## deployment process of 'ebx' web application in the target operational environment
## (see the deployment descriptor 'web.xml' of 'ebx' web application).
#ebx.persistence.url= \

#jdbc:sqlserver://127.0.0.1:1036;databasename=ebxDatabase
#ebx.persistence.driver=com.microsoft.sglserver.jdbc.SQLServerDriver
#ebx.persistence.user=xxxxxxxxx

#ebx.persistence.password=yyyyyyyy

## Case EBX® persistence system is Microsoft Azure SQL database.

#ebx.persistence.factory=azure.sql

## Specific properties to be set only only if you want to ignore the standard

## deployment process of 'ebx' web application in the target operational environment
## (see the deployment descriptor 'web.xml' of 'ebx' web application).
#ebx.persistence.url= \
#jdbc:sglserver://myhost.database.windows.net:1433;database=ebxDatabase;encrypt=true;\
#trustServerCertificate=false;hostNameInCertificate=*.database.windows.net;
#ebx.persistence.driver=com.microsoft.sglserver.jdbc.SQLServerDriver
#ebx.persistence.user=xxxxxxxxx

#ebx.persistence.password=yyyyyyyy

## Case EBX® persistence system is PostgreSQL.

#ebx.persistence.factory=postgresql

## Specific properties to be set only only if you want to ignore the standard

## deployment process of 'ebx' web application in the target operational environment
## (see the deployment descriptor 'web.xml' of 'ebx' web application).
#ebx.persistence.url=jdbc:postgresql://127.0.0.1:5432/ebxDatabase
#ebx.persistence.driver=org.postgresql.Driver

#ebx.persistence.user=xxxxxxxxx

#ebx.persistence.password=yyyyyyyy

59.5 Configuring the user and roles directory

This parameter specifies the Java directory factory class name. It must only be defined if not using
the default EBX directory.
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See also

Users and roles directory [p 435]

DirectoryFactory™

## Specifies the Java directory factory class name.
## Value must be the fully qualified name of the Java class.
## The class must extend com.orchestranetworks.service.directory.DirectoryFactory.

#ebx.directory.factory=xxx.yyy.DirectoryFactoryImpl

It is also possible to disable the built-in role "ADMINISTRATOR".

## Specifies whether the built-in role ADMINISTRATOR is disabled.
## Default value is false.

#ebx.directory.disableBuiltInAdministrator=true

59.6 Configuring EBX localization

This parameter is used to configure the locales used at runtime. This list must contain all the locales
that are exposed to the end-user. EBX will not be able to display labels and messages in a language
that is not declared in this list.

The default locale must be the first one in the list.

## Available locales, separated by a comma.

## The first element in the list is considered as the default locale.
## If not set, available locales are 'en-US, fr-FR'.

##t

#ebx.locales.available=en-US, fr-FR

See alsoExtending TIBCO EBX internationalization [p 245]

59.7 Setting temporary files directories

Temporary files are stored as follows:

## Directories for temporary resources.

# The property ebx.temp.directory allows to specify a directory for temporary files.
# Default value is java.io.tmpdir

#

ebx.temp.directory = \\${java.io.tmpdir}

#ebx.temp.directory = /tmp/java

# The property ebx.temp.cache.directory allows to specify the directory containing temporary files for cache.

# Default value is ${ebx.temp.directory}/ebx.platform.

#ebx.temp.cache.directory = ${ebx.temp.directory}/ebx.platform

# The property ebx.temp.import.directory allows to specify the directory containing temporary files for import.

# Default value is ${ebx.temp.directory}/ebx.platform.
#ebx.temp.import.directory = ${ebx.temp.directory}/ebx.platform

59.8 Activating the XML audit trail

By default, the XML audit trail is deactivated. It can be activated using the following variable:

# The XML history has been replaced by an SQL history.
# This old XML history can be activated using the following variable.
# Default is false.
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ebx.history.xmlaudittrail.activated = false

See alsoAudit trail [p 455]

59.9 Configuring the EBX logs

The most important logging categories are:

ebx.logdj.category.log.kernel

Logs for EBX main features, processes,
exceptions and compilation results of modules
and data models.

ebx.logdj.category.log.workflow

Logs for main features, warnings and
exceptions about workflow.

ebx.log4j.category.log.persistence

Logs related to communication with the
underlying database.

ebx.logdj.category.log.setup

Logs for the compilation results of all EBX
objects, except for modules and data models.

ebx.logdj.category.log.validation

Logs for datasets validation results.

ebx.log4j.category.log.mail

Logs for the activity related to the emails sent
by the server (see Activating and configuring
SMTP and emails [p 362]).

Note: This category must not use the Custom
SMTP appender [p 362] in order to prevent
infinite loops.

ebx.log4j.category.log.d3

Logs for D3 events on EBX.

ebx.logdj.category.log.dataservices

Logs for data service events in EBX.

ebx.logdj.category.log.monitoring

Raw logs for memory monitoring [p 302].

ebx.logdj.category.log.request

APT T

Logs all Request™ and Query™ issued in the
EBX repository having a duration exceeding
ebx.logs.request.durationThreshold
milliseconds. All queries are logged regardless
of their duration, if log level is set to DEBUG.

ebx.logdj.category.log.restServices

Logs for REST services events in EBX,
including those from the REST Toolkit [p 881].
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1

Some of these categories can also be written to through custom code using the LoggingCategory”
interface.

## Log4J properties:

##

## We have some specific syntax extensions:

## - Appender ebxFile:<aFileName>

## Defines a file appender with default settings (threshold=DEBUG)
##

## - property log.defaultConversionPattern is set by Java
#ebx.log4j .debug=true

#ebx.log4j.disableOverride=

#ebx.log4j.disable=

ebx.log4j.rootCategory= INFO

ebx.log4j.category.log.kernel= INFO, Console, ebxFile:kernel, kernelMail
ebx.log4j.category.log.workflow= INFO, ebxFile:workflow
ebx.log4j.category.log.persistence= INFO, ebxFile:persistence
ebx.log4j.category.log.setup= INFO, Console, ebxFile:kernel
ebx.log4j.category.log.mail= INFO, Console, ebxFile:mail
ebx.log4j.category.log.frontEnd= INFO, Console, ebxFile:kernel
ebx.log4j.category.log.frontEnd.incomingRequest= INFO
ebx.log4j.category.log.frontEnd.requestHistory= INFO
ebx.log4j.category.log.frontEnd.UIComponentInput= INFO
ebx.log4j.category.log.fsm= INFO, Console, ebxFile:fsm
ebx.log4j.category.log.fsm.dispatch= INFO
ebx.log4j.category.log.fsm.pageHistory= INFO
ebx.log4j.category.log.wbp= FATAL, Console

ebx.log4j.appender.Console.Threshold = INFO
ebx.log4j.appender.Console=com.onwbp.org.apache.log4j.ConsoleAppender
ebx.log4j.appender.Console.layout=com.onwbp.org.apache.log4j.PatternLayout
ebx.log4j.appender.Console.layout.ConversionPattern=${log.defaultConversionPattern}

ebx.log4j.appender.kernelMail.Threshold = ERROR

ebx.log4j.appender.kernelMail = com.onwbp.org.apache.log4j.net.SMTPAppender
ebx.log4j.appender.kernelMail.To = admin@domain.com

ebx.log4j.appender.kernelMail.From = admin${ebx.site.name}

ebx.log4j.appender.kernelMail.Subject = EBX® Error on Site ${ebx.site.name} (VM ${ebx.vm.id})
ebx.log4j.appender.kernelMail.layout.ConversionPattern=**Site ${ebx.site.name} (VM${ebx.vm.id})**%n
${log.defaultConversionPattern}

ebx.log4j.appender.kernelMail.layout = com.onwbp.org.apache.log4j.PatternLayout

ebx.log4j.category.log.monitoring= INFO, ebxFile:monitoring
ebx.log4j.category.log.dataServices= INFO, ebxFile:dataServices
ebx.log4j.category.log.d3= INFO, ebxFile:d3
ebx.log4j.category.log.request= INFO, ebxFile:request
ebx.log4j.category.log.restServices= INFO, ebxFile:dataServices

Custom 'ebxFile' appender

The token ebxFile: can be used as a shortcut to define a daily rolling file appender with default
settings. It must be followed by a file name. It then activates an appender that writes to a file located
in the directory ebx.logs.directory, with a threshold set to DEBUG.

The property ebx.log4j.appender.ebxFile.backup.Threshold allows defining the maximum
number of backup files for daily rollover.

## Directory of log files 'ebxFile:'
## This property is used by special appender prefixed
## by 'ebxFile:' (see log section below)

ebx.logs.directory=${ebx.home}/ebxLog

# Daily rollover threshold of log files 'ebxFile:'

# Specifies the maximum number of backup files for daily rollover of 'ebxFile:' appenders.
# When set to a negative value, backup log files are never purged.

# Default value is -1.

ebx.log4j.appender.ebxFile.backup.Threshold=-1
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Custom SMTP appender

The appender com.onwbp.org.apache.log4j.net.SMTPAppender provides an asynchronous email
sender.

See alsoActivating and configuring SMTP and emadils [p 362]

Custom module log threshold

By default, the log level threshold of the logging category associated with a custom module is set
to INFO.

This threshold can be customized by setting the property ebx.log4j.category.log.wbp.xxxxxx for
the custom module xxxxxx.

Example: ebx.log4j.category.log.wbp.mycompany-module=DEBUG.

T

See alsoModuleContextOnRepositoryStartup.getLoggingCategory”

Add-on module log threshold

By default, the log level threshold of any add-on module is set to INFo.

The log level threshold can be  customized by  setting the  property
ebx.log4j.category.log.addon.xxxxxx for the add-on module ebx-addon-xxxxxx.

Example: ebx.log4j.category.log.addon.daga=DEBUG

59.10 Activating and configuring SMTP and emails

The internal mail manager sends emails asynchronously. It is used by the workflow engine and the
custom SMTP appender com.onwbp.org.apache.log4j.net.SMTPAppender.

See alsoMail sessions [p 329]

## SMTP and emails

## Activate emails (true or false, default is false).

## If activated, the deployer must ensure that the entry 'mail/EBX_MAIL_SESSION' is bound
## in the operational environment of the application server (except if a specific email
## configuration is used by setting the property ebx.mail.smtp.host below).
#ebx.mail.activate=false

## Polling interval is in seconds (default is 10).
#ebx.mail.polling.interval=10

## Specific properties to be set only only if you want to ignore the standard
## deployment process of 'ebx' web application in the target operational environment
## (see the deployment descriptor 'web.xml' of 'ebx' web application).
#ebx.mail.smtp.host = smtp.domain.com

## SMTP port default is 25.

#ebx.mail.smtp.port= 25

#ebx.mail.smtp.login=

#ebx.mail.smtp.password=

## Activate SSL (true or false, default is false).

## If SSL is activated, a SSL factory and a SSL provider are required.
#ebx.mail.smtp.ssl.activate=true
#ebx.mail.smtp.ssl.provider=com.sun.net.ssl.internal.ssl.Provider
#ebx.mail.smtp.ssl.factory=javax.net.ssl.SSLSocketFactory
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59.11 Configuring data services

## Data services

# Specifies the default value of the data services parameter

# 'disableRedirectionTolLastBroadcast'.

# Default is false.
#ebx.dataservices.disableRedirectionToLastBroadcast.default=false

# Specifies the default value for deletion at the end of close and
# merge operations.

# If the parameter is set in the request operation, it overrides

# this default setting.

# If unspecified, default is false.
#ebx.dataservices.dataDeletionOnCloseOrMerge.default=false
#ebx.dataservices.historyDeletionOnCloseOrMerge.default=false

# Specifies the default maximum pagination size value for the select
# operations. This configuration is used by SOAP and REST connectors.
# Default value is 10000, maximum recommended value is 100000
#ebx.dataservices.pagination.maxSize.default= 10000

Upon WSDL generation, specifies if the target namespace value
corresponds to the content before 5.5.0 'ebx-services'

or 'urn:ebx:ebx-services' in conformity with the URI syntax.

If the parameter is set to true, there is no check of the target
namespace as URI at the WSDL generation.

If unspecified, default is false.
#ebx.dataservices.wsdlTargetNamespace.disabledCheck=false

#
#
#
#
#
#

## REST configuration

If activated, the HTTP request header 'Accept' is used to specify
the accepted content type. If none is supported, an error is
returned to the client with the HTTP code 406 'Not acceptable'.
If deactivated, the header is ignored therefore the best content
type is used.

Default is false.
#ebx.dataservices.rest.request.checkAccept=false

#
#
#
#
#
#

If activated, when a REST data service authentication negotiate fails,

EBX response includes fallback to 'Basic' authentication method by setting
the HTTP header 'www-Authenticate' to 'Basic'.

Note: This property only activate/deactivate

the authentication fallback.

Default is false.

#ebx.dataservices.rest.auth.tryBasicAuthentication=false

#
#
#
#
#
#

# Authorization token timeout is seconds.

# Default value is 1800 seconds (30 minutes)

# This value is ignored if 'Token Authentication Scheme' is not activated.
#ebx.dataservices.rest.auth.token.timeout=1800

59.12 Activating and configuring JMS

See alsoJMS for data services [p 330]

## JMS configuration for Data Services

## Activates JMS (true or false, default is false).

## If activated, the deployer must ensure that the entry 'jms/EBX_JMSConnectionFactory'
## are bound in the operational environment of the application server.

## The entry 'jms/EBX_QueueIn' should also be bound to enable handling Data Services
## request using JMS.

#ebx.jms.activate=false

## Activates JMS queue for failures (true or false, default is false).

## If activated, the deployer must ensure that the entry 'jms/EBX_QueueFailure' is bound
## in the operational environment of the application server.
#ebx.jms.activate.queueFailure=false
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## Number of concurrent listener(s)

## Default is 3.

## Property is used if ebx.jms.activate is set to true.
#ebx.jms.listeners.count=3

59.13 Configuring distributed data delivery (D3)

See Configuring D3 nodes [p 481] for the main configuration file properties pertaining to D3.

JMS for distributed data delivery (D3) [p 471]

Introduction to D3 [p 462]

59.14 Configuring REST toolkit services

## REST configuration

# Defines the maximum number of bytes that will be extracted

# from the REST request body to build some DEBUG log messages.

# Default value is 8192 bytes.

# This value is ignored if DEBUG level is not activated on the restServices logger.
#ebx.restservices.log.body.content.extract.size=8192

59.15 Configuring Web access from end-user browsers

HTTP Authorization header policy

EBX natively offers three policies to send and receive credentials using HTTP headers:

standard It corresponds to the authentication scheme, using the HTTP
Authorization header, described in the RFC 2617.

ebx To prevent HTTP Authorization header override issues, this
policy acts the same as the standard but the credentials are
stored in an EBX specific HTTP header.

both It is the combination of the two previously described
policies.

## EBX® authorization header policy for HTTP requests

##

## Possible values are: standard, ebx, both.

## standard:

## the standard HTTP Authorization header holds the credentials
## ebx:

## an EBX® specific HTTP header holds the credentials

## both:

## both (standard and specific) HTTP headers hold the credentials
##

## Default value is: both.

#ebx.http.authorization.header.policy=both
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URLs computing

By default, EBX runs in "standalone" mode, where external resources (images, JavaScript, etc.) are
provided by the application server.

Also by default, URL-related parameters in the main configuration file do not have to be set.

In this case, the server name and the port are obtained from the initial request sent to EBX.

See alsoURL policy (deprecated) [p 410]

## EBX® FrontServlet: default properties for computing servlet address

## {uselLocalurl}:

## If set to true, servlet address is a "local absolute" URL.

## (that is, a relative URL consisting of an absolute path: "/path")
## See RFC 2396, http://www.ietf.org/rfc/rfc2396.txt).

## This property is defined once for HTTP and HTTPS.

## Default value is false.

## {host}:

## If neither defined nor adapted, retrieves initial request host

## {port}:

## If neither defined nor adapted, retrieves initial request host

## {path}:

## Mandatory, may be empty

## {ui.path}:

## If not defined, defaults to ebx-ui/

## {http.useHttpsSettings}:

## If true, force the use of SSL security even if the incoming requests do not

## Resulting address will be:
## EBX®: protocol://{host}:{port}/{path}
## UI: protocol://{host}:{port}/{ui.path}

## Each property for HTTP (except {port}) may be inherited from HTTPS property,
## and reciprocally.

ebx.servlet.useLocalUrl=true

#ebx.servlet.http.host=
#ebx.servlet.http.port=
ebx.servlet.http.path=ebx/
#ebx.servlet.http.ui.path=ebx-ui/
#ebx.servlet.http.useHttpsSettings=false

#ebx.servlet.https.host=
#ebx.servlet.https.port=
ebx.servlet.https.path=ebx/
#ebx.servlet.https.ui.path=ebx-ui/

## External resources: default properties for computing external resources address
#i#

## The same rules apply as EBX® FrontServlet properties (see comments).

#i#

## Each property may be inherited from EBX® FrontServlet.

ebx.externalResources.useLocalUrl=true

#ebx.externalResources.http.host=
#ebx.externalResources.http.port=
#ebx.externalResources.http.path=
#ebx.externalResources.http.useHttpsSettings=false

#ebx.externalResources.https.host=

#ebx.externalResources.https.port=
#ebx.externalResources.https.path=
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Proxy mode

Proxy mode allows using a front-end HTTP server to provide static resources (images, CSS,
JavaScript, etc.). This architecture reduces the load on the application server for static HTTP requests.
This configuration also allows using SSL security on the front-end server.

The web server sends requests to the application server according to a path in the URL. The
servletAlias and uiServletAlias paths are specified in the main configuration file.

The web server provides all external resources. These resources are stored in a dedicated directory,
accessible using the resourcesAlias path.

EBX must also be able to access external resources from the file system. To do so, the property
ebx.webapps.directory.externalResources must be specified.

To force the wuse of SSL security even if the incoming requests do not,
ebx.servlet.http.useHttpsSettings and / or ebx.externalResources.http.useHttpsSettings
properties must be set to true. Their default values are false.

The main configuration file may be configured as follows:

## Path for external resources if they are not
## delivered within web applications
## This field is mandatory if in proxy mode.

ebx.webapps.directory.externalResources=D:/http/resourcesFolder

ebx.servlet.useLocalUrl=true

#ebx.servlet.http.host=
#ebx.servlet.http.port=
ebx.servlet.http.path=servletAlias
ebx.servlet.http.ui.path=uiServletAlias
#ebx.servlet.http.useHttpsSettings=false

#ebx.servlet.https.host=
#ebx.servlet.https.port=
ebx.servlet.https.path=servletAlias
ebx.servlet.https.ui.path=uiServletAlias

ebx.externalResources.useLocalUrl=true

#ebx.externalResources.http.host=
#ebx.externalResources.http.port=
ebx.externalResources.http.path=resourcesAlias
#ebx.externalResources.http.useHttpsSettings=false

#ebx.externalResources.https.host=
#ebx.externalResources.https.port=
ebx.externalResources.https.path=resourcesAlias

Attention

When proxy mode is used, the URL to the ebx-dataservices module must be configured through the
lineage administration panel. Note that the provided URL must end its path with /ebx-dataservices.

Reverse-proxy mode

If URLs generated by EBX, for requests and external resources, must contain a different protocol than
the one from the incoming request, a specific server name, a specific port number or a specific path
prefix, properties may be configured as follows:

#ebx.servlet.useLocalUrl=false
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ebx.servlet.http.host=reverseDomain
#ebx.servlet.http.port=
ebx.servlet.http.path=ebx/
#ebx.servlet.http.ui.path=ebx-ui/
#ebx.servlet.http.useHttpsSettings=false

ebx.servlet.https.host=reverseDomain
#ebx.servlet.https.port=
ebx.servlet.https.path=ebx/
#ebx.servlet.https.ui.path=ebx-ui/

## Web parameters (for external resources)
## if nothing is set, values are taken from servlet.

#ebx.externalResources.useLocalUrl=false
#ebx.externalResources.http.host=
#ebx.externalResources.http.port=

#ebx.externalResources.http.path=
ebx.externalResources.http.useHttpsSettings=true

ebx.externalResources.https.host=reverseDomain
#ebx.externalResources.https.port=
ebx.externalResources.https.path=

Attention

When reverse-proxy mode is used, the URL to the ebx-dataservices module must be configured
through the lineage administration panel. Note that the provided URL must end its path with /ebx-
dataservices.

59.16 Configuring failover

These parameters are used to configure the failover mode and activation key, as well as heartbeat
logging in DEBUG mode.

See alsoFailover with hot-standby [p 397]

## Mode used to qualify the way in which a server accesses the repository.
## Possible values are: unique, failovermain, failoverstandby.
## Default value is: unique.

#ebx.repository.ownership.mode=unique

## Activation key used in case of failover. The backup server must include this

## key in the HTTP request used to transfer exclusive ownership of the repository.
## The activation key must be an alphanumeric ASCII string longer than 8 characters.
#ebx.repository.ownership.activationkey=

## Specifies whether to hide heartbeat logging in DEBUG mode.

## Default value is true.
#ebx.repository.ownership.hideHeartBeatLogForDebug=true

59.17 Tuning the EBX repository

Some options can be set so as to optimize memory usage.

The properties are configured as follows:

## Technical parameters for memory and performance tuning

Import commit threshold allows to specify the commit threshold
exclusively for the archive import launched directly from Manager.

For more details about the commit threshold,
see the JavaDoc ProcedureContext.setCommitThreshold().

#
#
#
#
#
# Default value is 0.
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#
ebx.manager .import.commit.threshold=100

See alsoValidation report page [p 373]

59.18 Miscellaneous

Activating data workflows

This parameter specifies whether data workflows are activated. This parameter is not taken into
account on the fly. The server must be restarted whenever the value changes.

## Workflow activation.
## Default is true.

ebx.workflow.activation = true

Disabling user task legacy mode

This parameter specifies whether the creation service of a user task in legacy mode should be offered
in the workflow modeling. The default value is false.

APT

See UserTask.UserTaskMode . LEGACY_MODE™ for more information.

## Disables legacy work item mode (default is false)

## Specify if the creation service of user task in legacy mode must be offered
## in workflow modeling.

#ebx.manager .workflow.legacy.userTaskMode=true

Disabling hierarchy plan view

This parameter specifies whether the hierarchy plan view is hidden. The default value is true.

## Activate or deactivate Workflow hierarchy plan view
ebx.manager .workflow.hierarchyPlanView.hidden=false

Log procedure starts

This parameter specifies whether starts of the procedure execution are logged.

## Specifies whether transaction starts are logged. Default is false.

ebx.logs.logTransactionStart = true

Log validation starts

This parameter specifies whether starts of datasets validation are logged.

## Specifies whether validation starts are logged. Default is false.

ebx.logs.logvalidationStart = true

Request duration threshold for logs

This parameter specifies in milliseconds the threshold of duration of Request™ and Query™ to be
logged. Logs are generated if logging category ebx.log4j .category.log.request level is not higher
than INFo. If the level is DEBUG, all Request™ and Query™ are logged.

## Specifies in milliseconds the threshold of duration of Requests and Queries
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## to be logged
## Default value is 1000 ms.
## If unset, the default value is used.

#ebx.logs.request.durationThreshold=1000

Request duration threshold for logs

This parameter specifies in milliseconds the delay between 2 logs for Request™* and Query™ that goes
beyond the threshold of duration. If this value is greater than 0, and the query duration goes beyond
the threshold of duration, it will be logged again repeatedly with at least this delay between each log.
As log messages include duration, this is useful to track long queries duration.

APT APT

## Specifies in milliseconds the delay between 2 logs for Requests and Queries that goes

## beyond the threshold of duration. If this value is greater than 0, and the query duration
## goes beyond the threshold of duration, it will be logged again repeatedly with at least
## this delay between each log.

## Default value is 30000 ms.

## If unset, the default value is used.

#ebx.logs.request.logAgainEvery=30000

Deployment site identification

This parameter allows specifying the email address to which technical log emails are sent.

## Unique Site Name
## --> used by monitoring emails and by the repository

ebx.site.name= name@domain.com

Dynamically reloading the main configuration

Some parameters can be dynamically reloaded, without restarting EBX. The parameter
thisfile.checks.intervalInSeconds indicates how frequently the main configuration file is
checked.

### Checks if this file has been updated
### If value <= 0, no more checks will be done

thisfile.checks.intervalInSeconds=1

In development mode, this parameter can be set to as low as one second. On production systems,
where changes are expected to be less frequent, the value can be greater, or set to '0' to disable hot
reloading entirely.

This property is not always supported when the module is deployed as a WAR, as it would then depend
on the application server.

Declaring modules as undeployed

On application server startup, the initialization of deployed web applications / EBX modules and the
initialization of the EBX repository are performed asynchronously. In order to properly initialize the
EBX repository, it is necessary to compile all the data models used by at least a dataset, hence EBX
will wait endlessly for referenced modules to be registered.
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If a module is referenced by a data model but is not deployed (or no longer deployed), it is necessary
to declare this module as undeployed to unlock the wait and continue the startup process.
Note

The kernel logging category indicates which modules are awaited.

Note
A module declared as undeployed cannot be registered into EBX until it is removed from
the property ebx.module.undeployedModules.

Note

Any data model based on an unregistered module will have an "undeployed module"
compilation error.

See also

Module registration [p 498]

Dynamically reloading the main configuration [p 369]

## Comma-separated list of EBX® modules declared

## as undeployed.

## If a module is expected by the EBX® repository but is

## not deployed, it must be declared in this property.

## Caution:

## if the "thisfile.checks.intervalInSeconds" property is deactivated,
## a restart is mandatory, otherwise it will be hot-reloaded.

ebx.module.undeployedModules=

Module public path prefix

EBX modules' public paths are declared in the 'module.xml' file of each module. A context prefix
can be declared for all modules, without having to modify the 'module.xml' content, by specifying
the property that follows.

This prefix will apply to any EBX module, including core, add-on and specific modules.

When proxy and / or reverse-proxy mode are used, the ebx.servlet.http[s].path and
ebx.servlet.http[s].ui.path properties must take into account this module public path prefix
setting. Conversely, the ebx.externalResources.http[s].path property must end its path just before
a potential prefix.

ebx.servlet.useLocalUrl=true

#ebx.servlet.http.host=

#ebx.servlet.http.port=
ebx.servlet.http.path=reverse-proxy/prefix/ebx/
ebx.servlet.http.ui.path=reverse-proxy/prefix/ebx-ui/
#ebx.servlet.http.useHttpsSettings=false

#ebx.servlet.https.host=

#ebx.servlet.https.port=
ebx.servlet.https.path=reverse-proxy/prefix/ebx/
ebx.servlet.https.ui.path=reverse-proxy/prefix/ebx-ui/

## Web parameters (for external resources)
## if nothing is set, values are taken from servlet.

ebx.externalResources.useLocalUrl=true

#ebx.externalResources.http.host=
#ebx.externalResources.http.port=
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ebx.externalResources.http.path=reverse-proxy/
#ebx.externalResources.http.useHttpsSettings=false

#ebx.externalResources.https.host=
#ebx.externalResources.https.port=
ebx.externalResources.https.path=reverse-proxy/

## EBX® Module context path prefix

##

## If defined, applies to all EBX® modules public paths declared in
## any module.xml file (core, add-on and specific).

ebx.module.publicPath.prefix=prefix/

See URLs computing [p 365] for more information.

EBX run mode

This property defines how EBX runs. Three run modes are available: development,integration and
production.

When running in development mode, the development tools [p 509] are activated in EBX, some
features thus become fully accessible and more technical information is displayed.

Note

The administrator can always access this information regardless of the mode used.
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The additional features accessible when running in development mode include the following (non-
exhaustive list):

Documentation pane In the case of a computed value, the Java class name is
displayed. A button is displayed giving access to the path
to a node.

Compilation information Module and schema compilation information is displayed

in the dataset validation report.

Java bindings The generation of Java bindings is available if the schema
of the dataset mentions at least one binding.

Web component link generator =~ The Web component link generator is available on datasets
and dataspaces.

Data model assistant Data model configuration and additional options, such
as Services, Business Objects and Rules, Java Bindings,
Toolbars and some advanced properties.

Workflow modeling Declare specific script tasks.

Log The logs include additional technical information intended
for the developer. For example, a warning is written to logs
if a drop-down list is defined on a node which is not an
enumeration in a Ul Bean.

Product documentation The product documentation is always the most complete one
(i.e "advanced"), including administration and development
chapters.

## Server Mode
## Value must be one of: development, integration, production
## Default is production.

backend.mode=integration

Note

There is no difference between the integration and production modes.

Resource filtering

This property allows the filtering of certain files and directories in the resource directory contents
(resource type node, with an associated facet that indicates the directory that contains usable
resources).

## list (separated by comma) of regexps excluding resource
## the regexp can be of type [pattern] or "m:[pattern]:".
## the list can be void
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ebx.resource.exclude=CVS/*

Validation report page

The validation report page can display a finite number of items for each severity. This number can
be tuned with this property.

## Defines the maximum item displayed for each severity in the validation report page.
## Default value is 100.

ebx.validation.report.maxItemDisplayed=200

See alsoTuning the EBX repository [p 367]

Validation report logs

This property allows to specify the number of validation messages to display in the logs when
validating a dataset or a table.

## Defines the maximum number of messages displayed in the logs.
## Default value is 100.
## When set to 0 or a negative value, the limit is not considered.

ebx.validation.report.maxItemDisplayedInLogs=500

See alsoTuning the EBX repository [p 367]
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cHAPTER 60

Initialization and first-launch
assistant

Deliverables can be found on TIBCO eDelivery (an account is mandatory in order to access eDelivery,
please contact the support team to request one).

The TIBCO EBX Configuration Assistant helps with the initial configuration of the EBX repository.
If EBX does not have a repository installed upon startup and if the automatic installation [p 356] is not
enabled, the configuration assistant is launched automatically.

Before starting the configuration of the repository, make sure that EBX is correctly deployed on the
application server. See Java EE deployment [p 323].

Note

The EBX main configuration file must also be properly configured. See TIBCO EBX
main configuration file [p 355].

This chapter contains the following topics:

1. Configuration steps

60.1 Configuration steps

The EBX configuration assistant guides you through the following steps:
1. Validating the license agreement.
2. Configuring the repository.
3. Defining users in the default user and roles directory (if a custom directory is not defined).
4. Validating the information entered.
5. Installing the EBX repository.

Validating the license agreement

In order to proceed with the configuration, you must read and accept the product license agreement.
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Configuring the repository

This page displays some of the properties defined in the EBX main configuration file. You also define
several basic properties of the repository in this step.

Id of the repository Must uniquely identify the repository (in the scope of

(repositoryId) the enterprise). The identifier is 48 bits (6 bytes) long
and is usually represented as 12 hexadecimal digits. This
information is used for generating the Universally Unique
Identifiers (UUIDs) of entities created in the repository, and
also of transactions logged in the history. This identifier acts
as the "UUID node", as specified by RFC 4122.

Repository label Defines a user-friendly label that indicates the purpose and
context of the repository.

See alsoTIBCO EBX main configuration file [p 355]

Defining users in the default directory

If a custom user and roles directory is not defined in the EBX main configuration file, the configuration
assistant allows to define default users for the default user and roles directory.

An administrator user must be defined. You may optionally create a second user.

See alsoUsers and roles directory [p 435]

Validating the information entered

Before proceeding with the installation of the repository, you can review the configuration of the
repository and the information entered on the 'Configuration Summary' page. If you need to modify
information, you can return to the previous pages using the configuration assistant < Back button.

Once you have verified the configuration, click the button Install the repository > to proceed with
the installation.

Installing the EBX repository

The repository installation is performed using the provided information. When the installation is
complete, you are redirected to the repository login page.
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CHAPTER 61

Deploying and registering TIBCO
EBX add-ons

Note
Refer to the documentation of each add-on for additional installation and configuration
information in conjunction with this documentation.
This chapter contains the following topics:

1. Deploying an add-on module

2. Registering an add-on module

3. Activating an add-on module

4. Deleting an add-on module

61.1 Deploying an add-on module

Note

Each add-on bundle version is intended to run with a specific EBX version and all
its fix releases. Make sure that the EBX and add-on bundle versions are compatible,
otherwise the add-on registration will abort.

The web application deployment descriptor for the add-on module must specify that class definitions
and resources from the web application are to be loaded in preference to classes from the parent and
server classloaders.

For example, on WebSphere Application Server, this can be done by setting <context-priority-
classloader>true</context-priority-classloader> in the web-app element of the deployment
descriptor.

On  WebLogic, include <prefer-web-inf-classes>true</prefer-web-inf-classes> in
weblogic.xml.

See the documentation on class loading of your application server for more information.
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The EBX add-on common JAR file, named lib/ebx-addons.jar, must be copied in the library
directory shared by all web applications.

Note

The add-on log level can be managed in the main configuration file [p 362].

61.2 Registering an add-on module

Registering an add-on makes its configuration available in the admin section. Add-on features are
only available to end-users when the add-on is also activated [p 378].

To register a new EBX add-on in the repository:
1. Navigate to the 'Administration’ area.

2. Click the down-arrow in the navigation pane and select Technical configuration > Add-ons
registration.

3. On the Registered add-ons page, click the + button to create a new entry.
4. Select the add-on you are registering.

5. Click on Save.

Note

Unregistering an add-on will not delete any existing configuration, but will make it
available in the UI until the add-on is registered again.

61.3 Activating an add-on module

Activating an add-on makes its features available to the end-users. Only registered add-ons can be
activated.

To activate an EBX add-on in the repository:
1. Navigate to the 'Administration’ area.

2. Click the down-arrow in the navigation pane and select Technical configuration > Add-ons
registration.

3. Select the registered add-on you are activating and enable the 'Activation' field.

4. Click on Save.

61.4 Deleting an add-on module

To delete an add-on module from the EBX repository:
1. Navigate to the 'Administration’ area.

2. Click the down-arrow in the navigation pane and select Technical configuration > Add-ons
registration.

3. On the Registered add-ons page, tick the box corresponding to the add-on to be deleted.
4. In the 'Actions' menu, select 'Delete’'.

5. Close and purge the Administration datasets related to the previously used add-on, as well as the
including dataspaces.
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When an add-on is no longer deployed, a dataspace corresponding to the Administration dataset
will then appear in the list of Reference children under the dataspaces. When an add-on module
is no longer deployed, it is thus necessary to close/delete and purge manually all data/dataspaces
related to the add-on.
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CHAPTER 62

Building the image

This chapter contains the following topics:
1. Overview

2. Workstation requirement

3. Building the image

62.1 Overview

TIBCO EBX Container Edition image is Linux based (amd64 architecture) and includes the
following:

« Application Server Apache Tomcat 9.0
« JavaJDK 11

62.2 Workstation requirement

The image can be built on a workstation meeting following requirements:
« Operating system: Windows 10, macOS or Linux,
« Docker Desktop installed and running,

o Access to Internet.

62.3 Building the image

Download the installer

To build an EBX image, one needs to download file
TIB_ebx_{ebx.version.public}_addon_5.X.Y_container_edition.amd64.zip from TIBCO
eDelivery.

Running the installer
To start installer on Linux or macOS:
« Unzip the TIB_ebx_{ebx.version.public}_addon_5.X.Y_container_edition.amd64.zip,

« Open a terminal in folder where file ebx-ce-installer.sh file is located,
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» Execute command ./ebx-ce-installer.sh.
To start installer on Windows 10:
« Unzip the TIB_ebx_{ebx.version.public}_addon_5.X.Y_container_edition.amd64.zip,
» Open a Windows PowerShell in folder where file ebx-ce-installer.bat file is located,
» Execute command ebx-ce-installer.bat.
Follow instructions and select addons to be added to the image.

The installer will then build the image and print a summary similar to:

Kok Kk ke ke kK kK ko k ko k ok ok ok ok ok ok ok ok ok ok ok ok ok kK ko ko k ok ok ok ok ok ok ok ok ok ok ok ok ok ok ko ko ko ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok kK ok

The TIBCO EBX Container Edition image was successfully created with following names:
ebx:latest
ebx:{ebx.version.public}-mame-tese-dama-dmdv-5.X.Y
This image includes the following addon(s):
Match and Merge (MAME)
Information Search (TESE)
Digital Asset Manager (DAMA)
Data Model and Data Visualization (DMDV)
To run this image with the default configuration and an embedded database, use command:
docker run -p 8080:8080 -d ebx:latest
You can test EBX by visiting http://localhost:8080 in a browser.
To run this image with other configurations, for example with an external database, see
documentation.

Kok Kk ok ke ke ke kK ko ko k ko k ko ok ok ok ok ok ok ok ok ok ok ok kK ko k ko ok ok ok ok ok ok ok ok ok ok ok ok ok ok kb ko ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok ok kK kK ok

Testing the image
The image can be run locally using command:

docker run -p 8080:8080 -d ebx:latest

In production, it is recommended to not use tag latest. The installer will always generate another
tag depending on selected addons.

If previous sample, the tag is {ebx.version.public}-mame-tese-dama-dmdv-5.X.Y because the
following addons where selected:

« Match and Merge (MAME),

« Information Search (TESE),

» Digital Asset Manager (DAMA),

« Data Model and Data Visualization (DMDV).
The image can then be run using command:
docker run -p 8080:8080 -d ebx:{ebx.version.public}-mame-tese-dama-dmdv-5.X.Y
If no addons are selected, the tag is {ebx.version.public}

The image can be run using command:

docker run -p 8080:8080 -d ebx:{ebx.version.public}

Sharing the image
The steps to share an image depends on customer’s company infrastructure.

In following example, the image is pushed to a Docker private registry named myregistry:

docker tag ebx:{ebx.version.public} myregistry:5000/ebx:{ebx.version.public}
docker push myregistry:5000/ebx:{ebx.version.public}
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CHAPTER 63

Running the image

This chapter contains the following topics:

1. Starting EBX

Container access

Environment variables

Configuration files

Volumes

Linux user and group

Logs access

63.1 Starting EBX

N ok DN

First-launch assistant
To start EBX with default configuration that includes an embedded H2 database, execute command:

docker run -p 8080:8080 -d ebx:{ebx.version.public}

Using a browser, you can connect to EBX with URL http://localhost:8080. This will display the first-
launch assistant that will help you configure EBX.

For more information on the first launch assistant, see chapter Initialization and first-launch assistant
[p 375].

Automatic initialization

To start EBX with automatic initialisation on first startup and an embedded H2 database, execute

command:
docker run -d -p 8080:8080 \
-e "EBX_FLA_DISABLED=true" \

-e "EBX_INSTALL_ADMIN_PASSWORD=<password>" \
ebx:{ebx.version.public}

The EBX repository will be automatically created on first startup.

Using a browser, you can connect to EBX with URL http://localhost:8080. This will display the
EBX login screen. The username for administrator is admin and the password is the one specified
in previous command.

Note
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It’s possible to specify another username for the administrator. For more information see Automatic
repository installation on first launch [p 386].

Supported browsers

For details a supported browsers see: Supported Web Browsers [p 317].

63.2 Container access

The following command will start a bash shell inside the EBX container:

docker exec -it <container-id> bash

63.3 Environment variables

This chapter describes the environment variables supported by EBX Container Edition.

All are optional.

Disabling First-launch assistant
For security reasons, one might want to disable the first-launch assistant in all circumstances.
This is achieved by setting environment variable to EBX_FLA_DISABLED to true.

Automatic repository installation on first launch

If the repository is not yet initialized and first-launch assistant is disabled, EBX will automatically
trigger its installation if following mandatory variables are provided:

Name Default Description

EBX_INSTALL_ADMIN_LOGIN admin Sets the EBX administrator login name.

This parameter is ignored if repository variable
EBX_FLA_DISABLED value is not true or if
repository is already initialized.

EBX_INSTALL_ADMIN_PASSWORD Sets the EBX administrator login name.

This parameter is mandatory if
EBX_FLA_DISABLED value is true

and is ignored if repository variable
EBX_FLA_DISABLED value is not true or if
repository is already initialized.

Note
If mandatory variables are not provided, EBX will display an error message.
Example

To automatically install repository launch EBX using following command:

docker run -d -p 8080:8080 \

-e "EBX_FLA_DISABLED=true" \

-e "EBX_INSTALL_ADMIN_LOGIN=<login-name>" \
-e "EBX_INSTALL_ADMIN_PASSWORD=<password>" \
ebx:{ebx.version.public}
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URL configuration

Some EBX features require generating URLs. Specific configuration may be required to achieve this,

for example if EBX is running behind a reverse proxy or on a Kubernetes cluster.

Name

Default

Description

EBX_IS_SECURED

If incoming request is HTTPS, "true" is
assumed or else "false" is assumed.

If "true", the protocol "HTTPS" is
assumed. If "false", the protocol "HTTP"
is assumed.

EBX_HOSTNAME

The host name specified by the incoming
HTTP(S) request.

The EBX server host name.

EBX_PORT

The port number specified by the
incoming HTTP(S) request.

The EBX server port number.

EBX_ROOT_PATH

By default, the context path is empty.

If set, all EBX urls will be prefixed by
this value. The value must have a leading
/ and must not have a trailing / except if
value is /.

For example a valid value is /mdm/sales.

Setting this variable is useful when
running more than one instance of EBX
with the same host name.

EBX_URL_DEFAULT

This environment variable is used when
a background task needs to calculate a
URL to EBX.

It should be set to a full URL without the
path component (EBX_ROOT_PATH
applies for the path component).

For example a valid value is: https://
host_name.

If EBX_URL_DEFAULT is not specified
and EBX_HOSTNAME is specified,

a default is caculated with following
assumptions:

- If EBX_IS_SECURED is not specified,
'false' is assumed,

- If EBX_PORT is not specified, 443 is
assumed if EBX_IS_SECURED is true
or else 80 is assumed.

Database connectivity

For information on supported databases see chapter Supported databases [p 3201.

By default, an embedded H2 database is used. Data for this H2 database is persisted at location /ebx/

data/h2.
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An external database may be configured using following variables:

Name TIBCO EBX main Description
configuration file equivalent

EBX_DB_FACTORY ebx.persistence.factory Specifies the type of database server.

EBX_DB_URL ebx.persistence.url The JDBC URL. It has format: jdbc:postgresql://
<database_host>:<database_port_number>/
<database_name>.

EBX_DB_USER ebx.persistence.user The database user id.

EBX_DB_PASSWORD ebx.persistence.password The database user password.

For more information on these variables see their TIBCO EBX main configuration file equivalent in
chapter Configuring the EBX repository [p 357].

Note

The container includes JDBC drivers only for H2, PostgreSQL and Microsoft SQL Server. Using other
databases that are supported by EBX require adding the driver.

For instructions on how to add a driver, see Adding a new JDBC driver [p 394].

Example
To start EBX that connects to a Postgres database, execute following command:

docker run -d -p 8080:8080 \
-e "EBX_DB_FACTORY=postgresql" \
-e "EBX_DB_URL=jdbc:postgresql://<server_name>:5432/<database_name>" \
-e "EBX_DB_USER=<user_name>" \
-e "EBX_DB_PASSWORD=<user_name>" \
ebx:{ebx.version.public}
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Email connectivity

The EBX Mail service can be configured through the following environment variables :

Name TIBCO EBX main configuration file Default Description
equivalent

EBX_SMTP_HOST ebx.mail.smtp.host SMTP server host
name.

EBX_SMTP_PORT ebx.mail.smtp.port SMTP server port
number.

EBX_SMTP_LOGIN ebx.mail.smtp.login SMTP server
login id.

EBX_SMTP_PASSWORD ebx.mail.smtp.password SMTP server

login password.

EBX_SMTP_SSL_ENABLED ebx.mail.smtp.ssl.activate true Enables SSL.
Value can be 'true’'
or 'false'.

EBX_WORKFLOW_MAIL_SENDER ebx.manager.workflow.mail.sender The workflow
sender email.

If not set,
Workflows cannot
send notifications.

More information on the used properties can be found in chapter Activating and configuring SMTP
and emails [p 362].

Memory configuration

Environment variables JAVA_MEMORY_PERCENT may be used to configure the percentage of
the container memory that is assigned to the JVM the runs EBX. It must be an integer value between
0 and 100.

If not set, a default value is used at startup.
Note

This variable is for advanced usage. Setting it too low or too high may cause runtime issues.

Authentication for REST services
Basic authentication for REST services is not enabled by default.
To enable this feature set environment variable EBX_REST_AUTHENTICATION_BASIC to true.

63.4 Configuration files

Two Java property files are currently used to configure EBX.
On startup EBX reads property files in the following order:
» /opt/ebx/webapps/ebx/WEB-INF/ebx-default.properties
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+ /my_custom/conf/ebx-container.properties

File ebx-default.properties

The file /opt/ebx/webapps/ebx/WEB-INF/ebx-default.properties sets default EBX configuration
properties for the container.

It should never be modified at runtime as this may prevent easily updating EBX to a next version,
instead use /opt/ebx/conf/ebx-container.properties.

File ebx-container.properties

The file /opt/ebx/conf/ebx-container.properties is by default empty. Any property value specified
here will override the value set by ebx-default.properties.

This file is useful to change a property at runtime. To change a property at run time, create a new
file, for example /my_custom/conf/ebx-container.properties, containing the new property values
and mount de parent folder from the host to the container:

docker run -v /my-custom/conf:/opt/ebx/conf -p 8080:8080 -d ebx:{ebx.version.public}

For the list of properties supported by EBX see chapter TIBCO EBX main configuration file [p 355].

63.5 Volumes

This image defines the following volumes:

Location Description

/ebx/data The EBX root directory is located in this volume. It contains
EBX indexes and, when H2 embedded database is used,
persisted data.

/ebx/logs This volume is used for log files.
/ebx/temp This volume is used for temporary files.
Note

The volume /ebx/data should be mapped to a persistent volume even when an external database is
used. If not, EBX will have to rebuild its indexes on startup which may considerably increase boot
time.

63.6 Linux user and group

The Linux process running EBX is owned by user ebx (uid 1500).
User ebx’s primary group is ebx (guid 1500).

63.7 Logs access

Logs are sent to the stdout and stderr output streams and can be viewed using the following command:

docker logs <container-id>

Logs for both EBX and Tomcat will be displayed.
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Log files are also available under folder /ebx/logs:
« EBX logs files are in folder /ebx/logs/ebx

» Tomcat logs files are in folder /ebx/logs/tomcat.
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CHAPTER 64

Customizing the image

The EBX Container Edition image can be used as a parent image to create a customized image.
This chapter contains the following topics:

1. Setting default configuration

2. Adding a custom module

3. Adding a new locale

4. Adding a new JDBC driver

64.1 Setting default configuration
Setting default EBX configuration should not be based on /opt/ebx/conf/ebx-container.properties
as this file may be overridden at runtime.
Instead, proceed as following in the Docker file:

+ Rename file /opt/ebx/webapps/ebx/WEB-INF/ebx-default.properties, for example to ebx-
default-original.properties.

« Create a new file /opt/ebx/webapps/ebx/WEB-INF/ebx-default.properties container new
property values. This file must define property ebx.file.previous set to the original property file
new name, for example ebx-default-original.properties.

For the list of properties supported by EBX see chapter TIBCO EBX main configuration file [p 3551.

Here is a sample Docker file that set the locale to "en-US"
FROM ebx:{ebx.version.public}

RUN mv /opt/ebx/webapps/ebx/WEB-INF/ebx-default.properties \
/opt/ebx/webapps/ebx/WEB-INF/ebx-default-original.properties

RUN echo "ebx.file.previous=ebx-default-original.properties" >> \

/opt/ebx/webapps/ebx/WEB-INF/ebx-default.properties
RUN echo "ebx.locales.available=en-US" >> /opt/ebx/webapps/ebx/WEB-INF/ebx-default.properties

64.2 Adding a custom module

One can extend EBX by developing custom modules. An EBX module is a standard Java EE web
application, packaging various resources such as XML Schema documents, Java classes and static
resources.

For more information on EBX module see chapter Packaging TIBCO EBX modules [p 497].
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With EBX Container Edition, it is recommended to deploy modules as "unpacked" (exploded) WARs.
This allows a faster startup and avoids unnecessarily increasing container size because Tomcat will
not need to unpack WAR files.

The recommended way to add a module to an image is to:

+ Copy the WAR to folder /opt/ebx/webapps. As stated previously, exploded format is
recommended.

+ Create an associated Tomcat context XML file named module_war_name.xml and copy it to
folder /opt/ebx/contexts.

« Optionally, copy shared JARs to folder /opt/ebx/lib.
The Tomcat context XML file should have the following content:

<?xml version="1.0" encoding="UTF-8"?>
<Context docBase="${ebx.container.base}/webapps/module_war_name"/>

Using variable ${ebx.container.base} is required for correct support of environment variable
EBX_ROOT_PATH.

For more information on Tomcat contexts see https:/tomcat.apache.org/tomcat-9.0-doc/config/
context.html#Defining a context.

Here is a sample Docker file:
FROM ebx:{ebx.version.public}

COPY "./module_name.xml" "/opt/ebx/conf"
COPY "./module_name" "/opt/ebx/webapps"

64.3 Adding a new locale

To add a new local you must have the jar file containing the language pack and add the locale to the
ebx configuration.

Here is a sample Docker file

FROM ebx:{ebx.version.public}

COPY "<path_to_lib>" "/opt/ebx/1lib"

RUN mv "/opt/ebx/webapps/ebx/WEB-INF/ebx-default.properties" \
"/opt/ebx/webapps/ebx/WEB-INF/ebx-default-original.properties"

RUN echo "ebx.file.previous=ebx-default-original.properties" >> \

"/opt/ebx/webapps/ebx/WEB-INF/ebx-default.properties"
RUN echo "ebx.locales.available=es" >> "/opt/ebx/webapps/ebx/WEB-INF/ebx-default.properties"

In this example, the lib is copied and the locale is set to "es" using the method described in the "setting
default configuration" [p 393] section

64.4 Adding a new JDBC driver

Adding a new JDBC driver is similar to adding a new library. You simply have to copy the jar file in
the "/opt/ebx/lib" folder with the correct permission. Here is an example with the Oracle JDBC driver :
FROM ebx:{ebx.version.public}
ADD \

https://repol.maven.org/maven2/com/oracle/database/jdbc/ojdbc11/21.3.0.0/0jdbc11-21.3.0.0.jar \

"/opt/ebx/1ib/"

RUN chmod +r "/opt/ebx/lib/ojdbc11-21.3.0.0.jar"

See Database drivers [p 325] for more information.
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CHAPTER 65

Repository administration

This chapter contains the following topics:

1. Technical architecture

. Auto-increments

2
3. Repository management
4. Monitoring management
5. Dataspaces

65.1 Technical architecture

Overview
The main principles of the TIBCO EBX technical architecture are the following:

+ A Java process (JVM) that runs EBX is limited to a single EBX repository. This repository
is physically persisted in a supported relational database instance [p 3201, accessed through a
configured data source [p 357].

» A repository cannot be shared by multiple JVMs at any given time. However, a failover
architecture may be used. These aspects are detailed in the sections Single JVM per repository
[p 3971 and Failover with hot-standby [p 397]. Furthermore, to achieve horizontal scalability, an
alternative is to deploy a distributed data delivery (D3) [p 462] environment.

» A single relational database instance can support multiple EBX repositories (used by distinct
JVMs). It is then required that they specify distinct table prefixes using the property
ebx.persistence.table.prefix.

See also

Configuring the EBX repository [p 357]

Supported databases [p 320]

Data source of the EBX repository [p 329]
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Rules for the database access and user privileges

Attention

In order to guarantee the integrity of persisted master data, it is strictly forbidden to perform direct
SQL writes to the database.

It is required for the database user specified by the configured data source [p 357] to have the 'create/
alter' privileges on tables, indexes and sequences. This allows for automatic repository installation

and upgrades [p 399].

See also

SQL access to history [p 254]

Accessing a replica table using SQL [p 261]

Data source of the EBX repository [p 329]

Single JVM per repository

A repository cannot be shared by multiple JVMs. If such a situation was to occur, it would lead to
unpredictable behavior and potentially even corruption of data in the repository.

EBX performs checks to enforce this restriction. Before the repository becomes available, the
repository must first acquire exclusive ownership of the relational database. After starting the
repository, the JVM periodically checks that it still holds ownership of the repository.

These checks are performed by repeatedly tagging a technical table in the relational database. The
shutdown command for the application server ensures that the tag on this technical table is removed.
If the server shuts down unexpectedly, the tag may be left in the table. If this occurs, the server must
wait several additional seconds upon restart to ensure that the table is not being updated by another
live process.

Attention

To avoid an additional wait period at the next start up, it is recommended to always properly shut
down the application server.

Failover with hot-standby

The exclusion mechanism described above is compatible with failover architectures, where only one
server is active at any given time in an active/passive cluster. To ensure that this is the case, the main
server must declare the property ebx.repository.ownership.mode=failovermain. The main server
claims ownership of the repository database, as in the case of a single server.

A backup server can still start up, but it will not have access to the repository. It must declare the
property ebx.repository.ownership.mode=failoverstandby to act as the backup server. Moreover,
is required for both servers to define the same value for ebx.repository.directory, and to share the
directory defined by this value. (This is, in particular, so that the Lucene indexes can be shared, i.e.
not rebuilt on demand when the failover server starts.) Once started, the backup server is registered
in the connection log. Its status can be retrieved using the Java API or through an HTTP request, as
described in the section Repository status information and logs [p 398] below.
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In order to activate the backup server and transfer exclusive ownership of the repository to it, a specific
request must be issued by an HTTP request, or using the Java API:

o Using HTTP, the request must include the parameter activationkeyFromStandbyMode,
and the value of this parameter must be equal to the value declared for the entry
ebx.repository.ownership.activationkey in the EBX main configuration file. See Configuring
failover [p 3671.

The format of the request URL must be:
http[s]://<host>[:<port>]/ebx?activationKeyFromStandbyMode={value}

APL

« Using the Java API, call the method RepositoryStatus.wakeFromStandby™".

If the main server is still up and accessing the database, the following applies: the backup server marks
the ownership table in the database, requesting a clean shutdown for the main server (yet allowing
any running transactions to finish). Only after the main server has returned ownership can the backup
server start using the repository.

Repository status information and logs

A log of all attempted Java process connections to the repository is available in the Administration
area under 'History and logs [p 251]' > 'Repository connection log'.

The status of the repository may be retrieved using the methods in the RepositoryStatus™ APIL.

It is also possible to get the repository status information using an HTTP request that includes the
parameter repositoryInformationRequest with one of following values:

state The state of the repository in terms of ownership
registration.

« D: Java process is stopped.

« 0: Java process has exclusive ownership of the
database.

« s:Java process is started in failover standby mode, but
is not yet allowed to interact with the repository.

« N: Java process has tried to take ownership of the
database but failed because another process is holding
it.

heart_beat_count The number of times that the repository has made contact
since associating with the database.

info Detailed information for the end-user regarding the
repository's registration status. The format of this
information may be subject to modifications in the future
without explicit warning.
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65.2 Auto-increments

Several technical tables can be accessed in the 'Administration’ area of the EBX user interface. These
tables are for internal use only and their content should not be edited manually, unless removing
obsolete or erroneous data. Among these technical tables are:

Auto-increments Lists all auto-increment fields in the repository.

65.3 Repository management

Installation and upgrades

Automatic installation and upgrades

By complying with the Rules for the database access and user privileges [p 3971, the repository
installation or upgrade is done automatically.

Inter-database migration

EBX provides a way to export the full content of a repository to another database. The export includes
all dataspaces, configuration datasets, and mapped tables. To operate this migration, the following
guidelines must be respected:

The source repository must be shut down: no EBX server process must be accessing it; not
strictly complying with this requirement can lead to a corrupted target repository;

A new EBX server process must be launched on the target repository, which must be empty. In
addition to the classic Java system property -Debx.properties, this process must also specify
ebx.migration.source.properties: the location of an EBX properties file specifying the source
repository. (It is allowed to provide distinct table prefixes between target and source.)

The migration process will then take place automatically. Please note, however, that this process
is not transactional: should it fail halfway, it will be necessary to delete the created objects in the
target database, before starting over.

After the migration is complete, an exception will be thrown, to force restarting the EBX server
process accessing the target repository.

Limitations:

The names of the database objects representing the mapped tables (history, replication) may
have to be altered when migrated to the target database, to comply with the limitations of its
database engine (maximum length, reserved words, ...). Such alterations will be logged during
the migration process.

As a consequence, the names specified for replicated tables in the data model will not be consistent
with the adapted name in the database. The first recompilation of this data model will force to
correct this inconsistency.

Due to different representations of numeric types, values for xs:decimal types might get rounded
if the target database engine offers a lesser precision than the source. For example, a value of
10000000.1234567890123456789 in Oracle will get rounded to 16000000.123456789012345679 in
SQL Server.
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Repository backup

A global backup of the EBX repository must be delegated to the underlying RDBMS. The database
administrator must use the standard backup procedures of the underlying database.

Archives directory

Archives are stored in a sub-directory called archives within the ebx.repository.directory (see
configuration [p 355]). This directory is automatically created during the first export from EBX.

Attention

As specified in the security best practices [p 4941, access to this directory must be carefully protected.

Also, if manually creating this directory, make sure that the EBX process has read-write access to it.
Furthermore, the administrator is responsible for cleaning this directory, as EBX does not maintain it.

Note

The transfer of files between two EBX environments must be performed using tools such
as FTP or simple file copies by network sharing.

Repository attributes

A repository has the following attributes:

repositoryld

Uniquely identifies a repository within the scope of the
company. It is 48 bits (6 bytes) and is usually represented
as 12 hexadecimal digits. This information is used for
generating UUIDs (Universally Unique Identifiers) for
entities created in the repository, as well as transactions
logged in history tables or in the XML audit trail. This
identifier acts as the "UUID node' part, as specified by RFC
4122.

repository label

Provides a user-friendly label that identifies the purpose
and context of the repository. For example: "Production
environment".

store format

Identifies the underlying persistence system, including the
current version of its structure.
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65.4 Monitoring management

Monitoring and cleanup of the relational database

Some entities accumulate during the execution of EBX.

Attention
It is the administrator's responsibility to monitor and clean up these entities.

Database monitoring

The persistence data source of the repository must be monitored through RDBMS monitoring.

Database statistics

The performance of requests executed by EBX requires that the database has computed up-to-date
statistics on its tables. Since database engines regularly schedule statistics updates, this is usually not
an issue. Yet, it could be necessary to explicitly update the statistics in cases where tables are heavily
modified over a short period of time (e.g. by an import creating many records).

History tables: impact on UI

For history tables, some UI components use statistics to adapt their behavior in order to prevent users
from executing costly requests unwillingly.

For example, the combo box will not automatically search on user input if the table contains a large
volume of records. This behavior may also occur if the database's statistics are not up to date, because
a table may be considered as containing a large volume of records even if it is not actually the case.

Cleaning up dataspaces, snapshots, and history
A full cleanup of dataspaces, snapshots, and history from the repository involves several stages:
1. Closing unused dataspaces and snapshots to keep the cache to a minimal size.
2. Deleting dataspaces, snapshots, and history.
3. Purging the remaining entities associated with the deleted dataspaces, snapshots, and history from
the repository.
Closing unused dataspaces and snapshots

In order to keep the cache and the repository to a reasonable size, it is recommended to close any
dataspaces and snapshots that are no longer required. This can be done in the following ways:

» Through the user interface, in the 'Dataspaces' area.

« From the 'Dataspaces / Snapshots' table under 'Dataspaces' in the 'Administration’ area, using the
Actions menu in the workspace. The action can be used on a filtered view of the table.

1

» Through the Java API, using the method Repository.closeHome™.

« Using the data service "close dataspace" and "close snapshot" operations. See Closing a dataspace
or snapshot [p 721] for more information.
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Once the dataspaces and snapshots have been closed, the data can be safely removed from the
repository.

Note

Closed dataspaces and snapshots can be reopened in the 'Administration’ area, under
'Dataspaces'.

Deleting dataspaces, snapshots, and history

Dataspaces, associated history and snapshots can be permanently deleted from the repository.
However, the deletion of a dataspace does not necessarily imply the deletion of its history. The two
operations are independent and can be performed at different times.

Note

The deletion of a dataspace, a snapshot, or of the history associated with them is
recursive. The deletion operation will be performed on every descendant of the selected
dataspace.

After the deletion of a dataspace or snapshot, some entities will remain until a repository-wide purge
of obsolete data is performed. In particular, the complete history of a dataspace remains visible until
a repository-wide purge is performed. Both steps, the deletion and the repository-wide purge, must be
completed in order to totally remove the data and history. The process has been divided into two steps
for performance issues. As the total clean-up of the repository can be time-intensive, this allows the
purge execution to be initiated during off-peak periods on the server.

The process of deleting the history of a dataspace takes into account all history transactions recorded
up until the deletion is submitted or until a date specified by the user. Any subsequent historized
operations will not be included when the purge operation is executed. To delete new transactions, the
history of the dataspace must be deleted again.

Note

It is not possible to set a deletion date in the future. The specified date will thus be ignored
and the current date will be used instead.

The deletion of dataspaces, snapshots, and history can be performed in a number of different ways:

» From the 'Dataspaces/Snapshots' table under 'Dataspaces’ in the 'Administration' area, using the
Actions menu button in the workspace. The action can be used on a filtered view of the table.
« Using the Java API, and more specifically the methods Repository.deleteHome™ and

I

RepositoryPurge.markHomeForHistoryPurge™.

« At the end of the data service "close dataspace" operation, using the parameters
deleteDataOnClose and deleteHistoryOnClose, or at the end of a "merge dataspace" operation,
using the parameters deleteDataOnMerge and deleteHistoryOnMerge.

Purging remaining entities after a dataspace, snapshot, or history deletion

Once items have been deleted, a purge can be executed to clean up remaining data from all deletions
performed until that point. A purge can be initiated in the following ways:

» Through the user interface, by selecting in the 'Administration' area Actions > Execute purge
in the navigation pane.

API

+ Using the Java API, specifically the method RepositoryPurge.purgeAll™.
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+ Using the task scheduler. See Task scheduler [p 449] for more information.

The purge process is logged in the directory ${ebx.repository.directory}/db.purge/.

Cleaning up other repository entities

It is the administrator's responsibility to monitor and regularly cleanup the following entities.

Purge

A purge can be executed to clean up the remaining data from all deletions, that is, deleted dataspaces,
snapshots and history performed up until that point. A purge can be initiated by selecting in the
'Administration’ area Actions > Execute purge in the navigation pane.

Task scheduler execution reports

Task scheduler execution reports are persisted in the 'executions report' table, in the "Task scheduler'
section of the 'Administration' area. Scheduled tasks constantly add to this table as they are executed.
Even when an execution terminates normally, the records are not automatically deleted. It is thus
recommended to delete old records regularly.

User interactions

User interactions are used by the EBX component as a reliable means for an application to initiate and
get the result of a service execution. They are persisted in the ebx-interactions administration section.
It is recommended to regularly monitor the user interactions table, as well as to clean it, if needed.

Workflow history

The workflow events are persisted in the workflow history table, in the "Workflow' section of the
'Administration’ area. Data workflows constantly add to this table as they are executed. Even when
an execution terminates normally, the records are not automatically deleted. It is thus recommended
to delete old records regularly.

The steps to clean history are the following

« Make sure the process executions are removed (it can be done by selecting in the 'Administration’
area of Workflows Actions > Terminate and clean this workflow or Actions > Clean from a
date in the navigation pane).

+ Clean main processes in history (it can be done by selecting in the 'Administration’ area of
Workflows history Actions > Clear from a date or Actions > Clean from selected workflows
in the navigation pane).

» Purge remaining entities in workflow history using 'standard EBX purge'

See alsothe standard EBX purge [p 402]

Monitoring and clean up of the file system

Attention

In order to guarantee the correct operation of EBX, the disk usage and disk availability of the
following directories must be supervised by the administrator, as EBX does not perform any clean
up, except for Lucene indexes:
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Lucene indexes: ${ebx.repository.directory}/indexes-(...)/

Lucene indexes: Indexes can require a lot of disk space; they are critical to the correct functioning
of EBX. In nominal usage, they must not be deleted or modified directly. However, there are cases
where deleting these indexes might be needed:

If the vrepository is recreated from scratch, whereas the directory
${ebx.repository.directory}/ is preserved; to ensure consistency of data, it is then
required to delete the root directory of the indexes.

More generally, if the indexes have become inconsistent with the repository data (this could
happen in rare cases of bugs).

After deletion, the content of the indexes will be lazily recomputed per table, derived from the
content of the repository. The deletion must happen at the root folder of the indexes: if a single
directory is deleted at a lower level, the global structure of the index will become inconsistent.
This operation, however, has a cost, and should generally be avoided.

XML audit trail: ${ebx.repository.directory}/History/

Archives: ${ebx.repository.directory}/archives/

Logs: ebx.logs.directory [p 360]

Temporary directory: ebx.temp.directory [p 359]

Attention

For XML audit trail, if large transactions are executed with full update details activated (contrary
to the default setting), the required disk space can increase.

Attention

For pagination in the data services getChanges operation, a persistent store is used in the Temporary
directory. Large changes may require a large amount of disk space.

See also

XML audit Trail [p 456]

Tuning the EBX repository [p 367]

65.5 Dataspaces

Some dataspace administrative tasks can be performed from the 'Administration' area of EBX by
selecting 'Dataspaces'.

Dataspaces/snapshots

This table lists all the existing dataspaces and snapshots in the repository, whether open or closed.
You can view and modify the information of dataspaces included in this table.

See alsoDataspace information [p 100]

From this section, it is also possible to close open dataspaces, reopen previously closed dataspaces,
as well as delete and purge open or closed dataspaces, associated history, and snapshots.
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See alsoCleaning up dataspaces, snapshots, and history [p 401]

Dataspace permissions

This table lists all the existing permission rules defined on all the dataspaces in the repository. You
can view the permission rules and modify their information.

See alsoDataspace permissions [p 101]

Repository history

The table 'Deleted dataspaces/snapshots' lists all the dataspaces that have already been purged from
the repository.

From this section, it is also possible to delete the history of purged dataspaces.
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CHAPTER 606

Ul administration

TIBCO EBX comes with a full user interface called Advanced perspective [p 408] that includes all
available features. The interface is fully customizable [p 412] (custom logo, colors, field size, default

values, etc.) and available to built-in administrators.

Access to the advanced perspective can be restricted in order to simplify the end-user experience,
through global permissions [p 407], giving the possibility to grant or restrict access to functional
categories. Administrators can create simplified perspectives called recommended perspectives [p
420] for end-users, containing only the features and menus they need for their daily tasks.

This chapter contains the following topics:

1.

Global permissions

. Advanced perspective

2
3. Recommended perspectives
4,
5

. User session management

Custom views

66.1 Global permissions

Global permission rules can be created in EBX.
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The 'Display area' property allows restricting access to areas of the user interface. To define the access
rules, select 'Global permissions' in the 'Administration' area.

Profile Indicates on which profile the rule will be applied.

Restriction policy Indicates if the permissions defined here restrict the ones
defined for other profiles. See the Restriction policy concept
[p 286] for more information.

Dataspaces Defines permissions for the Dataspaces area.

Data Models Defines permissions for the Data Models area.
Workflow Models Defines permissions for the Workflow Models area.
Data Workflows Defines permissions for the Data Workflows area.
Data Services Defines permissions for the Data Services area.

Independently, it is also possible to:

« Defines the access permissions for the REST built-in
connector HTTP(S). This setting does not impact the
REST Toolkit applications.

+ Defines the access permissions for the REST OpenAPI
services.

+ Defines the access permissions for the SOAP connector

HTTP(S) and JMS.
+ Defines the access permissions for the WSDL
connector HTTP(S).
Administration Defines permissions for the Administration area.

Note

Permissions can be defined by administrators and by the dataspace or dataset owner.

66.2 Advanced perspective

The advanced perspective and its parameterization are unique. It is the parent perspective from which
any new perspective [p 420] will inherit.

Children perspectives can be created from that main perspective in order to offer a customized,
simplified menu to the end-users. Thanks to dataset inheritance, these simplified perspectives will
receive their parameters from the advanced perspective (the root dataset). These parameters can then
be overridden on the newly created simplified perspectives. Simplified perspectives can be created
underneath an existing simplified perspective, thus inheriting from the parent's parameters.
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See alsolnheritance [p 29]

The advanced perspective is available by default to all end-users but access can be restricted.

Note: Administrators can always access the advanced perspective even when it is deactivated.

It is possible to configure which perspective is applied by default when users log in. This 'default
perspective' is based on two criteria: 'recommended perspectives', defined by administrators and
'favorite perspectives', defined by users.

See also

Recommended perspectives [p 420]

Favorite perspectives [p 21]

Perspective creation

To create a perspective, open the 'Select an administration feature' drop-down menu and click on the
+ sign to create a child dataset.

See alsoCreating an inheriting child dataset [p 116]

User interface

Options are available in the Administration area for configuring the web interface, in the 'User
interface' section.

Attention

Be careful when configuring the URL policy (deprecated) [p 4101. If the web interface configuration
is invalid, it can lead to the unusability of EBX. If this occurs, use the "rescue mode" by
setting frontEnd.rescueMode.enable=true in EBX main configuration file [p 3551, and accessing the
following URL in your browser as a built-in administrator user: http://. . ./ebx/?onwbpID=iebx-
manager-rescue.

Session configuration

These parameters configure the user session options:

User session default locale Default session locale

Session time-out (in seconds) Maximum duration of user inactivity before the session
is considered inactive and is terminated. A negative value
indicates that the session should never timeout.

TIBCO EBX® Product Documentation 6.0.5 409



Documentation > Administration Guide > Technical administration > Ul administration

Interface configuration

Entry policy
Describes the URL to access the application.

Login URL If the user is not authenticated, the session is forwarded to
this URL.

The entry policy defines an EBX login page, replacing the default one.
If defined,
« it replaces an authentication URL that may have been defined using a specific user birectory™,
« it is used to build the permalinks in the user interface,
o if the URL is full, that is, starting with http:// or https://, it replaces the URL of the workflow
email configuration.
URL policy (deprecated)

Describes the URL and proxy policy. Both dynamic (servlet) and static (resources) URLs can be
configured.
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This configuration manner is deprecated and must be replaced by URLs computing [p 365]. After
configuring the EBX main configuration file, these configurations must be unset.

HTTP servlet policy

Header content of the servlet HTTP request:

- if a field is not set, the default value in the environment
configuration is used,

o if a default value is not set, the value in the initial
request is used.

HTTPS servlet policy

Header content of the servlet HTTPS request:

« if a field is not set, the default value is chosen (in an
environment configuration),

« if a default value is not set, the value in the initial
request is used.

HTTP external resources policy

Header content of the external resources URL in HTTP:

« if afield is not set, the default value in the environment
configuration is used,

o if a default value is not set, the value in the initial
request is used.

HTTPS external resources

Header content of the external resources URL in HTTPS:

policy « if afield is not set, the default value in the environment
configuration is used,
« if a default value is not set, the value in the initial
request is used.
Exit policy

Describes how the application is exited.

Normal redirection

Specifies the redirection URL used when exiting the session
normally.

Error redirection

Specifies the redirection URL used when exiting the session
due to an error.

This feature is now deprecated and may be ignored by EBX.

Redirection restrictions

Specifies the list of authorized domains and whether HTTPS
is mandatory for each domain.
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Graphical interface configuration

Activation & Allowed profiles

The 'Activated' radio button allows to activate or deactivate the perspective. When deactivated, the
perspective will only be made available to the administrator.

The 'Allowed profiles' feature is used to give access to the perspective to a given profile. Several
profiles can be added to the list of authorized profiles by clicking on the + icon below the numbered list.

The available perspective properties are:

Activated Indicates if the perspective is visible to authorized users.
Allowed profiles The list of authorized user profiles for the perspective.
Allowed devices The list of authorized devices for the perspective.

If not specified, only "EBX Web Application" can display
this perspective.

Default selection The menu item that is selected by default.

This property is not available for the advanced perspective.

Application locking
EBX availability status:

Availability status This application can be closed to users during maintenance
(but still remain open to administrators). Takes effect
immediately.

Unavailability message Message displayed to users when access is restricted to

administrator profiles.
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Security policy

EBX access security policy. These parameters only apply to new HTTP sessions.

IP access restriction Restricts access to designated IP addresses (see IP pattern
below).
IP restriction pattern Regular expression representation of IP addresses

authorized to access EBX. For example, ((127\.6\.0\.1) |
(192\.168\.*\.*)) grants access to the local machine and
the network IP range 192.168.*. *.

Unique session control Specifies whether EBX should control the uniqueness of
user sessions. When set to 'Yes', if a user does not log out
before closing the browser, it will not be possible for that
user to log in again until the previous session has timed out.
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Ergonomics and layout

EBX ergonomics parameters:

Max table columns to display According to network and browser performance, adjusts the
maximum number of columns to display in a table. This
property is not used when a view is applied on a table.

Maximum auto-width for table Defines the maximum width to which a table column

columns can auto-size during table initialization. This is to prevent
columns from being too wide, which could occur for very
long values, such as URLs. Users will still be able to
manually resize columns beyond this value.

Max expanded elements for a Defines the maximum number of elements that can be
hierarchy expanded in a hierarchy when using the action "Expand all".
A value less than or equal to '0' disables this parameter.

Default table filter Defines the default table filter to display in the filters list in
tabular views. If modified, users must log out and log in for
the new value to take effect.

Display the message box Defines the message severity threshold for displaying the
automatically messages pop-up.
IE compatibility mode Defines whether or not to compensate for Internet Explorer

8+ displaying EBX in compatibility mode.

In order to prevent Internet Explorer browsers from using
compatibility mode when displaying the repository user
interface, the meta-tag http-equiv="X-UA-Compatible"
content="IE=EmulatelE8" is added to the header of pages.
However, in some local environments, this setting may
conflict with existing policies, in which case this header
must be omitted by setting the parameter to 'No'. The default
value is "Yes'.

See Specifying Document Compatibility Modes &l for more

information.
Forms: width of labels The width of labels in forms.
Forms: width of inputs The width of form input fields in forms.
Forms: height of text areas The height of text entry fields in forms.
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Forms: aggregated lists

The number of hidden candidate lines to be generated,
available to create new instances in the list.

Forms: width of HTML editor

The width of HTML editors in forms.

Forms: height of HTML editor

The height of HTML editors in forms.

Searchable list selection page
size

Maximum number of rows downloaded at each request of
the searchable list selection (used for selecting foreign keys,
enumerations, etc.).

Record form: rendering mode
for nodes

Specifies how to display non-terminal nodes in record
forms. If this property is modified, users are required to log
out and log in for the new value to take effect.

Record form: display of
selection and association nodes
in creation mode

If enabled, the selection and association nodes will be
displayed in record creation forms.

Display density

Defines the default display density mode for all users. If no
density has been selected by the user yet, this value will be
applied. Conversely, if the user already chose a density, their
choice will prevail.

Avatar displayed in the header

This property defines the display mode of avatars in the
header. For example, it is possible to enable or disable the
use of avatars in the header by updating this property. If no
value is defined, the default value is 'Avatar only'. If it is a
relative path, prefix it with "../" to get back to the application
root URL.

Avatar displayed in the history

This property defines the display mode of avatars in the
history. For example, it is possible to enable or disable the
use of avatars in the history by updating this property. If no
value is defined, the default value is 'Avatar only'. If it is a
relative path, prefix it with "../" to get back to the application
root URL.

Avatar displayed in the
workflow

This property defines the display mode of avatars in the
workflow. For example, it is possible to enable or disable
the use of avatars in the workflow by updating this property.
If no value is defined, the default value is 'Avatar only'. If
it is a relative path, prefix it with "../" to get back to the
application root URL.
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Default option values

Defines default values for options in the user interface.

Import/Export

CSV file encoding

Specifies the default character encoding to use for CSV file
import and export.

CSV : field separator

Specifies the default separator character to use for CSV file
import and export.

CSV : list separator

Specifies the default list separator character to use for CSV
file import and export.

Import mode

Specifies the default import mode.

Missing XML values as 'null’

If 'Yes', when updating existing records, if a node is missing
or empty in the imported file, the value is considered as
'null'. If 'No', the value is not modified.
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Colors and themes

Customizes EBX colors and themes.

Web site icon URL (favicon) Sets a custom favicon. The recommended format is ICO,
which is compatible with Internet Explorer.

Logo URL (SVG) Specifies the SVG image used for compatible browsers.
Leave this field blank to use the PNG image, if specified.
The user interface will attempt to use the specified PNG
image if the browser is not SVG-compatible. If no PNG
image is specified, the GIF/JPG image will be used. The
logo must have a maximum height of 40px. If the height
exceeds 40px, it will be cropped, not scaled, to a height of
40px. The width of the logo will determine the position of
the buttons in the header. If it is a relative path, prefix it with
"../" to get back to the application root URL.

Logo URL (PNG) Specifies the PNG image used for compatible browsers.
Leave both this field and the SVG image URL field blank to
use the GIF/JPG image. The user interface will use the GIF/
JPG image if the browser is not PNG-compatible. The logo
must have a maximum height of 40px. If the height exceeds
40px, it will be cropped, not scaled, to a height of 40px. The
width of the logo will determine the position of the buttons
in the header. If it is a relative path, prefix it with "../" to get
back to the application root URL.

Logo URL (GIF/JPG) Specifies the GIF/JPG image to use when neither the PNG
nor SVG are defined. The recommended formats are GIF
and JPG. The logo must have a maximum height of 40px.
If the height exceeds 40px, it will be cropped, not scaled, to
a height of 40px. The width of the logo will determine the
position of the buttons in the header. If it is a relative path,
prefix it with "../" to get back to the application root URL.

Main Main user interface theme color, used for selections and
highlights.
Header Background color of the user interface header. By default,

set to the same value as the Main color.

Workflow badge Background and text/outline colors of new workflow task
counters.
Primary buttons Color of buttons selected by default. By default, set to the

same value as the Main color.
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Text of link style buttons Text color of some buttons having a link style (the text is
not dark or light, but colored). By default, set to the same
value as the main color.

Selected tab border Border color of the selected tab. By default, set to the same
value as the Main color.

Table history view: technical Background color of technical data cells in the table history
data view.
Table history view: creation Background color of cells with the state 'creation' in the

table history view.

Table history view: deletion Background color of cells with the state 'deletion' in the
table history view.

Table history view: update Background color of cells with the state 'update' in the table
history view.

Child perspective menu

An unlimited number of child perspectives can be created. Child perspectives inherit from the
parameters of the 'Advanced perspective'. Some of these parameters can be overridden as detailed
hereafter.

Activation & Allowed profiles

See Activation and Allowed profiles for the Advanced perspective [p 412] for more information.

Note

Any specific parameter set for this perspective will override the default parameters that
have been set in the 'Advanced perspective' configuration.

Perspective Menu
This view displays the perspective menu. It is a hierarchical table view.

From this view, a user can create, delete or reorder menu item records.

See alsoHierarchical table view [p 29]

Section Menu Item This is a top level menu item. It contains other menu items.

Menu group This is a container for other menu items.

Action Menu Item This menu item displays a user service in the workspace
area.
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Menu item properties

When creating a record in the 'Perspective’ Menu, the available perspective properties are:

Type The menu item type.

See alsoMenu item types [p 418]

Parent The parent of the menu item.

This property is not available for section menu items.

Label The menu item label.

The label is optional for action menu items. If not specified,
the label will be dynamically generated by EBX when the
menu item is displayed.

Allowed devices The list of authorized devices for this item.

If not specified, all devices can display this menu item.
Currently only two devices are supported:"EBX Web
Application" and "EBX GO".

Icon The icon for the menu item.

Icon can be either "standard" (provided by EBX) or an
image, specified by a URL, that can be hosted on any web
Server.

Icons size should be 16x16 pixels.

This property is not available for section menu items.

Top separator Indicates that the menu item section has a top separator.

This property is only available for section menu items.

Action The user service to execute when the user clicks on the menu
item.

See alsoUser interface services [p 643]

If an end-user is allowed to view the perspective but not to
execute the user service, an "access denied" message will
be displayed when the user clicks on the menu item.

This property is only available for action menu items.

Selection on close The menu item that will be selected when the service
terminates.

Built-in services use this property when the user clicks on
the 'Close' button.
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This property is only available for action menu items.

Ergonomics and layout

See Ergonomics and layout for the Advanced perspective [p 414] for more information.

Note

Any specific parameter set for this perspective will override the default parameters that
have been set in the 'Advanced perspective' configuration.

Colors and themes

See Colors and themes for the Advanced perspective [p 417] for more information.

Note

Any specific parameter set for this perspective will override the default parameters that
have been set in the 'Advanced perspective' configuration.

66.3 Recommended perspectives

It is possible for a perspective administrator to configure recommended perspectives dedicated to a
specific audience. These recommended perspectives are a way to choose which perspective is applied
by default when a user logs in, based on their role.

However, users always have the possibility to switch between the various perspectives that are
available to them and to set one as their favorite. See Favorite perspectives [p 21] for more information.

To configure recommended perspectives, go to User interface > Recommended perspectives >
Manage recommended perspectives.

Managing recommended perspectives

The main screen shows an ordered list of records associating a profile with a perspective. Note that
the order here is important since a user can match more than one record (see Resolution [p 420] for
more information).

» To add an entry, use the 'Create' action.

 To edit an entry, first select it in the list by clicking on it, then click on the 'Edit' action, or simply
double-click on it.

« To remove an entry, first select it in the list, then click on the 'Delete’ action.

« To move an entry, first select it in the list, then use the actions in the toolbar to the right of the list.

Resolution

When a user logs in, the following algorithm determines which perspective is selected by default:

// 1) favorite perspective

IF the user has a favorite perspective

AND this perspective is active

AND the user is authorized for this perspective
SELECT this perspective
DONE

// 2) recommended perspective

FOR EACH association in the recommended perspectives list, in the declared order
IF the user is in the declared profile
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AND the associated perspective is active

AND the user is authorized for the associated perspective
SELECT this perspective
DONE

// 3) advanced perspective

IF the advanced perspective is active

AND the user is authorized for this perspective
SELECT this perspective
DONE

// 4) any perspective
SELECT any active perspective for which the user is authorized
DONE

66.4 Custom views

Users can create and manage custom views directly from the 'View' menu on tables. This
administration section is the central point to manage these custom views.

Views

This table contains all custom views defined on any table. Only a subset of fields is editable:

Documentation Localized labels and descriptions.

Owner Defines the user(s) owning and authoring this view
definition.

View group Indicates the menu group in which this view is displayed in

the 'View' menu.

Share with Defines the users allowed to select this view from their
"View' menu.
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This table allows to manage permissions relative to custom views, by data model and profile. The
following permissions can be configured (the default value is applied when no permission is set for

a given user):

Permission

Description

Default value

Recommend views

Allows the user to manage recommended
views.

If the user is the dataset owner, the

default value is "Yes', otherwise it is 'No'.

Manage views

Defines the views the user can modify
and delete.

If the user is a built-in administrator,
the default value is 'Owned + shared',
otherwise it is 'Owned'.

Share views

Defines the views for which the user can
edit the 'Share with' field.

If the user is a built-in administrator,
the default value is 'Owned + shared',
else if the user is the dataset owner, it is
'Owned', otherwise it is 'None'.

Publish views

Allows the user to publish views to make
them available to all users using Web
components, workflow user tasks, or
data services.

If the user is a built-in administrator, the

default value is "Yes', otherwise it is 'No'.

66.5 User session management

This tool lists all user sessions and allows terminating active sessions when necessary.

For example: it is possible to invalidate and terminate all currently open and active sessions
for maintenance purposes. The access to the user interface can be temporarily closed, with an
unavailability message being displayed, through Application locking [p 412]. After active sessions
are terminated, users will not be able to reconnect and will see the unavailability message. The
maintenance operation can then be performed.
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CHAPTER 67

Ul - Workflow launcher

This chapter contains the following topics:
1. Introduction

Workflow launcher in data section

Creating and setting a launcher

Activating workflow launcher

Launching a workflow
Adding a workflow launcher to the custom toolbar at table top

N ok DN

Access a launcher after workflow model modification

67.1 Introduction

A Workflow Launcher is a user service for launching workflows in TIBCO EBX directly from
the data section without passing by the data workflow's inbox. This feature does not create workflow
publications but launches existing ones. It offers several advantages, including the ability to launch
workflow publication directly from the data section (table view, hierarchy view or record form view).
In this way, the user experience is improved by avoiding to the user shifting his attention back and
forth between the data section and the data workflow section. Hence, the user can launch a workflow
while still focusing on his main task.

The second advantage is that it allows to launch the same workflow publication from any data
selection. Thanks to the dynamic mapping of the workflow data context [p 32] with the current data
selection. The dynamic mapping offers the possibility to initialize the data context inputs at launch
time. Hence, in order to launch the same workflow from n different data selections, it is not longer
necessary to duplicate n times the same workflow model with different data selections or to provide an
initial user service to configure the data to select. The last solution is a programmatic solution which
would solve the previously cited problems, however it is not the ideal solution because it does not
fulfill the commitment zero line of code.
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Understanding this feature requires familiarization with the following concepts:

Concept Description/Link

‘Workflow model See documentation [p31]

Data context See documentation [p32]

Workflow publication See documentation [p 321

Publication name A unique identifier of a workflow publication

Data Workflow See documentation [p 321

Data section Is the data user interface (p 1131 which displays the datasets and tables in EBX. it is

accessible from the main header.

Workflow launchers dataset It contains two tables Launchers and Activations. With this dataset the user can
configure the launchers of workflow publications and activate them for a particular
user(s) and table(s). It is available in the Administration area in a section called
workflow management.

Launcher An entity which is used by the service workflow launcher to identify the workflow
publication to launch and how to initialize its data context.

Launchers A table in the workflow launchers dataset, each record is a Launcher type. In order
to be able to launch a workflow publication from a data section, a launcher which
points to a workflow publication should be added in this table.

Activation An entity which hides or shows the launcher of a workflow publication for a given
user profile(s) and for a particular table(s) from the data section.

Activations A table in the workflow launchers dataset, each record is an Activation type. In
order to make a workflow available on the toolbar of a particular table and for a
particular user, a record with the corresponding launcher should be created in this
table.

Dynamic mapping of data context Is the process of initialization of data context input variables when launching a
workflow publication. Before, the values of the data context were static defined at
modeling phase or set dynamically with Java coding, but now it is possible to set
dynamically the values of the data contexts, i.e. at launch time, with zero line of
code.

Reserved variables for data context A set of reserved variables. These variables define which data selection should

be mapped with a data context variable. The possible values are: ${dataspace},
${dataset}, ${table} and ${record}. For example, if the value ${table} is used for a
data context variable, this means that this variable will be mapped with the current
adaptation table reference, at launch time.

67.2 Workflow launcher in data section

As previously stated, workflow launchers are now available directly on the toolbar of tables, records
and hierarchies. There are a number of ways to display a workflow launcher on the toolbar of a table
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in data section. The display depends on the type of the toolbar (default toolbar or custom toolbar
in the DMA) and whether or not smart filtering [p 80] is applied. In the case of default toolbar, the
action menu displays all the workflow launchers in a separate submenu called Workflows (see the
screenshot below).
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In the case of a custom toolbar,it is possible to define an action button (see the screenshot below)
or action menu item for a particular workflow launcher. And finally, if the smart filtering policy is
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activated, then all the workflow launchers that are displayed using an action button or action menu
item will not appear in the Action menu.
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In order to display a workflow launcher on a toolbar, first, a launcher must be created and configured
(see creating and setting workflow launcher [p 426] section), then, an activation should be created
for this launcher (see activating workflow launcher [p 428] section). Note that, if the current user has
no rights to launch a workflow publication [p 175] then the workflow launcher will not be available
on the toolbar. Also, if the workflow publication is deleted or if there is any errors or warnings in
the configuration or activation of the launcher, then the corresponding workflow launcher will not be
available on the toolbar.

The title and tooltip of the button that will be displayed on the toolbar, are computed in the
following order of priority: the custom documentation of the launcher activation is used, otherwise
the documentation of the launcher is used. If description is left empty, then the following description
is used "This user service will launch a data workflow.".

Note

Particular attention should be paid for the workflow launchers which are available on
the record form. Only the launchers which requires record selection are displayed
on the toolbar of a record form. A workflow launcher which requires record selection is
the one for which one of the data context variable is mapped with the reserved variable
${record} in the configuration of its launcher.

67.3 Creating and setting a launcher

A launcher is the entity which is used by the service Workflow Launcher to identify the workflow
publication to launch and how to initialize its Data context. In order to create a launcher for a particular
workflow publication, first navigate to the administration area, then the workflow management
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section, select the workflow launchers dataset, select the launchers table, and then add a new record.
The second step, is to setup the following fields of the record:

Field name Description
Launcher name A unique identifier. It is used to select a launcher in the activation phase (p 4281.
Workflow publication name Defines the workflow publication that will be launched when the user service

"workflow launcher" is executed. The workflow model should be first defined and
published to be available in the list.

Data context variables This field contains the list of input variables which were defined in the data context
configuration (p 1711 phase of a workflow model. Each line is composed of a label, a
value, and a toggle button to switch between default and overwritten value (see the
screenshot below). The label is the name of the variable set by the user in the data
context of the workflow model.

By default, the value of each variable is the default one set in the data context. If
the default value field is left empty in the data context, then the value of the variable
is set to undefined. If the toggle button is set on overwritten value mode, then a
wizard is made available on the right of the input field which allows to select a
reserved variable.

When overwriting the value of a data context variable, two options are possibles:
the override value may be a constant or a reserved variable. If a constant is used,
then the value of the data context variable will not depend on the entity selection

at launch time. However, if a reserved variable is used, such as ${dataspace}, the
value of the corresponding variable will be mapped to the current entity selection,
for example the data context variable which is assigned to ${dataspace} will be
initialized with the current dataspace at launch time.

Note

If there are no input variables in the data context of the workflow
model, then this field should be hidden. If the workflow
publication name field changes then this input is updated
automatically and displays a new list of data context.

Documentation A documentation is composed of a label and a description. The default

value of the label is the publication name which is inherited from the field
"workflow publication name" and the default value of the description is empty.

If the "Publication name" field changes then the documentation will update
automatically." The label and description can be overridden if needed thanks

to the edit button on the right of the documentation widget." The value of the
documentation will be inherited by the activation. Note that the documentation
defined in the activation has a higher priority over the one defined in the launcher.
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At the bottom of a launcher record, a table of all activations of the current launcher is displayed (see
the section Launcher activations in the screenshot below).

TIBCYEBX 8 o o' e & » @ =

Administration createRecord

r1
La

Workflows launcher

Launcher Name createRecord

Actions ¥
Workflow Publication Name * [ |testCP-13244 e ]
Documentation * v English (United States) Zz
testCP-13244 Reserved variable Wizard Toggle Button
createRecord
Data Context Variables \ 7
Activati
chivations dataspace ${dataspace} N %]
dataset ${dataset} N z
table ${xpath(table)} N z
Launcher activations
+ Actions ¥ 1-1ofl~ Y
= Data Model Documentation Tables Profiles
Publication: test  Create a record table [see details]

[ Save and close ] [ Revert ] [ Close ]

67.4 Activating workflow launcher

An activation is the entity which controls the availability of a workflow launcher on a table or record
form. In order to display a workflow launcher in a toolbar of a particular table, first create a launcher
[p 426], then navigate to the administration area, select the workflow management section, select the
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workflow launchers dataset, select the activations table, and then add a new record. The second step,
is to setup the following fields of the record:

Field name

Description

Launcher

A unique identifier of a launcher which is associated to a publication name of the
target workflow publication p 4271. This field allows to select the launcher which
will be displayed in the data section.

Data model

The schema reference of a published Data Model. Only schemas that are published
and used in Datasets are available.

Tables

The identifier of a table which will display the workflow launcher. It is possible to
select one particular table or "All tables". This selector displays all tables which are
contained in the field Data Model [p 429].

Profiles

List of profiles which are allowed to see and launch the workflow launcher in the
previously selected tables.

Confirmation

This field allows displaying or not a dialog box to confirm launching of a data
workflow (see screenshot about confirmation message [p4311. By default this feature
is deactivated, in order to display the dialog box, the value "Enabled" should be
checked (see screenshot below).

Documentation

A documentation is composed of a label and a description. The default value

of the label and description are inherited from the documentation field of the
launcher. This field is used to display the title of the button of the user service in
the toolbar. The description is displayed when the user hovers over that button. The
documentation of the activation has a higher priority over the one of the launcher.
Note that, if the description of the documentation is left empty then the following
one is displayed "This user service will launch a data workflow. In the case of the
custom toolbar, the value of this field is also used for action button and action
menu item if the documentation field of the action button or action menu item is
left empty.
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67.5 Launching a workflow

Once a launcher created [p 426] and activated [p 428] the corresponding workflow launcher becomes
available on the toolbar's action menu. To launch the workflow click on the button of the workflow
launchers(see screenshot about default display of a workflow launcher [p 4257 ).

If

the option Confirmation [p 429] is enabled, then a dialog box displays to ask the user the

confirmation before launching the selected data workflow (see screenshot about data workflow launch
confirmation [p 431]). Otherwise, the dialog box does not display and different outcomes are possible:

If the option automatically open the first step [p 170] is activated and the user has the rights to
execute the first work item [p 157] of the workflow, then the workflow launches and the first work
item displays directly in the workspace of the Data section. While displaying the work item in
the workspace, the origin data selection still displayed on the breadcrumb which allows to the
user to maintain an overall contextual awareness (see screenshot about displaying a work item
on the data section [p 431] ).

If the option automatically open the first step [p 170] is deactivated and the user has the rights to
launch the workflow [p 1751, then the workflow is launched and added to the data workflow inbox [p
183]. An information message informs the user that the workflow has been launched successfully
and that it is necessary to go to the inbox of the data workflow section [p 183] to display and
execute the first work item.

If the workflow requires record selection (see note in the section workflow launcher in data area
[p 426] ), the workflow is launched and displayed if and only if a record is selected otherwise an
error message is displayed informing the user that a record should be selected. A record can be
selected manually from a table view or automatically when displaying a record form.

TIBCO EBX® Product Documentation 6.0.5 430



Documentation > Administration Guide > Technical administration > Ul — Workflow launcher

If more than one record are selected, then a warning message notifies that only one record should
be selected.

TIBCYEBX @ o &

Master Data - Reference ~ table

b # /
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Cancel
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?|
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test M Comment
Actions ¥
e ‘
name *
firstName *

Save

67.6 Adding a workflow launcher to the custom toolbar at
table top

The workflow launchers can be made available not only on default toolbar but also on custom toolbar
[p 76]1. A workflow launcher can be added on a custom toolbar as an action button [p 78] or as an action
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menu item [p 81] in a custom menu group [p 80]. Adding an action button or an action menu item to
launch a workflow on a custom toolbar follows a similar procedure as for common user services:
first, set the target field to current context otherwise the user service workflow launcher will not
be available, then select the user service workflow launcher. When the service workflow launcher
is selected, a new field Launcher, exclusive for workflow launcher user service, appears below the
service input field (see screenshot about adding a workflow launcher on custom toolbar [p 433 ).

The field Launcher displays the list of launchers that have already been created in the table
"Activation/workflow management/workflow launcher/Launchers" (see section about creating and
configuring launchers [p 426]) .Therefore, before adding a workflow launcher in a custom toolbar the
launcher should be created and configured for this workflow launcher.

As for default toolbar, in order to show the workflow launcher on a custom toolbar its launcher should
be activated in "Activation/workflow management/workflow launcher/activations". A quick link to
access the activations table of the launchers is displayed on the right of the field Launcher (see
screenshot about adding a workflow launcher on custom toolbar [p 433] )

The field Label and description displays the label and description inherited from the launcher (see
screenshot about adding a workflow launcher on custom toolbar [p 433]) ,then if the launcher field
changes, the label and description should update automatically. This field can be overridden to
customize the label and description of the action button on the toolbar. The label and description that
will be displayed on the toolbar, are computed in the following order of priority: the custom value of
the field Label and description of the action button is used, if this field is left empty or contains the
default label of the launcher, then the label and description of the launcher activation are displayed.
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If this last one is left empty, then the following description is used "This user service will launch a
data workflow.".

Note

The label and description which are displayed on the toolbar in the data section and the
label of the action button in the toolbar tree in the DMA could be different. This is the
case when the field "Label and description" of the "action button" is left empty (neither
default nor custom label is defined). The label of the "action button" in the toolbar tree in
the DMA is inherited from the label of the launcher, however, the label and description
on the toolbar in the data section are set to the label and description of the activation
of the launcher.
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> Configuration Service* Target * (@ Current context * Web component
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Adding a workflow launcher to a toolbar in other locations

The workflow launcher service is only available on the toolbar that displays in the following locations:
table view top, record form view top, or hierarchy view top. Until now, it is not possible to define this
service on the toolbar that displays on a table view row, association top, and association table row.

67.7 Access a launcher after workflow model modification

After creating a launcher [p 426] which points to a workflow publication [p 4271, the workflow model
of this publication may be changed and republished. For instance, the data context of the workflow
model may be changed: one or more variable data context can be added; one or more variable data
context can be removed; the name of a variable can be changed. In this particular case, the launchers
which points to this workflow publication should be reviewed and validated (saved) by the user
because the data context used by these launchers is no more valid and it should be updated to match
the one of the up-to-date workflow publication.

After republishing a workflow model, the user is notified if any of the workflow launcher points
to the current workflow publication and if it should be reviewed. For that purpose, after publishing
a workflow model, a preview button is displays allowing a quick access to the launchers in
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question .Note that if the user has no rights to access the workflow launchers list, then the names of
those launchers are displayed .

When the user access to one of these launchers, via the preview button in the workflow model section
orvia the Administration section, the persisted data context is replaced with the up-to-date data context
of the workflow publication, however the new data context is not yet persisted for the current launcher.
In order to update the data context of the launcher, the user should first review the values and then
save to accept the new changes (see screenshot about accessing a launcher after modification of the
data context of the corresponding workflow publication [p 434]).

TIBCYEBX 8 0 & e & » @ =
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Note that the default values are used for new data context values. Please review the default values and save the form to accept the new changes.
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up-to-date data context of the workflow publication «WFY1»
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CHAPTER 68

Users and roles directory

This chapter contains the following topics:
1. Overview

2. Concepts
3. Default directory

4. Custom directory

68.1 Overview

TIBCO EBX uses a directory for user authentication and user role definition.

A default directory is provided and integrated into the EBX repository; the 'Directory’ administration
section allows defining which users can connect and what their roles are.

It is also possible to integrate another type of enterprise directory.

See also

Configuring the user and roles directory [p 358]

Custom directory [p 438]

68.2 Concepts

In EBX, a user can be a member of several roles, and a role can be shared by several users. Moreover,
a role can be included into another role. The generic term profile is used to describe either a user or
arole.
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In addition to the directory-defined roles, EBX provides the following built-in roles:

Role Definition

Profile. ADMINISTRATOR Built-in Administrator role. Allows performing general
administrative tasks.

Profile. READ_ONLY Built-in read-only role. A user associated with the read-only
role can only view the EBX repository, and has no right to
perform modifications in the repository.

Profile. OWNER Dynamic built-in owner role. This role is checked dynamically
depending on the current element. It is only activated if the user
belongs to the profile defined as owner of the current element.

Profile. EVERYONE All users belong to this role.

Information related to profiles is primarily defined in the directory.

Attention

Associations between users and the built-in roles OWNER and EVERYONE are managed
automatically by EBX, and thus must not be modified through the directory.

User permissions are managed separately from the directory. See Permissions [p 275].

See also
profile [p 25]
role [p 26]
user [p 25]
administrator [p 26]

user and roles directory [p 26]

Policy

These properties configure the policies of the user and roles directory, for example, whether or not
users can edit their own profiles.

Users

This table lists all the users defined in the internal directory. New users can be added from there.

Roles

This table lists all the users defined in the internal directory. New roles can be created in this table.
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68.3 Default directory

Directory content
The default directory is represented by the dataset 'Directory’, in the 'Administration’ area.

This dataset contains tables for users and roles, as well as users' roles table, roles' inclusions table
and salutations table.

Note

If a role inclusion cycle is detected, the role inclusion is ignored at the permission
resolution. Refresh and check the directory validation report for cycle detection.

Note

Users' roles, roles' inclusions and salutations tables are hidden by default [p 586].

Depending on the policies defined, users can modify information related to their own accounts,
regardless of the permissions defined on the directory dataset.
Note

It is not possible to delete or duplicate the default directory.

Password recovery procedure

In the default directory, passwords are encrypted (by default with a SHA256-like algorithm), and
stored in this state. Consequently, it is impossible to retrieve lost passwords. A new password must
be generated and sent to the user.

There are two options for this procedure:

1. A notification email is sent to the administrator, the administrator manually changes the password
and sends the new password to the user.

2. A procedure automatically generates a new password and sends it to the user.

By default, the first option is used. To activate the second option, specify the property
ebx.password.remind.auto=true in the TIBCO EBX main configuration file [p 355].

Note

For security reasons, the password recovery procedure is not available for administrator
profiles. If required, use the administrator recovery procedure instead.

Administrator recovery procedure

If all the 'login/password' credentials of the administrators are lost, a special procedure must be
followed. A specific directory class redefines an administrator user with login 'admin’ and password
'admin'.

To activate this procedure:

 Specify the following property in the TIBCO EBX main configuration file [p 3551:

ebx.directory.factory=
com.orchestranetworks.service.directory.DirectoryDefaultRecoverFactory
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 Start EBX and wait until the procedure completes.
» Reset the 'ebx.directory. factory' property.

» Restart EBX and connect using the 'admin’ account.

Note

While the 'ebx.directory.factory' property is set for the recovery procedure,
authentication of users will be denied.

68.4 Custom directory

As an alternative to the default directory, it is possible to integrate a specific company directory. For
example, an LDAP instance, a relational database or a specific directory model instantiated into EBX.

See alsobirectoryFactory™
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CHAPTER 69

Data model administration

This chapter contains the following topics:

1. Administrating publications and versions

2. Migration of previous data models in the repository

3. Schema evolutions

69.1 Administrating publications and versions
Technical data related to data model publications and versions can be accessed in the Administration
section by an administrator.
Data Modeling contains the following two tables:
« Publications. Stores the publications available in the repository.
« Versions. Stores the versions of the data models available in the repository.
These tables are read-only but it is however possible to delete manually a publication or a version.

Important: If a publication or a version is deleted, then the content of associated datasets will become
unavailable. So this technical data must be deleted with caution.

It is possible to spread this technical data to other TIBCO EBX repositories exporting an archive from
an EBX repository and importing it to another one. It may be useful for propagating the evolutions
of data models to other repositories.

69.2 Migration of previous data models in the repository

In versions before 5.2.0, published data models not depending on a module were generated in the
file system directory ${ebx.repository.directory}/schemas/, with the name of the data model
(product.xsd for example if the data model is named Product). Since the 5.2.0 version, this kind of data
model is now fully managed within EBX through Publications. That is, republishing an existing data
model migrates it as a Publication and redirects linked datasets to the new embedded data model. The
previous XML Schema Document located in ${ebx.repository.directory}/schemas/ is renamed
and suffixed with toDelete, meaning that the document is no longer used and can be safely deleted.

69.3 Schema evolutions

It is crucial to evaluate the impact of data model changes on the administration side. The following
points are to be considered:
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Impacts on data persistence

Administration tasks can be related to the database cleanup after a modification of the models. The
following link describes how the evolutions of data models are managed at the persistence level:
Purging master tables in the database [p 443].

Impacts on side features

Some components rely heavily on the data models and can be impacted by their evolutions. Some
examples are: the user interface, the WSDL documents, existing archives, etc.

The 'Administration’ section offers the possibility to manage some of these components (such as the
views), whereas other components fall out of the administrator's scope, such as archives, WSDL files,
etc.
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cHAPTER 70

Database mapping administration

This chapter contains the following topics:
1. Overview

Renaming columns in the database

Purging columns in the database
Renaming master tables in the database
Renaming auxiliary tables in the database
Purging master tables in the database

O e

70.1 Overview

Information and services relative to database mapping can be found in the Administration area.

See also

Mapped modes [p 249]
DatabaseMapping™”

70.2 Renaming columns in the database
This feature is available on the 'Columns’ table records, under the 'Actions' menu. It allows renaming
a column in the database.

The administrator can specify the name of each column of the data model in the database for mapped
modes.

Once the service is selected on a record, a summary screen displays information regarding the selected
column and the administrator is prompted to enter a new name for the column in the database.

Note
It is required that the new identifier begins with a letter.

Besides, the new name must be a valid column identifier, which depends on the naming rules
of the underlying RDBMS.

See alsobpatabaseMapping””
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70.3 Purging columns in the database

This feature is available on the 'Columns' table records, under the 'Actions' menu. It allows purging
columns in mapped structures.

A column can be purged if it has been disabled for mapped modes.
A column is disabled for mapped modes when:
« the corresponding field has been removed from the data model, or

« the corresponding field has been changed in the data model, in a way that is not compatible (for
example: its data type has been modified), or

 the defined mapped modes have been disabled locally on the corresponding fields, using the
elements osd:history and osd:replication.

See also

Disabling history on a specific field or group [p 252]

Disabling replication on a specific field or group [p 261]

Note that this behavior will change for aggregated lists:

» when deactivating a complex aggregated list, its inner fields will still be in the LIVING state,
whereas the list node is disabled. As lists are considered as auxiliary tables in the mapping system,
this information can be checked in the 'Tables' table,

« on the other hand, when the deactivation is just for inner nodes of the list, then the list will remain
LIVING, while its children will be DISABLED IN MODEL.

A column can be purged only if its own state is DISABLED IN MODEL, or if it is an inner field of a
DISABLED IN MODEL list.

70.4 Renaming master tables in the database
This feature allows renaming master tables for history tables in the database. It is not available for
replicated tables since their names are specified in the data model.
Both features are available on the "Tables' table records, under the 'Actions' menu.
Master tables are database tables used for persisting the tables of the data model.

The administrator can specify in the database the name of each master table corresponding to a table
of the data model.

Once the service is selected on a record, a summary screen displays information regarding the selected
master table and the administrator is prompted to enter a new name for the master table in the database.

Note

It is required that the new identifier begins with a letter and with the repository prefix.

For history tables, it is also required for the repository prefix to be followed by the history
tables prefix.

Besides, the new name must be a valid table identifier, which depends on the naming rules
of the underlying RDBMS.
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70.5 Renaming auxiliary tables in the database
This feature allows renaming history auxiliary tables in the database. This feature is not available for
replicated tables since their names are specified in the data model.
This feature is available on the '"Tables' table records, under the 'Actions' menu.
Auxiliary tables are database tables used for persisting aggregated lists.

The administrator can specify in the database the name of each auxiliary table corresponding to an
aggregated list of the data model.

Once the service is selected on a record, a summary screen displays information regarding the selected
auxiliary table and the administrator is prompted to enter a new name for the auxiliary table in the
database.

Note
It is required for the new identifier to begin with a letter.
It is required for the new identifier to begin with the repository prefix.
It is also required for the repository prefix to be followed by the history tables prefix.

Besides, the new name must be a valid table identifier, which depends on the naming rules
of the underlying RDBMS.

70.6 Purging master tables in the database

This feature allows purging history in the database if it is no longer used.

It is available on the 'Tables' table records, under the 'Actions' menu, and is only available for master
tables. This feature only applies to master tables. When a master table is purged, all its auxiliary tables
are purged as well.

A mapped table can be purged in the database only if it has been disabled for the corresponding
mapped mode.

To disable the mapped mode for a table, follow the procedure hereafter.
« Deactivate historization of the table in the data model, or

« Remove the table from the data model
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CHAPTER 71

Workflow management

This chapter contains the following topics:
1. Workflows
2. Interactions

3. Workflow history

71.1 Workflows

To define general parameters for the execution of data workflows, the management of workflow
publications, or to oversee data workflows in progress, navigate to the 'Administration' area. Click on
the down arrow in the navigation pane and select Workflow management > Workflows.

Note

In cases where unexpected inconsistencies arise in the workflow execution technical tables,
data workflows may encounter errors. It may then be necessary to run the operation 'Clean up
inconsistencies in workflow execution tables' from the 'Actions' menu in the navigation pane
under Administration > Workflow Management > Workflows.

Execution of workflows

Various tables can be used to manage the data workflows that are currently in progress. These tables
are accessible in Workflow management > Workflows in the navigation pane.

See alsoAdministration of data workflows [p 195]

Workflows table

The "Workflows' table contains instances of all data workflows in the repository, including those
invoked as sub-workflows. A data workflow is a particular execution instance of a workflow model
publication. This table provides access to the data context variables for all data workflows. It can be
used to access the status of advancement of the data workflow in terms of current variable values, and
in case of a data workflow suspension, to modify the variable values.

From the 'Actions' menu of the "Workflows' table, it is possible to clear the completed data workflows
that are older than a given date, by selecting the 'Clean from a date' service. This service automatically
ignores the active data workflows.
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Tokens table
The "Tokens' table allows managing the progress of data workflows. Each token marks the current
step being executed in a running data workflow, as well as the current state of the data workflow.

See alsotoken [p 33]

Work items table

The 'Work items' table contains all the work items associated with user tasks that currently exist. If
necessary, you can manually allocate a work item to a user from this table in the case of a blockage in
a data workflow. It is preferable, however, to use the buttons in the workspace of the 'Data workflows'
area whenever possible to allocate, reallocate, and deallocate work items.

See alsowork item [p 33]

Waiting workflows table
The 'Waiting workflows' table contains all the workflows waiting for an event. If needed, a service is
available to clean this table: this service deletes all lines associated with a deleted workflow.

See alsowait task [p 32]

Comment table

The 'Comments' table contains the user's comments for main workflows and their sub-workflows.

Workflow publications

The "Workflow publications' table is a technical table that contains all the workflow model publications
of the repository. This table associates published workflow models with their snapshots. It is not
recommended to directly modify this table, but rather to use the actions available in the workflow
modeling area to make changes to publications.

Configuration

Email configuration

In order for email notifications to be sent during the data workflow execution, the following settings
must be configured under 'Email configuration':

o The URL definition field is used to build links and value mail variables in the workflow.

« The 'From email' field must be completed with the email address that will be used to send email
notifications.

Interface customization

Modeling default values
The default value for some properties can be customized in this section.

The administrator has the possibility to define the default values to be used when a new workflow
model or workflow step is created in the 'Workflow Modeling' section.
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Work items views

Specific columns are available in the inbox and in the monitoring work items tables, in the 'Data
workflows' section.

10 specific columns are available. For each specific column, a customized label can be defined.

Priorities configuration

The property 'Default priority' defines how data workflows and their work items across the repository
display if they have no priority level. For example, if this property is set to the value 'Normal', any
workflow and work item with no priority will appear to have the 'Normal' priority.

The 'priorities' table defines all priority levels available to data workflows in the repository. As many
integer priority levels as needed can be added, along with their labels, which will appear when users
hover over the priority icon in the work item tables. The icons that correspond to each priority level
can also be selected, either from the set provided by TIBCO EBX, or by specifying a URL to an icon
image file.

Temporal tasks

Under 'Temporal tasks', the polling interval for time-dependent tasks in the workflow can be set, such
as deadlines and reminders. If no interval value is set, the 'in progress' steps are checked every hour.

Workflow inbox counter configuration

The workflow inbox counter is refreshed asynchronously, even if the end-user does not launch any
action. To adjust it, two parameters need to be set:

Cache expiry (seconds) Expiration time (in seconds) before a new update of the
inbox cache. Please note that this parameter can impact the
CPU load and performance since the computation time can
be costly for a repository with many work items. If no value
is defined, the default value is 600.

User interface refresh Refresh time (in seconds) between two updates of the

periodicity (seconds) inbox counter in the user interface. Please note that this
refresh concerns all inbox counters in the user interface:
inbox counters of the custom perspective, header inbox
counter and Data Workflows inbox counter for the advanced
perspective. If no value is defined, default value is 5. If the
value is zero (or negative), the refresh is disabled. Also, the
modification will only be effective after a logout/login from
the user.

Also, please note that some actions can force the inbox counter to refresh:
« access on Data workflows
 access on any subdivision of the Data workflows section
« accept or reject a work item

« launch a workflow
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These parameters are accessible in Workflow management > Workflows > Configuration > Temporal
tasks in the navigation pane.

71.2 Interactions

To manage workflow interactions, navigate to the Administration area. Click the down arrow in the
navigation pane and select the entry Workflow management > Interactions.

An interaction is generated automatically for every work item that is created. It is a local data context
of a work item and is accessible from an EBX session. When a work item is executed, the user performs
the assigned actions based upon its interaction, independently of the workflow engine. User tasks
define mappings for their input and output parameters to link interactions with the overall data contexts
of data workflows.

Interactions can be useful for monitoring the current parameters of work items. For example, an
interaction can be updated manually by a trigger or a user service.

71.3 Workflow history

To view the history data workflow execution, browse the 'Administration' area. Click on the down
arrow in the navigation pane and select Workflow management > Workflow history.

The '"Workflows' table contains all actions that have been performed during the execution of
workflows.

This data can be viewed graphically or textually. It is especially useful to view the states of various
objects related to workflows at a given moment. This includes actions on work items, variables in the
data context, as well as tokens. In case of an error, a technical log is available.

Clean history

From the 'Actions' menu of the 'Workflows' table, the history of completed data workflows older than
a given date can be cleared by selecting the 'Clear from a date' service.

Only the history of workflows that have been previously cleaned (e.g. their execution data deleted)
is cleared. This service automatically ignores the history associated with existing workflows. It is
necessary to clear data workflows before clearing the associated history, by using the dedicated service
'Clear from a date' from the "'Workflows' table. Also, a scheduled 'Clear from a date' can be used with
the built-in scheduled task SchedulerPurgeWorkflowMainHistory.

Please note that only main processes are cleaned. In order to remove sub-processes and all related
data, it will be necessary to run a 'standard EBX purge'.

See alsoHow to clean workflow history [p 403]

Note

An API is available to fetch the history of a workflow. Direct
access to the wunderlying workflow history SQL tables is not
supported. See WorkflowEngine.getProcessInstanceHistory WorkflowEngine.
getProcessInstanceHistory™.

TIBCO EBX® Product Documentation 6.0.5 448



Documentation > Administration Guide > Technical administration > Task scheduler

CHAPTER 72

Task scheduler

This chapter contains the following topics:

1.
. Configuration from EBX

Overview

2
3. Cron expression
4,
5

. Task configuration

Task definition

72.1 Overview
TIBCO EBX offers the ability to schedule programmatic tasks.

Note

In order to avoid conflicts and deadlocks, tasks are scheduled in a single queue.

72.2 Configuration from EBX

The declaration of schedules and tasks is done by selecting '"Task scheduler' in the 'Administration’
area.

Schedules: defines scheduling using "cron expressions".

Tasks: configures tasks, including parametrizing task instances and user profiles for their
execution.

Scheduled tasks: current schedule, including task scheduling activation/deactivation.

Execution reports: reports of each scheduled task run that appear immediately after the task is
triggered. The reports include actions to interrupt, pause, or resume running tasks, when made
available by the task definition.

72.3 Cron expression

(An extract of the Quartz Scheduler documentation)

The task scheduler uses "cron expressions", which can create firing schedules such as: "At 8:00am
every Monday through Friday" or "At 1:30am every last Friday of the month".
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Format

A cron expression is a string composed of 6 or 7 fields separated by a white space. Fields can contain
any of the allowed values, along with various combinations of the allowed special characters for that

field. The fields are as follows:

Field Name Mandatory Allowed Values Allowed Special Characters
Seconds Yes 0-59 L=/

Minutes Yes 0-59 =%/

Hours Yes 0-23 =%/

Day of month Yes 0-31 ,-*?2/LW

Month Yes 1-12 or JAN-DEC =%/

Day of week Yes 1-7 or SUN-SAT ,-*¥?/L#

Year No empty, 1970-2099 ,- ¥/

A cron expression can be as simple as this: "Q * * * * "
or more complex, like this: "0/5 14,18,3-39,52 * ? JAN,MAR,SEP MON-FRI 2002-2010".

Note

The legal characters and the names of months and days of the week are not case sensitive.
MON is the same as mon.

Special characters

A cron expression is a string composed of 6 or 7 fields separated by a white space. Fields can contain
any of the allowed values, along with various combinations of the allowed special characters for that
field. The fields are as follows:

* ("all values") - used to select all values within a field. For example, "*" in the Minutes field
means "every minute".

? ("no specific value") - useful when you need to specify something in one of the two fields in
which the character is allowed, but not the other. For example, if T want my trigger to fire on a
particular day of the month (say, the 10th), but don't care what day of the week that happens to be,
I would put "10" in the day-of-month field, and "?" in the day-of-week field. See the examples
below for clarification.

- - used to specify ranges. For example, "10-12" in the hour field means "the hours 10, 11 and 12".

, - used to specify additional values. For example, "MON,WED,FRI" in the day-of-week field
means "the days Monday, Wednesday, and Friday".

/ - used to specify increments. For example, "0/15" in the seconds field means "the seconds 0, 15,
30, and 45". And "5/15" in the seconds field means "the seconds 5, 20, 35, and 50". You can also
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specify '/" after the "' character - in this case " is equivalent to having '0' before the '/'. '1/3" in the
day-of-month field means "fire every 3 days starting on the first day of the month".

o L ("last") - has different meaning in each of the two fields in which it is allowed. For example,
the value "L" in the day-of-month field means "the last day of the month" - day 31 for January,
day 28 for February on non-leap years. If used in the day-of-week field by itself, it simply means
"7" or "SAT". But if used in the day-of-week field after another value, it means "the last xxx day
of the month" - for example "6L" means "the last friday of the month". When using the 'L’ option,
it is important not to specify lists, or ranges of values, as you'll get confusing results.

« W ("weekday") - used to specify the weekday (Monday-Friday) nearest the given day. As an
example, if you were to specify "15W" as the value for the day-of-month field, the meaning is:
"the nearest weekday to the 15th of the month". So if the 15th is a Saturday, the trigger will fire on
Friday the 14th. If the 15th is a Sunday, the trigger will fire on Monday the 16th. If the 15th is a
Tuesday, then it will fire on Tuesday the 15th. However if you specify "1W" as the value for day-
of-month, and the 1st is a Saturday, the trigger will fire on Monday the 3rd, as it will not 'jump’
over the boundary of a month's days. The 'W' character can only be specified when the day-of-
month is a single day, not a range or list of days.

Note

The 'L' and "W' characters can also be combined in the day-of-month field to yield
'LW', which translates to "last weekday of the month".

» # - used to specify "the nth" day-of-week day of the month. For example, the value of "6#3" in
the day-of-week field means "the third Friday of the month" (day 6 = Friday and "#3" = the 3rd
one in the month). Other examples: "2#1" = the first Monday of the month and "4#5" = the fifth
Wednesday of the month. Note that if you specify "#5" and there is not 5 of the given day-of-
week in the month, then no firing will occur that month.
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Examples
Expression Meaning
0012**? Fire at 12pm (noon) every day.
015107 ** Fire at 10:15am every day.
01510 **? Fire at 10:15am every day.
01510 **7?* Fire at 10:15am every day.

01510 * * 7?2005

Fire at 10:15am every day during the year 2005.

0*14**? Fire every minute starting at 2pm and ending at 2:59pm, every
day.
00/514**? Fire every 5 minutes starting at 2pm and ending at 2:55pm,

every day.

00/514,18 * *?

Fire every 5 minutes starting at 2pm and ending at 2:55pm,
AND fire every 5 minutes starting at 6pm and ending at
6:55pm, every day.

00-514**7?

Fire every minute starting at 2pm and ending at 2:05pm, every
day.

010,44 14? 3 WED

Fire at 2:10pm and at 2:44pm every Wednesday in the month of
March.

01510 ?* MON-FRI

Fire at 10:15am every Monday, Tuesday, Wednesday, Thursday
and Friday.

0151015*°? Fire at 10:15am on the 15th day of every month.
01510L *? Fire at 10:15am on the last day of every month.
015107 * 6L Fire at 10:15am on the last Friday of every month.

01510 ? * 6L 2002-2005

Fire at 10:15am on every last friday of every month during the
years 2002, 2003, 2004 and 2005.

015107 * 6#3

Fire at 10:15am on the third Friday of every month.

00121/5%*?

Fire at 12pm (noon) every 5 days every month, starting on the
first day of the month.

0111111117

Fire every November 11th at 11:11am.
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Note
Pay attention to the effects of '?' and "*' in the day-of-week and day-of-month fields.

Support for specifying both a day-of-week and a day-of-month value is not complete (you
must currently use the '?' character in one of these fields).

Be careful when setting fire times between the hours of the morning when "daylight savings"
changes occur in your locale (for US locales, this would typically be the hour before and after
2:00 AM - because the time shift can cause a skip or a repeat depending on whether the time
moves back or jumps forward.

72.4 Task definition

EBX scheduler comes with some predefined tasks.

Custom scheduled tasks can be added by the means of scheduler Package
com.orchestranetworks.scheduler™ Java API.

The declaration of schedules and tasks is done by selecting '"Task scheduler' in the 'Administration’
area.

72.5 Task configuration

A user must be associated with a task definition; this user will be used to generate the session session™
that will run the task.
Note

The user will not be authenticated, and no password is required. As a consequence, a
user with no password set in the directory can only be used to run scheduled tasks.

A custom task can be parameterized by means of a JavaBean specification (getter and setter).
Supported parameter types are:
+ java.lang.boolean
+ java.lang.int
« java.lang.Boolean
» java.lang.Integer
+ java.math.BigDecimal
+ java.lang.String
+ java.lang.Date
 java.net.URI
+ javanet.URL

Parameter values are set in XML format.

TIBCO EBX® Product Documentation 6.0.5 453



Documentation > Administration Guide > Technical administration > Task scheduler

TIBCO EBX® Product Documentation 6.0.5 454



Documentation > Administration Guide > Technical administration > Audit trail

CHAPTER 73
Audit trail

This chapter contains the following topics:
1. Overview

2. Update details and disk management

3. File organization

73.1 Overview

Attention

XML audit trail is a feature that allows logging updates to XML files. This legacy feature, now
deprecated, will be removed in a future version. As an alternative, please consider using the history
feature, which registers table updates in the relational database; see History [p 251].

Any persistent updates performed in the TIBCO EBX repository are logged to an audit trail XML
file. Procedure executions are also logged, even if they do not perform any updates, as procedures are
always considered to be transactions. The following information is logged:

« Transaction type, such as dataset creation, record modification, record deletion, specific
procedure, etc.

« Dataspace or snapshot on which the transaction is executed.

+ Transaction source. If the action was initiated by EBX, this source is described by the user identity,
HTTP session identifier and client IP address. If the action was initiated programmatically, only
the user's identity is logged.

+ Optional "trackingInfo" value regarding the session

« Transaction date and time (in milliseconds);

 Transaction UUID (conform to the Leach-Salz variant, version 1);
« Error information; if the transaction has failed.

+ Details of the updates performed. If there are updates and if history detail is activated, see next
section.
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73.2 Update details and disk management

The audit trail is able to describe all updates made in the EBX repository, at the finest level. Thus, the
XML files can be quite large and the audit trail directory must be carefully supervised. The following
should be taken into account:

1. If an archive import is executed in non-interactive mode (without a change set), the audit trail
does not detail the updates; it only specifies the archive that has been imported. In this case, if it
is important to keep a fine trace of the import-replace, the archive itself must be preserved.

2. If an archive import is executed in interactive mode (with a change set), or if a dataspace is merged
to its parent, the resulting log size will nearly triple the unzipped size of the archive. Furthermore,
for consistency concerns, each transaction is logged to a temporary file (in the audit trail directory)
before being moved to the main file. Therefore, EBX requires at least six times the unzipped size
of the largest archive that may be imported.

3. In the context of a custom procedure that performs many updates not requiring auditing, it is
possible for the developer to disable the detailed history using the method Procedurecontext .

APT

setHistoryActivation .

See alsoEBX monitoring [p 403]

73.3 File organization

All audit trail files are stored in the directory ${ebx.repository.directory}/History.

"Closed" audit files

Each file is named as follows:
<yyyy-mm-dd>-part<nn>.xml

where <yyyy-mm-dd> is the file date and <nn> is the file index for the current day.

Writing to current audit files

When an audit file is being written, the XML structure implies working in an "open mode". The XML
elements of the modifications are added to a text file named:

<yyyy-mm-dd>-part<nn>Content.txt

The standard XML format is still available in an XML file that references the text file. This file is
named:

<yyyy-mm-dd>-part<nn>Ref.xml

These two files are then re-aggregated in a "closed" XML file when the repository has been cleanly
shut down, or if EBX is restarted.
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Example of an audit directory

2004-04-05-part00.xml
2004-04-05-part01.xml
2004-04-06-part00.xml
2004-04-06-part01.xml
2004-04-06-part02.xml
2004-04-06-part03.xml
2004-04-07-part00.xml
2004-04-10-part00.xml
2004-04-11-part00Content.txt
2004-04-11-partOORef.xml
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CHAPTER 74

Other

This chapter contains the following topics:

1. Lineage
2. Event broker

74.1 Lineage

To administer lineage, three tables are accessible:

» Authorized profiles: Profiles must be added to this table to be used for data lineage WSDL
generation.

+ History: Lists the general data lineage WSDLs and their configuration.
« JMS location: Lists the JMS URL locations.

74.2 Event broker

Overview

TIBCO EBX offers the ability to receive notifications and information related to specific events using
the event broker feature. This feature consists in sending notifications related to EBX core events to
the subscriber according to their chosen topics.

Terminology

Event broker Notification component for loosely-coupled event handling.
Consists of dispatching fired events from EBX core to
concerned subscribers. The event broker is mainly used for
monitoring and statistical purposes.

Topic Corresponds to the EBX event type that contains messages.
The number of subscribers registered to a topic is unlimited.

Subscriber Client implementation in the modules that receive the events

related to the subscribed topic(s).
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Topics
Dataspace and snapshot Corresponds to operations in the dataspace and in the
snapshot, such as: create, close, reopen, delete, archive
export and archive import (only for dataspace merge).
Repository Corresponds to operations in the repository, such as: start-
up and purge.
User session Corresponds to the operations related to user authentication,
such as: login and logout.
Administration

The management console is located under 'Event broker' in the 'Administration' area. It contains three
tables: "Topics', 'Subscribers' and 'Subscriptions'.

All content is read-only, except for the following operations:
» Topics and subscribers can be manually activated or deactivated using dedicated services.
» Subscribers that are no longer registered to the broker can be deleted.

The event broker is based on a thread pool mechanism. The maximum number of threads can be

defined in the properties file as follows:
# Defines the number of thread pool executors to
# guarantee the publication of asynchronous events.

# The default value is 2
ebx.eventBroker.threadPool.size=2

TIBCO EBX® Product Documentation 6.0.5 460



Distributed Data
Delivery (D3)




Documentation > Administration Guide > Distributed Data Delivery (D3) > Introduction to D3

CHAPTER /5

Introduction to D3

This chapter contains the following topics:
1. Overview

2. D3 terminology

3. Known limitations

75.1 Overview

TIBCO EBX offers the ability to send data from an EBX instance to other instances. Using a broadcast
action, it also provides an additional layer of security and control to the other features of EBX.
It is particularly suitable for situations where data governance requires the highest levels of data
consistency, approvals and the ability to rollback.

D3 architecture

A typical D3 installation consists of one primary node and multiple replica nodes. In the primary node,
a Data Steward declares which dataspaces must be broadcast, as well as which user profile is allowed
to broadcast them to the replica nodes. The Data Steward also defines delivery profiles, which are
groups of one or more dataspaces.
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Each replica node must define from which delivery profile it receives broadcasts.
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Involving third-party systems

The features of D3 also allow third-party systems to access the data managed in EBX through
data services. Essentially, when a system consumes the data of a delivery dataspace, the data is
transparently redirected to the last broadcast snapshot. This ensures a more controlled and reliable
view of the managed data.

Third-party systems can either access data directly through the primary node or through a replica node.
Thus, a physical architecture consisting of a primary node and no replica nodes is possible.

Protocols

If JMS is activated, the conversation between a primary node and a replica node is based on SOAP
over JMS, while archive transfer is based on JMS binary messages.

If JMS is not activated, conversation between a primary node and a replica node is based on SOAP
over HTTP(S), while binary archive transfer is based on TCP sockets. If HTTPS is used, make sure
that the target node connector is correctly configured by enabling SSL with a trusted certificate.
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See alsoJMS for distributed data delivery (D3) [p 471]
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75.2 D3 terminology

broadcast Send a publication of an official snapshot of data from a
primary node to replica nodes. The broadcast transparently
and transactionally ensures that the data is transferred to the
replica nodes.

delivery dataspace A delivery dataspace is a dataspace that can be broadcast to
authenticated and authorized users using a dedicated action.

By default, when a data service accesses a delivery
dataspace on any node, it is redirected to the last snapshot
that was broadcast. See Data services [p 469].

delivery profile A delivery profile is a logical name that groups one or more
delivery dataspaces. Replica nodes subscribe to one or more
delivery profiles.

cluster delivery mode Synchronization with subscribed replica nodes is performed
in a two-phase commit transactional process. This delivery
mode is designed to respond to a high volume of queries
using load balancing and/or fault tolerance. It ensures the
consistency of data in the cluster between replica nodes and
their primary node delivery dataspaces. Primary and replica
nodes use the same last broadcast snapshots.

federation delivery mode Synchronization is performed in a single phase, and with
each registered replica node independently. This delivery
mode is designed to be used with geographically distributed
and/or heterogeneous architectures where response time and
network availability cannot be guaranteed. At any one time,
replica nodes can be at different last broadcast snapshots.
The synchronization processes are thus independent of one
another and replay of individual replica nodes are performed
for certain broadcast failures.

Primary node An instance of EBX that can define one or more delivery
dataspaces, and to which replica nodes can subscribe. A
primary node can also act as a regular EBX server.

Replica node An instance of EBX attached to a primary node, in order
to receive delivery dataspace broadcasts. Besides update
restrictions on delivery dataspaces, the replica node acts as
aregular EBX server.
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Hub node An instance of EBX acting as both a primary node and a

replica node. Primary delivery dataspaces and replica node
delivery dataspaces must be disjoint.

75.3 Known limitations

General limitations

Each replica node must have only one primary node.

Embedded data models cannot be used in D3 dataspaces. Therefore, it is not possible to create a
dataset based on a publication in a D3 dataspace.

The compatibility is not assured if at least one replica node product version is different from the
primary node.

Broadcast and delivery dataspace limitations

Access rights on dataspaces are not broadcast, whereas access rights on datasets are.
Dataspace information is not broadcast.

If a dataspace and its parent are broadcast, their parent-child relationship will be lost in the replica
nodes.

Once a snapshot has been broadcast to a replica, subsequent broadcasts of any snapshot with
the same name will result in restoring the originally broadcast version of that same name on the
replica node. That is, if the original snapshot on the primary node is purged and a new one is
created with the same name and subsequently broadcast, then the content of the replica will be
restored to that of the previously broadcast snapshot, and not to the latest one of the same name.

To guarantee dataspace consistency between D3 nodes, the data model (embedded or packaged
in a module) on which the broadcast contents are based, must be the same between the primary
node and its replica nodes.

On areplica delivery dataspace, if several replica nodes are registered, and if replication is enabled
in data models, it will be effective for all nodes. No setting is available to activate/deactivate
replication according to D3 nodes.

Replication on replica nodes does not take part in the distributed transaction: it is automatically
triggered after commit.

Administration limitations

Technical dataspaces cannot be broadcast, thus the EBX default user directory cannot be synchronized
using D3.
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CHAPTER 76

D3 broadcasts and delivery
dataspaces

This chapter contains the following topics:
1. Broadcast

2. Replica node registration

3. Accessing delivery dataspaces

76.1 Broadcast

Scope and contents of a broadcast

A D3 broadcast occurs at the dataspace or snapshot level. For dataspace broadcasts, D3 first creates
a snapshot to capture the current state, then broadcasts this newly created snapshot.

A broadcast performs one of the following procedures depending on the situation:

« An update of the differences computed between the new broadcast snapshot and the current
'commit' one on the replica node.

+ A full synchronization containing all datasets, tables, records, and permissions. This is done on
the first broadcast to a given replica node, if the previous replica node commit is not known to
the primary node, or on demand using the user service in '[D3] Primary node configuration'.

See alsoServices on primary nodes [p 484]

Performing a broadcast
The broadcast can be performed:

» By the end-user, using the Broadcast action available in the dataspace or snapshot (this action is
available only if the dataspace is registered as a delivery dataspace)

1

+ Using custom Java code that uses D3NodeAsMaster™.

Conditions
In order to be able to broadcast, the following conditions must be fulfilled:

+ The authenticated user profile has permission to broadcast.
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The dataspace or snapshot to be broadcast has no validation errors.

Note: Although it is not recommended, it is possible to force a broadcast of a delivery
dataspace that contains validation errors. In order to do this, set the maximum severity threshold
allowed in a delivery dataspace validation report under '[D3] Primary node configuration' in the
'Administration’ area.

The D3 primary node configuration has no validation errors on the following scope: the
technical record of the concerned delivery dataspace and all its dependencies (dependent delivery
mappings, delivery profiles and registered replica nodes).

There is an associated delivery profile.
If broadcasting a dataspace, the dataspace is not locked.

If broadcasting a snapshot, the snapshot belongs to a dataspace declared as delivery dataspace
and is not already the current broadcast snapshot (though a rollback to a previously broadcast
snapshot is possible).

The dataspace or snapshot contains differences compared to the last broadcast snapshot.

Persistence

When a primary node shuts down, all waiting or in progress broadcast requests abort, then they will
be persisted on a temporary file. On startup, all aborted broadcasts are restarted.

See alsoTemporary files [p 486]

Destination

On the target replica or hub node side:

The ebx-d3-reference dataspace identifier is the common parent of all the delivery dataspaces.
The delivery dataspace has the same identifier in primary, replica or hub nodes.

If the delivery dataspace is missing, it will be created on the first or on the full synchronization
broadcast.

If the delivery dataspace already exists on the first broadcast or full synchronization, it will be
overridden.

If an existing dataspace with the same identifier as the delivery one is detected outside of the ebx-
d3-reference, an error will be raised.

See alsoKnown limitations [p 466]

Note

Broadcasts are performed asynchronously. Therefore, no information is displayed in the user
interface about the success or failure of a broadcast. Nevertheless, it is possible to monitor the
broadcast operations inside '[D3] Primary node configuration'. See Supervision [p 485].
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76.2 Replica node registration

Scope and contents

An initialization occurs at the replica node level according to the delivery profiles registered in
the TIBCO EBX main configuration file of the replica node. When the primary node receives that
initialization request, it creates or updates the replica node entry, then sends the last broadcast snapshot
of all registered delivery dataspaces.

Note

If the registered replica node repository ID or communication layer already exists, the replica
node entry in the 'Registered replica nodes' technical table is updated, otherwise a new entry
is created.

Performing an initialization
The initialization can be done:
« Automatically at replica node server startup.

« Manually when calling the replica node service 'Register replica node'.

Conditions
To be able to register, the following conditions must be fulfilled:
+ The D3 mode must be 'hub' or 'slave'.

» The primary and replica node authentication parameters must correspond to the primary node
administrator and replica node administrator defined in their respective directories.

» The delivery profiles defined on the replica node must exist in the primary node configuration.

 All data models contained in the registered dataspaces must exist in the replica node. If embedded,
the data model names must be the same. If packaged, they must be located at the same module
name and the schema path in the module must be the same in both the primary and replica nodes.

« The D3 primary node configuration has no validation error on the following scope: the technical
record of the registered replica node and all its dependencies (dependent delivery profiles, delivery
mappings and delivery dataspaces).

Note

To set the parameters, see the replica or hub EBX properties in Configuring primary, hub and
replica nodes [p 481].

76.3 Accessing delivery dataspaces

Data services

By default, when a data service accesses a delivery dataspace, it is redirected to the current snapshot,
which is the last broadcast one. However, this default behavior can be modified either at the request
level or in the global configuration.
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See alsoCommon parameter 'disableRedirectionToLastBroadcast' [p 698]

Access restrictions

On the primary node, a delivery dataspace can neither be merged nor closed. Other operations are
available depending on permissions. For example, modifying a delivery dataspace directly, creating
a snapshot independent from a broadcast, or creating and merging a child dataspace.

On the replica node, aside from the broadcast process, no modifications of any kind can be made to
a delivery dataspace, whether by the end-user, data services, or a Java program. Furthermore, any
dataspace-related operations, such as merge, close, etc., are forbidden on the replica node.

D3 broadcast Java API

The last broadcast snapshot may change between two calls if a broadcast has taken place in the
meantime. If a fully stable view is required for several successive calls, these calls need to specifically
refer to the same snapshot.

To get the last broadcast snapshot, see b3Node . getBroadcastVersion™.
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CHAPTER £/

D3 JMS Configuration

This chapter contains the following topics:

1. JMS for distributed data delivery (D3)

77.1 JMS for distributed data delivery (D3)

To configure D3 to use JMS instead of the default HTTP and TCP protocols, you must configure the
JMS connection factory [p 3301 and the following queues declared in the WeB- INF/web.xml deployment
descriptor of the 'ebx' web application.

Note

If the TIBCO EBX main configuration does not activate JMS and D3 (‘slave',
'hub' or 'master' node) through the properties ebx.d3.mode, ebx.jms.activate and
ebx.jms.d3.activate, then the environment entries below will be ignored by EBX
runtime. See JMS [p 363] and Distributed data delivery (D3) [p 363] in the EBX main
configuration properties for more information on these properties.
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Common declarations on primary and replica nodes (for shared
queues)

Reserved resource name Default JNDI name Description

jms/EBX_D3MasterQueue Weblogic: EBX_D3MasterQueue D3 primary JMS queue (only for D3
mode 'slave' or 'hub"). It specifies the
queue name used to send SOAP requests
to the D3 primary node. The message
producer sets the primary node repository
ID as a value of the header field JMSType.

JBoss: java:/jms/EBX_D3MasterQueue

Java type: javax.jms.Queue

jms/EBX_D3ReplyQueue Weblogic: EBX_D3ReplyQueue D3 Reply JMS queue (for all D3

modes except the 'single' mode). It
specifies the name of the reply queue
for receiving SOAP responses. The
consumption is filtered using the header
field JMsCorrelationID.

JBoss: java:/jms/EBX_D3ReplyQueue

Java type: javax.jms.Queue

jms/EBX_D3ArchiveQueue Weblogic: EBX_D3ArchiveQueue D3 JMS Archive queue (for all D3
modes except the 'single' mode). It
specifies the name of the transfer
archive queue used by the D3 node.
The consumption is filtered using the
header field JMSCorrelationID. If

the archive weight is higher than the
threshold specified in the property
ebx.jms.d3.archiveMaxSizeInKB,
the archive will be divided into several
sequences. Therefore, the consumption
is filtered using the header fields
IMSXGroupID and JMSXGroupSeq instead.

JBoss: java:/jms/
EBX_D3ArchiveQueue

Java type: javax.jms.Queue

jms/EBX_D3CommunicationQueue WebLogic: EBX_D3CommunicationQueue | D3 JMS Communication queue (for

all D3 modes except 'single' mode). It
specifies the name of the communication
queue where the requests are received.
The consumption is filtered using the
header field JMSType which corresponds
to the current repository ID.

JBoss: java:/jms/
EBX_D3CommunicationQueue

Java type: javax.jms.Queue

Note

These JNDI names are set by default, but can be modified inside the web application
archive ebx.war, included in EBXForwebLogic.ear (if using Weblogic) or in EBX. ear (if
using JBoss, Websphere or other application servers).
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Optional declarations on primary nodes (for replica-specific

queues)

Note

Used for ascending compatibility prior to 5.5.0 or for mono-directional queues topology.

The deployment descriptor of the primary node must be manually modified by declaring specific
communication and archive queues for each replica node. It consists in adding resource names in
'web.xml' inside 'ebx.war'. The replica-specific node queues can be used by one or more replica nodes.

Resources can be freely named, but the physical names of their associated queue must
correspond to the definition of replica nodes for resources jms/EBX_D3ArchiveQueue and jms/

EBX_D3CommunicationQueue.

Note

Physical queue names matching: on registration, the replica node sends the
communication and archive physical queue names. These queues are matched by
physical queue name among all resources declared on the primary node. If unmatched,

the registration fails.

Examples of JMS configuration

Shared queues

Specific queues

Primary-Replica nodes architecture

Between a primary node and two replica

Between a primary node and a replica

nodes with shared queues p 474)

node with replica-specific queues [p 475]

Hub-Hub architecture

Between two hub nodes with shared
queues [p 476]

Between two hub nodes with replica-
specific queues [p 477]
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Between a primary node and two replica nodes with shared queues

« D3 Primary Node »

MS

JMS client

jms/EBX_D3ReplyQueue

Jms/EBX_D3ArchiveQueue

jms/EBX_D3CommunicationQueue

-

Message Queueing (D3 / JMS)

« D3 Replica Node »
SLA

JMS client

jms/
EBX_D3MasterCusue

jms!
EBX_D3ReplyQueue

jmsi
EBX_D3ArchiveCusue

jms!
EBX_D3CommunicationQueus

i 7 '
| 1 |
| | |
| | |
| | |
| | |
| | |
| | |
--------- 1' |
| |

¥ v Y

Reservad resource name (defined in "WEB-INF/web.xml' of ‘ebx war')

Physical name (resource adapter / messaging)

Permanent consumer fillered by repository 1D (using JMS type)

< — — - Volatile consumer (using JMS correlation d)
- — — . Producer for SOAF request of archive (using queue from JNDI resource)
4 — — - Producer for SOAP response (using queue fram JMS reply to)

Jms/EBX_D3MasterQueue

jmsi
EBX_D3ReplyQueus

jmsi
EBX_D3ArchiveQueue

Jmsi
EBX_D3CommunicationQueus

JMS client

« D3 Replica Node »
SL2
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Between a primary node and a replica node with replica-specific queues

« D3 Primary node »

MS

JMS client
: jms/EBX_D3CommunicationQueue jms/EBX_D3ReplyQueue
I ims/SL_CommunicationQueue ims/SL_ArchiveQueue
I 7 3 o T T
| | | |
1 | | |
I : | |
| | I
P [ b e — — | | |
' | I I
[ . 1 I
I T
S 0
EBX_MS_COMMUNICATION EBX_MS_REPLY
fp G
| «JMSBroker» | : |
I I I 1
[~———————— P ——————— 4 | |
1 | | |
I | I |
] | < e
|
: jms/EBX_D3MasterQueue jms/EBX_D3ReplyQueue jms/EBX_D3CommunicationQueue jms/EBX_D3ArchiveQueue
|
l .
: JMS client
|
|
|

« D3 Replica node »

SL

Reserved or custom resource name (defined in "'WEB-INF/web.xm|' of ‘ebx.war’)

Physical name (resource adapter / messaging)
<+ Permanent consumer filtered by repository ID (using JMS type)

c—— Volatile consumer (using JMS correlation 1d)
== Praducer for SOAP request or archive {using queue from JNDI resource)
«—= Producer for SOAP response (using queue from JMS reply to)
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Between two hub nodes with shared queues

« D3 Hub »

H1

(= JMS client

|

1

: jms/EBX_D3ReplyQueue ims/EBX_D3MasterQueue Jms/EBX_D3CommunicationQueue jms/EBX_D3ArchiveQueue
1

! T T T

! * I | I +
! | I I I I
! I | [ | |
! | I | I I
! I | [ | |
| | I | I I
| | | | | | |
! I I I I I
| | | |

B et N D D et > - ———
== > ————— -+ ———- p===

EBX_D3_REPLY SHARED

EBEX_D3_COMMUNICATION

« JMS Broker »

jms/EBX_D3ReplyQueue jms/EBX_D3MasterQueue jms/EBX_D3CommunicationQueue

jms/EBX_D3ArchiveQueue

I JMS client

« D3 Hub »

H2

Reserved resource name (defined in "WEB-INF/web.xm|" of ‘ebx.war’)

Physical name (resource adapter / messaging)
Permanent consumer filtered by repository ID (using JMS type)

- Volatile consumer (using JMS correlation Id)
&c—= Producer for SOAP request or archive (using queue from JNDI resource)
c—- Producer for SOAP response (using queue from JMS reply to}
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Between two hub nodes with replica-specific queues

« D3 Hub »

H1

- JMS client
I
I
I jms/EBX_D3ArchivaOueua jms/EBX_DACommunicationQueve | jms/EBX_D3ReplyQueus jmsEBX_D3MastarQueve
I e - 3
I H2_CommunicationGueue
I LS -~ T T
| | | 1 1 I
| | | 1 | I
| | | | 1 I
| | | | | I
——————— A e e e e e e e e A e e | | I
| ! | I I I
[ [ 1 1 |
| | [

| |
EBX_H1_ARCHIVE | EBX_H1_COMMUNICATION | EBX_H1_REPLY

T | I e

I I I | | I

| | «JMS Broker» | } : |
o [ g g [(Spe— I I
| | | | | |
| | | I | I
1 | | | ) )
! DA H1_CommunicationClueue
: Ime/EBX_D3MasterQuaue Ims/EBY_D3ReplyQueua | jms/EBX_D3CommunicalionCuaue Ims/EBX_D3ArchiveQuaus
I
|
I- JMS client

« D3 Hub »

H2

Reserved or custom resource name (defined in "WEB-INF/web.xml’ of ‘ebx.war’)

Physical name (resource adapter / messaging)
Permanent consumer filtered by repository 1D (using JMS type)

c—- Volatile consumer (using JMS correlation Id)
<—=— Producer for SOAP reguest or archive (using queue from JNDI resource)
- Producer for SOAP response (using queue from JMS reply to)
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CHAPTER 78

D3 administration

This chapter contains the following topics:

1. Quick start
2. Configuring D3 nodes

3. Supervision

78.1 Quick start

This section introduces the configuration of a basic D3 architecture with two TIBCO EBX instances.
Before starting, please check that each instance can work properly with its own repository.

Note

Deploy EBX on two different web application containers. If both instances are running on the
same host, ensure that all communication TCP ports are distinct.

Declare an existing dataspace on the primary node
The objective is to configure and broadcast an existing dataspace from a primary node.

This configuration is performed on the entire D3 infrastructure (primary [p 4651 and replica [p 465] nodes
included).

Update the ebx.propertiesprimary node configuration file with:

1. Define D3 mode as primary in key ebx.d3.mode.

Note

The primary node can be started after the configuration.

After authenticating as a built-in administrator, navigate within the administration tab:

1. Prerequisite: Check that the node is configured as a primary node (in the 'Actions' menu use
'System information' and check 'D3 mode').

2. Open the '[D3] Primary configuration' administration feature.

3. Add the dataspace to be broadcast to the 'Delivery dataspaces' table, and declare the allowed
profile.

4. Add the delivery profile [p465] to the 'Delivery profiles' table (it must correspond to a logical name)
and declare the delivery mode. Possible values are: cluster mode [p 465] or federation mode [p 465].
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5.

Map the delivery dataspace with the delivery profile into the 'Delivery mapping' table.

Note
The primary node is now ready for the replica node(s) registration on the delivery profile.

Check that the D3 broadcast menu appears in the 'Actions' menu of the dataspace or one of
its snapshots.

Configure replica node for registration

The objective is to configure and register the replica node based on a delivery profile and
communications settings.

Update the ebx.properties replica node configuration file with:

1.
2.

Define D3 mode as replica in key ebx.d3.mode.

Define the delivery profile [p 465] set on the primary node in key ebx.d3.delivery.profiles
(delivery profiles must be separated by a comma and a space).

Define the primary node user authentication (must have the built-in administrator profile) for
node communications in ebx.d3.master.username and ebx.d3.master.password.

Define HTTP/TCP protocols [p 482] for primary node communication, by setting a value for the
property key ebx.d3.master.url

(for example http://localhost:8080/ebx-dataservices/connector).

Define the replica node user authentication (must have the built-in administrator profile) for node
communications in ebx.d3.slave.username and ebx.d3.slave.password.

Define HTTP/TCP protocols [p 482] for replica node communication, by setting a value for the
property key ebx.d3.slave.url

(for example http://localhost:8090/ebx-dataservices/connector).

Note

The replica node can be started after the configuration.

After authenticating as a built-in administrator, navigate inside the administration tab:

1.

Prerequisite: Check that the node is configured as the replica node (in the 'Actions' menu use
'System information' and check 'D3 mode').

Open the '[D3] Replica configuration' administration feature.

Check the information on the 'Primary information' screen: No field should have the 'N/A’ value.

Note

Please check that the model is available before broadcast (from data model assistant, it must
be published).

The replica node is then ready for broadcast.
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78.2 Configuring D3 nodes

Runtime configuration of primary and hub nodes through the user
interface

The declaration of delivery dataspaces and delivery profiles is done by selecting the '[D3] Primary
configuration' feature from the 'Administration' area, where you will find the following tables:

Delivery dataspaces Declarations of the dataspaces that can be broadcast.

Delivery profiles Profiles to which replica nodes can subscribe. The delivery
mode must be defined for each delivery profile.

Delivery mapping The association between delivery dataspaces and delivery
profiles.

Note

The tables above are read-only while some broadcasts are pending or in progress.

Configuring primary, hub and replica nodes

This section details how to configure a node in its EBX main configuration file.

See alsoOverview [p 355]

Primary node

In order to act as a primary node, an instance of EBX must declare the following property in its main
configuration file.

Sample configuration for ebx.d3.mode=master node:

## D3 configuration

# Configuration for master, hub and slave

# Optional property.

# Possibles values are single, master, hub, slave

# Default is single meaning the server will be a standalone instance.
ebx.d3.mode=master

See alsoprimary node [p 465]

Hub node

In order to act as a hub node (combination of primary and replica node configurations), an instance
of EBX must declare the following property in its main configuration file.

Sample configuration for ebx.d3.mode=hub node:

## D3 configuration

# Configuration for master, hub and slave
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# Optional property.

# Possibles values are single, master, hub, slave

# Default is single meaning the server will be a standalone instance.
ebx.d3.mode=hub

# Configuration dedicated to hub or slave

# Profiles to subscribe to
# Mandatory property if ebx.d3.mode=hub or ebx.d3.mode=slave
ebx.d3.delivery.profiles=

# User and password to be used to communicate with the master.

# Mandatory properties if ebx.d3.mode=hub or ebx.d3.mode=slave
ebx.d3.master.username=

ebx.d3.master.password=

# User and password to be used by the master to communicate with the hub or slave.
# Mandatory property if ebx.d3.mode=hub or ebx.d3.mode=slave

ebx.d3.slave.username=
ebx.d3.slave.password=

See alsohub node [p 466]

Replica node

In order to act as a replica node, an instance of EBX must declare the following property in its main
configuration file.

Sample configuration for ebx.d3.mode=slave node:

## D3 configuration

# Configuration for master, hub and slave

# Optional property.

# Possibles values are single, master, hub, slave

# Default is single meaning the server will be a standalone instance.
ebx.d3.mode=slave

# Configuration dedicated to hub or slave

# Profiles to subscribe to
# Mandatory property if ebx.d3.mode=hub or ebx.d3.mode=slave
ebx.d3.delivery.profiles=

# User and password to be used to communicate with the master.

# Mandatory properties if ebx.d3.mode=hub or ebx.d3.mode=slave
ebx.d3.master.username=

ebx.d3.master.password=

# User and password to be used by the master to communicate with the hub or slave.
# Mandatory property if ebx.d3.mode=hub or ebx.d3.mode=slave

ebx.d3.slave.username=
ebx.d3.slave.password=

See alsoreplica node [p 465]

Configuring the network protocol of a node

This section details how to configure the network protocol of a node in its EBX main configuration file.

See alsoOverview [p 355]

HTTP(S) and socket TCP protocols

Sample configuration for ebx.d3.mode=hub or ebx.d3.mode=slave node with HTTP(S) network
protocol:
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# HTTP(S) and TCP socket configuration for D3 hub and slave

# URL to access the data services connector of the master

# Mandatory property if ebx.d3.mode=hub or ebx.d3.mode=slave and JMS for D3 is not activated.

# This property will be ignored if JMS for D3 is activated.

# The URL must follow this pattern: [protocol]://[master_host]:[master_port]/ebx-dataservices/connector
# Where the possible values of 'protocol' are 'http' or 'https'.

ebx.d3.master.url=

# URL to access the data services connector of the slave

# Mandatory property if ebx.d3.mode=hub or ebx.d3.mode=slave and JMS for D3 is not activated.

# This property will be ignored if JMS for D3 is activated.

# The URL must follow this pattern: [protocol]://[slave_host]:[slave_port]/ebx-dataservices/connector
# Where the possible values of 'protocol' are 'http' or 'https'.

ebx.d3.slave.url=

# Minimum port to use to transfer archives on TCP mode.
# Must be a positive integer above zero and below 65535.
# If not set, a random port will be used.
#ebx.d3.slave.socket.range.min=

# Max port to use on TCP mode to transfer archives.
# Must be a positive integer above ebx.d3.slave.socket.range.min and below 65535.

# Mandatory if ebx.d3.slave.socket.range.min is set.
#ebx.d3.slave.socket.range.max=

JMS protocol

If JMS is activated, the following properties can be defined in order to enable JMS functionalities
for a D3 node.

Sample configuration for all D3 nodes with JMS network protocol:

## JIMS configuration for D3

# Taken into account only if Data Services JMS is configured properly

# Configuration for master, hub and slave

# Default is false, activate JMS for D3

## If activated, the deployer must ensure that the entries

## 'jms/EBX_D3ReplyQueue', 'jms/EBX_D3ArchiveQueue' and 'jms/EBX_D3CommunicationQueue'
## are bound in the operational environment of the application server.

## On slave or hub mode, the entry 'jms/EBX_D3MasterQueue' must also be bound.
ebx.jms.d3.activate=false

# Change the default timeout when using reply queue.

# Must be a positive integer that does not exceed 3600000.
# Default is 10000 milliseconds.
#ebx.jms.d3.reply.timeout=10000

# Time-to-live message value expressed in milliseconds.

# This value will be set on each message header 'JMSExpiration' that defines the

# countdown before the message deletion managed by the JMS broker.

# Must be a positive integer equal to @ or above the value of 'ebx.jms.d3.reply.timeout'.
# The value 0 means that the message does not expire.

# Default is 3600000 (one hour).

#ebx.jms.d3.expiration=3600000

Archive maximum size in KB for the JMS body message. If exceeds, the message

is transferred into several sequences messages in a same group, where each one does
not exceed the maximum size defined.

Must be a positive integer equals to © or above 100.

Default is O that corresponds to unbounded.

#ebx.jms.d3.archiveMaxSizeInKB=

O W H W

# Configuration dedicated to hub or slave

# Master repository ID, used to set a message filter for the concerned master when sending JMS message
# Mandatory property if ebx.jms.d3.activate=true and if ebx.d3.mode=hub or ebx.d3.mode=slave
#ebx.jms.d3.master.repositoryId=

See alsoJMS for distributed data delivery (D3) [p 471]
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Services on primary nodes

Services to manage a primary node are available in the 'Administration' area of the replica node under
'[D3] Primary node configuration' and also in the 'Delivery dataspaces' and 'Registered replica nodes'
tables. The services are:

Relaunch replays Immediately relaunch all replays for waiting federation
deliveries.

Delete replica node delivery Delete the delivery dataspace on chosen replica nodes and/

dataspace or unregister it from the configuration of the D3 primary
node.

To access the service, select a delivery dataspace from the
'Delivery dataspaces' table on the primary node, then launch
the wizard.

Fully resynchronize Broadcast the full content of the last broadcast snapshot to
the registered replica nodes.

Subscribe a replica node Subscribe a set of selected replica nodes.

Deactivate replica nodes Remove the selected replica nodes from the broadcast scope
and switch their states to 'Unavailable'.
Note

The "in progress" broadcast contexts are rolled
back.

Unregister replica nodes Disconnects the selected replica nodes from the primary
node.
Note

The "in progress" broadcast contexts are rolled
back.

Note

The primary node services above are hidden while some broadcasts are pending or in progress.
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Services on replica nodes

Services are available in the 'Administration' area under [D3] Configuration of replica node to manage
its subscription to the primary node and perform other actions:

Register replica node

Re-subscribes the replica node to the primary node if it has
been unregistered.

Unregister replica node

Disconnects the replica node from the primary node.

Note

The "in progress" broadcast contexts are rolled
back.

Close and delete snapshots

Clean up a replica node delivery dataspace.

To access the service, select a delivery dataspace from the
"Delivery dataspaces' table on the replica node, then follow
the wizard to close and delete snapshots based on their
creation dates.

Note: The last broadcast snapshot is automatically excluded
from the selection.

78.3 Supervision

The last broadcast snapshot is highlighted in the snapshot table of the dataspace, it is represented by

an icon displayed in the first column.

Primary node management console

Several tables make up the management console of the primary node, located in the 'Administration’
area of the primary node, under '[ D3] Primary node configuration'. They are as follows:

Registered replica nodes

Replica nodes registered with the primary node. From this
table, several services are available on each record.

Broadcast history

History of broadcast operations that have taken place.

Replica node registration log

History of initialization operations that have taken place.

Detailed history

History of archive deliveries that have taken place. The list
of associated delivery archives can be accessed from the
tables 'Broadcast history' and 'Initialization history' using
selection nodes.
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Primary node supervision services

Available in the 'Administration’ area of the primary node under '[D3] Primary node configuration'.
The services are as follows:

Check replica node information  Lists the replica nodes and related information, such as
the replica node's state, associated delivery profiles, and
delivered snapshots.

Clear history content Deletes all records in all history tables, such as 'Broadcast
history', 'Replica node registration log' and 'Detailed
history'.

Replica node monitoring through the Java API

A replica node monitoring class can be created to implement actions that are triggered when the
replica node's status switches to either 'Available' or 'Unavailable'. To do so, it must implement
the NodeMonitoring interface. This class must be outside of any EBX module and accessible from
the class-loader of 'ebx.jar' and its full class name must be specified under '[D3] Replica node
configuration'.

See alsoNodeMonitoring™

Primary node notification

A D3 administrator can set up mail notifications to receive broadcast events:
« On broadcast failure,
» On federation broadcast, if replays exceed a given threshold.

The mail contains a table of events with optional links to further details.

To enable notifications, open the '[D3] Primary node configuration' dataspace from the
'Administration' area and configure the 'Notifications' group under 'Global configuration'.

The 'From email' and "URL definition' options should also be configured by using the 'Email
configuration' link.

Log supervision

The technical supervision can be done through the log category 'ebx.d3', declared in the EBX main
configuration file. For example:

ebx.log4j.category.log.d3= INFO, Console, ebxFile:d3

See alsoConfiguring the EBX logs [p 360]

Temporary files

Some temporary files, such as exchanged archives, SOAP messages, broadcast queue, (...), are created
and written to the EBX temporary directory. This location is defined in the EBX main configuration
file:
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## Directories for temporary resources.

# When set, allows specifying a directory for temporary files different from java.io.tmpdir.
# Default value is java.io.tmpdir
ebx.temp.directory = \\${java.io.tmpdir}

# Allows specifying the directory containing temporary files for cache.
# If unset, the used directory is ${ebx.temp.directory}/ebx.platform.
#ebx.temp.cache.directory = ${ebx.temp.directory}/ebx.platform

# When set, allows specifying the directory containing temporary files for import.

# If unset, the used directory is ${ebx.temp.directory}/ebx.platform.
#ebx.temp.import.directory = ${ebx.temp.directory}/ebx.platform
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CHAPTER 79

Security Best Practices

Here is a list of best practices that are considered useful to enforce a good security level for the EBX
setup. These best practices apply to EBX and to other environments, their configuration, protocols
and policies. While these practices are commonly regarded as beneficial, they may not be relevant to
your particular infrastructure and security policy.

This chapter contains the following topics:
1. Encryption algorithms

HTTPS

Installation

Web Server

Application Server

Java
Database
Archive directory

User directory and Administration rights
10.Permissions

£ N e e WD

79.1 Encryption algorithms

The Web Server or Application Server may specify encryption algorithms when setting HTTPS
parameters. Some recommendations on these algorithms are provided in section HTTPS [p 490].
Password and fields having osd:password as a type store a hash of their value, using the SHA_512
algorithm. This is, notably, the case for the password of users of the default directory.

79.2 HTTPS

It is recommended to use HTTPS for communication with clients (GUI and REST or SOAP). All
HTTP traffic should be redirected to HTTPS.

A secure cipher suite and protocols should be used whenever possible. This applies, for example, to
Web Servers, Application Servers, and JDBC connections.

TLS v1.2 should be the main protocol, because it is the only version that offers modern authenticated
encryption (also known as AEAD).
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Several obsolete cryptographic primitives must be avoided:
« Anonymous Diffie-Hellman (ADH) suites do not provide authentication,
« NULL cipher suites provide no encryption,

« Export cipher suites are insecure when negotiated in a connection, but they can also be used
against a server that prefers stronger suites (the FREAK attack),

« Suites with weak ciphers (typically of 40 and 56 bits) use encryption that can easily be broken,
« RC4 is insecure,
» 3DES is slow and weak,

On the other hand, being too restrictive on allowed cyphers may prevent some clients from connecting,
as they may not be able to negotiate a HTTPS connection.

The following configuration is compatible with browsers supported by EBX.

« Cipher  suites: ECDHE-ECDSA-AES256-GCM-SHA384:ECDHE-RSA-AES256-GCM-
SHA384:ECDHE-ECDSA-CHACHA20-POLY1305:ECDHE-RSA-CHACHA20-
POLY1305:ECDHE-ECDSA-AES128-GCM-SHA256:ECDHE-RSA-AES128-GCM-
SHA256:ECDHE-ECDSA-AES256-SHA384:ECDHE-RSA-AES256-SHA384:ECDHE-
ECDSA-AES128-SHA256:ECDHE-RSA-AES128-SHA256

e Versions: TLSv1.2

79.3 Installation

Deployed components, such as as Web Server and Application Server, should be installed using a
non-root or unprivileged user, and following the principle of least privilege whenever possible. For
example, only necessary ports and protocols should be opened.

79.4 Web Server

If you have to expose web applications on the internet, it is a good practice to protect them with a
Web Server in a demilitarized zone, while EBX and the database server can be in a production zone.
Consider the following practices for your configuration.

The secure cipher suite and protocols should be set according to the above section HTTPS [p 490].

Do not use the default configuration, and remove any banner that might also expose the version and
type of web server.

For example, on Apache2, to remove the banner (default page returned at the root), just remove the
folder /var/www/html.

Also, on Apache2, to remove headers identifying the Web Server, the value of ServerTokens and
ServerSignature from the file security.conf should have the following values:

# ServerTokens

# This directive configures what you return as the Server HTTP response
# Header. The default is 'Full' which sends information about the 0S-Type
# and compiled in modules.

# Set to one of: Full | OS | Minimal | Minor | Major | Prod

# where Full conveys the most information, and Prod the least.
ServerTokens Prod

# Optionally add a line containing the server version and virtual host

# name to server-generated pages (internal error documents, FTP directory
# listings, mod_status and mod_info output etc., but not CGI generated

# documents or custom error documents).

# Set to "EMail" to also include a mailto: link to the ServerAdmin.

# Set to one of: On | Off | EMail
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ServerSignature Off

Use the Web Server to set restrictions with HTTP security headers. Note that headers related to the
origin impact authorized URLs for all resources returned by EBX. That includes the content of fields
of the URL type (example: image of avatar).

Here is a list of security headers and how to set them for EBX. First, configure EBX to not set any
HTTP security headers. To do so, set the property ebx.security.headers.activated to false or
unset.

X-XSS-Protection

The x-xss-protection header is designed to enable the cross-site scripting (XSS) filter built into
modern web browsers. Here is what the header should look like.

X-Xss-protection: 1; mode=block

Enable in Nginx

header always unset x-xss-protection
header always set x-xss-protection "1; mode=block"

Enable in Apache2

proxy_hide_header x-xss-protection;
add_header x-xss-protection "1; mode=block" always;

x-Frame-Options

The x-frame-options header provides clickjacking protection by not allowing iframes to load on the
site. Be aware, this may not be compatible with your configuration if EBX is integrated through frames
for example. Here is what the header should look like:

x-frame-options: SAMEORIGIN

Enable in Nginx

add_header x-frame-options "SAMEORIGIN" always;
Enable in Apache2

header always sets x-frame-options "SAMEORIGIN"
X-Content-Type-Options
The x-content-type-options header prevents Internet Explorer and Google Chrome from sniffing a
response away from the declared content-type. This helps reduce the danger of drive-by downloads
and helps treat the content properly. Here is what the header looks like.

x-content-type-options: nosniff

Enable in Nginx
add_header X-Content-Type-Options "nosniff" always;
Enable in Apache2
header always sets X-Content-Type-Options "nosniff"
Strict-Transport-Security
The strict-transport-security header is a security enhancement that restricts web browsers to
access web servers solely over HTTPS. This ensures the connection cannot be established through

an insecure HTTP connection which could be vulnerable to attacks. Here is what the header should
look like:

strict-transport-security: max-age=31536000; includeSubDomains

Enable in Nginx

add_header Strict-Transport-Security "max-age=31536000; includeSubDomains" always;
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Enable in Apache2
header always sets Strict-Transport-Security "max-age=31536000; includeSubDomains"

Content-Security-Policy

The content-security-policy HTTP header provides an additional layer of security. This policy
helps prevent attacks such as Cross Site Scripting (XSS) and other code injection attacks by defining
content sources which are approved and thus allowing the browser to load them. Here is what the
header shuould look like. Make sure to adapt it with your domain name (server.company.com in the
example).

content-security-policy: default-src 'self'; font-src * data: server.company.com; img-
src * data: server.company.com; script-src * 'unsafe-inline' 'unsafe-eval'; style-src
* 'unsafe-inline';

Enable in Nginx

add_header Content-Security-Policy "default-src 'self'; font-src * data:
server.company.com; img-src * data: server.company.com; script-src * 'unsafe-inline'
'unsafe-eval'; style-src * 'unsafe-inline';" always;

Enable in Apache2

header always sets Content-Security-Policy "default-src 'self'; font-src * data:
server.company.com; img-src * data: server.company.com; script-src * 'unsafe-inline'
'unsafe-eval'; style-src * 'unsafe-inline';"

Referrer-Policy
The Referrer-Policy HTTP header governs which referrer information should be included with
requests made. The Referrer-Policy tells the web browser how to handle referrer information that is
sent when a user clicks on a link that leads to another page. Here is what it should look like:
Referrer-Policy: strict-origin
Enable in Nginx

add_header Referrer-Policy: "strict-origin" always;
Enable in Apache2

header always sets Referrer-Policy "strict-origin"

79.5 Application Server

As for Web Servers, the same best practice applies: do not expose technical information on the
Application Server. For example, for Tomcat, it is recommended to fill the attribute server of
connector in server.xml with a generic value as AppServer.

<Connector port="8080" enableLookups="false" protocol="HTTP/1.1" useBodyEncodingForURI="true"
server="AppServer"/>

If the Application Server is exposed through HTTPS, the secure cipher suite and Protocols should be
set according to the above section HTTPS [p 490].

If there is a Web Server, it is also recommended to use ports higher than 1024 and let the Web Server
do proxy.

If there is no Web Server, security headers should be set by the Application Server as described above.

79.6 Java

It is recommended to follow the security best practices from Oracle. Last supported patches should
also be applied as soon as they are available, especially when they include security patches. Consider
using the Server JRE for server systems, such as application servers or other long-running back-end
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processes. The Server JRE is the same as the regular JRE except that it does not contain the web-
browser plugins.

EBX allows a very high level of customization through custom code. All integrated Java modules
are considered by EBX as trusted. Hence, all development on top of EBX should be reviewed and
validated. As an example, developers should not generate HTML from values coming from the
database without proper escaping. For more details on this, see the Cross Site Scripting prevention
on the OWASP site. Here is a proper escaping example: the name of a store is encoded before being
displayed in an HTML form. The SstringEscapeUtils class included in Apache Commons Lang is
used for string encoding.

public class StoreMainPane implements UIFormPane

{
public static final String STORE_NAME_STYLE = "font-weight: bold; padding-top:20px; padding-bottom:20px";

@override
public void writePane(final UIFormPaneWriter writer, final UIFormContext context)

{
String storeName = (String) context.getValueContext().getValue(Paths._Store._Name);

writer.add("<div").addSafeAttribute("style", STORE_NAME_STYLE).add(">");
writer.add("Data stored for " + StringEscapeUtils.escapeHtml(storeName));
writer.add("</div>");

77 oos

79.7 Database

Databases should be encrypted at rest and in transit. If there is a private key for encryption, it should not
be stored in the same location as the data files. Regarding the JDBC connection, consider configuring
the JDBC driver to use SSL/TLS. Contact your database administrator for detailed instructions. You
should always use the last supported version or RDBMS, including drivers.

79.8 Archive directory

On the server, the archive directory [p 400] must be properly secured and/or encrypted. Indeed, any
archive exported from the EBX instance will be created there, and these archives are neither encrypted
nor protected by password. As a consequence, any user with an access to these files will be able to
see the content regardless of any permission defined in EBX.

79.9 User directory and Administration rights

For production and test platforms, EBX must be integrated with a custom directory [p 438] to enforce the
password policy of your company. The default directory can be used only for development platforms.

According to the Separation of Duties best practice, administrators can manage users and grant access
but should not have any functional rights.

79.10 Permissions

Special care is required when defining permissions in EBX. Persons in charge of this are expected
to be aware of the content of the permission documentation [p 275], and especially the information
provided in the Important considerations about permissions [p 277] section.
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cHAPTER 80

Packaging TIBCO EBX modules

An EBX module is a standard Java EE web application, packaging various resources such as XML
Schema documents, Java classes and static resources.

Since EBX modules are web applications they benefit from features such as class-loading isolation,
WAR or EAR packaging, and Web resources exposure.

This chapter contains the following topics:

1. Module structure

. Module declaration

2
3. Module registration
4

. Packaged resources

80.1 Module structure

An EBX module contains the following files:

/WEB-INF/ebx/module.xml This mandatory document defines the main properties and
services of the module. See Module declaration [p 498].

/WEB-INF/web.xml This is the standard Java EE deployment descriptor. It
can perform the registration of the EBX module when the
application server is launched. See Module registration [p
498].

/META-INF/MANIFEST.MF Optional. If present, EBX reports the 'Tmplementation-
Title' and  'Implementation-Version' values to
Administration > Technical configuration > Modules and
data models.

/www/ This optional directory contains all packaged resources,
which are accessible via public URL. See Packaged
resources [p 5001.
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Required files for Oracle WebLogic server:

/WEB-INF/weblogic.xml

WebLogic deployment descriptor file which activates the

prefer-web-inf-classes policy, such as the following:

<?xml version="1.0" encoding="UTF-8"?>

<weblogic-web-app xmlns="http://xmlns.oracle.com/weblogic/

weblogic-web-app">
<container-descriptor>

<prefer-web-inf-classes>true</prefer-web-inf-classes>

</container-descriptor>
</weblogic-web-app>

See weblogic.xml Deployment Descriptor Elements for

more information.

80.2 Module declaration

A module is declared using the document /WEB-INF/ebx/module.xml. For example:

<?xml version="1.0" encoding="UTF-8"?>
<module xmlns="urn:ebx-schemas:module_2.4"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"

Xxsi:schemaLocation="urn:ebx-schemas:module_2.4 http://schema.orchestranetworks.com/module_2.4.xsd">

<name>moduleTest</name>
</module>

See the associated schema for documentation about each property. The main properties are as follows:

Element

Description

Required

name

Defines the unique identifier of the module in the server
instance. The module name usually corresponds to the name of
the web application (the name of its directory).

Yes.

publicPath

Defines a path other than the module's name identifying the
web application in public URLs. This path is added to the URL
of external resources of the module when computing absolute
URLSs. If this field is not defined, the public path is the module's
name, defined above.

services

Declares user services using the legacy API. See Declaration
and configuration of legacy user services. From the version
5.8.0, it is strongly advised to use the new user services ip 6431.

beans

Declares reusable Java bean components. See the workflow
package p 6291.

ajaxComponents

Declares Ajax components. See Declaring an Ajax component
in a module UIAjaxComponent .declareInModule™ in the Java
APIL.

80.3 Module registration

In order to be identifiable by EBX, a module must be registered at runtime when the application server
is launched. For a web application, every EBX module must:
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or:

contain a Java class with the annotation @webListener extending the class

1

ModuleRegistrationListener™.

Attention

When using the @webListener annotation, ensure that the application server is configured to
activate the servlet 3.0 annotation scanning for the web application. See Jsr 315: JavaTM Servlet
3.0 Specification for more information.

APT,

contain a Servlet extending the class ModuleRegistrationServlet™;
make a standard declaration of this servlet in the deployment descriptor /WEB- INF/web.xm1;

ensure that this servlet will be registered at server startup by adding the following standard element
to the deployment descriptor: <load-on-startup>1</load-on-startup>.

Additional recommendations and information:

APT

The method handleRepositoryStartup in ModuleRegistrationServlet™ allows setting the
logger associated with the module and defining additional behavior such as common JavaScript
and CSS resources.

The specific class extending ModuleRegistrationServlet must be located in the web application
(under /WEB-INF/classes or /WEB-INF/1lib; due to the fact that this class is internally used as a
hook to the application's class-loader, to load Java classes used by the data models associated
with the module).

The application server startup process is asynchronous and web applications / EBX modules are
discovered dynamically. The EBX repository initialization depends on this process and will wait
for the registration of all used modules up to an unlimited amount of time. As a consequence, if
a used module is not deployed for any reason, it must be declared in the EBX main configuration
file. For more information, see the property Declaring modules as undeployed [p 369].

All module registrations and unregistrations are logged in the log.kernel category.
If an exception occurs while loading a module, the cause is written in the application server log.

Once the servlet is out of service, the module is unregistered and the data models and associated
datasets become unavailable. Note that hot deployment/undeployment is not supported [p 318].

Deployment descriptor example

Here is an example of a Java EE deployment descriptor (/WEB- INF/web.xml):

<?xml version="1.0" encoding="UTF-8"?>
<web-app xmlns="http://java.sun.com/xml/ns/javaee"

xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:schemaLocation="http://java.sun.com/xml/ns/javaee

https://www.oracle.com/webfolder/technetwork/jsc/xml/ns/javaee/web-app_3_0.xsd"
version="3.0">

<servlet>

<servlet-name>InitEbxServlet</servlet-name>
<servlet-class>com.foo.RegisterServlet</servlet-class>
<load-on-startup>1</load-on-startup>

</servlet>
</web-app>
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Registration example

Here is an implementation example of the ModuleRegistrationServlet:
package com.foo;
import javax.servlet.*;
import javax.servlet.http.?*;
import com.onwbp.base.repository.*;
/**
*/
public class RegisterServlet extends ModuleRegistrationServlet

{

public void handleRepositoryStartup(ModuleContextOnRepositoryStartup aContext)
throws OperationException

// Perform module-specific initializations here
// Declare custom resources here
aContext.addExternalStyleSheetResource(MyCompanyResources.COMMON_STYLESHEET_URL);

aContext.addExternalJavaScriptResource(MyCompanyResources.COMMON_JAVASCRIPT_URL);

aContext.addPackagedStyleSheetResource("myModule.css");
aContext.addPackagedJavaScriptResource("myModule.js");

3
public void handleRepositoryShutdown()

// Release resources of the current module when the repository is shut down here
}...
public void destroyBeforeUnregisterModule()
// Perform operations when this servlet is being taken out of service here
}...
3

80.4 Packaged resources

The packaged resources are files and documents that can be directly accessed from client browsers and
can be managed and specified either as osd:resource fields or via the Java API. They have various
types and can also be localized.

See also

ResourceType™

Type osd:resource [p 522]

Directory structure

The packaged resources must be located under the following directory structure:
1. On the first level, the directory /www/ must be located at the root of the module (web application).
2. On the second level, the directory must specify the localization. It can be:

« common/ should contain all the resources to be used by default, either because they are locale-
independent or as the default localization (in EBX, the default localization is en, namely
English);

« {lang}/ when localization is required for the resources located underneath, with {lang} to
be replaced by the actual locale code; it should correspond to the locales supported by EBX;
for more information, see Configuring EBX localization [p 359].
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3. On the third level, the directory must specify the resource type. It can be:
« jscripts/ for JavaScript resources;
« stylesheets/ for Cascading Style Sheet (CSS) resources;
« html/ for HTML resources;
« icons/ for icon typed resources;

» images/ for image typed resources.

Example

In this example, the image logowithText.jpg is the only resource that is localized:

/www
— common
|— images
| |— myCompanyLogo. jpg
| L— logowithText.jpg
— jscripts
| L— myCompanyCommon. js
L— stylesheets
L— myCompanyCommon.css
— de
L— images
L— logowithText.jpg

L— fr
L— images
L— logowithText.jpg
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CHAPTER 81

Mapping to Java

This chapter contains the following topics:

1. How to access data from Java?

2. Transactions and concurrency

3. Mapping of data types
4. Java bindings

81.1 How to access data from Java?

Read access

Data can be read from various generic Java classes, mainly Adaptation® and valueContext™. The
getter methods for these classes return objects that are typed according to the mapping rules described
in the section Mapping of data types [p 505].

Write access
Data updates must be performed in a well-managed context:

» In the context of a procedure execution, by calling the methods setvalue... of the interface

T

valueContextForUpdate™, or

o During the user input validation, by calling the method setNewvalue of the class

1

valueContextForInputvalidation™.

Modification of mutable objects

According to the mapping that is described in the Mapping of data types [p 505] section, some accessed
Java objects are mutable objects. These are instances of List ,Date or any JavaBean. Consequently,
these objects can be locally modified by their own methods. However, such modifications will remain
local to the returned object unless one of the above setters is invoked and the current transaction is
successfully committed.
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81.2 Transactions and concurrency

Concurrency
At the dataspace level In a single dataspace, the system supports running only
one single read-write Procedure and multiple concurrent
ReadOnlyProcedures. Concurrent accesses outside any
Procedure are also supported.
At the repository level At the repository level, concurrency is limited for only some

specific operations. For example (non-exhaustive list):
« A data model publication excludes many operations.

« A dataspace merge excludes write operations on the
two dataspaces involved in the merge.

Queries snapshot isolation

The following table defines the properties related to queries isolation. Note that all of the rules applying
to QueryResult also apply to RequestResult:

Queries outside of a Procedure Data is frozen at the time of fetching the QueryResult. More
precisely, a query result accesses only committed data as of
the last committed transaction at the time of fetching this
result. The content of this result never changes afterwards.

A query outside of a Procedure can be considered as a self-
containing ReadOnlyProcedure.

Queries inside of a Procedure, The QueryRresult reflects the last committed state before

in the same dataspace as the the Procedure starts and the changes that occurred in the

Procedure underlying dataspace  Procedure previously to the QueryRresult fetch. The content
of this result never changes afterwards, whatever happens
in the Procedure.

Queries inside of a Procedure, in  The consistency is guaranteed at the repository level, so

another dataspace the QueryRresult reflects the last committed state before the
Procedure starts. The content of this result never changes
after the query is fetched, whatever happens in the whole
repository.

Adaptation objects

In Java, a persistent dataset or a persistent record are both represented by an instance of the Adaptation
class.
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The following table defines the properties related to Adaptation objects.

Immutability An Adaptation object instance is immutable.

Therefore, the client code should not "hold" an Adaptation
object for a long time (in particular beyond a transaction
boundaries). However, it is possible to invoke the method
Adaptation.getUpToDateInstance™.

Fetch If an Adaptation is fetched from a QueryResult, then the
snapshot isolation rules described in the previous section
apply. Otherwise, if an Adaptation is fetched from a running
Procedure, it reflects the last committed state before the
Procedure starts. Otherwise, outside of a QueryResult or a
running Procedure, the Adaptation reflects the state of the
record on its fetch-time.

See also

API

AdaptationHome. findAdaptationOrNull

AdaptationTable.
lookupAdaptationByPrimaryKey""

81.3 Mapping of data types

This section describes how XML Schema type definitions and element declarations are mapped to
Java types.

Simple data types

Basic rules for simple data types

Each XML Schema simple type corresponds to a Java class; the mapping is documented in the table
XML Schema built-in simple types [p 518].

I

See alsoSchemaNode.createNewOccurrence”

Multiple cardinality on a simple element

If the attribute maxoccurs is greater than 1, then the element is an aggregated list and the corresponding
instance in Java is an instance of java.util.List.

Elements of the list are instances of the Java class that is determined from the mapping of the simple
type (see previous section).

Complex data types

Complex type definitions without a class declaration

By default (no attribute osd:class), a terminal node of a complex type is instantiated using an internal
class. This class provides a generic JavaBean implementation. However, if a custom client Java code
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must access these values, use a custom JavaBean. To do so, use the osd:class declaration described
in the next section.

You can transparently instantiate, read and modify the mapped Java object, with or without the

1

attribute osd:class, by invoking the methods SchemaNode.createNewOccurrence™, SchemaNode.

1

executeRead” and SchemaNode.executewrite™.

Mapping of complex types to custom JavaBeans

You can map an XML Schema complex type to a custom Java class. This is done by adding the attribute
osd:class to the complex node definition. Unless the element has xs:max0ccurs > 1, you must also
specify the attribute osd:access for the node to be considered a terminal node. If the element has
xs:maxOccurs > 1, it is automatically considered to be terminal.

The custom Java class must conform to the JavaBean protocol. This means that each child of the
complex type must correspond to a JavaBean property of the class. Additionally, each JavaBean
property must be a read-write property, and its implementation must ensure that the value set by the
setter method is returned, as-is, by the getter method. Contextual computations are not allowed in
these methods.

Example
In this example, the Java class com.carRental.Customer must define the methods getFirstName()
and setFirstName(String).
A JavaBean can have a custom user interface within TIBCO EBX, by using a UiBeanEditor™".
<xs:element name="customer" osd:access="RW">

<xs:complexType name="subscriber" osd:class="com.carRental.Customer">

<xs:sequence>

<xs:element name="firstName" type="xs:string"/>
</§§;5equence>

</xs:complexType>
</xs:element>

Multiple cardinality on a complex element
If the attribute maxoccurs is greater than 1, then the corresponding instance in Java is:

« Aninstance of java.util.List for an aggregated list, where every element in the list is an instance
of the Java class determined by the mapping of simple types [p 518], or

« An instance of AdaptationTable™, if the property osd:table is specified.

81.4 Java bindings

Java bindings support generating Java types that reflect the structure of the data model. The Java code
generation can be done in the user interface. See Generating Java bindings [p 509].

Benefits
Ensuring the link between XML Schema structure and Java code provides a number of benefits:

« Development assistance: Auto-completion when you type an access path to parameters, if it is
supported by your IDE.

+ Access code verification: All accesses to parameters are verified at code compilation.

» Impact verification: Each modification of the data model impacts the code compilation state.
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+ Cross-referencing: By using the reference tools of your IDE, you can easily verify where a
parameter is used.

Consequently, it is strongly encouraged that you use Java bindings.

XML declaration

The specification of the Java types to be generated from the data model is included in the main schema.

Each binding element defines a generation target. It must be located at, in XPath notation, xs: schema/
xs:annotation/xs:appinfo/ebxbnd:binding, where the prefix ebxbnd is a reference to the namespace
identified by the URI urn:ebx-schemas:binding_1.0. Several binding elements can be defined if you
have different generation targets.

The attribute targetbirectory of the element ebxbnd:binding defines the root directory used for Java
type generation. Generally, it is the directory containing the project source code, src. A relative path
is interpreted based on the current runtime directory of the VM, as opposed to the XML schema.

See bindings XML Schema.

XML bindings example

<xs:schema xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
xmlns:ebxbnd="urn:ebx-schemas:binding_1.0">
<xs:annotation>
<xs:appinfo>
<!-- The bindings define how this schema will be represented in Java.
Several <binding> elements may be defined, one for each target. -->
<ebxbnd:binding
targetDirectory="../_ebx-demos/src-creditOnLineStruts-1.0/">
<javaPathConstants typeName='"com.creditonline.RulesPaths">
<nodes root="/rules" prefix="" />
</javaPathConstants>
<javaPathConstants typeName="com.creditonline.StylesheetConstants">
<nodes root="/stylesheet" prefix="" />
</javaPathConstants>
</ebxbnd:binding>
</xs:appinfo>
</xs:annotation>

</xs:schema>

Java constants can be defined for XML schema paths. To do so, generate one or more interfaces from
a schema node, including the root node /. The example generates two Java path constant interfaces,
one from the node /rules and the other from the node /stylesheet in the schema. Interface names
are described by the element javaPathConstants with the attribute typename. The associated node is
described by the element nodes with the attribute root.
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CHAPTER 82

Tools for Java developers

TIBCO EBX provides Java developers with tools to facilitate use of the EBX API, as well as
integration with development environments.

This chapter contains the following topics:

1. Activating the development tools

. Data model refresh tool

. Generating Java bindings

2
3
4. Path to a node
5

. Web component link generator

82.1 Activating the development tools

To activate the development tools, run EBX in development mode. This is specified in the EBX main
configuration file EBX run mode [p 371] using the property backend.mode=development.

82.2 Data model refresh tool
When editing the data model directly as an XML Schema document without using the data-modeling
tool provided by EBX, you can refresh it without restarting the application server.

In the 'Administration’ area, select Select > Technical configuration > Development tools > Refresh
updated data models (or Refresh all data models).

Attention

Since the operation is critical regarding data consistency, refreshing the data models acquires a global
exclusive lock on the repository. This means that most other operations (data access and update,
validation, etc.) will wait until the completion of the data model refresh.

82.3 Generating Java bindings

The Java types specified by Java bindings can be generated from a dataset or a data model, by selecting
Actions > Generate Java in the navigation pane.

See alsoJava bindings [p 506]
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82.4 Path to a node

The field 'Data path' is displayed in the documentation pane of a node. This field indicates the path to
the node, which can be useful when writing XPath formulas.

Note

This field is always available to administrators.

82.5 Web component link generator

The 'Web component link generator' service is a user interface designed to create HTTP requests that
call EBX web components. To launch this service, select Actions > Web component link generator
in the navigation pane.
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CHAPTER 83

Terminology changes

A new TIBCO EBX release can introduce new vocabulary for users. To preserve the backward
compatibility, these terminology changes do not usually impact the API. Consequently, Java class
names, method names, data services operation names, etc. still use the older version terminology. This
chapter purpose is to facilitate the correspondence of the old term in the API to the new terms.

See alsoGlossary [p 25]

This chapter contains the following topics:

1. Terminology changes in version 5.9

2. Terminology changes in version 5.0

83.1 Terminology changes in version 5.9

New term Term prior to version 5.9.0
D3 primary node D3 master node
D3 replica node D3 slave node
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83.2 Terminology changes in version 5.0

The following table summarizes the mappings between the version 5.0.0 terminology and previous

terminology:
New term Term prior to version 5.0.0
Dataset Adaptation instance
Child dataset Child adaptation instance
Data model Data model
Dataspace Branch
Snapshot Version
Dataspace or snapshot Home

Data Workflow Workflow instance
Workflow model Workflow definition
Workflow publication Workflow

Data services

Data services

Field Attribute
Inherited field Inherited attribute
Record Record/occurrence
Validation rule Constraint

Simple/advanced control

Simple/advanced constraint
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CHAPTER 84

Introduction

A data model is a structural definition of the data to be managed in the TIBCO EBX repository. Data
